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CUSTOMER LICENSE TERMS

THIS IS A LICENSE AGREEMENT, NOT AN AGREEMENT FOR SALE. PLEASE READ 
THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE OR INSTALLING IT 
ON YOUR COMPUTER. IF YOU DO NOT AGREE WITH THE TERMS AND CONDI-
TIONS OF THIS AGREEMENT, PROMPTLY RETURN THE UNUSED SOFTWARE FOR A 
FULL REFUND. 

 

Single User License

 

In consideration of your payment of the license fee (which is part of the purchase 
price) and your agreement to be bound by the provisions of this License, The Chip 
Merchant, Inc. (referred to as “COMPANY”), as Licensor, grants to you a nonexclu-
sive right to use and display this copy of a software program (referred to as the 
“SOFTWARE”) on a single computer (with a single CPU) at a single location so long 
as you comply with the provisions of this License. If the single computer on which 
you use the SOFTWARE is a multiuser system, the License only covers a single user 
on that system. Additional users are subject to the payment of additional license 
fees. COMPANY reserves all rights not expressly granted to you

 

MultiUser License

 

If you intend to use this software on more than one computer, or–the software is to 
be loaded on a LAN, WAN or other multiuser network, you must pay for a multiuser 
license. In consideration of your payment of a multiuser license fee and your agree-
ment to be bound by the provisions of this License, COMPANY, as Licensor, grants 
to you a nonexclusive right to use and display this copy of a software program 
(referred to as the “SOFTWARE”) on the number of computers for which you have 
purchased a license. COMPANY reserves all rights not expressly granted to you.

You own the magnetic or other physical media on which the SOFTWARE is origi-
nally or subsequently recorded or fixed, but an express condition of this License is 
that COMPANY retains title and ownership of the SOFTWARE recorded on the origi-
nal disk copy(ies) and all subsequent copies of the SOFTWARE, regardless of the 
form or media in or on which the original and other copies may exist. This License 
is not a sale of the original SOFTWARE or any copy.

The SOFTWARE and the accompanying written materials are the subject of copy-
right. Unauthorized copying of the SOFTWARE, including SOFTWARE which has 
been modified, merged or included with other software, or of the written materials 
is expressly forbidden. You may be held legally responsible for any copyright 
infringement which is caused or encouraged by your failure to abide by the provi-
sions of this License. Subject to the restrictions above, and if the SOFTWARE is not 
copy protected, you may make one (1) copy of the SOFTWARE solely for back up 
purposes. You must reproduce and include the copyright notice on the backup 
copy.

If you have purchased a single user license, then you may physically transfer the 
SOFTWARE from one computer to another provided that the SOFTWARE is used on 
only one computer at a time. You must remove any copy of the SOFTWARE on any 
computer from which the SOFTWARE is ‘transferred’ or if a computer is transferred 
from your possession, you must remove any copy of the SOFTWARE prior to trans-
fer to any third party. You may not electronically transfer the SOFTWARE from one 
computer to another over a network without a multiuser license and payment of 
additional license fees for additional computers. You may not distribute copies of 



 

the SOFTWARE or accompanying written materials to others. You may not modify, 
adapt, translate, reverse engineer, decompose, disassemble, or create derivative 
works based on the SOFTWARE. You may not notify, adapt, translate or create deriv-
ative works based on the written materials without the prior written consent of 
COMPANY. You acknowledge that software is subject to government restrictions as 
set forth in 48 CFR 52.227 or any laws concerning rights in technical data and com-
puter software. Countries subject to U.S. embargo are: Cuba, Iran, Iraq, Libya, North 
Korea, Syria, and the Sudan. This list is subject to change without further notice 
from COMPANY, and you must comply with the list as it exists in fact. You certify 
that you are not on the U.S. Department of Commerce’s Denied Persons List or affil-
iated lists or on the U.S. Department of Treasury’s Specially Designated Nationals 
List. You agree to comply strictly with all U.S. export laws and assume sole respon-
sibility for obtaining licenses to export or reexport as may be required. 

 

Transfer Restrictions

 

The SOFTWARE is licensed only to you and may not be transferred to anyone with-
out the prior written consent of COMPANY. Any authorized transferee of the SOFT-
WARE shall be bound by the terms and conditions of this License. In no event may 
you transfer, assign, rent, lease, sell or otherwise dispose of the SOFTWARE on a 
temporary or permanent basis except as expressly provided in this License.

 

Termination

 

This License is effective until terminated. This License will terminate automatically 
without notice from COMPANY if you fail to comply with any provision of this 
License. Upon termination you shall destroy the written materials and all copies of 
the SOFTWARE, including modified copies, if any.

 

Customer Support and Update Policy

 

COMPANY will provide customer support services to you if you pay a maintenance 
fee and sign a maintenance agreement provided by COMPANY. COMPANY may cre-
ate, from time to time, updated versions of the SOFTWARE. At its option, COMPANY 
will make such updates available to you if you pay an update fee and return the Reg-
istration Card included with the SOFTWARE to COMPANY.

 

Disclaimer of Warranty

 

The SOFTWARE and accompanying written materials (including instructions for 
use) are provided “AS IS” without warranty of any kind. COMPANY does not war-
rant, guarantee or make any representations regarding the use, or the results of 
use, of the SOFTWARE or written materials in terms of correctness, accuracy, reli-
ability, currentness or otherwise. No oral or written information or advice given by 
COMPANY, its dealers, distributors, agents, or employees will constitute or give rise 
to any representation or warranty as to the accuracy or correctness of such infor-
mation or advice and you shall not be entitled to place reliance thereon.

Neither COMPANY nor anyone else who has been involved in the creation, produc-
tion or delivery of this product shall be liable for any direct, indirect, consequential 
or incidental damages (including damages for loss of business profits, business 
interruption, loss of business information and the like) arising out of the use or 
inability to use such product even if COMPANY has been advised of the possibility 
of such damages.



 

Governing Law

 

This License shall be governed and construed in accordance with the internal laws 
of the State of California and any dispute concerning this Agreement shall be exclu-
sively brought in the Southern District of California, or the California State Court in 
San Diego, California.

By opening the package on which this License is contained, you acknowledge that 
you have read this License, understand it and agree to be bound by its terms and 
conditions. You also agree that this License is the complete and exclusive state-
ment of agreement between the parties and supersedes all proposals or prior 
agreements, oral or written, and any other communications between the parties 
relating to the subject matter of this License.

Should you have any questions concerning this License, or if you desire to contact 
COMPANY for any reason, please write to: The Chip Merchant, Inc., 4870 Viewridge 
Avenue, San Diego, California 92123

©2000 The Chip Merchant, Inc. HELIX is a registered trademark of The Chip Mer-
chant, Inc.
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Getting Started
This chapter describes how to install Helix and 
register your software with the company. You will also 
find an overview of the Helix Rapid Application 
Development Environment and its associated tools.
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1.1 Introduction
All but the smallest of businesses today rely on computerized data.
Whether you manufacture a product, sell directly to consumers, or
provide a service, the foundation of what you do is tied very closely
to the data you have on hand. You use that data to evaluate past prof-
itability and to plan for the future.

But having data on hand isn’t enough. Your data must be organized in
such a way that you can find the answers you need, when you need
them. Helix is a tool that can help you provide the organization your
data need and the access your business needs.

The Helix product family includes the following products.

• Helix RADE: the Helix Rapid Application Development Environ-
ment. This tool allows you to organize your data and create appli-
cations that access that data. Most of what you read about in the 
Helix Reference deals with using this product.

• The Helix Client/Server Toolset: deploys Helix applications to 
local and/or wide area networks. Helix applications can be used 
with any networking protocols supported by the Macintosh.

• The Helix Runtime Toolset: the Helix Collection Converter and 
The Helix Engine. The Toolset lets application developers create a 
package to market everything from product demos to finished, 
locked down, serialized, and time controlled applications. It also 
provides economic alternatives in situations where several appli-
cations are being used by individual users only.

• The Helix Utilities: a group of fundamental tools to keep Helix data 
and applications in top working condition.

1.1.1 Nature and Use of Helix Reference

The Helix Reference is an encyclopedia of the definitions and descrip-
tions of the objects, commands, and capabilities found in the full fam-
ily of Helix toolsets as described above. It is meant to provide
answers to questions that you may have as you develop or customize
a Helix application. 

The Helix Reference is not a guide to the application development
process itself, nor does it discuss relational database design. This
means that you should be familiar with relational database design
principles before beginning your Helix development work. You do not
necessarily need to be a computer programmer to develop Helix
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applications, but programming knowledge will make your job a bit
easier.

Note: For an in-depth tutorial in plain English on rela-
tional database design, see Relational Database Design
Clearly Explained by Jan L. Harrington, Morgan Kauf-
mann, 1998. The book is available through amazon.com.

Helix Reference emphasizes primarily functional detail and definition.
No reference can adequately provide step-by-step instructions on
how to build specific applications for the myriad of different busi-
nesses that will use it. Nonetheless, the Helix Reference contains
many real world examples of operational detail that can help anyone
design an efficient and powerful application, regardless of type.

Information is available at http://www.helixtech.com and on discus-
sion lists and other web sites.

1.1.2 Organization of this Book

Helix Reference is divided into 15 chapters that contain descriptions
grouped around a type of object or a central theme.

• Chapter 1: Getting Started—The remainder of this chapter con-
tains instructions on installing Helix, a quick tutorial on how to 
use the product, instructions and notes on updating existing col-
lections, and the benefits of registering your Helix products.

• Chapter 2: Helix Icons—In this chapter you will find the names 
and definitions of Helix’s primary structural building blocks.

• Chapter 3: Cursors—This chapter illustrates the many shapes 
that the Helix mouse pointer can assume and how those cursors 
behave. 

• Chapter 4: Menus—This chapter discusses the content of each 
pull down menu.

• Chapter 5: Data Types—Chapter 5 provides an overview of the 
data types Helix supports.

• Chapter 6: Top Level Structural Elements—This chapter contains 
the details about creating the top level structural elements of a 
database and a database application (the collection, user, rela-
tion, and sequence windows along with Get Info). Chapter 6 also 
covers copying and pasting structures between relations and col-
lections.



Introduction

1-5

• Chapter 7: Basic Building Blocks: Fields, Indexes, and Abaci—
Chapter 7 covers the details of the windows that make up the 
structure of relations and perform calculations on data (fields, 
indexes, and abaci).

• Chapter 8: Data Manipulation: Templates, Views, and Posting—In 
this chapter you will find the details of construction windows that 
support data modification and data viewing.

• Chapter 9: Queries: Quick, Form, and Power—This chapter covers 
three of Helix’s methods of querying and filtering data.

• Chapter 10: Calculation Tiles—Abaci and tiles are the Helix visual 
programming language. This chapter provides definitions and a 
pictorial guide to all the tiles.

• Chapter 11: Document Management—In this chapter you can 
learn to understand and use Helix’s implementation of binary 
large object (BLOB) technology.

• Chapter 12: Importing and Exporting Data—This chapter covers 
the import and export of data using Dump, Load, Publish, and 
Subscribe functions.

• Chapter 13: Printing with Helix—This chapter covers creating 
hard copy from your computer stored data.

• Chapter 14: Collection Management—This chapter deals with pro-
tecting Helix applications, including saving and data reliability. It 
includes problems that can occur and what you should do about 
them.

• Chapter 15: Performance Notes—This chapter discusses how 
internal structures relate to design consideration. It also includes 
a discussion of memory allocation.

• Chapter 16: The Helix Client/Server Toolkit—In this chapter you 
can find out how to put Helix to work in a multiuser environment.

• Chapter 17: The Helix Runtime Toolkit—This chapter covers 
developing and marketing stand alone applications with Helix.

• Chapter 18: Collection Maintenance—The final chapter discusses 
using the Helix Utility, Helix Update Collection, and other utility 
applications with Helix.

The book concludes with six appendices, providing technical infor-
mation about keyword exclusions, using Helix with Apple Events,
Helix error messages, and a brief history of the Helix products.

Note: Helix debuted in December 1984, the first relational
database product for the Macintosh. As far as we know, it
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was also the first client/server database product, allowing
Helix to be used over an AppleTalk network in 1989.

1.1.3 What You Need to Know

To work with Helix and this manual, you should be familiar with the
Mac OS (launching and switching applications, making menu
choices, working with windows, dragging icons, and so on) and basic
text editing skills such as cut, copy, and paste. 

1.1.4 Conventions Used in this Manual

The following conventions for keyboard and menu selections have
been used throughout this manual:

• Menu selections are given with the menu name first, followed by 
the menu option and separated by an arrow. For example, if you 
were to choose Print from the File menu, you would see File -> 
Print. If there is a submenu, then there will be a third part to the 
choice. For example, Style -> Font -> Geneva means to choose 
Geneva from the Font submenu of the Style menu.

• Command key equivalents are displayed with the word command, 
a hyphen, and a letter or number. For example, if you were to see 
Command-D, you would know to hold down the command key 
and press D while the command key is still down.

There are three special margin icons that mark paragraphs of special
interest:

The Tip icon appears next to paragraphs that provide
helpful hints that can either make working with Helix
easier or make your development work more efficient.

The Note icon appears next to items of interest. Notes
contain historical information and information that is
“nice to know.”

The Caution icon warns you of potential problems
and helps you avoid common mistakes.
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Many of the illustrations in this manual include numbers such as ①
or ②  to indicate items of special importance. Each number is
matched with text below the illustration that explains what you are
seeing.
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1.2 Installing and Updating Helix Software

1.2.1 Preparation

If you have virus protection software installed (e.g., Virex, Norton
AntiVirus), it may cause the installation to fail. Turn the protection off
during the installation process and then re-enable it once the installa-
tion is complete.

The safest course for any installation is to restart your computer with
the extensions off. To do so, restart your Mac while holding down the
Shift key, keeping it held down until you see the message “Extensions
Off.”

1.2.1.1 Mac OS Requirements
Helix and its associated version 4.5.5 applications run on any Macin-
tosh computer running Mac OS version 7.5.5 or higher.

1.2.1.2 Backward Hardware Compatibility
Only Helix Client will run on a non-PowerPC Macintosh computer
(68030 and 68040 CPUs only). Helix Server and all other applications
require at least a PowerPC 601 or higher processor.

1.2.2 Software Installation

Helix software can be installed from a CD-ROM or from an installer file
that can be downloaded from the Helix Web site.

1.2.2.1 Beginning Installation from a CD-ROM
To install from a CD-ROM:

1. Insert the CD-ROM into the Macintosh’s CD-ROM drive.
2. Open the CD-ROM window.
3. Double click on the Installer icon to begin the installation.

1.2.2.2 Beginning the Installation with a Downloaded Installer
To install with a downloaded Installer:

1. Make a backup copy of the Installer file.
2. Double click on the Installer icon to begin the installation.
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1.2.2.3 Performing the Installation
The first thing you will see after you launch the Installer is a splash
screen.

1. Click Continue. The License Agreement window appears.

2. Read the Helix Software License carefully and click Agree to pro-
ceed to the main installer. The main installer window appears.
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1.2.2.4 Doing a Complete Install
To install all Helix components:

1. Click the Install button. A Save File dialog box appears.

2. Find the folder in which you want to install Helix.
3. Click Install. You will see an alert containing a progress bar as the 

Installer copies files into the folder you selected. When installa-
tion is complete an alert appears.

4. Click Quit to return to the Finder.

1.2.2.5 Doing a Custom Install
If you want to install selected Helix components, then you should per-
form a custom install:
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1. Choose Custom Install from the popup menu at the top left of the 
Installer window.

2. Click on the check boxes to the left of the components you want 
to install.

Tip: To get information about a component, click the
question mark at the right edge of the Installer window.

3. Click Install. You will see an alert containing a progress bar as the 
Installer copies files into the folder you selected. When installa-
tion is complete an alert appears.
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4. Click Quit to return to the Finder.

1.2.3 Launching Helix Software for the First Time

Before you can use Helix RADE or Helix Server for the first time, you
must enter your serial number and enablement keys, which were pro-
vided when you purchased your Helix product. To enter this data and
to personalize your copy of Helix:

1. Double click on the Helix RADE or Helix Server icon. The Installa-
tion dialog box appears.

2. Enter your serial number and enablement key.

Tip: You might want to highlight and copy your enable-
ment key from another document and paste it into the
Installation dialog box since the enablement key is a long
and complicated alphanumeric sequence.

3. Enter the personalization information.
4. Click OK. Helix stores your information and launches the soft-

ware.

1.2.4 Using Helix RADE for the First Time

Note: If you have used Helix software before, you can skip
to section 1.2.5.
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A Helix application is stored in a single file known as a collection that
contains the logical structure of the database, the data, and all the
elements that make up the user’s interface to the data.

1.2.4.1 Creating a Collection
To begin creating a Helix application, you must therefore first create
a collection.

1. Double click on the Helix RADE icon. The splash screen will 
appear while the program is loading. When loading has finished, 
the splash screen is replaced by an Open File dialog box.

2. Click New to create a new collection. 

A window named Collection appears. The white area at the right of
the window is the work area where the elements of your application
will be placed. The left side (the palette) contains icon wells from
which you drag icons into the work area. (The icons wells never run
dry; you can drag as many icons from them as you need.) The bot-
tom left corner of the window contains a trash can. You drag an icon
into the wastebasket to delete it from the collection. 

Work area

Icon wells

①

①

②

②
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Caution: Once something has been thrown into the trash
can, it cannot be retrieved. Deletion is permanent; there is
no Undo.

1.2.4.2 Creating a Relation
A relation is a container for data that describe a single database
entity along with the forms and procedures you define for manipulat-
ing that data.

Note: In the relational data model, a relation is the defini-
tion of a two dimensional table (a table with columns and
rows). Jon Schneider, Helix’s original designer, was an
expert in relational database design and adopted much of
the relational database terminology.

To create a relation:

1. Drag a relation icon from the Relation icon well into the work area.

2. Double click on the relation icon to open the relation window. The 
relation window opens, showing eight icon wells in its palette.
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1.2.4.3 Creating Fields
A field is a container for a single piece of data. It is stored within a sin-
gle relation.

Note: In early versions of Helix fields were called
attributes, their proper name in the relational data model.
However, more users had an intuitive understanding of
field, so the terminology was changed.

To create fields for the first name, last name, and phone number:

1. Drag a field icon from the Field icon well into the work area. The 
name of the icon will be highlighted when you release the mouse 
button at the end of the drag.

2. Type fn for “first name” as the name of the icon. Your typing 
replaces the highlighted text but the field icon remains high-
lighted.

3. Press Command-D to duplicate the field icon. A new field appears 
to the right and slightly below fn. Name the new field ln for “last 
name.”

4. Press Command-D to duplicate the field icon once more. Name 
the new field phone.

1.2.4.4 Creating an Abacus
Abaci contain data manipulation instructions. You can use them to
perform computations, change data types, manipulate text, and so
on.

To create an abacus that combines the contents of the first and last
name fields you just created into one string with a space between
them:
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1. Drag an abacus icon from the Abacus icon well into the work area. 
Name it name.

2. Double click on the abacus icon to open the abacus window. 

The white area in the window is the abacus’s work area. You drag
items from the list at the left of the window into the work area to form
expressions that manipulate data. 

The contents of the scrolling list are controlled by the three switches
at the top left of the window. In the preceding illustration, the Tile
switch is selected and the list therefore contains the abacus tiles.

3. Type “fo” (for “follow”) as a shortcut for scrolling the list of tiles at 
the left of the window. The list will scroll to highlight the followed 
by tile. Drag the followed by tile into the work area. Notice that it 
has two black squares, one on either side. These are black holes, 
areas into which you must place something.

Tiles

Tile switch
Field switch
Abacus switch

①

②

②

①

③

③

④

④
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4. Drag a second followed by tile into the work area, placing the 
arrow coming out of the bottom of the second tile into the left 
black hole of the first tile.

5. Click the Field switch (the middle switch of the three switches at 
the top left of the abacus window). The list of tiles is replaced by 
a list of fields.

6. Drag the fn field into the left black hole of the second followed by 
tile.

7. Drag the ln field into the right black hole of the first followed by 
tile.

8. Double click on the right black hole of the second followed by tile 
(the only black hole still empty). A dialog box opens into which 
you can type a value.

first followed by

second followed by
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9. Press the space bar once to type a space.
10. Click OK.
11. Close the abacus window.

1.2.4.5 Creating an Index
Indexes allow you to change the order in which data are viewed. An
index does not sort data, but simply lets you see that data in an order
different from the way the data are stored.

To create an index that will let you view the names in alphabetical
order by last name:

1. Drag an index icon from the relation’s Index icon well into the 
work area.

2. Double click on the index icon to open its window. 
3. Drag the ln field into the top black hole at the right of the window.
4. Drag the fn field into the second black hole.

5. Close the window. Helix will show you a progress bar as it creates 
the index. (The progress bar may flash by so quickly that you can 
barely see it because there are currently no data in the database.)
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1.2.4.6 Creating Templates and Views
Templates provide a pattern for the way data will be laid out on the
screen or on paper. Views use templates to display data.

To create and use templates and views for the application you have
been creating:

1. Drag a template icon from the Relation window’s Template icon 
well into the work area.

2. Type enter as the template’s name.

3. Double click on the template icon to open its window.
4. Choose Icon -> Quick Entry -> Use Icon Names. Helix will draw a 

Quick Entry Template for you.

Selection tool

Border rectangle tool

Repeat rectangle tool

Label rectangle tool

Command rectangle tool

①

①
Data rectangle tool②

②

③

③

④

④

⑤
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⑥
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5. Close the template window.
6. Drag a view icon from the Relation window’s View icon well into 

the work area.
7. Type enter as the View icon’s name.

Tip: Helix allows duplicate names as long as the dupli-
cates are different types of icons.

8. Double click on the View icon to open its window.
9. Click the enter template in the leftmost column to highlight it.

10. Press Command-L. You will see the enter data input window. 
11. Use the size box to resize the enter window to show only the 

names of the three fields and the boxes for entering data.

12. Click anywhere on the relation window (the outer window) to 
make it the active window. It’s okay to leave the view window 
open.
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13. Drag another Template icon into the work area. Name it list.

14. Double click on the list template icon to open its window.
15. Click on the second tool from the left (the tool just to the right of 

the arrow) in the row of tools at the top left of the window. This is 
the data rectangle tool that is used to draw places for data to 
appear.

16. Move the pointer to the upper left corner of the window’s dotted 
work area. The pointer changes to a crosshair.

17. Drag down two dots and to the right for about two inches to cre-
ate a data rectangle.

18. Click on the abacus icon switch (the leftmost switch in the row of 
switches below the row of tools). A list of abaci in the collection 
appears in the list at the left of the window.

19. Drag the name abacus into the data rectangle.

20. Press Command-D to duplicate the data rectangle. The mouse 
pointer turns into a small rectangle.

21. Move the mouse pointer to the right of the first data rectangle and 
click. A second data rectangle appears next to the first.

22. Click the field icon switch (directly to the right of the abacus 
switch). The list at the left of the window now displays the names 
of all the fields in the collection.
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23. Drag the phone field into the second data rectangle.

24. Click the fourth tool from the left in the row of tools (the repeat 
rectangle tool).

25. Drag to draw a repeat rectangle around both of the data rectan-
gles in the template window’s work area. It must be bigger than 
the two data rectangles, but at this point, don’t worry if it seems 
too big.

26. Press Command-O to open the repeat rectangle’s dialog box.
Click enter in the list of views.

27. Click OK to close the repeat rectangle’s dialog box.

List of views

①

①
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28. Choose Edit -> Trim. The repeat rectangle will shrink to fit snugly 
around the two data rectangles.

29. Drag a second view icon into the Relation window’s work area and 
name it list.

30. Double click on the list view’s icon to open its window.
31. Click once on list in the leftmost column.
32. Click once on index in the third column from the left.

33. Press Command-L to display the empty listing form.
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1.2.4.7 Using the Forms
Now that you have created a data entry form and a listing form, you
can enter some data and see how the forms work together to give you
access to your data.

1. Close all windows except the list and enter view windows.
2. Click on the enter window to make it active.
3. If necessary, click in the box to the right of fn to get an insertion 

point.
4. Type a first name.
5. Press Tab.
6. Type a last name.
7. Press Tab.
8. Type a phone number.
9. Press Enter to store the data. Notice that your data shows up 

automatically in the listing form, in alphabetical order by last 
name. The collection of data that you just stored is known as a 
record.

Caution: Be sure to press Enter on the numeric keyboard
rather than Return to store a record. Return inserts a car-
riage return character into a record; Enter stores a record.

Note: In the relational data model, a record is known as
“row” or a “tuple.” However, as with fields, more users
intuitively understand “record” than “tuple.”

10. Repeat steps 3 through 9 to enter at least two more records. 

You have now experienced the basics of creating a Helix application.
Everything you learn from this point forward will expand upon the
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foundation techniques of using relations, fields, abaci, templates,
views, and indexes.

1.2.5 Updating an Existing Helix Collection

To run your existing collections with a newer version of Helix, the
collections will have to be run through the Helix Update Collection
utility.

To update a collection:

1. Double click on the Update Collection program icon.
2. Choose File->Open or press Command-O. An Open File dialog box 

appears.

3. Double click on the name of the collection to be updated. Helix 
displays an alert asking you if you have a backup copy of the col-
lection.

4. Click the Cancel button if you do not have a backup copy of the 
collection. Click the OK button if you do.

5. After you click OK, Helix updates the collection and displays a 
thermometer to show you the progress of the update. 
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When the update has finished, you can either update another collec-
tion or quit and return to the Finder.

1.2.6 The Helix Translator

The Translator is a tool that converts pre-Helix Express 3.5 collec-
tions for use on either a 68K or a PowerPC Macintosh. Older collec-
tions need to be updated for use with the current Helix products.

Keep in mind, however, that Helix RADE and Helix Runtime Engine are
not compatible with 680x0 processors.

The only visible change to a translated collection is the 17 to 15 deci-
mal place change mentioned in the Data Types section. After a collec-
tion is translated, it then can be updated.

Note to experienced users: The translation process takes
longer than previous updates, especially for collections
with a lot of data. (All indexes that have numbers and
dates will be broken; they’ll rebuild when the updated col-
lection is first opened.)

• As with any conversion, run the translator on a copy of your col-
lection.

• Use the Helix Utility to perform a data damage check on your col-
lections before translating or updating.

To translate a collection:

1. Launch Update Collection. The Update Collection dialog box will 
open.

2. Select the collection you want to update, then click the Update 
Button. Helix will automatically send the collection off to the 
Translator first (if necessary) and then perform the update.

1.2.7 Helix Server Notes 

Each Helix Server will accept clients up to the number of nodes your
server license covers. This number is calculated as simultaneous
access. If your copy of Helix Server is licensed for four nodes, up to
four clients can gain access or log in to the Server at any given time.

Ordinarily, Helix Client should not be run on the same computer as
Helix Server. If your installation requires that the server also be used
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as a workstation, contact Helix Technical Support for assistance.
Running the server and client applications on the same machine usu-
ally results in performance degradation, and may cause unpredict-
able results.

Additionally, the Helix Server should not be run on the same machine
as mail servers or other network services as this can severely
degrade performance.

Helix Server requires a local hard disk that provides sufficient disk
space for the application. In addition, Helix Server will create a
scratch file and a log file (if logging is enabled). The disk on which
the server software resides must also have room for these files.

To improve performance, set the Mac OS RAM cache (via the Mem-
ory Control Panel) to 1024K. Increasing this number may have little,
or in some cases, an adverse effect. For more information see Chap-
ter 15, Performance Notes.

1.2.8 Helix Client Notes 

The Helix Client or Helix Client 68K software must be installed on any
Macintosh being used to access Helix Server. You can install as many
copies of the Helix Client as you wish. However, simultaneous access
by clients is limited to the number set by your Helix Server license.

To distribute Helix Client software

1. If necessary, run the installer and use a custom install to transfer 
the client file to a hard disk.

2. Copy the Client folder to all Macintoshes that will be acting as cli-
ents.

The Client machine must be using System 7.5.5 or later to use Exter-
nal Document Storage or Publish and Subscribe.
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1.3 Helix Registration Benefits
We want you to get the most out of Helix. After you register with
Helix—by mail or online at the Helix web site (http://www.helix-
tech.com)—we will be able to keep in touch with you so that you can
be provided with important up to date information about products
and programs.

1.3.1 User Support

Helix Technical Support is available via our web site at http://
www.helixtech.com, or by phone, fax, or email.

Technical support telephone numbers are available in the splash
screen of each program and on our web site. Telephone support is
available Monday through Friday from 9:00am to 5:00pm Eastern
Time (EST or EDT).

1.3.2 Information about Helix Product Updates

You will be kept informed about Helix program updates and enhance-
ments.

1.3.3 Educational Programs

From time to time, the company will offer educational programs. All
programs are designed to help you maximize the return on your
investment in Helix technology.

1.3.4 Developer Support Services

Helix developers who are interested in advanced support options
(referrals, advanced technical information, etc.) are eligible for spe-
cialized programs. For more information about these programs, see
our web site at http://www.helixtech.com.
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The Helix Icons
This chapter briefly discusses each of the icons used 
in Helix.
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2.1 Introduction
Virtually everything in the Helix environment is represented by an
icon:

• Icons represent objects. Each object has attributes and/or a struc-
ture that Helix manages without your having to worry about it. 
Helix can “conceal” the attributes or structure from view when 
they are not needed.

• The attributes or structure of an object is contained, enclosed or 
encapsulated within its icon.

• Opening an icon allows the user to look inside the object at its 
attributes or structure and modify either if necessary.

When you open an icon, you will usually see a window that provides a
view of the icon’s content, structure or attributes. Many of these icon
windows have a similar format, as seen in the Collection window:

In this example, the window is divided into two basic parts, a palette
and a window/work area.

The palette area can contain the tools that you need to create or
build the structure or attributes of the particular object. You create
and build the specific structure or attributes in the work area.

Trash can
Palette
Icon wells

①

①

②

②

③

③
Work area

④

④
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The scroll bars on this window are not at the upper left corner of the
page as they are in many Macintosh applications. Helix always places
you in the middle of the window so that you don’t “box yourself into
a corner” or run out of work space.

Closing an icon means either that the structure of the object should
be hidden for now or that Helix should perform some action on that
object, such as saving the changes the designer has made to it.

Another way to say this is that closing an object indicates that the
designer wants the contents of that object to be validated, or wants
actions taken to implement the new structural modifications. Here,
Helix takes over and decides what to do in the particular instance.
The designer merely closes the icon to indicate readiness for the
next step.

Closing an icon does not mean that it will have to be reopened later
to use its contents. It only needs to be opened to change its
attributes or structure.

Helix uses icons as both building blocks and assembled objects, and
provides you with several basic tools in the form of icons. The appli-
cation you create takes the form of a file on a hard disk called a col-
lection. A collection, represented by a single disk icon, stores the
structure of a database (the way in which the data are organized),
the data, and the elements of a database application program that
can be used to access the data.

As part of its built-in security, Helix creates safety icons on the Mac
OS Desktop that are concerned with collection protection. All of the
icons—except the safety icons—can be opened to reveal a window in
which something may be specified or constructed.

The descriptions of icons in this chapter use the following phrasing.

• Contained in refers to where the icon is stored. It may be a distinct 
icon on a hard disk or it may be contained within another Helix 
icon. 

• Can contain indicates all of the icons that can be created and 
stored within a given icon.

• Can reference refers to the types of other icons that can be used 
by this icon.

Once defined, an icon that is part of a Helix collection cannot be
thrown away if it is referenced, or used, by any other icons. For
example, a view placed in a menu cannot be thrown away until either
the view is removed from the menu or the menu is thrown away.
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The names of icons within a collection can be any combination of
alphanumeric characters up to 128 characters. When you change an
icon name, Helix automatically propagates that change throughout
the collection, so that the name of the icon remains the same wher-
ever the icon is used. (The exception is user icon names; duplicates
can cause problems. See section 6.4.)
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2.2 Icon Overview
The illustration below summarizes all Helix icons. Those in the gray
area are application icons. Those with the blue background are utili-
ties. Icons in the white area below the gray and blue areas are used
within a collection to define the structure of the database and the
application that manipulates data.
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2.3 Application Icons

2.3.1 Helix RADE

Identifies: the Helix Rapid Application Development Environment

Usage: Opening this icon starts the RADE application, which is used
to create structure and enter data in a Helix Collection.

Contained: in a Helix RADE folder on a hard disk

Can Reference: nothing

2.3.2 Helix Client/Server Toolkit

The Helix Client/Server Toolkit is sold separately. It is priced accord-
ing to the number of users allowed simultaneous access to a collec-
tion.

2.3.2.1 Helix Server
Identifies: the Helix Collection Server application

Usage: Opening this icon starts Helix Server, which allows you to
make the information contained in a collection accessible to more
than one user in a workgroup at a time.

Contained: in a Client/Server Toolkit folder on a hard disk

Can Reference: nothing

2.3.2.2 Helix Client
Identifies: the Helix Collection Client application 

Usage: Opening this icon starts Helix Client, which allows a user to
visit or access a Collection being hosted by the Helix Server applica-
tion. It also allows users to save portions of the application structure
to their local desktop, facilitating access to the application itself.

Contained: in a Client/Server Toolkit folder on a hard disk

Can Reference: nothing
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2.3.3 Helix Runtime Toolkit

The Helix Runtime Toolkit is not included in the basic Helix package.
It is distributed to qualified Helix professional programmers only.

2.3.3.1 Helix Runtime Engine
Identifies: the Helix Runtime Engine 

Usage: Opening this icon starts the Helix Engine application, which is
used to allow single users access only to Custom Mode parts of Helix
applications. This is often done for demonstration purposes.

Contained: in a Runtime Toolkit folder on a hard disk

Can Reference: nothing

2.3.3.2 Helix Runtime Converter
Identifies: the Helix Collection Conversion utility application 

Usage: Opening this icon starts Collection Converter, which enables
collection designers to convert applications into a form (a Runtime
collection) that prevents access to the collection structure and to
convert them back if necessary.

Contained: in a Runtime Toolkit folder on a hard disk

Can Reference: nothing

2.3.4 The Helix Utilities

This portion of the reference covers only the utility applications sup-
plied with Helix. For functional information on these as well utility
applications, see Chapter 14.

2.3.4.1 Helix Utility
Identifies: the Helix collection data repair and compaction utility 

Usage: Opening this icon starts the Helix Utility application, which is
used to diagnose and repair problems related to the data stored in
your application’s database. The program also has the ability to
break all indexes in a collection and to compact a collection to con-
serve space.



Application Icons

2-11

Contained: in a Helix Utilities folder on a hard disk

2.3.4.2 Helix Update Collection
Identifies: the Helix Update Collection/Structure Check & Repair
application 

Usage: Opening this icon starts the Update Collection application,
which is used to bring your application from a prior version of Helix
to the current one. Update Collection also has the ability diagnose
and repair problems related to the structure of your application.

Contained: in a Helix Utilities folder on a hard disk

2.3.4.3 Custom Helper
Identifies: the Custom Helper application 

Usage: Opening this icon starts the Custom Helper application, which
is used to transform a two field, tab delimited ASCII text file into
online help available under Custom Help in the Apple menu.

Contained: in a Helix Utilities folder on a hard disk

2.3.4.4 Helix Translator
Identifies: the Custom Translator application 

Usage: The Helix Translator application is used to prepare a pre-Pow-
erPC Helix Collection for updating to post-PowerPC Helix versions.

Contained: in a Helix Utilities folder on a hard disk



Chapter 2: The Helix Icons

2-12



Desktop Collection Related Icons

2-13

2.4 Desktop Collection Related Icons

2.4.1 Collection

Identifies: a Helix application structure, created with the Helix RADE
Toolkit. This icon takes one of three forms, depending upon the last
application that was used to save it. These forms are illustrated top
to bottom at left. In the first case, the collection was last saved with
Helix RADE. The middle icon is how a collection appears after being
saved with Helix Server. The last one is how it appears after being
converted to Runtime.

Usage: This icon is created by saving a collection from within one of
the Helix applications mentioned above. It contains all the internally
stored data and structures that have been created, entered and
saved.

Can Contain: Relation, sequence, and user

Contained: anywhere on a hard disk

Can Reference: nothing

2.4.2 Logfile

Identifies: a copy of transactions that are applied to a collection in
the event of a system failure to recover completed data modifications
that have not been saved in the collection file

Usage: the logging function is turned on in Custom Mode by selecting
the Save & Log command. This will protect your work against loss
between saves.

Can Contain: no icons

Contained: on a hard disk. By default, the log file appears in the same
folder as the collection it is logging.

Can Reference: the Helix application and the collection for which it is
named
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2.4.3 Saved Structure

Identifies: structural components of Helix application used by a cli-
ent in Client/Server mode, saved to the local desktop

Usage: one of the files created on the local Desktop when a client logs
into an active Helix application. It stores structure used by that cli-
ent. At the conclusion of the user’s session, the user is given the
option of saving the structure locally. Doing so can result in dramati-
cally reduced time to access the collection as well as better overall
performance. No data are stored in this icon.

Can Contain: no icons

Contained: anywhere on a client Macintosh’s hard disk

Can Reference: a Helix application and the collection for which it is
named

2.4.4 Dump File

Identifies: a text file that was exported from a Helix application’s
database. Text files are set by default to open with Bare Bones Soft-
ware’s <http://www.barebones.com/> BBEdit, but can be opened by
any application that can read ASCII text files.

Usage: the output of a Dump All..., Dump Form…, or Dump Selec-
tions… command executed by the user to export records (data) from
the database

Can Contain: no icons

Contained: anywhere on a hard disk

Can Reference: nothing

2.4.5 Suitcase

Identifies: a safety file created by Helix, Helix Engine or Helix Server
while a collection is in use

Usage: During use, all changes to a collection are written to this file.
When a Save operation is performed, the information from this file is
written to the active collection. In this way, the actual collection is
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open only for a short period during a Save. This insures the safety of
the collection in case of a system failure during use; only the changes
since the last save will be lost. This icon is visible if a system failure
occurs while a collection is open, or if the Desktop is viewed while an
open collection is in the background. If viewed on the Desktop after a
crash, this icon can be discarded. If viewed while in the Finder, do not
move, rename, or discard this icon while its referencing collection is
open or the collection will be irreparably damaged.

Can Contain: no icons

Contained: on a hard disk, in the same folder as the collection it ref-
erences

Can Reference: a Helix application and the collection for which it is
named

Additional Use: The suitcase icon is also used to represent Helix Help
and Custom Help files.

2.4.6 St. Bernard

Identifies: a safety file created by Helix, Helix Engine, or Helix Server
to allow the recovery of a collection from an interrupted save opera-
tion

Usage: During a Save attempt, the Suitcase Recovery icon of a collec-
tion becomes a St. Bernard. At this time, a collection is most vulnera-
ble to a system failure. If the save is interrupted for any reason, the
St. Bernard icon will appear on the Desktop. This file contains the
data necessary to finish the incomplete save. Helix will automatically
finish the save when the collection is reopened, as long as this icon
has not been moved, renamed, double clicked on, or thrown away. 

Caution: NEVER disturb a Recovery icon in the shape of a
St. Bernard! If the St. Bernard icon has been disturbed in
any of the ways mentioned previously, it may be impossi-
ble to recover the collection!

Can Contain: no icons

Contained: on a hard disk, in the same folder as the collection it ref-
erences

Can Reference: Helix application and the collection for which it is
named
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2.4.7 Editions

Identifies: a file created by your Helix application when a publish
command is issued

Usage: Helix supports Apple’s Publish & Subscribe, which lets docu-
ments from diverse applications share information. An edition may
be published by Helix and subscribed to by the same or a different
collection, in addition to being used by other applications. For exam-
ple, a Helix collection may publish a Contact Information edition that
is subscribed to by a letter template created by a word processor
application that is compliant with Publish & Subscribe. Using this
function with Helix’s document management capabilities, you can
effectively create and manage document content directly from a
Helix application.

Can Contain: no icons

Contained: anywhere on a hard disk

Can Reference: a Helix application and the file for which it is named
(a default, which may be overwritten)
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2.5 Collection Level Icons

2.5.1 User

Identifies: a user of a Helix Collection

Usage: Creating a user icon defines a “user” for the collection. A
developer opens the icon to create a personalized user menu, assign
individual form permissions, and assign individual command key
equivalents. Passwords for the user may be assigned using the Pass-
word command from the Set menu. Duplicating the icon duplicates
everything but the password.

Contained: in the Collection icon

Can Contain: no icons

Can Reference: view, user, or sequence

2.5.2 Relation

Identifies: a related group of data items and structures

Usage: Create a relation icon to define a data entity. Open the icon to
create the data structure, as well as to access all of the development
tools (except Custom Menus). Duplicating a relation icon duplicates
everything contained in the relation except the data.

Contained: in a Collection icon

Can Contain: abacus, field, index, post, form query, powerquery, tem-
plate, view, and trash can icons

Referenced by: abacus and post

2.5.3 Sequence

Identifies: a predefined sequence of actions that can be performed by
a user

Usage: Create a sequence icon to define a series of actions that can
be activated with a single command. Open the sequence icon to con-
struct the series using users, views, certain menu commands, and
other sequences.
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Contained: in a Collection icon and, in some cases, other sequence
icons

Can Contain: no icons

Can Reference: view, user, and sequence

Sequences are described in detail in section 6.6.

2.5.4 Trash Can

Identifies: a way of deleting objects from a Helix collection

Usage: Drag an icon from the workspace to the trash. There is no
Empty Trash command. When an icon is in use, Helix will warn you
before you throw it away. Objects dragged to the trash are destroyed
immediately and cannot be retrieved. 

Note: The trash can is not an icon well. You cannot drag
items from the trash into a work area.

Can Contain: no icons

Contained: in a collection icon, relation icon, sequence icon, and
user icon

Can Reference: nothing.
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2.6 Relation Level Icons

2.6.1 Field

Identifies: a column of data in a relation

Usage: Create a field icon to define a column of data in a relation.
Open the icon’s window to choose data type, field type (inert or nor-
mal; keyword in text fields), access formatting and validation dialogs,
and set storage options for the document data type.

Contained: in the Relation icon

Can Contain: no icons

Can Reference: nothing

Referenced by: abacus, template, form query, power query, and post.

2.6.2 Abacus

Identifies: a procedure to be performed on data

Usage: Create an abacus icon to define a procedure that manipulates
the data in a relation. Open the icon to construct the procedure using
the calculation tiles, field icons, literal values, and other abacus
icons.

Contained: in the Relation icon

Can Contain: field and abacus icons, calculation tiles, and a trash can

Can Reference: field, abacus, template, and relation icons

Referenced by: abacus, template, form query, power query, index,
and post

2.6.3 Template

Identifies: a “blueprint” used by a view or form query icon to specify
the look and function of those icons

Usage: Create a template icon to define the underlying basis for a
form query or view window. Open the icon to construct the template.
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Contained: in a Relation icon

Can Contain: no icons

Can Reference: field, abacus, template, and sequence

Referenced by: abacus, view, and form query

2.6.4 View

Identifies: a view into a relation allowing access to the data within
the relation

Usage: Create a view icon to view, print, enter, change, post, load or
dump data in the relation. Open the view icon to specify the view
parameters and to perform any of these functions.

Contained: in a Relation icon

Can Contain: no icons

Can Reference: template, abacus (in the form of abacus queries),
form query, power query, index, and post

Referenced by: template (when linking entry view to list template;
see section 8.2.2) and post

2.6.5 Index

Identifies: an ordering of the data within a relation

Usage: Create an index icon to define an order for the data within a
relation. Open the icon to specify the fields to be used to order the
data and whether the ordering is ascending or descending.

Contained: in a Relation icon

Can Contain: no icons

Can Reference: field and abacus icons

Referenced by: view
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2.6.6 Form Query

Identifies: a logical expression used to filter the data seen in a view

Usage: Create a form query icon to define a subset of the data con-
tained within a relation. Open the icon to construct a logical expres-
sion that will filter data. The logical expression in a form query
cannot be modified by users.

Contained: in a Relation icon

Can Contain: no icons

Can Reference: template, field, and abacus icons

Referenced by: view icon

2.6.7 Power Query

Identifies: a logical expression used to filter the data seen in a view

Usage: Create a power query icon to provide Full and Custom Mode
users a way to define their own search criteria. Open the icon to
select the fields and abaci on which a search can be based.

Contained: in a Relation icon

Can Contain: no icons

Can Reference: field and abacus

Referenced by: view

2.6.8 Post

Identifies: automatic data manipulation functions

Usage: Create a post icon to automatically change, enter, replace and
delete data in the same or different relation as the result of actions
taken on a view. Open the icon to specify which data to affect and
how it should be affected. More than one post icon may be attached
to the same view to affect changes in more than one place at the
same time.

Contained: in a Relation icon
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Can Contain: no icons

Can Reference: relation, view, field and abacus icons

Referenced by: view

2.6.9 Trash Can

Identifies: a way of deleting objects from a relation

Usage: Drag an icon from the workspace to the trash. There is no
Empty Trash command. When an icon is in use, Helix will warn you
before you throw it away. Objects dragged to the trash are destroyed
immediately and cannot be retrieved. 

Can Contain: no icons

Contained: in a Collection icon or relation icon

Can Reference: nothing
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Cursors
When you are working with Helix, the pointer can 
assume one of many shapes, known as cursors. This 
chapter defines what each shape represents and how 
that cursor can be used.
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3.1 Introduction
There are two categories of cursors: function cursors and waiting
cursors. Function cursors let you know what action will occur if you
click the mouse button. Waiting cursors let you know what Helix is
doing when you must wait for a process to finish.

Caution: Whenever the cursor starts to flicker rapidly, it is
signaling a low disk space warning. You should exit Helix
and make sufficient room on the disk containing the col-
lection. See section 14.5 for more information. 
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3.2 Function Cursors
Function cursors are shapes the pointer assumes when a specific
function or group of functions can be performed by clicking the
mouse.

3.2.1 Arrow

The arrow cursor appears over an item that can be selected. Clicking
the mouse selects the item and allows you to drag icons, scroll,
move, close or resize windows, or select items from pull down
menus.

3.2.2 Column Swapper

The column swapper appears at the top of a collection or relation
window where the cursor can be used to interchange adjacent Name,
Contents, Custom Icon Name, and Comments columns. The column
swapper is available only in “View by Name” and “View by Kind”
mode. (See section 6.3.3.4.)

3.2.3 Divider Dragger

The divider dragger appears at the top of a collection or relation win-
dow where the cursor may be used to change the width of the Name,
Contents, Custom Icon Name and Comments columns. It is available
only in “View by Name” and “View by Kind” mode. (See section
6.3.3.4.)

3.2.4 Button

The button cursor appear when the mouse pointer is over an area on
a form—a button or hot spot—that has been defined to function as a
button. Clicking the mouse button activates the hot spot. (See sec-
tions 8.1.8 and 6.6.)

3.2.5 Duplicate Rectangle

The duplicate cursor appears when you have used the duplicate com-
mand on one or more selected rectangles on a template. The dupli-
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cated rectangles can be placed on the template by moving the cursor
to the desired location. (See section 8.1.3.5.)

3.2.6 I-Beam

The I-beam cursor appears over a data entry rectangle or anywhere
that you can type text. Clicking the mouse creates a text insertion
point (the blinking vertical bar).

3.2.7 Cross hair

The cross hair cursor appears in a template when you have selected
one of the rectangle tools and have moved the mouse pointer over
the work area. Clicking the mouse in the work area positions a corner
of the rectangle being drawn. Dragging the mouse draws the rectan-
gle in the direction the mouse is moved. (See section 8.1.3.2.)

3.2.8 Retrieve

The retrieve cursor appears on a listing form to indicate that double
clicking on a record on the form will cause another form to open. The
data displayed on the newly opened form will be from the same
record that was double clicked on the list. (See sections 8.1.4.6 and
8.2.4.2.)

3.2.9 Grow

Available in Full Mode only, this cursor appears in the lower right
corner of a custom window whose grow box has been removed to let
the application developer resize the window. Hold down the Option
key and position the cursor at the lower right corner of the window
(where the grow box is usually found). Drag the corner of the window
to enlarge or reduce the window’s size as desired.

3.2.10 Move Window

Available in Full Mode only, this cursor allows the designer to reposi-
tion a custom window that does not have a drag bar. Hold down the
Option and Command (the one with the cloverleaf design on it) keys
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and position the cursor on the window. The window can then be
moved to a new position on the screen.

3.2.11 Mouse Click

Available in Full Mode only, this cursor appears when you’ve opened
an icon’s Info window and performed a “Command-Period” operation
to stop the window from searching for all the locations in the Collec-
tion where that icon appears. When the cursor is positioned over that
part of the window, clicking once will reactivate the search.
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3.3 Wait Cursors
Wait cursors are shapes the cursor assumes when you have to wait
for Helix to complete an activity.

3.3.1 Command

The command cursor appears when Helix is doing something that
can be interrupted by pressing Command-. (Command-period).

3.3.2 Save (Disk Access)

The save cursor appears when Helix is saving something to disk. This
function is not interruptible.

3.3.3 Wait

The wait cursor appears when Helix is performing a function that
cannot be interrupted.

3.3.4 Server AutoSave

The server AutoSave cursor appears when a save is occurring on the
server. This function is not interruptible. This cursor informs the cli-
ent of what is happening.

Note: A special ResEdit template available from Helix
Technical Support can prevent this cursor from appearing
on client machines, if desired.

3.3.5 Network Wait

The network wait cursor appears when data are being transferred
between the client and the server. This function cannot be inter-
rupted.
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3.3.6 Asynchronous List

The asynchronous list cursor appears when an asynchronous list is
building. It is possible to switch to or open other windows. This func-
tion can be interrupted by closing the list. See section 8.2.4.4. for
more information.
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Menus
This chapter discusses Helix menus, with a brief 
description of what each item does, when it is 
available, whether it can be removed from or used in 
a custom menu, and whether it is available when 
constructing a sequence. This chapter also covers 
special use commands for custom menus.
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4.1 Apple Menu
The first five Apple menu commands provide Helix information and
help. The remaining options in the menu are determined by the con-
tents of the Apple Menu Items folder on each specific Macintosh.

4.1.1 About Helix [RADE, Server, Client, Engine]

Usage: displays Helix product version information, the Helix program
serial number, expiration date (if any), trademarks, copyright notice,
and credits

When: always available

Custom Menu: removable

Sequence: not available

4.1.2 Helix Info...

Usage: shows the current Collection size, the space available on all
mounted volumes, the current UserName and client/server informa-
tion

When: always available

Custom Menu: removable

Sequence: not available

4.1.3 Why?

Usage: displays a message explaining an error or action condition

When: whenever a beep sounds, the menu bar flashes, an icon
zooms, or “marching ants” appear

Custom Menu: removable
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Sequence: not available

Note: If the Why? option is moved to another menu, the
header of the menu that contains it will flash when a
“Why?” message is available.

4.1.4 Help

Usage: accesses a wide variety of helpful hints

When: if the Helix Help icon is currently on a mounted volume

Custom Menu: removable

Sequence: not available

4.1.5 Custom Help

Usage: provides specialized help information written by the collec-
tion developer

When: if the Helix Custom Help icon is currently on a mounted vol-
ume

Custom Menu: removable

Sequence: not available

For more information, see section 16.8.1.

4.1.6 Apple Menu Items

Usage: Apple Menu Items usually include the Control Panels and the
Chooser, as well as other items and aliases that have been placed in
the Apple Menu Items folder within the System Folder.

When: always available

Custom Menu: not removable

Sequence: not available

Note: No other menu items can be inserted in this menu
below the Apple Menu Items.
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4.2 File
File menu commands affect files that contain Helix collections. The
first group of commands enable creating, opening, saving work, log-
ging. The second group handles printing of a collection’s data and
structure. The third group provides commands for importing and
exporting data. The fourth group displays information about client
and server working environments.

The above menu shows all the print and dump commands that can
appear. The commands that are available at any one time are depen-
dent upon the status of Helix. See the individual commands below for
the occasions when each one will appear on the menu.

4.2.1 New…

Usage: creates a new collection

When: a collection is not currently open

Custom Menu: not available

Sequence: not available

4.2.2 Open...

Usage: opens an existing collection

When: a collection is not currently open
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Custom Menu: not available

Sequence: not available

4.2.3 Close Collection

Usage: closes a collection, leaving the Helix application running;
enables the New and Open commands

When: a collection is open

Custom Menu: removable

Sequence: not available

Note: If changes have been made to the current collection,
an alert will appear giving you the chance to save your
changes.

4.2.4 Save

Usage: saves a new collection to disk or saves any changes made to
an existing collection

When: a collection is currently open and changes have been made

Custom Menu: removable

Sequence: available

Note: For a new collection, this command is identical to
the Save As... command.

For more information, see Chapter 14.

4.2.5 Save As...

Usage: saves a copy of a collection to disk under a new name and/or
in a new location

When: a collection is currently open

Custom Menu: removable
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Sequence: not available

Note: For a new collection, this command is identical to
the Save command. Also use this command to save a copy
of the current collection to disk as a new collection. Helix
will then make the newly created collection the current
collection and work will take place in that new file. The
original collection will be closed and not updated.

Caution: After a Save As..., you will no longer be working
in the Collection that you originally opened.

4.2.6 Revert to Saved...

Usage: discards any changes that have been made to the current col-
lection and restores the collection to its last saved version

When: a collection is open that has previously been saved to disk

Custom Menu: removable

Sequence: not available

Note: Any changes made to the Collection since the last
Save command or AutoSave will be lost.

4.2.7 Save & Log...

Usage: saves the current state of a collection and activates a log file

When: Helix is in Custom Mode

Custom Menu: removable

Sequence: not available

For more information, see sections 14.1.4 and 14.2

4.2.8 Save & Stop Logging...

Usage: saves all work to the collection and stops the logging function

When: Helix is in Custom Mode and the logging feature has been acti-
vated
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Custom Menu: removable

Sequence: not available

Note: This command replaces the Save & Log command
once Save & Log has been selected. 

4.2.9 Page Setup...

Usage: displays the Page Setup dialog, with printing options for page
size and orientation, reduction or enlargement, printer effects, and
other options

When: the active window is a window whose contents can be printed

Custom Menu: removable

Sequence: available

Any options selected in Page Setup for a form will be remembered by
the template used by the form. You can therefore choose different
options for different templates within the same collection.

For more information, see section 13.2.

4.2.10 Print Form

Usage: prints the active view window

When: a form displayed in a view is the active window

Custom Menu: removable

Sequence: available

This command brings up the Print dialog box for the current printer.

When used with a non-list form displayed in a view, Print Form prints
the record currently displayed on the view. When used with a list
form displayed in a view it prints the entire list, unless the page
range to be printed has been restricted in the Print dialog box.

Note: The options available in the Print dialog box
depend on the printer selected for the system. See your
Apple manual for information about selecting a printer.
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For more information, see section 13.3.

4.2.11 Find and Print All

Usage: prints a group of records defined by the active view window

When: a non-list form displayed in a view is the active window

Custom Menu: removable

Sequence: available

This command displays the Print dialog box for the current printer.
After setting any print specifications, clicking the OK button will print
all selected records available to the form displayed in this view.

Helix will perform a Find First, print the record, Find Next, print, and
so on, until all records retrievable by the form displayed in this view
have been printed.

Records are found according to the specifications of a selected query
and in the order specified by any selected index.

4.2.12 Print Template...

Usage: prints a template work area

When: a template window is the active window in Full Mode

Custom Menu: not available

Sequence: not available

This command displays the Print dialog for the current printer. Click-
ing the OK button on the dialog prints the template work area. If the
template work area is larger than the selected page size, Helix prints
the work area in segments on multiple pieces of paper, starting with
the upper left corner of the template.

4.2.13 Print Scaled...

Usage: prints the contents of a collection, relation, or abacus window

When: a collection, relation, or abacus window is the active window
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Custom Menu: not available

Sequence: not available

This command displays the Print dialog box for the current printer.
Clicking on the OK button on the dialog prints the contents of the
window, which will be sized to fit on one page. The size will be
reduced, if necessary, but not enlarged.

Note: This command can only be used to print to an
ImageWriter.

4.2.14 Print Paged...

Usage: prints the contents of a collection, relation, or abacus window

When: A collection, relation, or abacus window is the active window

Custom Menu: not available

Sequence: not available

This command displays the Print dialog box for the current printer.
Clicking on the OK button on the dialog prints the contents of the
window full sized, breaking it into several pages, if needed.

Note: Selections in the Page Setup dialog will determine
the page size of each segment.

Note: This command works best when printing to an
ImageWriter.

Tip: When printing a collection or relation window dis-
played in View by Name or View by Kind mode, use the
Wide paper orientation if the contents of the window are
wider than 8 inches.

For more information, see section 13.3.

4.2.15 Load...

Usage: imports data into a Helix Collection

When: a non-listing form displayed in a view that contains entry
fields and that does not contain a subform
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Custom Menu: removable

Sequence: available

Loads data into the selectable fields shown on the current form from
an ASCII text file. The command displays a dialog box that allows the
user to set field and record delimiters. Any options selected in the
Load dialog are remembered by the current form, independent of
load options selected for other forms.

For more information, see section 12.3.

4.2.16 Dump All...

Usage: exports data from a Helix Collection into an ASCII text file
(sometimes called a data file)

When: a form displayed in a view is the active window

Custom Menu: removable

Sequence: available

The set of records dumped is determined by the query selected in
the Form Setup view, if any. The order in which the records are
dumped is determined by the index selected in the Form Setup view.
If there is no index or query selected, dump order defaults to the
order in which the records were entered.

Note: Views that display only summary statistics or calcu-
lations can also be dumped.

Dumping from a form containing a subform will dump the host form
fields and then the respective subform fields. However, if the host
form fields are inert, the dump file will be empty.

For more information, see section 12.2.

4.2.17 Dump Collection/Relation Info...

Usage: exports data about the Helix collection’s underlying (Full
Mode) structure to an ASCII text file

When: a collection or relation is the active window
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Custom Menu: not available

Sequence: not available

Note: The default name for the dump file is Info Report-1.

For more information, see section 6.3.4.

4.2.18 Dump Selections

Usage: exports data from the records selected on a user selectable
list to an ASCII text file

When: one or more records are selected on a user selectable list

Custom Menu: removable

Sequence: available

The records are dumped in the order in which they were selected on
the list.

For more information, see section 12.2.

4.2.19 Full Mode Info.../Server Info...

Usage: displays a window with collection information such as serial
number, license and registration information, save statistics, mem-
ory usage, and file locations

When: a collection is open

Custom Menu: available

Sequence: available

For more information, see section 16.7.

4.2.20 Client Info...

Usage: displays a window showing client activity

When: only in Helix client/server mode

Custom Menu: available
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Sequence: available

For more information, see section 16.7.

4.2.21 Quit

Usage: closes an open collection, if needed, and exits the Helix appli-
cation that opened it; closes an existing saved structure and leaves
an open collection in client/server mode

When: always available

Custom Menu: not removable

Sequence: available

If Helix closes an open collection, a dialog box appears asking if you
want to save changes. Saving the changes closes the collection as
modified (remember that both structural and data changes will mod-
ify a collection) and then exits the Helix application. Not saving exits
the Helix application and the collection reverts to its last saved state.

Tip: Select Cancel to abort the Quit command.



Chapter 4: Menus

4-14



Edit

4-15

4.3 Edit
The Edit menu provides commands that manipulate selected data in
conjunction with the Clipboard, provides the current date and time,
automatically creates or manipulates template structures that dis-
play data and control Helix’s implementation of Apple’s Publish &
Subscribe feature, first introduced in System 7.0.

4.3.1 Undo

Usage: undoes the previous operation

When: on views displaying data entry forms

Custom Menu: not removable

Sequence: not available

This command is generally implemented only for editing functions in
Custom Mode. For example, selecting Undo after dragging a field icon
into a workspace will not remove the field icon. If you highlight a
word in a text editing rectangle, press the delete key, and then select
Undo, however, the word will reappear.

Note: As in the Finder, undo will only reverse the last oper-
ation.
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4.3.2 Cut

Usage: removes (deletes) selected items (including pictures and doc-
uments) and moves them to the Clipboard

When: data are selected on a form or in an icon name

Custom Menu: not removable

Sequence: not available

4.3.3 Copy

Usage: copies selected items (including pictures and documents)
and places the copy on the Clipboard

When: data are selected on a form or in an icon name

Custom Menu: not removable

Sequence: available

4.3.4 Paste

Usage: inserts a copy of the Clipboard contents at the current inser-
tion point

When: This command is available when data are selected, the text
insertion cursor is present, or a picture field is selected. The con-
tents of the Clipboard must be of the same type of data as the target
for the Paste operation.

Custom Menu: not removable

Sequence: available

4.3.5 Clear

Usage: erases selected data or pictures without changing the current
Clipboard contents

When: data are selected

Custom Menu: not removable
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Sequence: not available

4.3.6 Select All

Usage: selects the entire contents of an icon name, a label rectangle
on a template, or a data rectangle on an entry form displayed in a
view

When: a Helix rectangle or icon is selected

Custom Menu: removable

Sequence: available

4.3.7 Clear Selections

Usage: deselects all records currently selected on a user selectable
list

When: one or more records is selected on a user selectable list

Note: This command is not available for a subform.

Custom Menu: removable

Sequence: available

For more information, see section 8.2.4.3.

4.3.8 Select All Records

Usage: on a user selectable list, selects all records on the list

When: a list containing records is the active window

Note: This command is not available for a subform.

Custom Menu: removable

Sequence: available

For more information, see section 8.2.4.3.
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4.3.9 Copy Record/Copy All Records

Usage: when used on an entry form displayed in a view, copies a
record to the Clipboard; when used on a list form displayed in a view,
changes to Copy All Records and copies all records retrieved by the
list to the Clipboard

When: an entry or list form that does not contain a document field is
the active window

Custom Menu: removable

Sequence: available

For more information, see section 8.2.4.3.

4.3.10 Copy Selected Records

Usage: copies any record(s) selected on a user selectable list to the
Clipboard 

When: one or more records are selected on a user selectable list

Note: This command is not available for a subform.

Custom Menu: removable

Sequence: available

For more information, see section 8.2.4.3.

4.3.11 Paste Record

Usage: On an entry or list form displayed in a view, this command
pastes one or multiple records from the Clipboard to the entry or list
form displayed in a view. If multiple records exist on the Clipboard,
each is pasted into a separate record. On a list, multiple or single
records are pasted directly into the list. If records are already
selected on the list to which the Paste is applied, those selected
records are deleted.

When: an entry or list form displayed in a view is the active window
and the Clipboard contains data

Custom Menu: removable
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Sequence: available

For more information, see section 8.2.4.3.

4.3.12 Copy/Paste Record Options

Usage: sets options for records being copied or pasted; see section
12.2.4 for more information on the dialog box. 

Note: The settings are the same as the Dump and Load set-
ting for the form. Changing the setting for Copy/Paste
Record Options... also changes them for Dump and Load
and vice versa.

When: an entry or list form displayed in a view is the active window
and Copy Record or Paste Record are available

Custom Menu: removable

Sequence: not available

For more information, see section 8.2.4.3.

4.3.13 Time Stamp

Usage: inserts the current date and/or time into the selected data
entry field

When: a field rectangle with a date data type or text data type is
selected on a data entry form displayed in a view

Custom Menu: removable

Sequence: available

The displayed (and storable) value is dependent on the display for-
mat of the date field. If the field is formatted for both date and time,
then TimeStamp includes both date and time information. If the field
is formatted for date alone, then TimeStamp provides only the date
information and the time component is stored as 00:00:00. If the field
is formatted for time alone, them TimeStamp includes only time infor-
mation and the date component is stored as January 1, 0001.
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If the Field has a text data type, TimeStamp inserts the complete cur-
rent date and time. The inserted value may then be edited using stan-
dard text editing procedures.

4.3.14 Trim

Usage: This command shrinks a selected border or repeat rectangle
on a template, or shrinks the form rectangle itself, to its smallest pos-
sible size. Resized data rectangles to fit the “Example” text shown in
the Display and/or Data Entry format dialog boxes. It also resizes
label and command rectangles containing pictures so that the rectan-
gles fit the pictures exactly.

When: a trimmable rectangle is selected on a template

Custom Menu: not available

Sequence: not available

The Trim command behaves differently depending upon the status of
the Grid. If the Grid is on, Trim will shrink the rectangle down to the
smallest nearest full “click” on the Grid. (This is easier to visualize
with the Graph Paper option turned on; see sections 4.6.14 and 4.6.15
for details). With the Grid off, the selected rectangle (page, label, or
data) will shrink to the size of its contents.

4.3.15 Set Rectangle Color

Usage: sets the color of a rectangle on a template

When: a rectangle is selected on a template

Custom Menu: not available

Sequence: not available

4.3.16 Create Publisher

Usage: publishes data from a list form displayed in a view to an edi-
tion file

When: a list form displayed in a view is the active window

Custom Menu: removable
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Sequence: available

For more information, see section 12.5.1.1.

4.3.17 Publisher Options...

Usage: sets options for publishing data from a list form displayed in a
view

When: a list form displayed in a view is the active window and Create
Publisher... has already been selected

Custom Menu: removable

Sequence: available

For more information, see section 12.5.1.2.

4.3.18 Subscribe To...

Usage: subscribes to an edition file created either from within Helix
or by another application

When: an entry form displayed in a view that does not contain a doc-
ument field is the active window

Custom Menu: removable

Sequence: available

For more information, see section 12.5.2.1.

4.3.19 Subscriber Options

Usage: on an entry form displayed in a view, sets options for sub-
scribing to data

When: an entry form displayed in a view is the active window and
Subscribe To... has already been selected

Custom Menu: removable

Sequence: available
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For more information, see section 12.5.2.2.

4.3.20 Show Clipboard

Usage: displays the Clipboard and its contents (if any)

When: a collection is open

Custom Menu: removable

Sequence: not available 



Icon

4-23

4.4 Icon
The Icon menu commands provide functions that concern icons, rect-
angles, and the collection and relation windows.

This menu is not available when Helix RADE is in Custom Mode.

4.4.1 Open

Usage: opens selected icons or rectangles

When: This command is available when a rectangle or one or more
icons are selected. Note that an icon or rectangle can also be opened
by positioning the cursor over it and double clicking the mouse.

Custom Menu: not applicable

Sequence: available

4.4.2 Duplicate

Usage: This command makes a copy of any selected icon in a collec-
tion or relation window. On a template, it makes a copy of any
selected label, command, or data rectangle, or group of rectangles.

When: an icon is selected in a collection or relation window or a
label, command, or data rectangle, or group of rectangles is selected
on a template.
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Custom Menu: not applicable

Sequence: not available

When you duplicate an icon, the duplicate retains all other icons ref-
erenced by the original. The copy contains all settings and constants
in the original as well.

Note: The data represented by a relation or field icon are
not copied when either icon is duplicated.

4.4.3 Close

Usage: closes the currently active window

When: a window is open

Custom Menu: available

Sequence: available

A currently active window can also be closed by clicking in the close
box on the left side of the window’s Title Bar.

Note: Close does not automatically appear on any menu
in Custom Mode. However, it is available when construct-
ing custom menus.

4.4.4 Close All

Usage: This command closes all windows, including the collection
window, and leaves a clear desktop. It does not, however, actually
close the collection; it merely closes the collection’s window.

When: any window is open

Custom Menu: available

Sequence: available

Note: Close All does not automatically appear on any
menu in Custom Mode. However, it is available when con-
structing custom menus.
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4.4.5 Save

Usage: This command saves a new template or changes made to an
existing template. When changes are made to a template, the ‘modi-
fied template’ indicator is displayed as inverted. After Save is
selected, the indicator is displayed normally. Changes made to the
template are not reflected on the form displayed in a view until the
template is saved.

When: Save is available when a template is open and changes have
been made to it but not saved. Note that a modified Template may
also be saved by clicking the close box on the left corner of the win-
dow’s title bar.

Custom Menu: not applicable

Sequence: not available

4.4.6 Revert

Usage: replaces the current version of a template with the last saved
version

When: modifications have been made but not saved on an open tem-
plate

Custom Menu: not applicable

Sequence: not available

4.4.7 Quick Entry

Usage: Quick Entry creates a non-listing type template that contains
data rectangles for all non-inert fields that have been created in a
relation arranged vertically. The template also includes label rectan-
gles containing field names to the left of the data rectangles.

When: a blank template (one without any rectangles) is open

Custom Menu: not applicable

Sequence: not available

Tip: The order in which the fields and labels appear on
the form is determined by the order in which the field
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icons were last selected. Therefore, click on the field icons
in the order that you want them positioned on the tem-
plate prior to selecting this command.

The attributes of the label and data rectangles created conform to
the current settings of the applicable commands in the √, Font, and
Style menus.

Check boxes or radio buttons will not be displayed on the template
or form displayed in a view even though the data entry format was
originally set as check boxes or radio buttons. The data displays as
“Yes” or “No.”

For more information, see sections 8.1.2 and 8.2.1.

4.4.7.1 Custom Names/Icon Names
Usage: on a Quick Entry form, determines whether the custom names
(if any) or the icon names are displayed in the label rectangle(s)

When: a blank template (one with no rectangles) is open

Custom Menu: not applicable

Sequence: not available

For more information, see sections 8.1.2 and 8.2.1.

4.4.8 Quick List

Usage: Quick List functions the same as Quick Entry, but creates a
listing type template that contains data rectangle for all non-inert
fields that have been created in the Relation arranged horizontally.
The template also contains label rectangles for field names above the
data rectangles.

When: a blank Template (one with no rectangles) is open

Custom Menu: not available

Sequence: not available

Tip: The order in which the fields and labels appear on
the form is determined by the order in which the field
icons were last selected. Therefore, click on the field icons
in the order that you want them positioned on the tem-
plate prior to selecting this command.
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The attributes of the label and data rectangles created conform to the
current settings of the applicable commands in the √, Font, and Style
menus.

Check boxes or radio buttons will not be displayed on the template
or form displayed in a view even though the data entry format was
originally set as check boxes or radio buttons. The data displays as
“Yes” or “No.”

For more information, see sections 8.1.2 and 8.2.1.

4.4.8.1 Custom Names/Icon Names
Usage: on a Quick List form, determines whether the custom names
(if any) or the icon names are displayed in the label rectangles

When: a blank Template (one with no rectangles) is selected

Custom Menu: not applicable

Sequence: not available

For more information, see sections 8.1.2 and 8.2.1.

4.4.9 Move Forward

Usage: moves the selected background rectangle on top of the rectan-
gle immediately above it in the background layer

When: a background rectangle is selected on a template

Custom Menu: not available

Sequence: not available

Note: This command is dimmed if the rectangle selected is
the frontmost (or only) rectangle of the background layer.

4.4.10 Bring to Front

Usage: moves selected background rectangle it in front of all other
background rectangles

When: a background rectangle is selected on a template

Custom Menu: not available
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Sequence: not available

Note: This command is dimmed if the rectangle selected is
the frontmost (or only) rectangle of the background layer.

4.4.11 Move Backward

Usage: moves the selected background rectangle behind the rectan-
gle immediately below it in the background layer

When: a background rectangle is selected on a template

Custom Menu: not available

Sequence: not available

Note: This command is dimmed if the rectangle selected is
the bottom (or only) rectangle of the background layer.

4.4.12 Send to Back

Usage: moves the selected background rectangle behind all other
rectangles it in the background layer

When: a background rectangle is selected on a template

Custom Menu: not available

Sequence: not available

Note: This command is dimmed if the rectangle selected is
the bottom (or only) rectangle of the background layer.

4.4.13 View by Icon

Usage: This command displays each item in a collection or relation
window as an icon. This is the default display mode

When: a collection or relation window is the active window

Custom Menu: not available

Sequence: not available
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Note: Icons can be manipulated as they are in the Finder:
opened by double clicking, selected for renaming or dupli-
cation, or dragged into the Trash.

4.4.14 View by Name

Usage: This command displays the contents of a collection or rela-
tion window alphabetically. Each line of the listing contains a mini
icon, the icon name, the custom name (if any), the icon contents, and
comments (if any). 

When: a collection or relation window is the active window

Custom Menu: not available

Sequence: not available

Note: Icons can be manipulated as they are in the Finder:
opened by double clicking, selected for renaming or dupli-
cation, or dragged into the Trash.

For more information, see sections 6.3.2.2 and 6.5.2.

4.4.15 View by Kind

Usage: View by Kind displays the contents of a collection or relation
window by category. Each line of the listing contains a mini icon, the
icon name, the custom name (if any), and the icon contents and com-
ments (if any). The collection categories are Relation, User and
Sequence. The relation categories are Field, Abacus, Template, View,
Index, Form Query, Power Query and Post. Listings are organized
alphabetically within each category.

When: a collection or relation is the active window

Custom Menu: not available

Sequence: not available

Note: Icons can be manipulated as they are in the Finder:
opened by double clicking, selected for renaming or dupli-
cation, or dragged into the Trash.

For more information, see sections 6.3.2.2 and 6.5.2.
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4.4.16 Get Info

Usage: Get Info opens a window that provides information about an
icon and where it is used. The Get Info window also allows the defini-
tion or modification of an icon’s custom name and the insertion of
comments. Comments can also be added directly in either of the two
list views (View by Name or View by Kind).

When: an icon is selected

Custom Menu: not applicable

Sequence: not available

For more information, see section 6.2.

4.4.17 Set Window Type

Usage: sets the window style (for example, document or alert) for
view and query windows

When: one or more view and/or query icons are selected in a relation
window

Custom Menu: not applicable

Sequence: not available

This custom window feature allows the collection designer to change
the appearance of view, form query, and power query windows.

Tip: The Set Window Type... command is available only
when at least one view or query icon is selected in a rela-
tion window. You can assign the same window attributes
to multiple windows at once by selecting multiple view
and/or query icons.

For more information, see section 8.2.9.

4.4.18 Show Collection

Usage: Show Collection opens the collection window or makes it the
active window. This command does not open a collection file, but
instead redisplays a collection window that was closed previously.
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When: a collection is currently open

Custom Menu: not available

Sequence: not available

4.4.19 Icon Well Labels

Usage: turns the icon well labels on or off

When: a collection is open in Full Mode

Custom Menu: not applicable.

Sequence: not available

A check beside this command indicates the command is turned on.
No check mark means the command is turned off. With new collec-
tions, the normal state is “labels on.”

4.4.20 Clean Up

Usage: arranges the icons within an active collection or relation win-
dow into neat rows

When: a collection or relation window is open in View by Icon mode

Custom Menu: not applicable

Sequence: not available

4.4.21 Compile Forms

Usage: compiles all of the forms in a collection before entering Cus-
tom Mode

When: modifications have been made to any view definition

Custom Menu: not applicable

Sequence: not available

Normally, a form is compiled the first time it is opened after its tem-
plate is created or modified, or the items chosen in its Show Selection
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mode are defined or modified. When a collection is opened by Helix
Server, all forms are compiled and the clients must wait for the com-
pilation to complete before they can visit the collection.

Compile Forms provides a way for the collection designer to improve
performance for users by compiling all of a collection’s views before
the collection is opened in Custom Mode by Helix Server.
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4.5 Set
The Set menu commands allow the settings of options in the Helix
environment. Most of these commands bring up a dialog box when
selected.

4.5.1 Custom Mode/Full Mode

Usage: toggles between Full Mode and Custom Mode

When: a user has been set for the currently open collection

Custom Menu: removable

Sequence: not available

When in Full Mode, the Custom Mode command appears on the menu
and when in Custom Mode, the Full Mode command replaces the Cus-
tom Mode command.

A new Collection starts in Full Mode.

The very first time you switch a collection from Full Mode into Cus-
tom Mode, you must use the User... command. (See section 4.5.2.)

A new user starts in Custom Mode when selected.

Helix remembers which mode (Full or Custom) each user is in and
restores that mode when the user next opens the collection. Also,
Helix remembers which forms are open and where for each user in
Custom Mode and restores them to their locations when the user
next opens the collection. Full Mode window status is also remem-
bered but not on a per user basis. This means that a Full Mode user
will be presented with the windows that were open when the last Full
Mode user closed the collection.

Tip: To prevent a user from accessing Full Mode, remove
the Full Mode command from the Set menu. However, if
there are no users who are in or who may enter Full Mode,
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then every user is automatically in Full Mode. This pro-
tects against the situation where the first set of menus is
created (without the Full Mode command), the designer
tests them by going into Custom Mode, and there is no
way back. In this case, the way back is simply to close
and reopen the collection.

Caution: A gap in this protection occurs if a collection has
two users with the same name. If the “second” user icon is
the only one with the Full Mode capability and the User
Name Security command is checked, the collection may
never be accessed in Full Mode.

Note: When switching to Custom Mode, the Custom Mode
user will be the user who was either selected when the
Collection was opened or who was last selected using the
User... menu command.

For more information, see section 4.5.2.

4.5.2 User...

Usage: changes or specifies the current user of a collection

When: there is at least one user icon in a collection

Custom Menu: removable

Sequence: available

Accessing the User... command brings up the user selection dialog
box. After selecting a user from the scrollable list, the collection
enters the last state (Full Mode or Custom Mode) the collection was
in for that user. If the user has password protection, another dialog
will open asking for the proper password.

Caution: If a user icon has no name (its name area is
completely empty), it will not appear in the user dialog.

If User Name Security has been set for the collection, the User... com-
mand will bring up the dialog described in section 4.5.5.

If there is only one user defined for a collection, the User... command
will open it.
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Note: The User... command must be used the first time a
collection is switched from Full Mode into Custom Mode.

4.5.3 User Password...

Usage: sets or changes a user’s password

When: one or more user icons exist in a collection

Custom Menu: removable

Sequence: not available

In Full Mode, the Password dialog box appears after specifying a user
(if there is more than one). The old password is not needed to enter a
new password.

In Custom Mode, the Password dialog box is displayed immediately,
since the command affects the current user. The old password is
required to enter a new password.

4.5.4 Collection Password...

Usage: sets a password for the entire collection

When: a collection is open

Custom Menu: available

Sequence: not available

This command allows a collection developer to specify a password
that must be supplied before a collection can be opened. Once set,
the collection cannot be opened without this password.

Collection Password does not automatically appear on any menu in
Custom Mode. It is available in the command selection list when con-
structing Custom Menus. However, we strongly recommend that this
command not be placed on a custom menu. Otherwise, users who
may not even have access to Full Mode could lock everyone out of a
collection (even inadvertently).

Warning: Passwords are your responsibility. Once set, they
cannot be circumvented by you or Helix. Attempts to do so
can damage your collection.
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4.5.5 User Name Security

Usage: suppresses the display of the user selection list when opening
a collection or selecting the User... command

When: a collection is open

Custom Menu: available

Sequence: not available

When enabled, this command forces the user to enter a user name
into the User Name dialog when the collection is opened and a user
icon exists. This applies even to collections last saved in Full Mode.
In Custom Mode, the list of users is suppressed when User Name
Security is enabled. The default state is disabled.

Unlike User Password, User Name Security cannot be set on a user-
by-user basis. Selecting the command for one user in a Collection
effectively selects it for all users in the collection.

Note: User Name Security does not automatically appear
on any menu in Custom Mode. Although it is available in
the custom menu command selection list, we suggest that
it only be put on an Administrator’s menu.

4.5.6 Custom Paper

Usage: This command selects among numerous page sizes for print-
ing labels and forms. A selected size then becomes available in the
Page Setup dialog.

When: a collection is open

Custom Menu: removable

Sequence: not available

Note: Custom Paper selections are used only by the Image-
Writer printer driver.

For more information, see sections 4.2.9 and 13.2.3.
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4.5.7 Starting Page #...

Usage: sets the beginning page number for page numbering

When: a view displaying its form is the active window

Custom Menu: removable

Sequence: available

This command sets the starting page number for the current view
only. The form remembers the setting, even if different starting page
number specifications are set for other forms.

Note: If not set, the default starting page number is 1.

For more information, see section 4.6.10.

4.5.8 AutoSave...

Usage: sets a Helix application to automatically perform Save opera-
tions that will bring the currently open collection up to date and pro-
tect work from loss

When: after a collection is saved for the first time

Custom Menu: removable

Sequence: not available

Enabling AutoSave also allows Helix to clear memory full conditions
during times when a save operation cannot be performed manually
(for example, during a load, while opening a long list with a query,
building indexes, etc.).

For more information, see section 14.1.5.

4.5.9 Color Preferences

Usage: specifies the colors used in Helix’s color selection palette

When: Full Mode only

Custom Menu: not available
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Sequence: not available
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4.6 √
The √ (check) menu commands toggle a variety of options.

All the commands on the √ menu work in a similar manner. When a
check mark appears next to a command, the command is on; other-
wise, it is off.

The first group of options is set for each rectangle drawn in the tem-
plate work area. Each rectangle tool on every template palette retains
its own settings. Each new rectangle drawn is given the same settings
as the corresponding tool on the palette. Selecting an existing rectan-
gle places the settings for the selected rectangle into the palette tool.
When a change is made to the settings and a rectangle is selected
when the change is made, the change affects both the palette rectan-
gle tool and the selected rectangle. Selecting the rectangle tool dese-
lects any selected rectangles and allows changes to be made to the
tool settings without affecting any rectangle, but new rectangles then
drawn will have the new settings.

The second group of menu commands is used to toggle options that
are used as aids in designing a form. They are only usable when a
template window is open and apply to the entire window.

The status of this group of commands is remembered by each tem-
plate. When a template is closed and then reopened, the options in
the first group are set as they were just before closing. A new tem-
plate will always have every item in this second grouping turned on.

The third group of options applies to how certain classes of informa-
tion will appear on a view when its form is displayed. They are set
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when a view displaying its form is active while in Full Mode. Each
view displaying its form retains the status of these options. A new
view has the last three options checked.

The commands in the last group apply only to the abacus window.

4.6.1 Scale Picture

Usage: causes a label or data rectangle scale picture to fit the size of
the rectangle

When: a data rectangle, label rectangle, or tool on an active template
window that references a Picture data type is selected

Custom Menu: not available

Sequence: not available

The Scale Picture option allows the scaling or clipping of pictures to
fit either label or data rectangles.

The normal setting for the Scale Picture option is off, showing no
check mark. Unless this setting is changed, all Rectangles will clip
pictures rather than scale them.

If the Scale Picture command does not have a check beside it, the
picture retains its original size. If the Rectangle is too small to display
the entire picture, the excess portions of the image are not visible
without adding vertical and horizontal scroll bars to the field’s rect-
angle on the template. The entire picture is stored, however. If the
picture is smaller than the rectangle, white space is visible along one
or more edges. The rectangle can always be selected and resized on
the template.

If the Scale Picture command has a check, the picture is sized pro-
portionally to fit the size of the rectangle

Note: Scale Picture can also be selected from the label,
data and command rectangle dialog boxes. (See sections
8.1.7.1, 8.1.4.1, and 8.1.8.1.)

Tip: Radio buttons can be spaced farther apart or closer
together by selecting Scale Picture. The radio buttons will
be scaled to fit the data rectangle drawn. (See section
7.1.4.1.)
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4.6.2 Frame Rectangle

Usage: controls the display of a visible border around a rectangle

When: a template is the active window and a rectangle or tool is
selected

Custom Menu: not available

Sequence: not available

The border is visible in both the template window and when the form
is displayed in a view window.

The default states for Frame Rectangle is on for data and command
rectangles and off for label, border, and repeat rectangles.

Repeat rectangles always print. If unframed, however, they will not
appear on the printout.

Tip: Frame Rectangle can also be selected from all rectan-
gle dialogs. (See sections 8.1.4.1, 8.1.5.1, 8.1.6.1, 8.1.7.1,
and 8.1.8.1.)

4.6.3 Printable

Usage: determines whether a rectangle prints when a form displayed
in a view is printed

When: a label, data or command rectangle is selected on a template

Custom Menu: not available

Sequence: not available

This option is normally on. To turn if off for a selected rectangle,
choose Printable from the √ menu; the rectangle appear on the form
when it is displayed in a view but will not be printed.

Tip: Printable can also be selected from all rectangle dia-
logs. (See sections 8.1.4.1, 8.1.5.1, 8.1.6.1, 8.1.7.1, and
8.1.8.1.)
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4.6.4 Keep Value

Usage: sets a default value for a data rectangle based on the last
value entered for the field

When: a template is the active window and a data rectangle has been
selected

Custom Menu: not available

Sequence: not available

When a data rectangle has been set to Keep Value, the rectangle will
retain the last value that was displayed or entered. When the form is
cleared, as when a record is entered, the form will display the same
data in the rectangle. The data can be edited, or accepted without
modification.

Tip: Keep Value can also be selected from the data rectan-
gle dialog box. (See section 8.1.4.1.)

The default state of this option is off. 

4.6.5 Allow Click

Usage: allows or prevents a field from being selected with a mouse
click

When: a template is the active window and a data rectangle is
selected

Custom Menu: not available

Sequence: not available

When Allow Click is on, the user can position the cursor over a field
and click to place the insertion point in that field. Allow Click is inde-
pendent of whether a field can be tabbed into.

When Allow Click is off, tabbing is the only way to get to the field.
This is useful if the collection designer has a need to force the user to
visit fields in tab order.

If neither Allow Click nor Allow Tab are on, the field is non-selectable
and cannot display an insertion point. The user therefore cannot
type in the field. The field can, however, subscribe to and load data.
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Allow Click must be on to edit or query fields formatted as popups.

Tip: To Allow Click for all fields in a form, select all of the
data rectangles on the template and select allow click
until a check mark appears to the left.

The default state of this option is on.

For more information, see section 8.1.4.6.

4.6.6 Allow Tab

Usage: includes or eliminates a field from the tab order

When: a template is the active window and a data rectangle is
selected

Custom Menu: not available

Sequence: not available

When Allow Tab is on, the user will be able to reach the field by press-
ing the Tab key. Allow Tab is independent of whether a field can be
clicked.

When Allow Tab is off, tabbing will skip over the field. This is espe-
cially useful when a field has been given an editable default value. If
needed, users will be able to select the field with a click and replace
the default.

If neither Allow Tab nor Allow Click are on, the field is non-selectable
and cannot accept data entered from the keyboard. It can, however,
subscribe to or load data.

The default state of this option is on.

For more information, see section 8.1.4.6.

4.6.7 Allow Query

Usage: allows or prevents a quick query from being activated for the
selected field(s), and allows or suppresses the display of the selected
field on form queries using that template
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When: a template is the active window and a data rectangle is
selected

Custom Menu: not available

Sequence: not available

When Allow Query is on, a quick query or a form query can use that
field on views or form queries using that template.

Allow Query can be turned off if a collection designer wants to allow
data entry into a field but prevent unoptimized searches (an example
is preventing “contains” searches on a very large text field).

Tip: To prevent quick queries for all of the fields on a
form, you may also use the lock quick query command.
(See section 4.6.19.)

Tip: To eliminate specific fields from a form query, you
can also duplicate the template, delete fields for which
queries should not be allowed and use this second tem-
plate for the form query.

To permit form queries but not quick queries on a field, leave Allow
Query on but turn off Allow Click and Allow Tab.

The default state of this option is on.

For more information, see section 8.1.4.6.

4.6.8 Allow Edit

Usage: allows or prevents a user from modifying data in a field

When: a template is the active window and a data rectangle is
selected

Custom Menu: not available

Sequence: not available

If Allow Edit is off the user can view, copy, and (if Allow Query is
checked) quick query on a field, but not modify its contents.

If Allow Edit is off, the only Edit menu command enabled is Copy.
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The Allow Edit setting affects all Helix actions that modify data. The
underlying principle is that you can modify a field on a form by typing
into it (or performing an action that simulates typing, such as load
and subscribe) or by posting into it, but not both. 

Therefore, if Allow Edit is on for a target field, you can type, load data
from a text file, and subscribe into the field as well as perform posts
of Options 1–4 out of the field, but you cannot perform an Option 0
post into the field. (See section 8.1.4.6.) 

In contrast, if Allow Edit is off for a field you can perform an option 0
post to that field on the current record but you cannot type into it (or
load or subscribe).

Tip: To prevent users from editing any of the fields on a
form, you can either select all of the data rectangles and
uncheck Allow Edit, or you can deselect the Add, Replace
and/or Delete form permissions for that view in the user
window. (See section 6.4.5.)

The default state of this option is on.

For more information, see section 8.1.4.6.

4.6.9 Background

Usage: moves one or more label rectangles containing text or a pic-
ture to the background layer of a template

When: a label rectangle is selected on a template

Custom Menu: not available

Sequence: not available

Note: If a background rectangle is selected, Background
will move the rectangle to the foreground layer only if it
will not overlap any other rectangles in the foreground. 

Tip: Background can also be selected from the label rect-
angle dialog box. (See section 8.1.3.4.)

The default state of this option is off.
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4.6.10 P# is Page Number

Usage: marks a label rectangle so that the characters “P#” will trans-
late into a page number when viewing or printing a form

When: a template is the active window and a label rectangle or the
label rectangle tool is selected

Custom Menu: not available

Sequence: not available

When working in a template, any label rectangle can be given the P#
is Page Number attribute. Wherever “P#” appears in a label rectangle
and the P# is Page Number command has been selected for that rect-
angle, a page number appears when the form is displayed on a view.

Note: An uppercase P must be used, and there must be no
space between the P and the number sign (#).

Tip: When placed inside a repeat rectangle, the P# is Page
Number command will provide “line numbers” (except on
a subform).

Tip: P# is Page Number can also be selected from the
label rectangle dialog box. (See section 8.1.7.2)

4.6.11 Visible on First Page

Usage: makes a label or data rectangle visible on the first page of a
form displayed on a view

When: a template is the active window and a label rectangle, data
rectangle, or group of rectangles is selected

Custom Menu: not available

Sequence: not available

If a rectangle is selected and Visible on First Page is not checked, that
rectangle will be neither visible nor printable on the first page,
regardless of the status of the Printable command for that rectangle.
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4.6.12 Visible on Interior Page(s)

Usage: makes a label or data rectangle visible only on the interior
page(s) of a report (not the first or last page)

When: a template is the active window and a label rectangle, a data
rectangle, or a group of rectangles is selected

Custom Menu: not available

Sequence: not available

If a rectangle is selected and Visible on Interior Page(s) is not
checked, that rectangle will be neither visible nor printable on the
interior page(s), regardless of the status of the Printable command
for that rectangle.

4.6.13 Visible on Last Page

Usage: makes a label or data rectangle visible only on the last page of
a report

When: a template is the active window and a label rectangle, a data
rectangle, or group of rectangles is selected

Custom Menu: not available

Sequence: not available

If a rectangle is selected and Visible on Last Page is not checked, that
rectangle will be neither visible nor printable on the last page, regard-
less of the status of the Printable command for that rectangle.

4.6.14 Graph Paper

Usage: toggles the display of the visible dots that serve as a rectangle
alignment aid in the template work area

When: a template is the active window

Custom Menu: not available

Sequence: not available
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When checked, this command displays a dot pattern in the template
work area to allow easy alignment or placement of rectangles.

The default state of this option is on.

4.6.15 Grid

Usage: toggles an invisible grid that constrains cursor movement in
the template work area

When: a template is the active window

Custom Menu: not available

Sequence: not available

When checked, this command causes the cursor to move in incre-
ments corresponding to the dot pattern of the Graph Paper (approxi-
mately 1/9 inch increments). The cursor will “snap” from one grid
point to the next as it moves across the work area. The Grid com-
mand works independently of whether Graph Paper is on or off.

Tip: When used in combination with the Graph Paper
option, Grid makes it easier to align rectangles to the
Graph Paper’s dots.

Tip: If you have difficulty grabbing the move bar or grow
box of a rectangle, it is probably because the Grid option
does not allow exact placement of the cursor on the rect-
angle. Turning off the Grid option will allow exact place-
ment, and the move bar or grow box can then be grabbed
easily.

The default state of this option is on.

4.6.16 Ruler

Usage: toggles the ruler markings along the top and left sides of the
template work area

When: a template is the active window

Custom Menu: not available

Sequence: not available
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When checked, this command displays a standard ruler for measur-
ing size and spacing. This becomes important when a form is
designed to print information onto prepared forms or labels. 

The ruler appears along the top and left edges of the template and
shows where a point on the template is in relation to the printable
page. The ruler extends down and to the right with no practical limit.

The default state of this option is on.

For more information, see section 8.1.11.4.

4.6.17 Preview

Usage: Preview allows the designer to view templates with sample
entries in data and command rectangles. This can aid the design pro-
cess by making it easier to correctly size rectangles prior to display-
ing the template on a view.

When: a template is the active window

Custom Menu: not applicable

Sequence: not available

Note: Pictures pasted into command rectangles are visible
on templates only in Preview mode.

For more information, see section 8.1.10.

4.6.18 Allow Query Bypass

Usage: allows or prevents deselecting a portion of a quick query by
displaying or suppressing the “Also Use” checkbox

When: a view in Setup mode is the active window

Custom Menu: not available

Sequence: not available

Allow Query Bypass is selectable only when a query is attached to a
form, and is dimmed (i.e., non-selectable) when no query is attached
to the form.
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For a discussion of how this command affects a form displayed on a
view, see section 9.2.1.

The default value for this option is on.

4.6.19 Lock Quick Query

Usage: allows or prevents a quick query from being used on a form
by enabling or dimming the quick query command and by enabling
or disabling the Cancel button

When: a view is the active window

Custom Menu: not available

Sequence: not available

If a quick query is attached to a form when the collection is opened
in Custom Mode, Lock Quick Query prevents users from changing
the field being used to query the form by dimming the Quick Query
command whenever the form is the active window. Whatever field
was being used for the quick query when the collection was moved
into Custom Mode will be the field that appears in the locked quick
query.

If Lock Quick Query is chosen for a form that has no active quick
query, when the collection is opened in Custom Mode users will not
be able to open a quick query on any of the form’s fields.

The default state of this option is off.

For more information, see section 9.2.1.

4.6.20 Shade Defaults

Usage: sets a form displayed on a view to shade data entry fields that
have a default value that has been set by the Keep Value command or
by Calculation Retain

When: a form displayed on a view is the active window

Custom Menu: not available

Sequence: not available
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When checked, this command lightly shades any data rectangle on a
form containing data that are not typed by the user, have not been
entered, and will be stored as part of the record if either the Enter or
Replace command is selected. This command helps avoid potential
confusion over what is typed as part of a record and what is automat-
ically displayed. This option is a visual aid only and does not affect
data in any way.

If no new information is typed, the shading will remain until the
record has been entered.

The default state of this option is on.

To turn the option off and work on a form that does not shade the
default data, select the Shade Defaults option from the menu while a
form is displayed on a view and Helix is in Full Mode. The form
remembers the setting; changing the setting does not affect any other
form.

Note: If the Shade Defaults option is on, the shading will
be printed, exactly as seen on the screen.

4.6.21 Shade Invalid Fields

Usage: sets whether a form displayed on a view should shade data
that is invalid by the validation criteria specified for a given field icon

When: a form displayed on a view is the active window

Custom Menu: not available

Sequence: not available

Because validation criteria for a field icon can be added at any time,
data already entered can become invalid. In other words, the data do
not meet the validation criteria attached to the field. When the Shade
Invalid Fields command is set for a form displayed on a view and a
field has invalid data, it displays this data as a shaded field. This data
may be viewed without triggering any beeps or validation lockout, as
long as no changes are made to the shaded fields. A change made to a
shaded field must conform to the current validation specification.

Tip: If Shade Invalid Fields is turned off for a list, field val-
idation will not be performed and the list may display
faster.
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The default state of this option is on.

For more information, see section 8.2.6.

4.6.22 Keep Current

Usage: allows Helix to continually update a form displayed on a
user’s screen with changes made by other networked users working
with the same form

When: a listing or entry form displayed on a view is the active win-
dow

Custom Menu: not available

Sequence: not available

Tip: Keep Current should always be checked for a form
that displays a statistic that needs to be kept current (such
as a {Max} + {1}).

The default state of this option is on.

For more information, see section 8.2.4.5.

4.6.23 Common Calculation

Usage: retains the result of an abacus calculation in memory

When: an abacus is used on a form that is the active window

Custom Menu: not available

Sequence: not available

This option can be chosen when the result of an abacus is used in
more than one calculation on a form. It is most useful for slow, non-
statistic tiles such as Locate or Extract. The first time the abacus is
evaluated the result is stored in memory so that it does not have to
be recalculated, which may improve the response time of the form.

Caution: This menu command should be used with discre-
tion. If Common Calculation does not provide a notice-
able improvement, consider removing it from the abacus.

The default state of this option is off.
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4.7 View
View menu commands provide control over view windows.

The first group of commands manages the view window display and
the set of records selected for display in a form displayed on a view.

The second and fourth groups of commands deal with using a form
displayed on a view to enter and modify records in the database.

The third group is for stepping through and displaying the set of
selected records in a form displayed on a view. These commands are
only active when a non-list form displayed on a view is active.

The fifth group of commands deals with deleting records and trigger-
ing post functions for selected records.

4.7.1 Controlling What is Displayed on a View

The following four commands are states of the same menu selection.
They affect what is displayed on a view (for example, a form, setup,
or posting).

4.7.1.1 Show Setup
Usage: displays a view’s setup mode in the view window, allowing the
developer to set the specifications for the form

When: a view is the active window, and the window is not currently in
setup mode

Custom Menu: not available

Sequence: not available
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When you select this command, a view switches to setup mode. This
display allows templates, subform templates, query icons (abacus,
form, or power query), and indexes to be specified for use with this
form.

For more information, see sections 8.2.2 and 8.2.8.

4.7.1.2 Show Posting
Usage: places a view window in posting selection mode so the devel-
oper can select posting functions for the form

When: a view is the active window, a template has been selected in
setup mode, and posting selection is not visible currently

Custom Menu: not available

Sequence: not available

For more information, see section 8.2.

4.7.1.3 Show Form
Usage: displays the specified form on a view

When: a view is the active window, the form is not displayed cur-
rently on the view, a template has been selected in view setup mode,
and all required subform specifications (if any) are complete

Custom Menu: not available

Sequence: not available

Show Form is available if the view is in either setup mode or posting
selection mode.

This menu command is replaced by Find All when a template has not
yet been selected from the template selection list in form setup
mode.

Note: A form item on a custom menu appears dimmed if
the view was not displaying its form when the collection
was switched from Full Mode to Custom Mode.

For more information, see section 8.2.
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4.7.1.3.1 Find All
Usage: automatically shows a default list form for a relation

When: a view is the active window and a template has not been
selected in form setup mode

Custom Menu: not available

Sequence: not available

This menu command displays a default list form similar to a form
using a template created by the Quick List menu command.

The command is replaced by the Show Form command when a tem-
plate is selected from the template scrollable list in the form setup
mode.

For more information, see section 8.2.1.

4.7.2 Searching for Records

The View menu contains four commands for manipulating queries
that may be attached to a view. Users can open the queries and enter
selection values.

4.7.2.1 Quick Query
Usage: locates specific records by specifying a criterion for a single
field

When: a field on a form displayed on a view is selected and Lock
Quick Query has not been selected

Custom Menu: removable

Sequence: available

This command displays the Quick Query dialog box at the top por-
tion of a form displayed on a view. It is used to specify criteria for the
selected field that are used to limit the records visible on the form.

For more information, see section 9.2.
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4.7.2.2 Open Query
Two types of queries can be used with this menu command. The
query icon allows users to enter search criteria into the fields on a
form. The power query allows more technically sophisticated users
to formulate their own logical search expressions.

4.7.2.2.1 Form Query
Usage: filters the records available for display in a view based on cri-
teria entered for specific fields and/or abaci on a query form

When: a form display on a view is the active window and a query
icon has been selected in form setup mode for the view

Custom Menu: removable

Sequence: available

This command displays the query form’s window in which a user can
open data rectangles to enter selection criteria for fields and/or
abaci.

Tip: In Custom Mode, hold down the Option key while
choosing the form name from a menu to open the query
prior to opening the form to which it is attached.

For more information, see section 9.3.

4.7.2.2.2 Power Query
Usage: filters the records available for display in a view based on cri-
teria entered in a power query window

When: a form displayed on a view is the active window and a power
query has been selected in form setup mode of the view window

Custom Menu: removable

Sequence: available

This command displays a power query window in which a user can
choose criteria from predefined selection lists.

Tip: In Custom Mode, hold down the Option key while
choosing the form name from a menu to open the query
prior to opening the form to which it is attached.
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For more information, see section 9.4.

4.7.3 Saving a Record

Two commands that occupy the same location in the View menu
(Enter and Replace) control the saving of records.

4.7.3.1 Enter
Usage: stores a new record in the database

When: an entry form displayed on a view is the active window and a
new record is showing with at least one field containing data

Custom Menu: removable

Sequence: available

Tip: You can use the Enter key (but not the Return key) on
the keyboard to enter a record instead of selecting the
command from the menu.

Note: Generally, data cannot be entered using a list type
form. For exceptions to this rule, see sections 4.3.11 &
8.1.6.2.

If the Macintosh beeps or the menu bar flashes after either selecting
Enter from the View menu or pressing the Enter key, an error has
occurred and the record was not stored in the database. The two
most common reasons are that one or more fields did not pass a vali-
dation check or that the record is locked. Select the Why? command
from the Apple menu to read a message explaining the situation.

This menu command is replaced by Replace while viewing existing
records.

If this menu command is removed from a user’s custom menu, then it
is impossible for that user to enter data into any relation unless Enter
is placed in a sequence on the form. Removing this command from a
custom menu also removes the Replace command.

For more information, see sections 4.7.3.2, 4.11.5, 4.11.12, and 8.2.4.1.

4.7.3.2 Replace
Usage: stores changes to records that already exist in the database
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When: an entry form displayed on a view is the active window and an
existing record is showing in which the value in at least one field has
changed

Custom Menu: removable

Sequence: not available, although records can be replaced via a
sequence containing the Enter command

Tip: The Enter key (but not the Return key) may be used
instead of selecting Replace from the menu to replace a
record.

Note: Generally, data cannot be replaced using a list type
form. For exceptions to this rule, see sections 4.3.11 &
8.1.6.2.

If the Macintosh beeps or the menu bar flashes after either selecting
Enter from the View menu or pressing the Enter key, an error has
occurred and the modified record was not stored in the database.
The two most common reasons are that one or more fields did not
pass a validation check or that the record is locked. Select the Why?
command from Apple menu to read a message explaining the situa-
tion.

This menu command is replaced by Enter while viewing a record that
has not been entered into the database.

To remove this command from a custom menu, remove the Enter
command. If the Enter command is removed from a user’s Custom
Menu, it becomes impossible for that user to change or modify any
records in any relation. There is one exception; the Post All com-
mand can modify existing records with the Post All menu command.

For more information, see sections 4.7.7, 4.11.5, 4.11.12, and 8.2.4.1.

4.7.4 Sequential Record Access

Four commands provide sequential access (first/next order) to
records displayed on a non-list view: Find First, Find Next, Find Prior,
and Find Last.



View

4-59

4.7.4.1 Find First
Usage: displays an automatically constructed non-list form on a view
and/or displays the first record in a relation that can be displayed on
a non-list form on a view

When: the active window is either a view in form setup mode that
does not have a template selected or a non-listing form is displayed
on a view

Custom Menu: removable

Sequence: available

The most common usage of this menu command is to display the first
selectable record when a non-list form is displayed on a view.

If no query or index has been selected for the form, then Find First
displays the first record that was entered into the relation.

If a query has been selected for the form, then Find First displays the
first record that meets the query specifications.

If an index has been selected for this form, then Find First displays
the first record that corresponds with the ordering of the values in
the indexed field(s).

If both a query and an index have been selected for the form, Find
First displays the first record that meets both the requirements of the
query and the ordering specified by the index.

When no records exist, or no records exist that match any specified
criteria, a clear form appears.

If data for a new record have been entered into the form or changes
made to an existing record but the record has not been stored in the
database, invoking this command will bring up a dialog asking if the
changes should be saved before finding the first record.

For more information, see sections 4.7.4.2, 4.7.4.3, and 4.7.4.4.

4.7.4.2 Find Next
Usage: displays the next record in a relation that meets selection cri-
teria (if any) that have been applied to a non-list form displayed on a
view.
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When: the active window is a non-listing form displayed on a view
and a record has been retrieved previously using any of the Find
menu commands

Custom Menu: removable

Sequence: available

If no query or index has been selected for the form, then Find Next
displays the next record that was stored in the relation.

If a query has been selected for this form, then Find Next displays the
next record that meets the query specifications.

If an index has been selected for this form, then Find Next displays
the next record that corresponds with the ordering of the values in
the indexed field(s).

If both a query and an index have been selected for this form, Find
Next displays the next record that meets both the requirements of
the query and the ordering as specified by the index.

When no more records exist, a clear form appears.

If data for a new record have been entered into the form or changes
made to an existing record but the record has not been stored in the
database, invoking this command will bring up a dialog asking if the
changes should be saved before finding the next record.

For more information, see sections 4.7.4.1, 4.7.4.3, and 4.7.4.4.

4.7.4.3 Find Previous
Usage: displays the previous record in a relation that meets selection
criteria (if any) that have been applied to a non-list form displayed
on a view

When: the active window is a non-listing form displayed on a view
and a record has been retrieved previously using any of the Find
menu commands

Custom Menu: removable

Sequence: available

This command operates like Find Next but instead displays the previ-
ous record in the set of records that can be displayed on the form.
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For more information, see sections 4.7.4.1, 4.7.4.2, and 4.7.4.4.

4.7.4.4 Find Last
Usage: displays an automatically constructed non-list form on a view
and/or displays the last record in a relation that can be displayed on
a non-list form on a view

When: the active window is either a view in form setup mode that
does not have a template selected or a non-listing form is displayed
on a view

Custom Menu: removable

Sequence: available

This command operates like Find First, except that the record dis-
played will be the last record in the set of records that can be dis-
played on the form.

For more information, see sections 4.7.4.1, 4.7.4.2, and 4.7.4.3.

4.7.4.5 Clear Form
Usage: displays an automatically constructed non-list form on a view
and/or displays an empty entry form on a view

When: the active window is either a view in form setup mode that
does not have a template selected or a non-listing form displayed on
a view

Custom Menu: removable

Sequence: available

Clear Form provides an empty form on which a new record can be
entered. It does not delete a record or alter data in any way.

If Clear Form is selected while the form is displaying an existing
record that has been modified or the form is displaying a new record
that has not been stored, a dialog box asks if the changes should be
saved before clearing the form.

Each time a new record is stored in the database by selecting the
Enter command from the menu or by pressing the Enter key the form
is automatically cleared, providing an empty form for entering
another record.
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Tip: The first time a Clear Form is performed, the form is
cleared, but values in rectangles that have Keep Value
specified are retained. When a second Clear Form is per-
formed, the kept values are also cleared. For this reason,
a collection designer will sometimes create a sequence
containing two consecutive Clear Form commands to
clear a form with kept values so that the user can have a
clean form for data entry.

For more information, see sections 4.7.3.1 and 4.7.3.2.

4.7.5 Revert

Usage: restores an existing record to its original state

When: the active window is a non-listing form on a view displaying
an existing record that has been modified but has not been stored in
the database

Custom Menu: removable

Sequence: available

Revert can only be used before the Replace command is selected
from the menu or the Enter key is pressed.

For more information, see section 4.7.3.2.

4.7.6 Deleting Records

Three menu commands concern the deletion of stored records:
Delete, Delete All, and Delete Selections.

4.7.6.1 Delete
Usage: erases the selected record from the relation

When: the active window is a non-listing form displayed on a view
showing an existing record

Custom Menu: removable

Sequence: available
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Caution: This command deletes an entire record regard-
less of what portion of the record is displayed on the form.

When Delete is selected from the menu, a dialog box appears and
asks if the record should be deleted from the relation. Selecting the
Delete button will complete the operation; selecting Cancel will abort
the operation.

If the form contains a subform, a dialog is displayed that gives the
user the option of deleting either the outer form record, the subform
records, or both. It shows the number of records to be deleted and
the relations in which they are stored. When Helix is in Full Mode, a
check box appears to the left of each relation name. Records will only
be deleted from relations with an “x” in the corresponding box. Click
on a box to change its status. These choices are remembered in Cus-
tom Mode.

If the Delete command is used in a sequence and the sequence is set
to “optional” or “never,” users will not be presented with any warning
dialogs when either selecting this sequence from a menu or clicking it
from a command rectangle (button) on the form.

Note: See section 4.7.6.3 for deleting multiple records with
one command.

When an existing record has been deleted, the next record in form
order will appear.

Caution: A deletion is permanent. There is no Undo. The
only way to recover deleted records is to revert to the pre-
viously saved version of the collection. This will work only
if the collection has not been saved after the Delete.
Revert to Saved also loses all other changes made to the
collection since the last save.

4.7.6.2 Delete All
Usage: erases all records that appear on a listing form

When: a listing form displayed on a view is the active window

Custom Menu: removable

Sequence: available

Delete All provides a way to delete a number of records with one
command, but only on a listing form. The command deletes entire
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records, regardless of what portion of the record is displayed on the
list.

When Delete All is selected from the menu, a dialog box appears to
ask if the records should be deleted from the relation. Selecting the
Delete button will complete the Delete All operation; selecting the
Cancel button will abort the operation.

Caution: A deletion is permanent. There is no Undo. The
only way to recover deleted records is to revert to the pre-
viously saved version of the collection. This will work
only if the collection has not been saved after the Delete
All. Revert to Saved also loses all other changes made to
the collection since the last save.

A subform is a list and, as such, can also be used for a global delete.
Subforms may list information from several different relations. If
Delete All is selected all records represented by the subforms will be
deleted, regardless of the relation(s) in which the records are stored.
A dialog box will appear informing you of the number of records to
be deleted and the relations in which they reside. When Helix is in
Full Mode, a check box appears to the left of each relation name.
Records will only be deleted from relations with an “x” in the corre-
sponding box. Click on a box to change its status. These operations
are remembered in Custom Mode.

For more information, see section 4.7.7.1.

4.7.6.3 Delete Selections
Usage: deletes records that are selected on a selectable list

When: a selectable list has one or more records selected

Custom Menu: removable

Sequence: available; however, not available for a subform

For more information, see section 8.2.4.3.

4.7.7 Posting Records

Three commands control the triggering of posting. Posting is a Helix
operation through which modifications are made to data not visible
to the user. A post can affect records in another relation or it may
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affect the current relation. Post can create new records, modify exist-
ing records, or delete records.

4.7.7.1 Post All
Usage: triggers a posting function for each record represented on a
listing form

When: the active window is a listing form displayed on a view and a
post icon has been selected for the view when it was in post selection
mode under the Post All column

Custom Menu: removable

Sequence: available

This menu command will change to Find and Post All when the view
displays a non-listing form. This indicates that the Find and Post All
command will trigger the selected posting functions for all records
that are viewable on the form.

For more information, see section 4.7.1.2.

4.7.7.2 Find and Post All
Usage: triggers a posting function for every record retrievable by a
non-listing form

When: the active window is a non-listing form displayed on a view
and a Post icon has been selected for the view when it was in post
selection mode under the Post All column

Custom Menu: removable

Sequence: available

This menu command will change to Post All when the view displayed
a listing form. This indicates that the Post All command will trigger
the selected posting functions for all records that are on the list.

For more information, see section 4.7.1.2.

4.7.7.3 Post Selections
Usage: triggers a posting function for each record selected on a
selectable listing form displayed on a view
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When: one or more records are selected on a selectable listing form
and a Post icon has been selected for the view when it was in post
selection mode under the Post All column

Custom Menu: removable

Sequence: available
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4.8 Docs
A document refers to an application file or any saved work file cre-
ated by an application. Helix can store, retrieve, manipulate, and sub-
launch documents from menu commands and sequences.

All document related commands can be found on this menu. For
more information on working with documents, see Chapter 8.

4.8.1 Copy from Volume

Usage: moves a copy of a document (for internal storage) or the refer-
ence to a document (for external storage) into a Helix collection

When: a document field is selected on an entry form

Custom Menu: available

Sequence: available

The copy of the document or the reference to it is brought into Helix
only when you press the Enter key or select the Enter command. At
that point a check is made to ensure that the document still exists
and then the copy is brought into Helix.

4.8.2 Copy to Volume

Usage: moves a copy of a document (stored either internally or exter-
nally) to the selected volume

When: a document field is selected on an entry form

Custom Menu: available

Sequence: available
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4.8.3 Move Into Collection…

Usage: available only for internally stored documents; moves a copy
of a document from the selected volume into the collection and
deletes the original document

When: a document field is selected on an entry form and the storage
format is internal

Custom Menu: available

Sequence: available

Move into Collection... is similar to Copy from Volume... with the
exception that the original document is deleted from its volume after
the copy is brought into Helix. The document is imported into the
collection when you press the Enter key or choose an Enter com-
mand. At that point, a check is made to ensure the document still
exists and then a copy of it is moved from the volume. After the doc-
ument has been safely brought in, the original is deleted.

4.8.4 Work On Original...

Usage: This command is available only for externally stored docu-
ments and only when System 7 or later is active; it opens a document
in its native application and at its current location. The document
can then be viewed and/or modified.

If Keep Versions is active, a copy of the document is made before it is
opened. This copy becomes the new version of the document. The
next time the document is accessed, Helix uses the current version.

When: data in a document field are selected on an entry form and the
storage format is external

Custom Menu: available

Sequence: available

Selecting a document field and then choosing Work on Original... trig-
gers the following series of actions:

1. If the volume from which the document in the document field was 
loaded or last modified is not mounted, Helix attempts to mount it 
or prompts the user to do so.
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2. A copy of the document is created when Keep Versions is 
selected. The copy is opened at its current location. It can then be 
viewed and/or edited. When Keep Versions is not selected, the 
original document is opened in its current location for viewing 
and/or editing.

3. Helix launches the document’s native application (if available at 
the local workstation).

For more information, see section 11.5.5.2.

4.8.5 Work On Copy...

Usage: copies a document to the local workstation and opens it in its
native application, where it can be viewed and/or modified

If Keep Versions is active, any changes made and saved cause the cre-
ation of a new version of the document. The next time the document
is accessed, the new version is opened, updated, worked on, deleted,
and so on.

When: This command is available when data in a document field are
selected on an entry form. The Macintosh must be running at least
System 7. It is available for documents with any storage format. 

Custom Menu: available

Sequence: available

Selecting a document field and then choosing Work on Copy... trig-
gers the following sequence of actions.

External documents:

1. If the volume from which the document in the document field was 
loaded or last modified is not mounted, Helix attempts to mount it 
or prompts the user to do so.

2. A copy of the document is created in the same folder as the Helix 
application in use. This copy is then transferred to the local work-
station. If this cannot be done—for example, because the docu-
ment already exists in the target folder—the operation is aborted. 

3. Helix launches the document’s native application (if available at 
the local workstation). The document copy is opened for viewing 
and/or modification.

Internal documents:
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1. The document is copied to the local drive to the same folder that 
contains the Helix application in use.

2. Helix launches the document’s native application (if available at 
the local workstation).

3. The document’s application opens the document copy. The docu-
ment can then be viewed and/or modified.

4.8.6 Open Original…

Usage: Open Original is available only for externally stored docu-
ments and only when System 7 or later is active; it opens a document
in its native application and at its current location. The document
can then be viewed and/or modified. Saving a changed document
overwrites the original.

When: data in a document field are selected on an entry form and the
storage format is external

Custom Menu: available

Sequence: available

Selecting a document field and then choosing Open Original... trig-
gers the following sequence of actions.

1. If the volume from which the document in the document field was 
loaded or last modified is not mounted, Helix attempts to mount it 
or prompts the user to do so.

2. Helix launches the document’s native application (if available at 
the local workstation).

3. The document’s native application opens the document at its cur-
rent location. The document can then be viewed and/or modified.

4.8.7 Open Copy...

Usage: This command copies a document to the local workstation
and opens it in its native application, where it can be viewed and/or
modified. The document can only be brought back into the collection
by using a Copy from Volume or a Move into Collection command.

The copy of the document is effectively separated from the collec-
tion. The document in the collection is not affected.
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When: Open Copy is available when data in a document field are
selected on an entry form. The Macintosh must be running at least
System 7. This command is available for documents with any storage
format. 

Custom Menu: available

Sequence: available

Selecting the document field and then choosing Open Copy... triggers
the following sequence of actions.

External documents:

1. If the volume from which the document in the document field was 
entered or last modified is not mounted, Helix attempts to mount 
it or prompts the user to do so.

2. Helix creates a copy of the document in the same folder as the 
Helix application in use. This copy is then transferred to the local 
workstation. If this cannot be done—for example, the file already 
exists in the target folder—the operation is aborted.

3. Helix launches the document’s native application (if available at 
the local workstation). The document’s native application opens 
the copy for viewing and/or modification.

Internal documents:

1. Helix copies the document to the local drive, into the same folder 
that contains the Helix application in use.

2. Helix launches the document’s native application (if available at 
the local workstation).

3. The document’s native application opens the document copy. The 
copy can then be viewed and/or modified.

4.8.8 Print Document...

Usage: This command causes Helix to launch a document’s native
application. Then the document’s native application opens the docu-
ment and Helix triggers the Print... command.

When: Print Document... is available when data in a document field
are selected on an entry form. The Macintosh must be running at
least System 7. This command is available for documents with any
storage format.
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Custom Menu: available

Sequence: available

Selecting the document field and then choosing Print Document...
triggers the following sequence of actions.

External documents:

1. If the volume from which the document field was entered or last 
modified is not mounted, Helix attempts to mount it or prompts 
the user to do so.

2. Helix launches the document’s native application (if available at 
the local workstation). The document’s native application opens 
the document.

3. Using Apple Events, Helix triggers the Print... command for the 
document’s application. The application displays the Print dialog 
box. When printing (or spooling) is complete, the document is 
closed and its application quits. Control returns to Helix.

Internal documents:

1. Helix copies the document to the local drive, into the same folder 
that contains the Helix application in use.

2. Helix launches the document’s native application (if available at 
the local workstation). The document’s native application opens 
the document

3. Using Apple Events, Helix triggers the Print... command for the 
document’s application. The application displays the Print dialog 
box. When printing (or spooling) is complete, the document is 
closed and its application quits. Control returns the user to Helix

4.8.9 Transfer Original

Usage: This command is available only for externally stored docu-
ments; it moves a document from its current location to another
mounted volume. Helix automatically updates the reference to the
document stored in the Helix collection when the user presses Enter
to store the record. If the volume from which the document in the
document field was loaded or last modified is not mounted, Helix
attempts to mount it or prompts the user to do so.

When: data in a document field are selected on an entry form and the
storage format is external
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Custom Menu: available

Sequence: available

When the user chooses Transfer Original, a standard Save File dialog
opens in which the user selects a new location for the document. The
document is then copied to the new location. When the user presses
Enter, Helix updates the reference and deletes the document from its
original location.

If Keep Versions is active, the current version of the document is
moved. Older versions remain in their current location(s).

4.8.10 Delete Original

Usage: This command is available only for externally stored docu-
ments; it deletes a document from its current location. Helix also
deletes the reference to the document stored in the collection. If the
volume from which the document in the document field was loaded
or last modified is not mounted, Helix attempts to mount it or
prompts the user to do so. If any file cannot be found, that document
field is not cleared.

When: data in a document field are selected on an entry form and the
storage format is external

Custom Menu: available

Sequence: available

If Keep Versions is active, the current version of the document is
deleted. Older versions remain in their current location(s).

4.8.11 Delete All Originals

Usage: This command deletes one or more externally stored docu-
ments from their current location(s). Helix also deletes the reference
to the document(s) stored in the Collection. If the volume from which
the document in the document field was loaded or last modified is
not mounted, Helix attempts to mount it or prompts the user to do
so.

When: a listing form containing a document field is the active window
and the storage format is external
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Custom Menu: available

Sequence: available

If Keep Versions is active, the current version of the document is
deleted. Older versions remain in their current location(s).

4.8.12 Update Document

Usage: Update Document updates the reference to an externally
stored document. Helix automatically updates the reference to the
document(s) stored in the collection if the new path can be deter-
mined. If the new path cannot be determined automatically, Helix
prompts the user to locate the document.

When: a document field is selected on an entry form and the storage
format is external

Custom Menu: available

Sequence: available

If Keep Versions is active, Helix updates the location of the current
version of the document.

For more information, see sections 4.8.13 and 4.8.14.

4.8.13 Find & Update All

Usage: This command updates the reference to one or more exter-
nally stored documents. Helix automatically updates the reference to
the document(s) stored in the collection if the new path can be
determined. If the new path cannot be determined automatically,
Helix prompts the user to locate the document.

This command is often used in conjunction with a query to update a
set of records.

When: Find & Update All is available when a non-listing form dis-
played on a view containing a document field is the active window
and the storage format is external. Internal documents are ignored if
the field storage format is mixed.

Custom Menu: available
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Sequence: available

Helix performs a Find First, updates the record, Find Next, updates,
and so on, until all records retrievable by this form have been
updated.

If Keep Versions is active, Helix updates location of the current ver-
sion of the document. Older versions are not affected.

For more information, see sections 4.8.12 and 4.8.14.

4.8.14 Update All

Usage: Update All updates the reference to one or more documents
on a listing form. Helix automatically updates the reference to the
document(s) stored in the collection if the new path can be deter-
mined. If the new path cannot be determined automatically, Helix
prompts the user to locate the document.

When: a listing form is the active window and the storage format is
external

Custom Menu: available

Sequence: available

If Keep Versions is active, the current version of the document is
updated. Older versions remain in their current location(s).

For more information, see sections 4.8.12 and 4.8.13.



Chapter 4: Menus

4-76



Font

4-77

4.9 Font
The Font menu allows the user to select different typefaces. It con-
tains the names of all available fonts.

4.9.1 Fonts

Usage: selects fonts for data and label rectangles

When: a label or data rectangle or tool on a template is selected

Custom Menu: available

Sequence: not available

The font selected for a data rectangle applies to the entire rectangle,
except when a field or abacus formatted as Styled Text is contained
within the rectangle. Fonts can change within a label rectangle. Fonts
can also be changed through the rectangle dialog boxes.
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4.10 Style
The Style menu commands allow the application developer to change
the appearance of text. Each rectangle retains its own settings.

4.10.1 Font Attributes

Usage: sets the text style attribute of a rectangle

When: a template is the active window and a rectangle or rectangle
tool is selected

Custom Menu: not available

Sequence: not available

Any font can be displayed in Plain Text, or with any of five attributes.
More than one style may be selected for a rectangle. The six menu
selections allow switching between attributes and affect how the con-
tents of label and data rectangles will appear.

Note: Every style selected for a data rectangle applies to
the entire rectangle, except when the rectangle contains a
Styled Text field and/or Styled Text abacus.

Tip: Font attributes can also be changed through the rect-
angle dialog boxes.

4.10.2 Font Size

Usage: specifies font size

When: a template is the active window and a rectangle or rectangle
tool is selected
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Custom Menu: not available

Sequence: not available

Selecting a font size that is too small for the currently selected rect-
angle causes a beep. The Why? message explains the reason for the
beep.

Tip: Font size can also be changed through the rectangle
dialog boxes.

For more information, see section 4.10.3.

4.10.3 Custom Size

Usage: Custom Size sets a point size other than those listed on the
Style menu to be used for a rectangle. The user enters a point size
between 1 and 127 in a dialog box.

When: a template is the active window and a rectangle or rectangle
tool is selected

Custom Menu: not available

Sequence: not available

Selecting a font size that is too small for the currently selected rect-
angle causes a beep. The Why? message explains the reason for the
beep.

Tip: A custom font size can also be set in the rectangle
dialog boxes.

4.10.4 Alignment

Usage: sets the alignment of data within label and data rectangles

When: a template is the active window and a label rectangle, data
rectangle, or tool is selected

Custom Menu: not available

Sequence: not available

Three commands, Align Left, Align Center and Align Right, affect the
alignment of data within a rectangle. Depending upon which align-
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ment is selected, data that appear in a rectangle are left or right justi-
fied or centered within the rectangle.

Tip: Alignment can also be set in the rectangle dialog
boxes.

4.10.5 Colors

Usage: assigns colors to data rectangles or all or part of label rectan-
gles

When: a template is the active window and a label rectangle, data
rectangle, or tool is selected

Custom Menu: available for Styled Text fields only

Sequence: not available

Tip: Colors can also be set in the rectangle dialog boxes.
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4.11 Special Use Commands
Some commands do not appear on the regular Full Mode menus.
They can be found only in custom menu or sequence construction. 

4.11.1 Edit Users

Usage: triggers a dialog that is used to duplicate or delete a user or to
change a user’s password

When: only in Custom Mode

Custom Menu: available

Sequence: not available

Edit Users is found under the command switch in the User window.

4.11.2 Top Menu

Usage: returns a user on a submenu to the “home” or top level menu
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When: the user is working with a submenu

Custom Menu: available

Sequence: available

For more information, see section 6.4.4.4.

4.11.3 Draw Screen

Usage: In a sequence, after activating a form displayed on a view,
Draw Screen draws the entire contents of all affected windows before
starting the next step in the sequence.

When: a sequence window is open

Custom Menu: not available

Sequence: available

Normally, if a sequence is executing a series of Find commands it will
not draw every record, only the last one. Draw Screen placed after a
sequence step causes the active window to be drawn fully before the
sequence proceeds to the next step.

4.11.4 Pause

Usage: Pause provides a one second delay during a sequence. Multi-
ple Pause commands in a sequence result in longer delays.

When: a sequence window is open

Custom Menu: not available

Sequence: not available

This command can be used after a Draw Screen (section 4.11.3) to
hold the display of a window for a specified amount of time.

4.11.5 Static Enter

Usage: allows data to remain visible on a data entry form after an
Enter command has been used to store the record



Special Use Commands

4-85

When: an entry form displayed on a view is the active window

Custom Menu: not available

Sequence: available

When a new record is entered or data in an existing record are
replaced using a Static Enter sequence, the values in the fields are not
cleared but remain visible.

Tip: Static Enter can also be triggered by holding down the
Option key while pressing the Enter key or choosing the
Enter command, assuming the Enter key is enabled. (See
section 8.2.4.1.)

4.11.6 Dump Form

Usage: dumps the current record or list to a text file

When: a form displayed on a view is the active window

Custom Menu: available

Sequence: available

When an entry form is the active window and displaying a record, the
Dump Form command dumps only that record.

If no record is displayed, only the defined abacus calculations that
appear on the form are dumped. If posting is attached to an empty
form, or to modified or new records that have not yet been stored in
the database, the form will not be dumped.

4.11.7 Home Field

Usage: returns the insertion point to the first selectable data rectan-
gle containing a field on a form

When: the I-beam cursor is present in a field on a form

Custom Menu: not available

Sequence: available
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4.11.8 Tab Field

Usage: advances the cursor to the next selectable field on a form

When: there is at least one selectable field on a form

Custom Menu: not available

Sequence: available.

4.11.9 Beep

Usage: causes the Macintosh to beep

When: a sequence containing the Beep command is activated

Custom Menu: not available

Sequence: available

4.11.10 Sort Order

Usage: opens a dialog box that allows users to change the index
specified for a list form displayed on a view

When: a list form displayed on a view is the active window, and Sort
Order has been enabled for that view

Custom Menu: removable

Sequence: available

Tip: Hold down the Command key while choosing the
form name to open the Sort Order dialog prior to opening
the list to which it is attached.

For more information, see section 7.2.2.

4.11.11 Enter Override

Usage: allows the collection designer to remove Enter privileges (to
disable the Enter key or command) but still allow the user to perform
the Enter function through a sequence or menu command
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When: an entry form is displayed on a view is the active window

Custom Menu: available

Sequence: available

For more information, see section 4.11.12.

4.11.12 Static Enter Override

Usage: allows the collection designer to remove Enter privileges (dis-
able the Enter key) but still allow the user to perform the Static Enter
function through a sequence or menu command

When: an entry form displayed on a view is the active window

Custom Menu: available

Sequence: available

For more information, see section 4.11.11.

4.11.13 Refresh

Usage: updates the data displayed on a cold form or the data dis-
played on a form to which a cold query is attached without closing
and reopening the form

When: a cold form or a form to which a cold query is attached is the
active window

Custom Menu: available

Sequence: available

For more information, see sections 8.2.4.5 and 9.3.5.

4.11.14 Publish Now

Usage: sends an edition file

When: a list form displayed on a view has been published

Custom Menu: available
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Sequence: available

Note: This command is equivalent to clicking the Send
Edition Now button of the Publisher Options dialog.

For more information, see section 12.5.1.2.

4.11.15 Fonts

Usage: adds a list of installed fonts to a custom menu so that a user
can set the typeface in a styled text field

When: the cursor is an I-beam in a styled text field

Custom Menu: available

Sequence: not available

4.11.16 Sizes

Usage: adds one or more type sizes to a custom menu so a user can
set the type size in a styled text field

When: the cursor is an I-beam in a styled text field

Custom Menu: available as six options: 9, 10, 12, 18, 24, and Custom
Size

Sequence: not available

4.11.17 Styles

Usage: adds one or more type styles to a custom menu so a user can
set the type style in a styled text field

When: the cursor is an I-beam in a styled text field

Custom Menu: available as individual styles; Bold, Italic, Outline, and
so on

Sequence: not available
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4.11.18 Colors

Usage: adds a list of colors to a custom menu so users can set the
color of text in a styled text field

When: the cursor is an I-beam in a styled text field

Custom Menu: available

Sequence: not available
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Data Types
This chapter discusses the data types that Helix uses 
to maintain data. It also covers the formatting options 
available with each type.
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5.1 Introduction
Helix stores each piece of data as one of eight data types: Text, Styled
Text, Number, Fixed Point, Date, Flag, Picture, and Document. This
chapter defines each data type briefly, and lists the range, precision,
and options for each type.

Caution: Once you have specified a data type for a field
and have stored data in that field, changing the field’s data
type will erase all of the data stored in the field. When you
attempt to change a field’s data type, an alert appears giv-
ing you the chance to abort the change. If you proceed,
you may also invalidate any abacus, power query, index,
view, or post icons that use this field as part of their defini-
tions.

Helix provides calculation tiles that convert data of one type into
another for output without affecting stored data. For more informa-
tion, see section 10.7.

5.1.1 Data type options

In addition to the choice of a basic data type, a collection developer
can choose to set a variety of options for a field. The specific options
available depend to some extent on the type of field.

5.1.1.1 Format
The format of an object refers to the entry method and the display
characteristics of the data and has no effect on how it is stored. The
format of an icon can be changed at any time.

The data type format options chosen for a field do not affect the font
or text style of the data display.

The following entry format options determine the way in which users
enter values:

• Standard: The standard entry format is the same as no format. 
Users type data into the field.

• Static Popup: A static popup is a popup menu with options that 
are specified when the field is formatted. 

• Dynamic Popup: A dynamic popup is a popup menu with options 
that are taken from a relation in the database.
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• Radio Buttons: A flag field can be formatted as a set of two or 
three radio buttons.

• Check Boxes: A flag field can be formatted as a check box.

Display formats specify how data will be displayed on the screen,
regardless of how a user types the data. For example, a date can be
formatted so that data entered in any short form, such as 2-13-52 or
2/13/52, is displayed in a long form such as February 13, 1952.

The way Helix stores data internally for each data type is indepen-
dent of display and entry formats. For instance, the storage space
required for a number is 10 bytes. This is unrelated to any formatting
specifications, the magnitude of the number, or the precision of the
value (the number of digits to the right of the decimal point).

For more information on format options, see section 7.1.4.

5.1.1.2 Validation
Validation options provide one or more criteria to which data in a
field must adhere. If the data do not meet the validation criteria,
Helix will not store the record containing the data in the database.

For more on validation, see section 7.1.5.

5.1.1.3 Keyword/Edit Keyword
Any text field (but not styled text fields) can be marked as a keyword
field. Helix creates an index on every word in the field to speed up
searches of the contents of the field. The Edit Keyword button dis-
plays a dialog box containing words that will be ignored when a key-
word field is indexes. A collection developer can edit this list as
needed.

For more information on keywords, see section 7.1.6.

5.1.1.4 Inert
Data in an inert field are not stored in the database. Use this option
when the value in a field needs to exist only temporarily, as a source
of data to other Helix tools or as a trigger for an operation. In many
ways, an inert field is analogous to a variable in a programming lan-
guage.

For more information on inert fields, see section 7.1.7.
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5.1.1.5 Storage
This option applies only to the Document data type. It determines
where the document BLOB (binary large object) is stored in relation
to the collection. 

For more on the document storage option, see section 11.2.

5.1.2 Undefined Data

All data types can exist as null or undefined (a value of “unknown,” or
having no data). For example, when a clear data entry form contain-
ing a number field first appears on the screen, the field’s value is
unknown; until an actual value is entered, the value of the field is
“undefined,” as opposed to having a value such as 0. It is important to
remember that a value of undefined is not the same as 0 or a blank or
any other meaningful value. For example, for a flag field, a value of
undefined is not the same as the value “False.”

When an undefined value is used in a calculation, the result is usually
undefined. However, this is dependent on the actual tiles used in the
calculation. For specific handling of undefined values in calculations,
see Chapter 10.



Chapter 5: Data Types

5-6



Text Data Type

5-7

5.2 Text Data Type

Definition: variable length character string

Range: from zero characters (undefined) to 32,768 characters per
field

Validation Option: available

Inert Option: available

Other Options: keyword

Entry Format Options: Standard, Static Popup, Dynamic Popup

Display Format Options: None; text is displayed the way it is entered.
There are several calculation tiles that perform text string manipula-
tions. See section 10.4.
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5.3 Styled Text Data Type

Definition: variable length character string

Range: from zero characters (undefined) to 32,768 characters per
field

Note: The length of a styled text field includes the hidden
formatting characters. Therefore, the amount of visible
text that can be stored in a styled text field is less than
32,768.

Validation Option: available

Inert Option: available

Other Options: none

Entry Format Options: Standard, Static Popup, Dynamic Popup

Display Format Options: None; collection designer may allow users
to format entered data for font, size, style and color. Text is displayed
the way it is entered.

Styles, including fonts, point sizes, and colors, can be mixed within a
label or command rectangle.

A data rectangle containing a styled text field (or an abacus with
styled text output) can contain a mixture of fonts, styles, point sizes,
and colors.

Tip: Since no keyword option is available for styled text
fields, you need to resort to a bit of a trick to get Helix to
appear as if it had indexed styled text field contents. Place
the field in a Text tile in an abacus and then use an option
0 Post to store that information in a keyword field that is
not on the current form. You can then search the unseen
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keyword field when working with the styled text data. For
more on calculation tiles, see Chapter 10. For more on
Posting, see Chapter 8.
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5.4 Number Data Type

Definition: floating point numeric

Range: ±1.8 * 10E±308

Precision: 16–17 digit extended floating point number accuracy

Note: Helix uses the Standard Apple Numerics Environ-
ment (SANE) for all numbers and numeric calculations.
This package is warranted by Apple Computer Inc. to
“meet all requirements for extended precision floating
point arithmetic as prescribed by IEEE Standard 754 and
IEEEG draft standard p. 854.” Further details can be found
in the IEEE Standard 754 and the Apple Numerics Manual.

Validation Option: available

Inert Option: available

Other Options: none

Entry Format Options: Standard, Static Popup, Dynamic Popup

Display Format Options: Complete control over display of numeric
formats; numbers entered with no decimal places and then displayed
with decimal places show “0” in each decimal place.
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To set a default format for a number field, you click the format button
in the field window to display the number format dialog box:

The number shown next to the word “Example” (in the bottom left
corner of the box) provides a sample of how a number will be dis-
played on a form when using the currently selected format options.
The display changes as you change format options, reflecting the
new format options.

At the top of the dialog, an area labeled “Number of digits” lets the
user enter a number between 1 and 15 to specify the entry and dis-
play precision of the number. The default value is zero decimal
places, and if a value is not entered, the value remains zero. Here is a
case where undefined (an empty box) means zero.

Specifying the number of digits to be displayed after the decimal
point has no effect on the value Helix stores. For example, the num-
ber 123.456 with a display precision of two appears as 123.46 after
the user has tabbed out of the field on an entry form. Setting the
number of digits to be displayed to four (4) causes the number to
appear as 123.4560.

If the actual number of digits to the right of the decimal point is
greater than the number of digits displayed, Helix rounds the display
but does not change the stored value.

①

① An example of how the number will appear

②

② The display precision of the number

③

③

④

④

⑤

⑤
⑥

⑥

Currency format

Group separators (commas and so on)

Scientific notation

Percentage format
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If the displayed number of digits is greater than the number of signifi-
cant digits in the stored value, Helix displays zeros for the remaining
display digits to the right of the decimal point.

The lower portion of the dialog box contains Check Boxes for other
number formatting options:

• When the Currency box is checked, any number displayed will be 
preceded by the currency symbol of the Macintosh system that 
was used when the collection was created. For example, 143 is dis-
played as $143 on an American Mac OS. Negative currency num-
bers are displayed in parentheses, instead of with a minus sign. 
For example, -143 will appear as ($143). If (143) is entered, this 
number will be displayed as ($143) if formatted for currency, or as 
-143 if no format options have been selected.

• When the Groups box is checked, the number appears with the 
group separators that were defined by the Macintosh system in 
use when the collection was created. For example, 123456 appears 
as 123,456.00.

• When the Scientific box is checked, the number appears in scien-
tific notation (for example: -1.23456e+4).

• When the Percent box is checked, a percent sign (%) automati-
cally appears at the end of a number. A number may be entered as 
a percent in any number type field. If the user types 10%, the entry 
is converted into the numerical value 0.10. The number appear as 
10% only when the percent format has been selected. In a calcula-
tion, 10% has a value of 0.10.

Numerical symbols vary according to the localized version of the
Macintosh operating system in use when the collection was created.
For example, when using a USA system and after selecting format
options, the number 12345 might be displayed as 12,345.00. Selecting
the same options on an Italian Macintosh system would produce
12.345,00. However, running the collection made on the American
system on an Italian system will still display 12,345.00. Helix automat-
ically uses the symbols of the system in use when the collection was
created initially.
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5.5 Fixed Point Data Type

Definition: fixed point numeric

Range: -10,737,418.24 to +10,737,418.23

Precision: two digits to the right of the decimal point

Helix stores a fixed point data type as a long integer with the effective
range shown above.

Helix stores 8 digits to the left of the decimal point (up to 10,737,418)
and stores 2 digits to the right of the decimal point, regardless of any
display or entry format. In other words, it stores two digits to the
right of the decimal point whether you enter or display zero, one or
two digits. The stored number is used in calculations.

If you enter more than two decimal places, Helix displays an error
dialog box stating that the data entered are incompatible with the
field’s data type.

Operations performed on fixed point data types don’t depend on
SANE. This can help avoid certain rounding problems that can occur
when repeated operations are performed on decimals with two digits
of precision. The fixed point data type is therefore particularly useful
for currency fields, especially those that are used in calculations.

Validation Option: available

Inert Option: available

Other Options: none

Entry Format Options: Standard, Static Popup, Dynamic Popup
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Display Format Options: To set a default format for a fixed point
field, you click the format button in the field window to display the
fixed point format dialog box:

The number shown next to the word “Example” (in the bottom left
corner of the box) provides a sample of how a fixed point value will
be displayed on a form when using the currently selected format
options. The display changes as you change format options, reflect-
ing the new format options.

At the top of the dialog, an area labeled “Number of digits” lets the
user enter 0, 1, or 2 to specify the entry and display precision of the
number. The default value is zero decimal places, and if a value is not
entered, the value remains zero. Here is a case where undefined (an
empty box) means zero.

Specifying the number of digits to be displayed after the decimal
point has no effect on the number stored. 

If the actual number of digits to the right of the decimal point is
greater than the number of digits displayed, Helix rounds the display
but does not change the stored value.

If the displayed number of digits is greater than the actual number,
Helix displays zeros for the remaining digits to the right of the deci-
mal point.

① An example of how the number will appear

②

② The display precision of the number

③

③

④

④

Currency format

Group separators (commas and so on)

①



Fixed Point Data Type

5-17

The lower portion of the dialog box contains Check Boxes for other
number formatting options:

• When the Currency box is checked, any number displayed will be 
preceded by the currency symbol of the Macintosh system that 
was used when the collection was created. For example, 143 is dis-
played as $143 on an American Mac OS. Negative currency num-
bers are displayed in parentheses, instead of with a minus sign. 
For example, -143 will appear as ($143). If (143) is entered, this 
number will be displayed as ($143) if formatted for currency, or as 
-143 if no format options have been selected.

• When the Groups box is checked, the number appears with the 
group separators that were defined by the Macintosh system in 
use when the collection was created. For example,123456 appears 
as 123,456.00.

Numerical symbols vary according to the localized version of the
Macintosh operating system in use when the collection was created.
For example, when using a USA system and after selecting format
options, the number “12345” might be displayed as “12,345.00.”
Selecting the same options on an Italian Macintosh system would pro-
duce “12.345,00.” However, running the collection made on the Amer-
ican system on an Italian system will still display “12,345.00.” Helix
automatically uses the symbols of the system in use when the collec-
tion was created initially.
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5.6 Date Data Type

Definition: date and time

Range: from January 1, 0001 12:00:00 AM to December 31, 9999
11:59:00 PM

Precision: Date and time can be specified to the second.

Validation Option: available

Inert Option: available

Other Options: Display leading zeros in time, Include seconds in time

Entry Format Options: Standard, Static Popup, Dynamic Popup

Display Format Options:

①

① Date formats

②

② Time formats

③

③ Display leading zero for time components less than 10

④

④ Include seconds in time display

⑤

⑤  Sample of formatted data 
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There are two components to a date data type: the date and the time.
These two parts are formatted independently. Either the date or the
time may be omitted completely, but not both; when one is selected
for omission, the other Omit button dims.

The date can be displayed in any of the styles shown in the Date area
of the dialog box. Click a radio button to choose the style displayed
to its right.

The time can be displayed in either 12 hour AM/PM style or 24 hour
military time. Two check boxes provide the choice of including lead-
ing zeros (9:30 becomes 09:30) or including seconds. 

When entering data into a field that has a date data type, a date/time
value may be entered using any of the styles shown in the format dia-
log box. It is accepted as a date/time value and is displayed accord-
ing to the format that has been selected. If a date/time is entered in a
style that is not supported, the entry will not be accepted and the
computer will beep when the user attempts to tab out of the field.
The Why? message will inform the user that the entry is incompati-
ble with the field.

If only the date component is being entered, then Helix stores the
time component as 00:00:00. If only the time component is being
entered, Helix stores the date component as January 1, 0001.

The selected format determines what is displayed, not what is
stored. For instance, if a field is formatted to omit the time compo-
nent and a date containing time information is entered, the extra data
are accepted and stored, but are not visible. To see everything that is
stored in the field, you must reformat the display.

00:00:00 or 12:00 AM means midnight; 12:00:00 or 12:00 PM means
noon.

Date and time display varies according to the localized version of the
Macintosh OS in use when the collection was created. For example,
after selecting format options using an American system, the date 01/
01/99 is displayed as “January 1, 1999.” Selecting the same options
using an Italian Macintosh OS produces “1 Gennaio 1999.” Helix auto-
matically uses the date and time conventions of the system in use
when the collection was created.

Helix default settings for interpreting two digit year input are set to
recognize 20 through 99 as twentieth century dates (1920–1999) and
00 through 19 as twenty-first century dates (2000–2019).



Flag Data Type

5-21

5.7 Flag Data Type

Definition: Boolean

Range: True or False

Note: False < True and Undefined does not equal either
True or False.

Validation Option: available

Inert Option: available

Other Options: Case, Label controls

Entry Format Options: Standard, Check box, Radio buttons
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Display Format Options:

A flag field can be formatted in any one of the six styles represented
under the Labels area of the dialog box. Clicking a radio button
selects the style to its right. The bottom entry in the Labels area
allows the collection developer to enter custom labels.

If a flag field uses the standard format, the Labels area choice deter-
mines the text that is displayed in the field on a form. If the flag field
uses either radio buttons or a check box, the Labels area determines
what labels appear next to the radio buttons or check box on a form.
Radio buttons use both labels; check boxes uses only the first.

Tip: Radio buttons can appear as sets of two or three. If
you choose to use three radio buttons, the third is labeled
“undefined.”

The options in the Case area determine whether the style choices
available under the Labels heading appear with all upper case let-
ters, lower case letters, or mixed case with the first letter of each
word in upper case and the rest in lower case.

Just as with the number or date data type, the format option that is
chosen does not restrict how data can be entered but only how they
will be displayed. Flag type data can be entered in any of the five for-
mats shown, but the entry will be displayed using the selected for-
mat options.

①

① An example of the display format

②

② Labels for radio buttons or check boxes; text
for standard format

③

③ Case for displayed values

④

④ Format types

⑤

⑤ Custom label settings



Flag Data Type

5-23

If “Enter custom labels only” is checked for a flag field, the user can
type in either the first letter(s) of the label or the complete label
name.
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5.8 Picture Data Type

Definition: any graphic image that can be placed on the Macintosh
Clipboard or Scrapbook

Range: picture size is limited by disk size and monitor resolution

Validation Option: not available

Inert Option: available

Other Options: none

Entry Format Options: None; pictures are entered into a picture field
by pasting from the Clipboard or a Scrapbook or extracted from a
document field by the picture tile (see section 10.8.12).

Display Format Options: none

There are several restrictions on picture data type usage:

• Picture fields cannot be searched.

• An Index cannot be built using a picture field.

• Pictures cannot be dumped or loaded. Picture fields will be 
skipped over when dumping data from a form containing picture 
fields.

• Pictures cannot be edited within Helix.

• The only calculation tiles that can accept the picture data type are 
Display, If-Then-Else, Lookup, Defined, Undefined, and Undefined 
Becomes (see sections 10.2.1, 10.10, and 10.11).

For more information, see section 4.6.1.
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5.9 Document Data Type

Definition: Each document field in a record can contain a file— either
an application (such as a word processing, graphics, or spreadsheet
program) or a document created with an application.

Range: The size of a file that can be placed in a document field is
restricted only by the amount of available disk space.

Validation Option: Not available; document fields cannot be vali-
dated directly, but their attributes can be validated by using an aba-
cus query. See section 10.8.

Inert Option: available

Other Options: storage; See section 11.2.

Entry Format Options: None; documents are entered into a docu-
ment field using the Copy from Volume... or Move into Collection...
commands. See section 11.5.

Display Format Options: None; a defined document field displays the
document’s name and the related icon on an entry or list form con-
taining that document field. If available, a “mini icon” will also appear
in the lower right corner, indicating whether the document is stored
internally or externally (see section 11.2). The actual contents of the
file are not shown.

To see the contents of a document use the Copy to Volume, Work on
Copy, Work on Original, Open Copy, or Open Original commands, or
the Picture Tile.

Unlike the other Field formats, you cannot select portions of a Docu-
ment Field—the whole document must be selected.
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Top Level 
Structural 
Elements
This chapter begins with an introduction to Helix 
RADE windows and to window information. It also 
contains an in-depth discussion of the use of the 
windows that provide a collection’s top level structure 
(collection, user, relation, and sequence). The 
chapter ends with coverage of copying and pasting 
these icons and their contents.
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6.1 Introduction
Helix RADE icons appear in either a collection window workspace or
a relation window workspace. To create an icon, you drag it from its
well into the workspace. You must then open the icon’s window to
work with it by either double clicking the icon or selecting the Open
command from the Icon menu.

Icons may open to a single window, such as the user icon and the
template icon.

Icons may also open windows whose appearance is affected by vari-
ous menu commands. For example, the view icon window can appear
in one of three states (form, setup, or posting) depending on whether
the collection developer chooses Show Form, Show Setup, or Show
Posting from the View menu.

Other icons contain nested views, where opening one window is the
only way to get to another. Icons of this type include the field icon
and the post icon.

6.1.1 Navigation

Most Helix RADE windows and dialog boxes support “tab-and-type”
navigation for selection lists and/or text entry boxes.

These dialog boxes and windows use standard selection conventions.

• If there is more than one selection list or text entry box, press the 
Tab key to move between them.

• A selected list or text entry box has a double line border, similar 
to the border that appears around a default button.

• To quickly select an item in a list of text items, type one or more 
letters from the beginning of the item you want to select.

• The up and down arrow keys move between items on a list 
(except for lists in which multiple items can be chosen).

6.1.2 Buttons

As with most Macintosh dialog boxes, Helix RADE dialog boxes con-
tain OK buttons that save the settings in the dialog box and Cancel
buttons that close the dialog boxes without saving settings. You can
choose the buttons from the keyboard as well as by clicking on them.



Chapter 6: Top Level Structural Elements

6-4

• You can choose the default button (usually OK), which is indi-
cated by a double line border, by pressing the Enter key.

Caution: In dialog boxes, the Return key will also select
the default button. However, when you performing data
entry, the Return key places a carriage return character in
the data rather than selecting a button. It is therefore a
good idea to get into the habit of using only the Enter key
to activate default buttons.

• To choose the Cancel button, press Command-period.

• To choose other buttons, press the Command key plus the first 
letter of the word on the button. For example, to select a No but-
ton, press Command-N; for a Move File button, press Command-
M.

Tip: When two buttons in the same window have the
same first letter, the command key equivalent for one of
the buttons is usually the second letter in its name.
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6.2 Get Info
Use the Get Info command, available in the Icon menu, to get informa-
tion about an icon and where it is being used in a collection. This is
particularly useful when you want to discard an icon and must
remove all references to it from all other icons.

There are three ways to invoke Get Info:

• Select an icon and then chose Icon->Get Info.

• Selecting an icon and then press Command-I

• Press the Command key and double click on an icon.

6.2.1 Components of the Get Info Window

The description section at the top of the window contains a picture of
the icon and its name. Double clicking on the icon opens the icon’s
window. 

The information below the picture of the icon includes:

• The type of icon.

• The collection or relation where the icon is stored.

• The contents of the icon. The information in the contents section 
is the same as the contents area in View By Name and View By 
Kind.

①

① Description

②

② Custom name

③

③ Comments

④

④ Icons that reference the 
current icon



Chapter 6: Top Level Structural Elements

6-6

The Custom Name section contains a text box into which you can
enter or modify a custom name. (For more information, see sections
4.4.7.1 and 4.4.8.1.)

Use the Comments section to enter notes about the icon. This area is
the same as the Comments column in View by Name and View by
Kind. If you enter more than three lines of text in the Comments sec-
tion, the text scrolls up as you enter each new line. You can scroll the
Comments section by using the up and down arrow keys to move the
insertion point. You can also scroll the comments by dragging to
select more than three lines of text.

Note: The Comments section is limited to 32K of text.

The Used By section contains a list of other icons that use the
selected icon. You can open one of these icons by double clicking on
it. To see the Get Info window for any icon in the Used By list, Com-
mand-double click on the icon. 

Opening a template or abacus in the Used By section highlights and
centers the used icon in the window. If the icon is used more than
once within the abacus, opening the abacus highlights and centers
the icon in one of its locations in the abacus.

The Locked check prevents an icon from being deleted or renamed.
You can, however, change its attributes and edit its comments.

A locked icon has an L attribute in View by Name or View by Kind
modes.
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6.2.2 Hidden References in Get Info

There are some circumstances under which the icon name in the
Used By section of the Get Info window is in italics. An italicized icon
name indicates a hidden reference.

Examples of hidden references:

• In the preceding illustration, a field is used as a linking element in 
a dynamic popup on a template. Because the referenced field can-
not be selected when the view is opened, it is a hidden reference: 
Helix considers a field formatted as a dynamic popup to be a 
hidden reference when the field uses itself as a menu or data 
value.

• A user in Custom Mode leaves a view open when leaving the col-
lection. The view is then removed from this user’s menu. When a 
Get Info is performed on the view, the user’s icon will be in italics.

• A field or abacus is removed from a template. You will be unable 
to throw away the field or abacus until you have saved the tem-
plate by selecting Save from the Icon menu. This is because Helix 
maintains a copy of the original template internally so that you 
can revert it to its original condition without saving.

6.2.3 Custom Icon Name

Collection designers sometimes give icons cryptic, coded names to
facilitate the design process, but these names may not be appropriate
for users. For example, when naming inert fields, some designers put
an i in front of the field name (for example, iDocName). To users, this
looks like a typographical error. In Helix RADE, you can assign Cus-
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tom Names to icons through the Get Info window to provide more
meaningful names for users.

6.2.3.1 Assigning Custom Names
To assign a custom name, select an icon in the relation window and
then choose Get Info from the Icon menu. The Get Info window
opens.

Type the custom name into the text box below the Custom Name
label and close the Get Info window.

This custom name is displayed in the relation window in either View
by Name or View by Kind mode.

6.2.3.2 Custom Names on Quick Forms
Custom icon names can be displayed on Quick Forms. The Quick
Entry and Quick List menu commands allow you to choose between
custom or icon names.
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These menu items are available when a template is open and when a
view is in show setup mode, but no template is selected. Custom
names will always be used if you choose Find All to produce a list or
Find First to produce an entry form when a view is in show setup
mode and no template has been selected.

Custom names for views and queries are displayed only in Custom
Mode. In Full Mode, the icon name is displayed in the title bar.
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6.3 Collection
Invoked by: choosing Show Collection from the Icon menu (see sec-
tion 4.4.18), selecting New or Open from the File menu, or, when in
the Finder, opening Helix or an existing collection

Uses of: create and store user, relation, and sequence icons (See sec-
tions 6.4, 6.5, and 6.6.)

This is the starting window for all database and application develop-
ment. Everything that can be created with Helix RADE originates from
the collection window.

6.3.1 Components of the Collection Window

When a collection is created by opening the Helix RADE icon or by
selecting New from the File menu, an empty window like the one illus-
trated below appears. There are three icon wells in the palette on the
left side of the window. 

A Helix database and application is constructed by dragging an icon
from an icon well contained in the palette into the work area or work-
space. Newly created icons can be named and opened to display
other windows where tools reside, ready to be used to create data-
base and application components.

Icons can be discarded by dragging them to the trash can at the bot-
tom of the palette. If an icon zooms back to its original location, the
icon is being used by other icons and cannot be discarded until all
references to it have been removed. (See section 6.2)

①

① Palette

②

② Workspace or work area

③

③ Trash can
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6.3.2 Viewing Collection Information

There are three commands in the Icon menu that are enabled when a
collection window is active: View by Icon, View by Name, and View
by Kind. These commands serve functions very similar to their coun-
terparts in the Finder.

6.3.2.1 View by Icon
In View by Icon mode, the contents of a collection window appear as
icons that can be renamed, duplicated, moved, and dragged to the
trash can. As in the Finder, multiple icons can be selected by shift
clicking or by drawing a selection Rectangle around them.

When icons are dragged from icon wells into the collection window,
they remain where they are placed. Icons can be arranged and rear-
ranged at will. In addition, the Clean Up command can be used to line
up icons automatically in the window. (See section 4.4.20.)
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6.3.2.2 View by Name
The View by Name version of the collection window is organized into
two areas, the palette and the icon entries.

The palette functions as it does in View by Icon mode—icons can be
dragged from the icon wells into the workspace.

Note: In either View by Name or View by Kind mode, if the
user drags an icon from its well to the workspace, there is
no control over where the icon will appear when switch-
ing back to View by Icon mode. If you prefer your icons to
appear in the same area of the workspace, either create
them in View by Icon or create them by duplicating an
existing icon in either of these views.

The icon entries in the View by Name mode (one line per item in the
window) are sorted alphabetically by name. Each line consists of five
parts.

• The mini icon identifies the type of each icon. Double click on the 
mini icon to open the icon, just as you would in View by Icon 
mode.

The header for this column has a mini icon switch that indicates
whether you are in Fast Find mode (indicated by an arrow) or
Editing mode (indicated by an A). Clicking on the mini icon switch
toggles between these two modes. (See sections 6.3.3.1 and
6.3.3.2.)

①

①  The palette

②

② Mini icons

③

③ Icon names

④

④ Icon contents

⑤

⑤ Comments about icons

⑥

⑥ Custom names
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The Name of the icon is the name given to the icon by the collec-
tion developer. If the column is too narrow to display the entire
name, it ends with an ellipsis (…). The width of this column can
be changed. (See section 6.3.3.4.)

• The Contents column provides information about the icon, such 
as the number of icons and records in a relation, the category of a 
user, or the number of steps in a sequence.

An independent icon (one not used by any other icon) is indicated
by a “[-]” at the beginning of the Contents column.

If the column is too narrow to display all of the information for the
icon, it will end with an ellipsis. The width of this can be changed.
(See section 6.3.3.4.)

• The Comments column displays information that you enter about 
the usage and importance of each icon. It can be edited any time 
it is visible and from the Get Info window. (See section 6.2.)

• The Custom Name column displays any custom name assigned to 
the icon. Custom names are specified in the Get Info window. (See 
section 6.2.3.)

6.3.2.3 View by Kind
The illustration below shows the same collection window in View by
Kind mode. Items are sorted alphabetically within each icon cate-
gory.

6.3.3 Working with the Collection Window

When a collection window is in View by Name or View by Kind mode,
the mini icon switch allows you to switch between two functions, a
Fast Find mode to find and select icons rapidly and an Editing mode
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for editing icon names and entering information in the Comments col-
umn.

In addition, two special cursors, available only in View by Name or
View by Kind mode, allow you to manipulate some aspects of the win-
dow display.

6.3.3.1 Fast Find Mode
In Fast Find mode (indicated by a mini icon arrow) typing moves you
to the first item whose name starts with the characters you type, or
the first succeeding item if that name doesn’t exist. If you pause for
more than one second while typing, the selection process will restart
with the first character that you enter after the pause.

Tip: An additional search method is available in View by
Kind mode. Clicking in an icon well scrolls you to the first
item of that type, allowing you to switch quickly between
icon types.

For a summary of Fast Find operations, see section 6.3.3.3.

6.3.3.2 Editing Mode
Clicking on the mini icon when it is in Fast Find mode puts you in
Editing mode (indicated by an A, ). 

Clicking in an editable column (Name or Comments) also invokes
Editing mode. In this case, the item on which you click is selected and
temporarily extended to the right for editing. Typing will replace the
text you have selected.

Note: The Contents column cannot be edited, since it is
generated by Helix RADE. Custom Names can be edited
only in the Get Info dialog.

6.3.3.3 Fast Find and Editing Mode Keyboard Shortcuts
Keyboard shortcuts for Fast Find and Editing operations are summa-
rized in Table 6.1.

Key Combination Result

Return or Enter Toggles between Fast Find and Editing mode

Up Arrow Previous icon (if any)

Table 6.1 Keyboard navigation aids for View by Name and View by Kind mode
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6.3.3.4 Changing the Display
Two special cursor shapes appear when you move the mouse
pointer across the header in View by Name or View by Kind mode.

When you are close to the divisions between the columns, the cursor
changes to a divider dragging cursor (see section 3.2.3), indicating
that you can adjust the column widths. This is useful if the majority
of your icon names are lengthy or if you have several icons with simi-
lar names and/or contents and you do not want the icon entries to
appear truncated.

Note: Neither the width nor the position of the mini icon
column can be changed. 

Down Arrow Next icon (if any)

Left Arrow Previous character when editing Name/Comment

Right Arrow Next character when editing Name/Comment

Option-Up Arrow Top line

Option-Down Arrow Bottom line

Tab or Option-Right/Left Moves back and forth between Name and Comment; if 
switching to Comment, forces Editing mode

Clear If in Editing mode, deletes current field

Backspace/Delete If in Fast Find mode, performs an undo; in Editing mode, 
deletes one character

Key Combination Result

Table 6.1 Keyboard navigation aids for View by Name and View by Kind mode

①

① The divider dragging cursor
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To move a divider, hold down the mouse button when the divider
dragging cursor appears and drag the column divider to the right or
left. A dotted vertical line moves with the column divider. Move the
mouse until the dotted line marks the desired column width. Then
release the mouse button.

The cursor changes to a column swapping cursor (see section 3.2.2)
when over the header to indicate that dragging one column header
over another one will swap their positions. The widths of the two col-
umns remain unchanged.

6.3.4 Dumping Collection Information

The Dump Collection Information command puts information about
the collection into a tab delimited text file that can be edited by a
word processor or text editor to document the collection.

The text file contains the following.

• A header line

• A single line description of the collection

• A line for each user icon

• Data for each relation

To dump information on the contents of each relation, see section
6.5.4, Dumping Relation Information.

①

①  The column swapping cursor
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6.3.5 Printing Collection Information

The collection window can be printed from Helix RADE using the
Print Paged and Print Scaled commands. Refer to section 13.3.2 for
details.
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6.4 User
Invoked by: dragging a user icon into a collection window

Uses of: create custom menus, change user categories, select permis-
sions for individual forms, and select command key equivalents for
custom menu options

The Helix RADE collection window has an icon well for user icons,
symbolized by a person sitting at a desk. Each user icon represents
one or more users of the collection along with a set of custom menus.

The name of the icon is the user name for a set of menus and com-
mands that are customized for a specific user or group of users. A
user selects the user icon name to access the collection in which the
user icon is stored. 

The icon contains a specified set of menus and commands, and also
stores restrictions that describe which functions can be performed
with any given menu option.

The open user icon window lets a collection developer do the follow-
ing.

• Create custom menus

• Specify user categories

• Set form permissions

• Choose command key equivalents for the custom menus

Note: Other characteristics of each user are determined by
various Set menu commands. For more information, see
section 4.5.

Because the user window allows the manipulation of Helix’s standard
pull down menus, the standard pull down menus do not work as
menus while a user window is active. Instead, selecting a pull down
menu selects it for editing as a custom menu. The menu’s options
appear, allowing a collection developer to insert new options, insert a
dashed bar between groups of options, remove options, or change
the position of existing options or menus.
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6.4.1 Components of the User Window

The major components of the user window include the following.

• The selection list, below the four switches at the top right of the 
window, is used to choose items to be placed in menus and also 
to select views for granting and revoking permissions. (See sec-
tion 6.4.5.)

Note: As with other Macintosh windows, the title bar can
be used to move the window out of the way of pull down
menus that are being edited. However, in this case the
window moves horizontally only. Usually the window will
not have to be moved, as the menus will automatically
appear to one side when they are pulled down.

• The four switches are for view icons, user icons, menu com-
mands, and sequence icons. Selecting one of the four switches 
causes a different set of items to appear in the selection list.

Selecting the view icon switch displays a list of all view icons in
the collection. To place a view on a custom menu, select the view
name in the list and drag it onto a menu (see section 6.4.4). When

①

① Selection list

②

② View switch

③

③ User switch

④

④ Menu switch

⑤

⑤ Sequence switch

⑥

⑥ Form permission check boxes

⑦

⑦ User category check boxes

⑧

⑧ Number of users allowed

⑨

⑨ Command key equivalents

⑩

⑩ Hierarchal menu tool
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the user chooses the view from the menu, the view’s window
opens, giving the user access to the view.

The view names that appear in the selection list are the view icon
names. When placed on a menu, they change to custom names, if
any have been defined. (See section 6.2.3.)

Choosing the user icon switch displays a list of all user icons in
the collection. When you place a user icon in a custom menu,
Helix uses the menus in that user icon as a submenu.

Clicking the menu switch displays the allowable menu commands
that are not currently on this user’s menus to appear in the selec-
tion list. Commands can be dragged from the selection list and
placed on a menu.

Selecting the sequence icon switch displays all valid sequence
icons in the collection. To place a sequence on a custom menu,
select the sequence name in the list and drag it onto a menu (see
section 6.6). When the user chooses the sequence from the menu,
Helix executes the sequence.

• The form permission check boxes specify the operations that can 
be performed on a form by a user logged in to the collection under 
this user name. The permissions affect all occurrences of a given 
view on the user’s menus, except for submenu items. (See section 
6.4.5.)

• The user category check boxes specify one of four user types. The 
category (see section 6.4.2) is determined by allowing one, two, or 
none of the Login and Edit User operations. Without Login, the 
user icon name will not appear in the User Selection dialog box; 
without Edit User, the user cannot be changed or deleted through 
the Edit Users dialog box (see section 6.4.3). The type of user 
defined by the check box combination is shown in parentheses 
beneath the check boxes.

• The collection designer optionally can set the number of clients 
who can simultaneously logon to the same user. The default is 
infinity. To change the default, select contents of the text box, 
press the Delete key, and type the maximum number of users 
allowed.

• Command key equivalents can be assigned to most menu items, 
including views, using the Command key boxes (see section 6.4.6).

• Use the hierarchal menu tool to create a small arrow to the right 
of a menu item that will drop down when the arrow is pressed. Up 
to 31 menu items can be placed on a hierarchal menu.
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• The OK button accepts and records the current state of the 
menus and closes the dialog.

• The Cancel button discards any changes and closes the dialog.

• The Auto button is enabled only when the menus under construc-
tion contain no view names. Clicking the Auto button creates a 
menu for each relation. Each menu contains the names of all the 
views in that relation.

• The trash can lets the collection developer remove menu options 
from a custom menu. All options placed on a custom menu can be 
removed from the menu by selecting the item and dragging it to 
the trash can. Most, but not all, commands from Helix’s standard 
menus can be removed in the same way. (See Chapter 4 for the 
specific menu item to see if it can be removed.) Removed com-
mands are displayed in the selection list when the menu com-
mand switch has been clicked.

Note: Removing an option from a custom menu does not
discard the item from the collection; it merely removes it
form the custom menu.

6.4.2 User Categories

There are four categories of users: Administrator, User, Prototype,
and Submenu. Each is defined by two attributes: Can it be accessed
from the user selection list (Login)? Can it be edited—duplicated,
deleted, or have its password changed—from Custom Mode?

• Administrators (Login = Yes; Editable = No) can be accessed but 
not edited through the Edit Users dialog. An administrator can be 
duplicated, deleted, and have its password set in Full Mode. This 
type of user is often used for a system manager.

• Users (Login = Yes; Editable = Yes) can be accessed; they also can 
be fully edited. This is the standard type of user.

• Prototypes (Login = No; Editable = Yes) cannot be accessed, but 
can be edited to an extent. As their name suggests, they are most 
often set up as a “standard use” for duplicating. As a result, they 
cannot be deleted nor can they have a password.

• Submenus (Login = No; Editable = No) can neither be accessed nor 
edited. They can only appear as items on other users’ custom 
menus. (See section 6.4.4.4 for a discussion of submenus.)

Form permissions are set in the usual way for all four categories of
users. (See section 6.4.5.)
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6.4.3 Editing Users

The Edit Users menu command, which is available only in Custom
Mode, is used to duplicate, delete, and set passwords for users.

To edit users, a collection developer must first place the Edit Users
command in a custom menu. A user can then choose the command
while working in Full mode to open the Edit Users dialog box.

As you can see, the dialog box also shows the number of Clients
allowed for the selected user.

6.4.3.1 Duplicating Users
Duplicating a user lets a system administrator create additional user
logons, each with its own name and password. To duplicate a user,
select the user or prototype to be duplicated from the Edit Users dia-
log box.

Note: If the Show Prototypes Only check box is selected,
only prototypes will appear in the user selection list. Sub-
menus and administrators do not appear in the user selec-
tion list because they cannot be duplicated from the Edit
Users dialog.

Click the Duplicate button. The Duplicate User dialog box appears.

①

① List of users

②

② Number of clients allowed per user
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When a User is duplicated, only the custom menus are copied. Pass-
words are ignored.

If you choose a name that has already been used in the collection for
any category of user, the following message appears.

6.4.3.2 Setting Passwords from Edit Users
Edit Users can be used to set passwords for users only. Because pro-
totypes cannot be used to log onto Helix, the Password button dims
when you choose a prototype from the list of user icon names. Sub-
menus and administrators do not appear in the list; they, too, cannot
have their passwords changed from the Edit Users dialog.

After selecting a user, click the Password button. The Set Password
dialog boxes appear, asking you to set and verify the new password.
(See section 4.5.3.)

6.4.3.3 Deleting Users
Only Users can be deleted through the Edit Users dialog box. If a pro-
totype is chosen from the list, the Delete button dims. Submenus and
administrators do not appear in the user selection list and therefore
cannot be deleted from within the Edit Users dialog.

After selecting a user, click the Delete button. A dialog box appears
asking you to confirm the deletion:

Click the Delete button to remove the user; click Cancel to abort the
deletion.
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6.4.4 Creating Menus

There are two ways to create custom menus using the user icon dia-
log box. The first is to allow Helix to generate the menus automati-
cally; the second is to create the menus yourself.

6.4.4.1 Generating Auto Menus
Click the Auto button in the user icon dialog box. Helix RADE creates
one menu for each relation in the collection and then places all of the
view icon names into these menus according to the relation in which
the icons were created. 

To specify the order in which items appear, click on the relation icons
in the collection window in the order in which you wish them to be
displayed on the menu bar before you begin generating custom
menus.

6.4.4.2 Creating Custom Menus
A collection developer has complete control over the location,
options, and appearance of a custom menu. To create a custom
menu:

1. Open a user icon.
2. Click on the menu bar at the location where you want the new 

menu to appear. A small box then appears with a text insertion 
cursor. 

3. Type the name of the menu. (Menus must be given a name before 
any items can be inserted.) A small empty rectangle appears 
below the menu name. This rectangle marks the place to which 
you drag the first item that will appear as a menu option.

4. Select a view, user, menu command, or sequence name from the 
list below the switches and drag it over the rectangle under the 
menu name. A bar appears across the empty rectangle when the 
cursor is in the correct position to drop an item into that menu. 
When the bar appears, release the mouse button. The item 
appears in the menu as an option.

Note: All views appear under their view names in the
selection list. However, the name changes to the view’s
custom name, if it has one, when the view is placed on a
custom menu.
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5. Select the next view name, user, menu command, or sequence 
from the selection list to be placed in the menu, if desired, or cre-
ate another menu on the menu bar.

A horizontal dotted line is available at the bottom of each selection
list. This line can be placed anywhere on a menu to separate groups
of related menu options.

Tip: Hierarchal menus can be used to group logical func-
tions together while keeping the overall length of a menu
from growing excessively long. For more information, see
section 6.4.4.5.

Note: The total combined number of Helix menu bar and
hierarchal menus for any one user is 31. Since there a lim-
ited amount of space on the menu bar, the name length of
the menus will also tend to determine the total number of
menus that can be created for each user icon. (A menu
can, however, contain other menus: see section 6.4.4.4.)
Some system extensions install their own menus on the
menu bar and therefore also take up space.

6.4.4.3 Menu Editing Considerations
A custom menu can be edited (in Full Mode) at any time. Double click
on the user icon to open the window to display the custom menu bar.
Names on the menu bar can be changed at any time by editing them.

Click on a menu name to edit the options in that menu.

Menu options can be relocated. To move a menu option, select the
option and drag it to the desired location on the same or another
menu.

When moving an option from one menu to another, drag the option
so that the cursor points to the name of the menu you desire. This
will cause that menu to pull down. You can then drag the option to
the place you want it to appear in the menu and drop it at that loca-
tion by releasing the mouse button.

Menu options can be removed. Drag an unwanted item from a menu
and into the trash can in the user dialog box.

Views, sequences, and users appearing in a custom menu are consid-
ered in use, and the icons cannot be thrown away in the relation or
collection window. The names must be removed from the menu first.
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Each menu can have a maximum of 31 options. Helix ignores attempts
to place additional options on the menu. When you are working with
the Apple menu,   Accessories appears as the menu’s last option.
This represents any and all items in the Apple Menu Items folder. All
of these items count toward the maximum that the Macintosh system
allows. It may appear, therefore, that you are being permitted to
insert fewer items into the Apple menu than should be permitted.

Similarly, the Colors item takes up the space of eight menu options.
Fonts uses all 31, so it must be the only item on a menu.

Menus with more than 19 items scroll during menu editing. The
menus you have created scroll when you drag the cursor below the
last visible item, allowing you to access additional items.

All menus can be edited, including the Apple, File, Edit, Set, and View
menus. See section 6.4.7, User Interface Guidelines, for restrictions.

6.4.4.4 User Submenus
Clicking the user switch at the top of the selection list displays a list
of user icons. Any user icon name can be dragged from the list and
placed on any menu. Placing a user icon name onto a custom menu
creates a menu option that, when chosen by a user working in Cus-
tom Mode, switches to the set of custom menus contained in the cho-
sen user icon. Such a menu accessed menu is called a submenu.
Submenus allow you to set up a variety of specialized sets of menus
(such as project tracking, reference directories, etc.) that are
accessed only from within designated users’ menus.

To define a user icon as “submenu only,” deselect both user category
check boxes. When this is done, the user icon name will not appear in
the user dialog box.

Submenus cannot be duplicated or deleted from the Edit Users dialog
box.

Caution: When constructing a custom menu, be sure to
check the submenu design carefully. Each submenu should
provide a way back to a top level menu from which any
submenu can be selected or should contain the Top Menu
command. Otherwise, a user could get trapped in a sub-
menu and possibly have to exit Helix to escape.



Chapter 6: Top Level Structural Elements

6-28

6.4.4.5 Hierarchal Menus
To create a hierarchal menu, drag the hierarchal menu arrow to the
menu. Then type a title for the hierarchal menu option next to the
hierarchal menu arrow.

A small empty box appears to the side of the main menu option next
to the arrow. Drag up to 31 items (including lines) to this hierarchal
menu as you would for any other custom menu.

6.4.5 Form Permissions 

Selecting a view icon name in the selection list enables the permis-
sion check boxes. These let a collection developer specify which
operations can be performed on a form by the user whose menus are
being edited. Permission settings affect all occurrences of the view
on the user’s menus. Views on submenus have their own set of per-
missions.

6.4.5.1 Permissions and Their Menu Commands
Menu options for actions that are blocked (permission check boxes
are empty) are dimmed when the view is used in Custom Mode. The
permissions necessary to enable specific actions are summarized in
Table 6.2.

Permission To Enable

Find Open Query, Quick Query, Find First, Find Next, Find Previous, Find 
Last

Add Enter, Static Enter, Paste Record

Replace Replace, Paste All Records (when a record is selected on a list)

Delete Delete, Delete All, Delete Selections, Delete Originals, Delete All 
Originals

Print Print Form, Find and Print All

Load Subscribe to, Load, Paste All Records

Dump Dump Form, Dump Selections, Dump All..., Copy Record, Copy 
Selected Records, Copy All Records, Create Publisher

Table 6.2 Permissions necessary for form actions
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6.4.6 Command Key Equivalents 

Command key equivalents can be assigned to most menu items,
including form names, user names, and sequences. These items can
then be accessed by holding down the command key and pressing
the key for the character that has been assigned to that item. This
shortcut bypasses the use of the mouse to pull down menus and
select menu options.

Command key equivalents can be dragged from the keyboard picture
near the bottom of the user dialog box to any menu option, from one
menu option to another, or from a menu option to the trash can.

Available characters appear in bold type. If a command key equiva-
lent is in use, then it is dimmed on the keyboard and cannot be used.

Two menu items do not accept command key equivalents. Enter is
always equivalent to the Enter key;   Accessories represents the
entire contents of the Apple Menu Items folder. The user interface
guidelines discussed in section 6.4.7 explain additional restrictions.

Tip: Buttons in dialogs can be selected via conventional
command key equivalents. For more information, see sec-
tion 6.1.2.

6.4.7 User Interface Guidelines 

The Macintosh user interface guidelines are a set of official Apple
requirements that all Macintosh programs should follow. These
guidelines were published so that there would be consistency in the
basic operation of Macintosh programs. Helix closely follows these
guidelines, and Helix application designers will find their applications
easier for users to learn and use if they adhere to the guidelines as
well.

One set of guidelines governs menus, and the items they contain, and
is therefore applicable to custom menu design.

• The first three menus are the Apple menu, the File menu, and the 
Edit menu. These menus cannot be removed. Their names can be 
edited, but any attempt to delete a name or to insert another 
menu to the left of the Edit menu is not allowed.

• The first item on the Apple menu is always About Helix RADE...
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• The contents of the Apple Menu Items folder are always on the 
Apple menu, and no other options can be inserted beneath them.

• The last item on the File menu is always Quit.

• The first six items on the Edit menu are always Undo, (a menu 
line), Cut, Copy, Paste, and Clear.

• Command key equivalents for Undo (Command-Z), Cut (Com-
mand-X), Copy (Command-C), and Paste (Command-V) cannot be 
changed.

Helix RADE enforces these guidelines.
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6.5 Relation
Invoked by: dragging an icon from the relation icon well in the collec-
tion window into the collection window’s workspace

Uses of: create data storage structures and all the related application
elements that create and manipulate the stored data

Double clicking a relation icon opens a relation window. The relation
window and the icons that it contains are the principal tools for Helix
RADE application and database development.

6.5.1 Components of the Relation Window

The palette on the left of the relation window contains eight icon
wells representing the field, abacus, template, view, index, form
query, power query, and post icons. To use one of these icons, drag it
out into the work area.

The trash can below the icon wells is used to discard unwanted
icons. Any icon dragged into the trash can is destroyed immediately
and cannot be retrieved.

Note: If an icon snaps back to its original location after
you place it in the trash can, the icon is referenced by
another icon somewhere and therefore cannot be dis-
carded.

For information on the specific icons in the relation window’s icon
wells, see Chapters 7, 8, and 9.

①

① Palette containing icon wells

②

②  Work area

③

③ Trash can
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6.5.2 Viewing Relation Information

The View by Icon, View by Name, and View by Kind menu options are
available when a relation window is active. These commands work
the same in the relation window as they do in the collection window.
(See section 6.3.2 for detailed information.)

As in the collection window, an independent icon (one not used in
any other icon) is indicated by a hyphen (-) at the beginning of the
contents column for that icon.

Note: Independent index icons may be used for query and
search optimizations. Therefore delete independent index
icons from a relation with caution.

The contents column in the relation window is more extensive than
that in the collection window (see Table 6.3). If a particular type of
information is not applicable (for example, if a field is neither inert
nor validated, or if there are no post icons attached to a form) then
nothing appears. An exception is the Query information for the View
icon.

Icon Information Format

Field The data type Text

Styled Text

Number

Date/Time

Flag

Picture

Document

Inert/Validated? [I] = Inert

[V] = Validated

Abacus Output data type? Text

Styled Text

Number

Integer

Table 6.3 Contents column information in the relation window
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Date

Flag

Picture

Document

Lookup/Summary? [L] = Lookup

[S] = Summary

Template Entry or list? Entry

List

Number of subforms? /x subforms
(x = number of subforms)

View Which Template? Template name

or Quick Entry/List

Attached Queries? /A: Abacus Query name

/Q: Template Query name

/P: Power Query name

(a slash and a blank space 
appear if no Query has 
been selected for the 
form)

Attached Index? /Index name

Attached Posts? (xE) = number of Post on 
Entry icons

(xA) = number of Post All 
icons

(xP) = number of Post on 
Print icons

(xD) = number of Post on 
Dump icons

Form Query What Template? Template name

Icon Information Format

Table 6.3 Contents column information in the relation window
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6.5.3 Working with the Relation Window

Icons in the relation window and the display of the window itself are
handled just as they are in the collection window; you can view by
icon, name, or kind, and can change the display as needed. (See sec-
tions 6.3.2 and 6.3.3 for details.)

6.5.4 Dumping Relation Information

The Dump Relation Information command puts information about
the relation into a tab delimited text file that can be loaded into a
word processor to document a relation.

A dump file begins with a header line, followed by a line for each icon
in the relation. Each icon line consists of the icon type, icon name,
contents, and comments. The fields in the file are separated by tabs,
with a carriage return at the end of the line.

Power Query Winnow items? /Total Searchable items
/Total Reference items
/Total Permanent items

Index Contents? For the first two levels, the 
icon type (field or aba-
cus), icon name, and 
direction. Also includes 
the total number of levels.

F: = Field icon name

A: = Abacus icon name

[A] = ascending order

[D] = descending order 

...(x) = number of icons in 
index (if more than 2)

Post Post Option Target? opx: Target Relation

AutoOpen form? (V: View name)

Icon Information Format

Table 6.3 Contents column information in the relation window
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The icons in the relation are dumped in the order currently selected
for the window, or in by Kind order if the window is in View by Icon
mode.

6.5.5 Printing Relation Information

To print a relation window from Helix RADE, use the Print Paged or
Print Scaled command. For details, see section 13.3.2.
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6.6 Sequence
Invoked by: dragging an icon from the collection window’s icon well
into the collection window’s work area

Uses of: create a procedure that executes Helix operations when a
user selects a single menu option or by clicks a button on a form

A sequence represents a series of Helix commands to be executed in
a specified order. A sequence can contain views, users (including sub-
menus), certain Helix commands, and other sequences (with certain
restrictions on recursion).

Sequences are created only by the collection designer and can be
placed in custom menus or attached to command rectangles on a
template so that they can be executed by the user.

6.6.1 Components of the Sequence Window

①

①  Icon switches

②

② Selection list

③

③ Sequence construction area

④

④ Trash can

⑤

⑤ Run button

⑥

⑥ Dialog options

⑦

⑦ Message options
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Sequences are constructed much like custom menus. The icon
switches are used to display selection lists of views, users, com-
mands, and sequences. The collection developer drags items from
the selection lists into the sequence construction area. 

Helix numbers items in the construction area automatically. The
order of the items in the construction area determines the order in
which actions will be executed. 

Unneeded items can be dragged from the construction area to the
trash can. This action removes items from the sequence list only;
they remain in the selection lists.

The Run button is used to execute a sequence from the dialog box.
This is one way to test a sequence before placing it on a user menu.

Tip: Not all sequences execute properly when you click
the Run button in the sequence window. This is especially
true of sequences attached to command buttons when
they start with commands that affect the current window
(for example, a command to close the window). To test
such sequences, you will need to display the form on
which the sequence’s command button appears and then
click the command button.

The Dialog options are used to specify when dialog boxes, such as
those that appear during Load, Print, Delete All, and so on, are pre-
sented to the user. (See section 6.6.6.)

The Message options are part of the sequence’s error handling fea-
ture. A sequence that has not been constructed correctly will stop
when it comes to a command that cannot be executed. At this point a
Why? message explaining the error is available.

Selecting the Why? check box will cause the Why? message to open
automatically.
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There are three message options for the error message, Custom, Stan-
dard, and None. The default is the standard message, shown below.

This particular dialog box indicates that the Delete All command is
not available, in this instance, because the Delete permission had
been disabled for that form on that particular User’s Custom Menu.

The Custom option allows the collection designer to replace the stan-
dard Why? message.

When the collection developer executes a sequence in Full Mode
using the Run button, Helix appends the custom message to the stan-
dard message. In Custom Mode, only the custom message will appear
in the Why? dialog.

The None option suppresses the display of the Why? message. If an
error is encountered during the execution of a sequence, the
sequence aborts.

6.6.2 Users in a Sequence 

Putting a user in a sequence has the same effect as selecting that user
from a Custom Menu. If there is a password attached to the user, the
password dialog will appear.

6.6.3 Views in a Sequence

When a view appears in a sequence, the executing sequence simply
opens the view.
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6.6.4 Commands in a Sequence

Most Helix commands can be placed in a sequence (see Chapter 4).
Additionally, there are 6 commands that are available only in
Sequences:

See section 4.11 for more information on these commands.

6.6.5 Sequences in a Sequence

A sequence can contain other sequences (including itself).

For example, a sequence that prints a form, then performs a Post All
followed by a Delete All, can be constructed and then placed as a
step in other sequences.

If an error occurs during the execution of a subsequence (a sequence
within a sequence), the error message displayed gives the name and
line number of the subsequence rather than the name and line num-
ber of the containing sequence.

Recursion—a sequence that contains itself as a step—is restricted to
tail recursion. This means that if a sequence has itself as a step, no
other commands can follow that line of the sequence. If you go to the
selection list and drag out the sequence on which you are working,
the only place that you can put it is at the end of its own list—and
you will not be able to put anything else below it.

Tip: The limitation on recursion has a practical use: It can
be used to set up an automated demo. After setting up a
sequence to run through the demo once, add the sequence
to itself. Once you start the sequence, it will be repeated
until interrupted by a Command-period or until an error is
encountered that aborts the sequence.

6.6.6 Dialog Boxes in a Sequence

Many of the commands used in a sequence, such as Print Form or
Load, display dialog boxes that must be handled before the sequence
can proceed. But what if the collection designer wants to bypass

Beep Draw Screen Home Field

Null Pause Tab Field
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these dialogs? How do you get a sequence that can run unattended or
prevent a user from responding in an inappropriate way?

The Dialog options let the designer specify whether the user should
always, optionally, or never see (and thus have to reply to) command
dialog boxes on a sequence-by-sequence basis.

If the developer chooses Always, the sequence will always present
dialog boxes to the user.

If the developer chooses Optionally, dialog boxes will be displayed
only if the Option key is pressed when the sequence is selected. Oth-
erwise, the sequence will use the settings in the dialog boxes the last
time they appeared as the default replies.

If the developer chooses Never, Helix will never display a dialog, but
will try to use the default responses. The exception is user pass-
words, which will always be presented.

Tip: If you intend to set a sequence to Never show dialogs,
you must run the sequence once with the option set to
Always (or Optionally, if you run it with the Option key
held down) to set the default responses for the dialog
boxes.

In the case of Print Document, the Print dialog box usually appears,
and requires user response, even if the Never option was selected in
the sequence. This is because the Print dialog box that appears is
generated by the document’s native application rather than by Helix.

If you are automating a load operation, the sequence should first
open the entry form and then issue the Load command, which dis-
plays the Open File dialog box. When you specify the file to be loaded
using the Open File dialog box, Helix remembers the file name and its
location along with the form. When the load is subsequently per-
formed using this view within a sequence, Helix will not need to ask
for the file name.

Tip: If you don’t want to wait for the load to complete, you
can use Command-period to cancel it; the file name will
still be remembered.

A similar scheme can be used for printing, with the exception that
printing information (number of copies, print mode page range, and
so on) is stored in the template along with the Page Setup informa-
tion.
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If Helix is unable to use stored values for a dialog box (for example, a
specified load file no longer exists or the sequence was never run to
set default values for dialog boxes), the sequence aborts.

Note: The Never option has no effect on the Why? dialog.
The Why? dialog is always shown in the event of an error.

The Optionally option can be used where the stored responses to the
dialog boxes need to be overridden occasionally. For example, the
same sequence could be used to print out a daily report in black and
white but a monthly report in color.

The behavior of a sequence using the Optionally option (also known
as an optional sequence) also depends on the attributes of any
enclosing sequences. For example, an optional sequence can be
placed as the only item in an always sequence, and both can be
placed on a menu (or attached to command buttons on a form) to
allow choice of using an optional or always sequence.

As a simple example, consider the two sequences below. If the Print,
Ask First sequence is executed, the Print dialog box is always pre-
sented because the option selected for the sequence (Always) is
applied to the called sequence (Print, Don’t Ask). If Print, Don’t Ask is
executed, however, the dialog box is presented only if the Option key
is pressed.
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6.6.7 Conditional Sequences

A conditional sequence is a sequence that executes only if a specified
condition is true. The triggering of a conditional sequence is con-
trolled by a field or by the output of an abacus. The abacus could out-
put such values as the username, the date, or the values from a
record or records in another relation, such as a global.

For example, assume that you want a button to appear on certain
users’ forms and not others. First, you would create an access rela-
tion with three fields, User name, Item name, and Item status. Each
row contains the name of a user icon, the name of an item that
appears conditionally, and a flag that indicates whether the item
should appear for a given user. A form on which the item appears
would then include a condition to test whether the user’s record in
the access relation contains a value of true for a Item status field to
determine access to the function.

There are two methods of making a sequence conditional: directly, by
making the sequence itself conditional; or indirectly, by making the
button that contains the sequence a conditional button. (See section
8.1.8.)

In a conditional sequence, the sequence will not run unless the value
of the controlling field (or the output of the abacus) is a fixed point or
number value greater than or equal to 1.

This allows values in a record or collection wide parameters such as
the date or the current user to trigger sequences.

The best way to set up an abacus for triggering a conditional
sequence is to use an If-Then-Else tile that will output either 0 (zero)
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or a fixed point or number ≥ 1. When the Abacus outputs 1 or a larger
number, the sequence will run; otherwise it will not.

Tip: The flag output of an abacus can be converted to a
fixed point or number.

When a field or abacus used as a conditional sequence’s trigger has a
value greater than 1, the sequence will execute as many times as the
trigger value.

This makes it possible to run automated demo sequences without
imbedding a sequence in itself (as described in the Tip in section
6.6.5). A repeating sequence can be cancelled by typing Command-
period.

Conditional sequences use values to the left of the decimal point. In
other words, they truncate rather than round. Thus 1.6 becomes 1
and 0.90 is treated as zero.

Caution: If the window that triggered a sequence closes,
any further conditional sequences in the set triggered by
that window will not execute and will not resume even if
the window is reopened later in the sequence.
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6.7 Copying and Pasting Structure
Helix RADE lets you copy and paste collection level icons and their
contents, either into the same collection or a different collection.
This makes it possible, for example, to update multiple copies of the
same collection with changes made to one copy or to reuse common
components in multiple collections.

To copy structural elements, you select a user, sequence, or relation
icon or any icon within a relation, and use the Copy command from
the Edit menu. Then open the collection or relation into which you
want to place the copy and use the Edit menu’s Paste command.

6.7.1 Copy Structure

Copy Structure lets you select one or more items in a collection or
relation window and copy the icon(s) to the Clipboard. Items can be
copied regardless of whether the window is in View By Icon, View By
Kind, or View By Name mode.

Note: If you look at the Clipboard, it will show lines if you
have copied while in View By Name or View By Kind, and
icons if you have copied from a window in View By Icon
mode.

6.7.1.1 Copies vs. Referenced icons
A structure copy contains two classes of icons, copied and referenced.

Copied icons are those icons that were selected in the active window
when the copy was made. The copy contains all of the significant
information about the selected icons.

Referenced icons are icons that are referenced by the copied icons,
but were not selected. The copy contains only partial information
(known as the icon’s sketch) about these icons:

Icon Type  Content of the Sketch

Field Data type and whether inert

Abacus Data type of output

Template List or non-list

View None

Table 6.4
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6.7.2 Paste Structure

Once you have copied structure, you can paste it…

• into any collection or relation window, to create new icons.

• into the Scrapbook.

• as a picture or text into a word processing or graphics program. 
Pasting after copying from a window in View By Icon mode cre-
ates a graphic in a word processing or graphics program. Pasting 
after copying from a window in View by Name or View by Kind 
mode creates editable text in a word processor.

• to replace selected icons to change formatting or validation with-
out losing data. Other icons that reference the replaced icon con-
tinue to do so.

Tip: Prior to copying and pasting structure using the Scrap-
book, increase the memory allocated to the Scrapbook to
at least 2560 K (2.5MB).

6.7.2.1 Default Paste Behavior
By default, when a collection developer pastes structural elements,
Helix first attempts to figure out which icons to create. It must then
ask the user to identify the icons that the pasted icons reference so
that the referenced icons can be correctly linked to the pasted icons.
In general, copied icons are created in the destination or replace
selected icons of the same name, kind, and sketch; referenced icons
are linked to existing icons of the same name, kind, and sketch.

Query None

Post None

Power Query None

Index None

Sequence None

User None

Relation None

Icon Type  Content of the Sketch

Table 6.4
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If a referenced icon cannot be linked, then no link is used.

If there are multiple icons that satisfy the conditions for replacement
or linking, then Helix replaces links to the icon that matches the inter-
nal object number of the copy, if any. This is useful when pasting into
the same or a derivative collection. If a matching internal object num-
ber cannot be found, Helix uses the most recently clicked icon.

6.7.2.2 Manual Control of Paste Structure
If you do not want the default paste behavior, hold down the Option
key while selecting the Paste command (or press Com-
mand-Option-V) to open the Paste Object dialog box.

6.7.2.2.1 Components of the Paste Object Dialog
The Paste Object dialog box gives the collection developer complete
control of each icon pasted. In particular, you can determine whether
to paste an item as a new object or in place of an existing icon.

The leftmost scrollable list shows all of the relations that contain
icons that are being pasted. If users or sequences are being pasted,
the leftmost list also shows a line for the collection. Selecting an item
in the leftmost list causes the second list to show all of the objects in
that item. Copied icons appear in boldface, referenced icons appear
in plain type.

Note: Copying an entire relation causes most of the icon
names to appear in bold face.

When something is selected in the leftmost list, the third list shows
all of the potentially matching icons in the collection. If the relation
selected in the leftmost list is the source relation for all of the copied

①

① Source relations and/or collection

②

② Objects in selected source

③

③ Potential matching destinations

④

④ Matching objects
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icons, only the relation into which icons are being copied appears in
the third list.

When there is something selected in the left three lists, the fourth list
shows all icons in the object specified by the third list that match, by
kind and referenced items information, the icon specified by the first
two lists. Selecting an icon in the fourth list creates the link.

Tip: You can select items in the scrollable lists from the
keyboard: Tab and Shift-Tab move between scrollable
lists; up arrow and down arrow move vertically within a
list. You can also select an icon by typing its name. The
left arrow and right arrow keys move through the list
alphabetically, ignoring kind.

Use the New button to create and link an icon in either the third or
fourth list. New copied icons have all of the characteristics of the
original; new referenced icons match in name, kind, and sketch only.

A message appears telling the user how many icons remain to be
linked. If any icons are still unlinked, then clicking the Next button
selects the next unlinked icon in the left two lists.

A Delete non-replaced icons check box appears when you are pasting
into a collection window. It indicates what you want done with icons
that exists in a destination relation and have no icons replacing
them. If the check box is selected, Helix attempts to delete icons that
are not being replaced. If, however, there are any outside references
to those non-replaced icons, the delete will not be successful. 

Caution: If Delete non-replaced icons is selected, there is
no warning about deleting data; it is deleted silently.

The Auto button attempts to link icons by name, kind, and sketch.

The OK button makes one final attempt at linking, this time creating a
new icon for every unlinked copied icon. Then it proceeds with the
Paste operation.



Reference

Chapter

Helix

7

Basic Building 
Blocks: Fields, 
Indexes, and 
Abaci
This chapter looks at icons found in the relation 
window that form the foundations of Helix 
applications.
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7.1 Field
Invoked by: dragging a field icon from the field icon well in a relation
window into the relation window’s workspace

Uses of: select the data type of the field and choose among options
for data entry, display, validation, and storage

7.1.1 Components of the Field Window

The Field window consists of two columns. The Type column con-
tains radio buttons that represent the possible data types for field
icons. Use the Options column to set various field icon options.

7.1.2 Choosing a Data Type

The first step in creating a field is to choose a data type for the data
that will be stored in the field. To do so, click the radio button next to
a data type to choose that type for the field.

Note: The default data type is text.

Once you specify the data type, Helix will verify that any data entered
in that field conform to the data type. For example, if a letter is
entered into a number field, a beep sounds, the field is selected, and
Helix does not store the data.

Caution: If you have specified a data type for a field icon
and have entered data using this icon, changing the data

①

① Data types

②

② Options
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type erases all of the data stored in the field. Because the
consequences of changing a data type are potentially so
destructive, Helix displays an alert asking you to confirm
the change.

For more information on data types, see Chapter 5.

7.1.3 Deleting Fields

A field can be deleted from the collection by dragging it into the trash
can. As noted in Chapter 2, objects dragged to the trash are
destroyed immediately and cannot be retrieved.

If the field is not used anywhere (for example, in an abacus, or inside
a data rectangle on a template), doing so will simply cause it to disap-
pear. 

If the field is in use but contains no data, dragging the field to the
trash can causes the icon to snap back to its original location. If it
does this, you can select Why? from the Apple menu to find out why
the deletion wasn’t possible.
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If data have been entered in the field and you attempt to drag it to the
trash, the following alert appears.

Using Helix RADE’s Get Info function (see section 6.2), you can deter-
mine all the places an icon has been used and remove it from each
one in succession. If you click the Erase button, all data in the field
will be erased, but you will still not be able to remove the icon from
the collection. It will snap back to its original location providing the
Why? message on the preceding page.

Tip: This feature can be very useful, both when designing
a collection as well as when using one. You might want to
keep a field in its relation, but delete all of its data.

Once an icon containing data has been removed from all of its con-
nections, dragging it to the trash presents the following alert:

7.1.4 Field Format Options

Whenever a field icon is opened and the text, styled text, number,
fixed point, date, or flag data type is selected, the Format button in
the Options column of the field icon window becomes active. Clicking
this button displays a Format Options dialog box.

Note: The Format button is dimmed for the picture and
document data types because they do not have formatting
options.

The Format Options dialog box lets you set a default for how data are
to be displayed and how data are to be entered. Format options do
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not affect the stored data, nor do they affect the font or style of the
data display. The latter are set in a data rectangle on a template.

The format options of a field icon can be changed at any time. In
addition, you can override the default format by choosing a different
format for a data rectangle on a specific template. 

Tip: Format options can also be accessed through the For-
mat button of the abacus window (see section 7.3.1), and
in the data rectangle dialog box by double clicking, select-
ing the Custom radio button, and then clicking the Format
button (see sections 8.1.4.1 and 8.1.4.11). However, when
you set format options for an abacus or data rectangle,
they affect only that abacus or data rectangle, rather than
the field’s default format.

7.1.4.1 Field Format Options Dialog Components

The contents of the Field Format dialog box vary somewhat depend-
ing on the data type of the field. However, the dialog box does have
the following general components.

• data type of the field: The data type of the field is represented by 
one of the following icons:

• field-specific options: Field-specific options appear in the upper 
right portion of the dialog box.

①

① Field data type

②

② Field-specific options

③

③ Data entry options

④

④ Option descriptions

⑤

⑤ Format example
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• data entry options: 

Three of the data entry formats (Standard, Static Popup, and
Dynamic Popup) are available for text, styled text, number, fixed
point, date, and flag data types. Radio buttons and check boxes
are available for flag data type only.

• options: Any additional options available for the chosen format 
appear in a box below the field-specific options.

• example: The example provides a sample of how formatted data 
will appear.

7.1.4.2 Standard Data Entry Format
The standard data entry format is available for all data types except
picture and document. A user enters data into a standard format field
by typing a value on the keyboard.

The format dialog boxes for the standard data entry format are the
same, regardless of the data type of the field.

• Standard: When you open a field format dialog box, Helix selects 
the standard data entry format as the default.

Note: When an icon for a format type is selected, the right
panel of the dialog box changes to reflect information per-
tinent to that format. 

①

① Type of format (standard)

②

② Example of formatted data
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• Example: The example area displays a sample of how formatted 
data will appear when typed. In a standard format field, data are 
formatted exactly as they are entered.

7.1.4.3 Static Popup Menu
The Static Popup is available for text, styled text, number, fixed
point, date, and flag fields.

With this data entry format, the collection designer creates a popup
menu of acceptable input choices. If the developer selects “Allow
data to be typed in also”, the user can type data into the field or
select an item from the popup menu. If the check box is not checked,
then the user is limited to values in the popup menu.

The static popup format dialog box has the following components.

• Static Popup: To create a static popup menu for a field, click the 
static popup icon in the format list at the left of the dialog box. 

• Menu Item: Use the Menu Item area to enter and edit menu items. 
You can enter the items in any order; they can be reordered and 
sorted as needed. The following buttons are used to move menu 
items from this area to the menu and back.

①

① Type of format (Static Popup)

②

②  Menu item entry area

③

③ Menu assembly area

④

④ Move from assembly area to 
entry area

⑤

⑤ Move from entry area to
assembly area

⑥

⑥ Sort the items in the menu
assembly area

⑦

⑦ Remove a menu itme

⑧

⑧ Sample format

⑨

⑨ Option to allow users to
type values as well as choose
from the menu
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- <<: The << button moves items from the Menu area to the 
Menu Item area where they can be edited.

- >>: The >> button moves items from the Menu Item area where 
they are edited, to the Menu area.

• Menu: The Menu assembly area displays the menu as it will 
appear on a form.

• Sort: The Sort button sorts the items in the menu assembly area in 
alphabetical order. When sorting, all items are handled as text, 
even though the items may be numbers. This means that “10” will 
be sorted after “1,” rather than after “9.”

• Remove: The Remove button deletes a menu item. This button is 
dimmed when no menu item is selected.

• Example: The example area displays a sample of how formatted 
data will appear. 

• Options: A static popup menu has one additional option. If the 
check box in this area is checked, users can type a value into the 
field as well as choosing from the popup menu. When the option is 
not selected, users can only enter data by selecting a menu item.

Tip: If Enter Custom Labels Only is selected for a flag field,
the user can type in either the first letter of the label or the
complete label name.

7.1.4.4 Dynamic Popup Menu
Dynamic popups allow the designer to create menus whose contents
are drawn from data stored in the database. The selection of data
that appear as menu options is based on up to five criteria—relation,
query, index, menu value, and data value—or as few as two—relation
and data value. This is similar to selecting queries and indexes to
control the data and record order on lists. Because dynamic popups
are based on data within the collection’s database, their items can
(and usually do) change.
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Dynamic popups are available for text, styled text, number, fixed
point, date, and flag fields. You configure the popup in a Format dia-
log box: 

Note: When styled text is used in a popup, it is displayed
as normal text.

To configure a dynamic popup, you must choose at least a relation
and data value:

1. Click the Dynamic Popup switch in the format list at the left of the 
Format dialog box.

2. [required] Click the Relation radio button to display all available 
relations in the selection list. Then click on the name of the rela-
tion from which options for the dynamic popup should be taken.

3. [optional] If you want to restrict the records from the chosen rela-
tion that appear in the menu, you can attach an abacus, form, or 
power query to the menu. After selecting a Relation, you can 
select a Query to restrict the items listed in the menu. Click the 
Query radio button to display all available queries in the selec-
tion list. Then click on the query that should be used to restrict 
the contents of the menu.

4. [optional] By default, records appear on the menu in the order in 
which they are stored in their relation. To use an index to control 
record order, click on the Menu Order radio button to display all 
indexes in the selected relation in the selection list. Then click on 
the index name.

5. [required] The Menu Value determines the field or abacus whose 
values will be used as menu options. To set the menu value, first 
click on the Menu Value radio button. The selection list then dis-

①

① Dynamic Popup switch

②

② Selection list

③

③ Let users type values

④

④ Allow the menu to resize itself
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plays a list of all fields in the selected relation with an abacus 
switch at the top. To choose a value from a field, click the field’s 
name in the selection list. To choose an abacus, click on the aba-
cus switch to display all the abaci in the relation. Then click on 
the abacus’s name.

Tip: It can be very helpful to users to display a menu value
that is different from the value that is stored in the data-
base. For example, you might want to create a menu that
displays customer names but that stores customer num-
bers.

Note: The data type of the menu value does not have to be
the same as the data value stored in the database. How-
ever, when the data types of the menu value and the data
value differ, you must choose a data value.

6. [sometimes required] T data value specifies the field or abacus 
whose value will be stored in the database. The data type of that 
field or abacus must match the data type of the field that will be 
receiving the data chosen from the dynamic popup. To specify 
that data value, click the Data Value radio button. The selection 
list then displays a list of all fields in the selected relation with an 
abacus switch at the top. To choose a value from a field, click the 
field’s name in the selection list. To choose an abacus, click on the 
abacus switch to display all the abaci in the relation. Then click on 
the abacus’s name.

Note: When the data type for the selected field or abacus
and that of the field into which data will be stored are the
same, the data value defaults to the menu value.

There are two check boxes in the Options area of the dynamic popup
Format dialog box that affect how the dynamic popup behaves. When
the Allow data to be typed in also check box is selected, the user can
select a menu item or type data into the field. When this item is not
selected, users are required to select a menu item to enter data into
the field.

When the Allow menu to resize to data option is checked, the data
rectangle on the template can be sized to the smallest possible verti-
cal and horizontal measurements acceptable for the selected font,
size, and style. When the popup is selected on a view, the menu
resizes itself so that it can display the longest menu value.
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7.1.4.4.1 Smart Search Example
Popup menus provide a means of assuring consistency during data
input. For example, if you want to require users to enter a valid two
character state abbreviation, a popup (whether static or dynamic)
that contains correct data and that does not allow the user to type a
value eliminates any chance of someone entering Calif. instead of CA.

One of the most useful applications of Helix’s dynamic popup capa-
bility, as well as one that illustrates much of the functionality of the
RADE tools, is the Smart Search.

A Smart Search lets a user type in a portion of a value. Helix then
uses that portion in a search to restrict the menu options that appear
in the popup. For example, if a user wanted to see state abbrevia-
tions that began with N, the user would type N and press Tab. Helix
would then include only those abbreviations beginning with N as
options in the popup menu.

There are many things you can do with a Smart Search. Once you
know how to construct one, you can use it to locate any type of data
in your database.

This example will use a very simple construction. In it, a user in Full
Mode will search a list of companies for a particular company’s
record, using the beginning of the company’s name. 

To construct the Smart Search, a collection developer would do the
following:

1. Open a the collection in which the Smart Search is to be imple-
mented.

2. Create a relation and name it Global. Double click the relation 
icon to open it.

3. Create a field and name it Search.
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4. Create a template and name it Smart Search. Double click the tem-
plate icon to open it.

5. Draw a data rectangle in the upper left corner of the template 
work area as shown below.

6. Click the Field switch to display all the fields in the relation in the 
selection list.

7. Drag the Search field icon into the data rectangle.
8. Close the template to save the changes.
9. Close the Global relation window.
10. Create a second relation and name it Companies. Double click the 

relation icon to open it.
11. Create a field and name it Contact ID.
12. Create a second field and name it Company Name. 
13. Double click the Company Name field icon and click the Keyword 

check box. Then close the icon window. A thermometer will flash 
by briefly.

14. Create an index icon. Leave its name as Index.
15. Double click on the index icon to open it. 
16. Drag Company Name from the list of fields into the topmost black 

hole on the right. 
17. Close the index icon’s window.
18. Create a template and name it Quick Entry. 
19. Double click the template icon to open it.
20. Select Icon->QuickEntry->Use Icon Names. Label and data rectan-

gles appear on the screen. 
21. Click on the second data rectangle (the one containing the field 

Company Name) to select it.
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22. Drag the handle in the lower right corner of the selected rectangle 
down to resize the rectangle to three lines in height. At this point, 
the template should look like the following.

23. Close the template window.
24. Create a view and name it Quick Entry. 
25. Double click the Quick Entry view to open it
26. Click on the template Quick Entry in the leftmost column. 
27. Choose View->Show Form. 
28. Use the Quick Entry form to enter the following four records:

29. Close the view.
30. Create an abacus and name it Popup Link. 
31. Double click the abacus icon to open it.

Contact ID Company Name

AMNH American Museum of Natural History

AHA American Hospital Association

NMS National Museum Supply

NHS National Hospital Supply
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32. Drag a Use From tile out into the work 
area and double click on it to open the tile 
definition dialog box.
a. Click the template switch above the 

right list and select Smart Search.
b. Select the field icon called Search. 

from the left list.
c. Click OK.

33. Drag a Word Starts With tile into the work 
area so that the arrow at the bottom of 
the Use From tile fits into the second (right) hole in the Word 
Starts With tile.

34.Click the field switch in the palette on 
the left of the abacus window to display a 
list of fields in the relation.
35.Drag the Company Name field into the 
first (left) hole of the Word Starts With tile. 
Your abacus now says {Word {Company 
Name} starts with {{Use {Search} from 
{Smart Search}}. 

36. Close the Popup Link abacus window.
37. Close the Companies relation window.
38. Open the Global relation window.
39. Open the Smart Search template. 
40. Double click inside the data rectangle containing the Search field.

a. Click the Custom radio button in the lower right corner of the 
dialog box. 

b. Click the Format button. The Field Format dialog box appears.
c. Click the Dynamic Popup switch in the list of formats at the left 

of the dialog box. The Dynamic Popup configuration options 
appear in the dialog box.

d. Click the Relation radio button.
e. Click Companies in the selection list.
f. Click the Query radio button.
g. Click Popup Link in the selection list.
h. Click the Index radio button. 
i. Click Index in the selection list.
j. Click the Menu Value radio button.
k. Click Company Name in the selection list.
l. Click the Data Value radio button.
m. Click the Contact ID field in the selection list.
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n. Click both check boxes in the Options section.
o. Click OK to save these specifications.

41. Click OK to close the Field Format dialog box.
42. Close the template.
43. Create a new view icon and name it Smart Search. 
44. Double click the Smart Search view icon to open it.
45. Select the Smart Search template in the leftmost column. 
46. Select View->Show Form.

To use this form, type “Amer” in the data rectangle on the screen and
press Tab. Then display the options in the popup menu. Notice that
the only values that appear as options are those that start with the
characters you typed. In this case, since the Company Name was
stored in a keyword field, any company name with a word that begins
with “Amer” appear in the popup menu. Try typing other combina-
tions (for example, His or Mus) to see the results. 

The key to the Smart Search is the interplay between the dynamic
popup and the abacus you constructed in the target relation (in this
case, Companies) to link the values stored there to the value you
enter as a search key. When you press Tab to exit the Search data
rectangle, you trigger the evaluation of the abacus. The abacus uses
the value in the Search field on the Smart Search template (specified
in the Use From tile) as the value in the right hole of the Word Starts
With tile. Because this abacus is used as a query on the dynamic
popup, only those records that have a company name starting with
the value in that Search field can appear as menu options.

A Smart Search does not necessarily have to be based on a Starts
With relationship. You can use a combination of And, Or, Starts with,
Word =, Word starts with, and Equals tiles to create Smart Searches. 

7.1.4.5 Formatting Options for Flag Fields
Two formatting options, radio buttons and check boxes, are available
for flag fields only.

7.1.4.5.1 Radio Buttons
Flag fields can be formatted to display as radio buttons. The buttons
can be displayed either vertically or horizontally and as two or three
buttons.
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When you choose radio buttons as the format for a flag field, a user
can enter data by clicking a radio button, typing in the first letter of
the label, or typing T, Y, or 1, or F, N, or 0 (if Enter Custom Labels Only
was not selected).

The Grouping option determines whether radio buttons are dis-
played horizontally or vertically.

The Size option determines whether the field will appear as two or
three buttons. When “3 Buttons” is selected, the third button is
always labeled Undefined if the Display Labels option is selected.

Note: Any field can have a value of Undefined. A flag field
therefore can actually take three values: true, false, and
undefined.

The Display Labels option determines whether Helix will display the
labels specified in the data entry format dialog box. Selecting this box
tells Helix to display the labels.

7.1.4.5.2 Check Boxes
Flag fields can be formatted to display as check boxes. The data value
entered then depends on the state of the checkbox. A check box’s

①

① Radio button switch

②

② Horizontal or vertical display

③

③ Number of buttons

④

④ Choice of displaying labels

Two horizontal buttons Three vertical buttons
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value is always undefined when a clear form is displayed unless the
field has been given a default value. Once a check box is selected, its
value can be reset to Undefined by pressing the Backspace key.

The Display Labels option determines whether Helix will display the
labels specified in the data entry format dialog box. Selecting this
box tells Helix to display the labels.

7.1.4.5.3 Custom Labels for Flag Fields
When you first open the Format dialog box for a flag field, you will
see the following options for configuring the field’s labels.

①

① Check box switch

②

② Choice of displaying labels

①

① Labels to be used when Display Labels is checked

②

② Case for standard label display

③

③ Require user to type values for data entry
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You can use either the standard labels (Yes/No, Y/N, True/False, T/F,
or 1/0) or custom labels that you enter yourself. For instance, in the
preceding example, the label Autographed? has been designated for
the true label. There is no false label because this field is formatted as
a check box; Helix uses only the true label for check boxes. If the field
were formatted as radio buttons, then a collection developer would
enter both labels.

When “Enter custom labels only” is selected, the database designer
forces the user to select a radio button or check box by typing the
first letter of the label. For instance, in the preceding example, the
user could simply type an A to select Autographed?.

When the option is not selected, the user can type a Y, T, 1, or the first
letter of the positive custom label, or N, F, O, or the first letter of the
negative custom label.

In addition, a radio button or check box can always be selected with
the mouse.

Radio buttons that are displayed as a group of two use only the labels
specified in the Labels area. When radio buttons are displayed as a
group of three, the third button is always Undefined.

The Case option determines the case of the text for the label. This
applies only to the five sets of standard labels, not to custom labels.

Once the label options are set, click on either the radio buttons or the
check box switch to display the panel specific to that option.

7.1.4.6 Overriding Formats
The display and/or entry formats that you set in field format dialog
boxes can be overridden for any given data rectangle on a template.
This gives you the freedom to display and enter data in different ways
from form to form. Changing a format on a template does not change
the format stored with the field. The field format remain as originally
defined—or not defined—when the field icon was opened in the rela-
tion window.

For example: A flag field was formatted as Standard entry when the
field icon was opened in the relation window. When placed on the
entry form template, the data rectangle was opened and the entry
format changed to Radio Buttons. When this same flag field is placed
on a second template, the entry format will default to the icon format,
Standard in this case, unless it is changed again.
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7.1.5 Field Validation

One of the most effective things a database developer can do to
avoid inaccurate data is to attach validation criteria to fields. If the
data entered in a field do not pass the test specified in the validation
criteria, Helix will not store the record containing that data. When a
user presses Enter to store a record containing invalid data, Helix
sounds a beep, flashes the Apple menu, and selects the invalid field. 

At this point, the user can select Why? from the Apple menu (or
press Command-Y) and read an explanation of the problem. The user
cannot tab out of an invalid field. The user can, however, reposition
the cursor with the mouse and click into another field to continue
typing information, but the record cannot be stored in the database
as long as it contains data that did not pass the validation check.

Validation criteria are specified in a dialog box that you reach by
clicking the Validate button in the field window. Once you specify a
field’s data type, you can add validation criteria. 

Note: Picture and document fields cannot be validated in
this way. (See section 11.5.6 for indirect validation of Doc-
ument fields.) 

Clicking the Validate button displays the following dialog box:

The selection list in the middle of the dialog box displays either a list
of tiles (validation operators) that can be used to construct validation

①

① Field for which validation criteria are being set

②

② Operator switch

③

③ Abacus switch

④

④ Message that appears when criteria are violated
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expressions or a list of all abaci in the relation that return a text
value. The contents of the list is determined by the two switches
above. The keyboard displays the validation operators; the abacus
switch displays the abaci.

You can create a validation expression using one of two methods, by
constructing an abacus using calculation tiles that results in a text
data type or by using one of the predefined validation operators. 

The large text box at the right of the dialog box appears when you
select the keyboard switch. It contains the message that appears in a
dialog box when Why? is selected from the Apple menu. Helix pro-
vides a generic message, but you can change the message as needed
using standard Macintosh editing techniques.

7.1.5.1 Validation Operators
One way to construct a validation expression is to use the predefined
validation tiles. Selecting the keyboard switch on the scrollable list
displays the list of tiles. The black dot on each tiles represents the
data typed into the field being validated. The small box or boxes rep-
resent a specific value against which the data being entered into the
field are to be compared.

To select a tile, click on it in the selection list. When you do so, a text
edit box appears to let you type the value against which the field data
are to be compared. Enter the value using standard Macintosh editing
techniques. 

Once you have attached validation criteria to a field, Helix will auto-
matically evaluate the criteria each time a user enters data into the
field. Helix places the field’s value in the validation expression and
determines whether the resulting statement is true or false. If the

①

① Validation tiles

②

② Box for typing comparison value

③

③ Default Why message
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statement is true, then the data are valid and will be stored in the
database. If the statement is false, then the data are not valid and
Helix will not store the record containing the data in the database.

The value entered into the value box must match the data type of the
field icon being validated. For example, entering text in the value box
when the field has a number data type is not allowed. The OK button
will remain dimmed until the data type of the supplied value matches
the data type of the field.

When you select the keyboard switch, you also have access to the
text editing box under Why Message. The default message or a cus-
tom message that you enter is displayed in the Why? dialog box
whenever the data entered into the field fail the validation check. A
beep sounds and/or the Apple menu flashes, alerting the user that
the data entered have failed the validation check and that a message
is available.

To change the default message, edit the message using standard
Macintosh editing techniques.

When using the predefined validation tiles, there must be a message
in the message text box. The OK button remains dimmed until you
provide a message.

The operators provided by the validation tiles vary according to the
data type of the field. These operators perform the same function as
the calculation tiles that they resemble. The usability of specific
operators with specific data types follows the equivalent uses with
the calculation tiles. 
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Some operators require two values.

The validation tile chosen in the preceding example requires that the
value entered into the Quantity field be greater than zero and less
than one hundred. The black dot represents the position of the field
data in the expression; the two boxes represent the literal values on
either side of the field data.

Three operators require no values: Defined, Undefined,
and Unique.

The Defined operator specifies that a field must be
defined (in other words, it must have a value) before the
record can be entered or replaced. Attaching a Defined
criteria to a field makes a value in that field mandatory.

The Undefined operator specifies that a field must be undefined (in
other words, it cannot have a value) before a record can be entered
or replaced.

The Unique operator specifies that the value in the field must be
unique to that field in the current relation before the record can be
entered or replaced. This is especially useful when entering data into
a field (such as an ID code) that is the primary key of the relation.

7.1.5.2 Validation Using an Abacus
Much more sophisticated validations can be accomplished with the
calculation tiles in an Abacus than by using one of the predefined val-
idation tiles. Clicking on the abacus switch in the validation dialog
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box displays the list of available abacus icons. Selecting an abacus
tells Helix to use that abacus for data validation.

Notice that there is no text edit box for a Why message on the right.
When you select an abacus for validation, the message is provided
by the output of the abacus. Therefore, all you need to do to use an
abacus for field validation is to choose the abacus and close the vali-
dation dialog box.

For an abacus to be used for validation, the output of the abacus
must be a text data type. In fact, only those abaci that result in a text
data type appear in the scrollable selection list when you select the
abacus switch at the top of the scrollable list. If the output of a vali-
dation abacus is defined (in other words, the calculation results in a
Why? message), then Helix considers the field data invalid and the
defined output is available in the Why? dialog. If the output of the
abacus is undefined (in other words, no message), then Helix consid-
ers the field data valid and permits data entry.

A validation abacus typically is constructed using the If-Then-Else
tile. The first hole contains the result of some sort of comparison.
One of the other two holes contains the text of the Why message.
The other hole is left undefined. The comparison must be con-
structed so that if the result is false, Helix chooses the hole contain-
ing the message. If the comparison is true, Helix must choose the
undefined hole.
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In the example above, the calculation reads “If {{{“Product”} = {Eggs}}
and {{“Quantity”} is less than {12}}} Then {message} Else {unde-
fined}.” The message contained in the second hole of the If-Then-Else
tile reads:

This calculation evaluates the entries in two fields to determine if the
quantity entered can be accepted.

The full power of the calculation tiles is available for validation. See
Chapter 10 for more information.

7.1.5.3 Document Field Validation & Duplicate Suppression
Document fields cannot be validated directly; the Validation button is
dimmed. However, the document tiles discussed in section 10.8 can
be used to validate a document. To do so, you attach an abacus vali-
dation (see section 7.1.5.2) that tests the values of acceptable docu-
ment tiles to any non-document field. The type of validations that can
be enforced through this type of indirect validation include the fol-
lowing.

• that the document field is defined

• that the document name/pathname is not a duplicate

• that the document is a certain type (for example, only a Microsoft 
Word document)
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For example, the Unique tile can be used to prevent the entry of a
duplicate document name. If a document with the same name
already exists in the database, the Unique tile returns false and a
message can be displayed informing the user.

Place the Doc Name abacus and the Document Name field on the
form and select the abacus shown above as the validation for the
Document Name field. When this validation is used, a record with the
duplicate document name cannot be entered.

7.1.5.4 Validation Menu Option
A form displayed on a view can be set to shade data rectangle areas
containing invalid data with the Shade Invalid Fields command.

When you tab or click out of an invalid field while entering or chang-
ing data using a form, it will normally be shaded. This shading is dif-
ferent from the shading seen with defaulted fields. (See section
4.6.21, Shade Invalid Fields, for more information.)

7.1.5.5 Validation Notes
Validation for a field can be eliminated by deselecting the validation
tile or abacus. To do so, click below the last item in the list or select
an item and then drag the mouse out of the list area.

Validation for a field can be changed or added at any time.

When a user enters a new record, Helix performs a validation check
on every field in the relation that has a validation criteria, even
though a given field may not appear on the form that is being used to
enter the record. The only exception to this is if the field is inert; val-
idation is only applied to an inert field when it is visible on a form.
(See section 5.1.1.4 for an explanation of inert fields.)

You can specify criteria that invalidate existing data. If the validation
criteria of a field are changed, existing data that do not meet the new
specifications are displayed in a shaded field. These invalid records
can be viewed without triggering any beeps or validation lockouts as
long as no changes are made to the invalid fields. A change made to a
shaded field, however, must conform to the current validation speci-
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fications. If it does not, Helix will not allow the changes. The original
value will remain unchanged.

When using Replace to modify a record, validation is performed only
on the modified field(s).

Validation is not performed on posted fields. (See section 8.3.8.)

7.1.6 Keyword Option

Text (but not styled text) fields can be designated as keyword fields
by selecting the keyword check box. A field designated as keyword
can be searched for a specific word. In this context, word is defined
as a character string with a space or new line character at the begin-
ning and a space, period, comma, carriage return, or tab at the end.
The word can contain any ASCII character.

A keyword field is commonly used to contain long text, such as a
description. When you designate a field as a keyword field, Helix
builds an index on almost every word in the field. The result is very
fast searches on the content of the field.

Tip: Be judicious in your use of keyword fields. Although
they do support fast searches on the contents of text fields,
there is also significant overhead in using keyword fields.
Whenever a keyword field is modified, Helix must reindex
the field. The index also takes up more space in the collec-
tion than any other type of index.

Helix maintains a set of 31 words that it automatically ignores when
indexing and searching a keyword field. These are common words
such as the, a, an, he, she, it, past and present conjugations of “to be,”
and so on. You can edit this list.

7.1.6.1 Editing Keywords
When you check the Keyword check box in a field window, Helix acti-
vates the Edit Keyword button. This button displays the dialog box
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that allows you to edit the words to be ignored when indexing and
searching a keyword field.

To add a word to the list, type the word to be added in the text box at
the top of the dialog box. Click the Add button to add it to the list.

To remove a word from the list, select the word in the word list. Click
the Remove button to delete it from the list.

Click the Revert button to return the word list to its state when the
dialog was opened. Using Revert does not close the dialog box.

The default list of words to ignore is as follows:

Helix also ignores some single characters. These include carriage
return, tab, ! :, ‘, >. (For a list of characters, see Appendix A.) These
characters cannot be removed from the ignore list using the proce-
dures described above, but instead must be removed using a ResEdit
template that can be obtained from Helix Technical Support.

Editing the words or characters to be ignored causes all of the back-
ground keyword structures to be rebuilt. This process can take some
time if large amounts of data already exist in keyword field.

A Have She An He That

And His The Are I They

As In This Be Is To

But It Was By Not We

For Of With From On Had Or

①

① The field to which the ignore list applies

②

②  The list of words to be ignored

③

③ Text box for typing additions to the list
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Two calculation tiles are available for use specifically with keyword
fields. The Word Starts with and Word Equals tiles accept only key-
word field icons in the first hole. Either a constant or text can be
placed in the second hole. These tiles are primarily used to form aba-
cus queries.

A Keyword field is a text field with additional attributes, and can
therefore be used in any calculation tile that accepts text. When using
a keyword field in tiles other than Word Starts with or Word Equals,
you must build appropriate indexes for optimization.

7.1.7 Inert Option

The field icon window has an option called Inert. Selecting the check
box at the bottom of the Options column designates a field as inert.
An inert field allows the input of data, but does not store that data.

A collection developer typically uses inert fields to make data avail-
able for various data manipulation operations, including calculations,
queries, subforms, and posting—anywhere a value is needed to trig-
ger an operation, but does not need to be stored (or at least not
stored in the same relation in which the form resides). The inert field
can be thought of as a temporary holding pen for data that are never
saved. Like a variable in a programming language, an inert field never
holds more than one value at a time.

Note: If you are a programmer, then you may want to think
of inert fields as transient variables. They are in contrast
to fields that contain persistent data, data that are stored
in the database.

An inert field does not represent a column in a relation. When you tab
out of an inert field on a form, the field value becomes usable by vari-
ous Helix tools but is not stored anywhere.

A summary operation (for example, total, average, etc.) cannot be
performed on an inert field.

An index cannot be built on an inert field.

A Lookup Tile can use the value typed into an inert field to trigger a
search for data. However, a Lookup Tile cannot target (lookup) an
inert field since there is no stored data to lookup. Therefore, an inert
field can only appear in the third hole of a Lookup tile (or any four
hole Sub tile).
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Any number of abacus calculations can simultaneously use the value
in an inert field.

An inert field can be used in conjunction with posting.

Validation for an inert field is only applied when the inert field
appears on a view.

Inert fields are not included on the template when you create a quick
form. (See sections 8.1.2 and 8.2.1.)
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7.2 Index
Invoked by: dragging an index icon from its icon well into a relation
window’s work area

Uses of: Index sets the ordering of data for display purposes and
facilitates the rapid retrieval of records. Although building and main-
taining indexes requires time during data entry and index storage
makes a collection slightly larger, the difference in query perfor-
mance is usually worth the overhead.

7.2.1 Components of the Index Window

An index stores an ordered list of the data values in one or more
fields and/or abaci, known as an index key. The key is a duplicate of
the data stored in a relation. Therefore, any actions you take with an
index key do not affect data stored in the relation.

An index window provides lists of fields and abaci that can be used as
index keys and specifications for the order of key fields.

The switches at the top left of the index window change the selection
list between field icon names and abacus icon names. The field icon
switch is selected in the illustration.

The icon selection list contains a scrollable list of the names of all
icons in the relation that can be used in an index.

①

① Field switch

②

② Abacus switch

③

③ Selection list

④

④ Black hole

⑤

⑤ Ordering arrow

⑥

⑥ Insertion bar
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The trash can lets you take icons from the index definition list and
throw them away, removing them from the index key. 

The black hole at the right of the dialog box represents the first field
or abacus in the index key. Dragging an icon into this square causes it
to turn white, indicating acceptance of the icon. 

When the hole turns white, release the mouse button to complete the
operation. When an icon is placed into the hole, a new hole appears
below it, providing space to enter a secondary field or abacus into
the index key.

The black icon insertion bar above each hole lets you insert an icon
between two icons already in the list. To make the insertion, drag an
icon from the selection list onto the insertion bar. When the insertion
bar turns white, release the mouse button. Helix RADE creates a new
black hole to accommodate the additional icon.

The ordering arrow indicates whether the key values will be sorted
in ascending or descending order. When the arrow is up, sorting is
ascending; when the arrow is down, sorting is descending. To change
the order, click the arrow.

Ascending ordering provides the following sort orders.

• text data: alphabetical from A to Z. Helix is not case sensitive and 
therefore ignores the differences between upper and lowercase 
letters.

• number data: numerical order from low to high
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• date and time data: chronological order from earliest to latest

• flag data: false precedes true

Descending order reverses each of the above sort orders.

As many as 128 icons can be used in an index key. As each icon is
inserted, Helix creates a new black hole.

When you close an index window, Helix RADE builds the index
according to your specifications. These specifications can be
changed at any time, but the index will need to be rebuilt each time
they are changed.

7.2.2 User Definable Sorts

The Sort Order command allows Custom Mode users to change the
index on a list form. The command is available only in Custom Menus
and sequences. It is enabled only if the current form is a list and the
collection designer has specified it as enabled for the form.

7.2.2.1 Enabling Sort Order
When the form is in show setup mode, the collection designer speci-
fies the indexes from which the user can choose in Custom Mode.
Checking an index in the selection list makes it available for the user
in the Sort Order dialog box.

The entry at the top of the list under the index icon is labeled No
Index. If the collection designer checks this entry, the user can dese-
lect the current index without being forced to choose another index. 

If an index is checked but is unusable (for example, it needs to be
rebuilt) it will be grayed out in the index selection list and will not

①

① Default index

②

② Index selection list
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appear in the Sort Order dialog box. When the index does become
usable again, it will no longer be grayed out and will appear in the
Sort Order dialog box. 

The default index is always the last index the collection designer
chose from the form’s show setup view. An arrowhead to the right of
the index name indicates the default index. A user can select the
default index by clicking on the Default button in the Sort Order dia-
log box.

7.2.2.2 Using Custom Indexes
When a user chooses Sort Order from a custom menu, Helix opens a
dialog box containing a selection list of indexes chosen for the form.
The Index currently selected for the form, if any, is highlighted.

The user chooses the index (the sort order) that he or she wants to
apply to the current form by selecting an index from the selection
list. 

The button labeled Default at the bottom left of the dialog resets the
index selection to whatever the collection designer originally speci-
fied. 

When the user closes the dialog box, Helix redraws the list form
using the new index to order the records.

7.2.3 Placing More than One Icon into the Index List

The first field or abacus placed in an index icon determines the out-
ermost sort order for the index keys. In the example given in the pre-
vious section, the Author field is the first in the list. Therefore, an
index will be built on all entries stored in the Author field.

Additional icons refine the definition of the index. For instance, what
if there were five records with the same author? In what order would
should they be displayed?
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The field or abacus that follows Author in the index key specifies how
records should be sorted whenever the values in the Author field are
the same. If you place the Book Title field under Author and two or
more records contain exactly the same author’s name, Helix RADE
goes to the next entry in the index key (Book Title) and displays the
records for that author alphabetically by title.

If you are preparing labels for a bulk mailing, you might want the
labels in zip code order first and then alphabetically by last name
within each zip code. To do this, create an index that has a zip code
field as the first part of the index key and a last name field as the sec-
ond.

Only one index is built for each index icon, but up to 128 field or aba-
cus icons can be inserted into a single index.

In the case of the Author and Book Title example, since Author is first
on the list, this field is the only one that Helix considers to have an
index. Any further icons inserted into this same list are merely addi-
tional specifications for the Author Index. Therefore, the Book Title
field is not indexed. Although this distinction may seem trivial, it is
important when deciding which indexes to create for query optimiza-
tion. 

If Helix RADE thinks that an index will help speed up the display of
data on a form, it will beep and place its suggestion in the Why mes-
sage box. When making such an index, be sure to place the suggested
field or abacus in the first position in the index key.

7.2.4 Fragile Indexes

Some of the indexes built by Helix RADE are fragile; that is, they can
be invalidated for a variety of reasons. In particular, indexes that are
built on an abacus using a Lookup tile in the calculation can be easily
invalidated.

If an index is invalidated, the index icon will still appear in the rela-
tion window, and it will contain one or more field or abacus icons, but
the data are no longer being ordered by this index and it cannot be
used until it is rebuilt.

The simple way to rebuild an index is to open it, click once on the
first arrow to reverse its direction, click it again to set it back the way
it originally was, and then close the index. 
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Tip: In the case of large index rebuilds, it’s a good idea to
save the collection immediately after finishing rebuilding
the index.

7.2.5 Invalid Indexes

Helix RADE automatically invalidates an index for any of the follow-
ing reasons.

• Index building was stopped using the Command-period key com-
bination.

• The index was built using a field icon that subsequently had its 
field type changed. Since changing the data type of a field into 
which data has already been entered will cause all entered data to 
be erased, any index built on that data will be invalidated.

• The index was built using an abacus icon and the calculation was 
later changed. If an abacus icon is used in an index, changing the 
calculation contained in the abacus invalidates the index. Even 
opening and closing a black hole in a tile in the calculation is suffi-
cient to invalidate an index if you close the black hole with the OK 
button instead of the Cancel button.

• An index is built on an abacus that uses a Lookup tile and the data 
set in the target relation is subsequently altered. In general, it is 
not a good practice to build an index on a calculation that con-
tains a Lookup Tile unless the data in the target relation are 
changed infrequently.

Invalidated indexes are rebuilt automatically when you open a form
for which the index is selected, when you open a collection, or when
you close a collection. A thermometer appears to chart the rebuild-
ing progress. All invalid indexes in a relation are rebuilt at the same
time.

7.2.6 Index Notes

The following notes and tips can make your use of indexes more
effective.

• Data can be sorted in ascending or descending order. An index 
can contain some fields and/or abaci in ascending order and oth-
ers in descending order.

• Selecting an index is useful for displaying information in a particu-
lar order. However, if a given index is to be used to determine the 
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order of data on a view, it must be selected from the index selec-
tion list in the form setup view window.

• An index can be built on a field and/or an abacus. There is one 
major exception; abacus icons that contain a calculation using a 
Summary or Form tile cannot be used in an index key.

• Indexing a field can improve searches. The index does not have to 
be selected anywhere to be useful in this way.

• Helix RADE will suggest by beeping and providing a Why message 
that you build an index on a particular field or abacus if doing so 
will speed up operations.

• Certain calculations can be sped by indexes. These include the 
Lookup, Minimum and Maximum, and anything in a For hole of a 
tile. See the discussion of specific tiles in Chapter 10 for details on 
these calculations.

• An Index must be built on the linking field on a subform.

• The icon that tops the list of icons in an index is the only one that 
Helix RADE considers to be indexed. All of the following icons 
within an index merely refine the definition of the index of the field 
or abacus in the first black hole.

• For maximum efficiency, do not put more icons into the index list 
than necessary. Up to 128 can be inserted in any one list, but two 
or three are enough for most uses. Think about how many levels 
of information you will need sorted. Additional icons merely serve 
to break ties in cases where all of the previous fields contain the 
same data.

• Each field that is indexed adds to the time needed to perform an 
enter, add, delete, or replace command. Helix RADE is adding to or 
correcting all affected Indexes each time a user performs one of 
these actions. Indexes also affect the speed of load operations.

• Since indexes take up disk space and tend to slow down data 
entry, build indexes only on fields that really need them. Some 
types of data do not lend themselves to indexing. An example 
would be a Comments field, which is better served (if it must be 
searched) by making it a keyword field.

• When a user enters a record that contains an indexed field, Helix 
updates the index to accommodate the new data. This costs a lit-
tle time for each index involved. The alternative is to wait until the 
field needs to be indexed and then build the index.

• An index can be built on a field at any time before, during, or after 
data entry. The more records already entered, the longer the 
index takes to build.
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• Index building can be cancelled by pressing Command-period. 
This returns control of the program to you, but the index that was 
being built is lost and cannot be used. The definition of the index 
remains, however, and the index can be rebuilt later by opening 
and closing its icon.

• All usable indexes appear by name in the form setup view win-
dow. Clicking an index name causes data displayed on the form to 
be displayed in the order specified by that index.

• No Index need be selected for entering information. A selected 
Index does not affect data entry in any way. Indexes only affect 
data display.

• An index can be thrown away at any time if it is not in use on a 
view. Throwing away an index does not affect the data entered 
and may free disk space within the collection. An index can be 
discarded by dragging it into the relation window trash can. If the 
index is referenced somewhere, it cannot be discarded and will 
snap back to its original location.

• An index can speed up a query when the first field or abacus in 
the index key is the field or abacus being queried.
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7.3 Abacus
Invoked by: dragging an abacus icon from an icon well into the work
area of a relation window

Uses of: construct calculations to be performed on data stored in the
database

Note: Because Helix’s capabilities have been enhanced so
significantly since the product first appeared, the term cal-
culation is no longer truly descriptive of the possible oper-
ations of an abacus. An abacus represents a procedure
that manipulates data in some way; it is in no way
restricted to arithmetic calculations. 

To construct an abacus calculation, you open an abacus icon. The
abacus window contains calculation tiles, each of which represents
some operation to be performed on data. The tiles include mathemat-
ical operations, logical comparisons, text manipulations, data and
time manipulations, data type conversions, decision making, and so
on. You can use these tiles to construct complex procedures without
having to worry about the proper use of symbols and punctuation
(the syntax).

Abaci can be used in many ways:

• on a template to prepare data for display.

• to provide criteria that restrict the data that will appear on a view.

• as the basis for an index.

• as part of another abacus calculation.

• to provide criteria for data validation.

• to provide source values in posting.
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7.3.1 Components of the Abacus Window

The abacus window contains a selection list controlled by switches,
and a work area.

The contents of the selection list represent the items that can be
dragged into the work area.

• calculation tile switch: The calculation tiles switch displays a list 
of all calculation tiles. To begin construction of an abacus, you 
drag a tile into the work area.

You can scroll the selection list to display additional tiles. You can
also select a specific tile by typing the first letter or letters of a tile
name. For example, if you type loo, the selection list scrolls to the
Lookup tile. Pressing the Tab key then selects the next tile that
begins with loo. 

In the preceding example, typing loo selects the Lookup tile; pressing
Tab then selected the Lookup Summary tile. Typing - (a hyphen) first
selects the minus tile (a - b); pressing the Tab key then selects the
negation tile (-a). 

Some tile names do not begin with a character you can type from the
keyboard and therefore require key combinations. To select the Dis-
play tile, press Option-space. To select a delta tile, type Option-J.

①

① Work area

②

② Abacus switch

③

③ Field switch

④

④ Calculation tile switch

⑤

⑤ Selection list
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• field switch: The field switch displays a list of the names of all the 
fields in the relation. You drag a field from the selection list to a 
black hole in a calculation tile.

• abacus switch: The abacus switch displays a list of all abacus 
icons in the relation. Abaci can also be dragged from the list and 
inserted into black holes.

The name of an abacus icon will not appear on the list in an abacus
window (or the index or view windows) if:

a. it does not contain a valid calculation. There are cases, how-
ever, where an abacus icon will be displayed even though it 
contains empty black holes.

b. it is the abacus on which you are currently working.
c. it uses the current calculation. This prevents the formation of 

a circular calculation (one that uses itself).

Use the Format button to specify the display format of the result of a
calculation. Its operation is the same as the formatting capabilities
within a field icon. The button becomes active as soon as Helix RADE
knows the resulting data type of the calculation. When you have fin-
ished constructing the calculation, click on the Format button to
access the Format dialog box.

Note: Text, Styled Text, Picture, and Document type data
do not have display Format options.

Use the trash can in the abacus window to discard unwanted calcula-
tion tiles, field icons, and/or abacus icons. You can select any number
of items and drag them to the wastebasket at the same time. If a tile
contains icons in its black holes, the icons will move along with the
tile into the trash can.

Tip: To throw away a tile, point to a portion of the tile that
is outside the black holes. If you click on a black hole and
try to drag the tile, nothing will happen.

Discarding a field from the abacus window does not affect the data
stored in the field. The trash can only discards the image of the icon
in this window and in no way affects the original icon in the relation
window.
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7.3.2 Constructing a Calculation

The real power of the calculation tiles comes when you combine
them to perform the specific data manipulation required by the
application you are creating.

Tip: The abacus window can be resized to allow more vis-
ible working area for the calculation by dragging the grow
box in the lower right corner of the window border. Click-
ing the zoom box (in the upper right corner) sizes the
window so that all of the tiles in the work area are visible,
unless the construction is too large to be displayed on
your monitor.

7.3.2.1 Bringing Tiles into the Abacus Window
To create a calculation in the abacus window, select the desired tile,
and drag it into the window.

An outline of the tile follows the mouse pointer as your drag.

7.3.2.2 Calculation Tile Components
A calculation tile has three components.

①

① Black hole

②

② Operator

③

③ Arrow
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Black holes receive information, either from a field, an abacus, the
arrow of another tile, or by direct input.

The operator indicates the action the tile performs.

A tile’s arrow represents the result of the operation performed by the
tile. 

7.3.2.3 Moving and Linking Tiles
To select and move a tile, click on the body of the tile anywhere out-
side of the black holes and drag the tile to its new location. An outline
of the tile follows the mouse pointer as you drag.

If you select just the tile body, the arrow segments remain where they
are as you drag the body and are redrawn to reach the new location
of the tile.

To move the arrow segments along with the tile, you must select each
before moving the tile. To select the entire tile, Shift-click on each
part of the tile or drag around the entire tile with the mouse pointer.

Arrow segments are redrawn to accommodate the new location of
any part that has been moved.

There are two benefits to being able to reposition a tile’s arrow sepa-
rately from the tile body.

• Two tiles can be connected by placing the arrow tip of one tile 
into a black hole of another tile.

• The tiles and their arrow components can be rearranged to 
achieve a cleaner, more understandable layout.

To connect two tiles, drag the arrow tip of one tile until it is approxi-
mately in the center of a black hole in the destination tile. When the
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destination black hole turns from black to white, the operation has
been accepted. The two tiles are now connected.

In the preceding illustration, two values can be multiplied using the
top tile. The result of the multiplication is then added to a third value
in the lower tile. The remaining black holes in the two tiles might
contain numbers that you type in, the arrows from other tiles, or field
or abacus icons.

If you hear a beep when you are attempting to connect tiles and the
black hole remains black, Helix cannot connect the tiles, typically
because what you are attempting to place in the hole is of the wrong
data type. 

If the black hole remains black and there was no error beep, reposi-
tion the arrow in the hole and try again. If the hole remains black,
Helix RADE thinks there is nothing in it, regardless of how it may look
to you.

If you attempt to connect two tiles that cannot be legally joined, the
arrow tip you tried to place in the black hole may end up located
behind the black hole and its tile. This means that the connection
was not allowed. You may have to move the tile in front out of the
way to grab the arrow again.

A calculation will not work if there is more than one unconnected
arrow anywhere in the window. Only the arrow of the last tile in the
abacus (the arrow that represents the result of the calculation) can
be unconnected. The arrows of all other tiles must be inserted into
black holes. There are no exceptions. If you create tiles that end up
not being used in the calculation, throw them into the trash can.

7.3.2.4 Black Hole Input
The black holes of most tiles accept either field icons or abacus
icons. This means that one calculation can be nested within another,
allowing the creation of basic calculations that can be used in any
number of other calculations.
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To access a particular icon, select the desired list of icons by clicking
on the appropriate switch at the top of the selection list. Then, drag
the name of the field or abacus from the selection list to the destina-
tion black hole.

If the tile does not accept the icon, you hear a beep and the tile hole
remains black. This happens when the data type of the icon is not
compatible with the calculation tile.

Some tiles (Total, *, and /, for example) accept only numbers or inte-
gers. Some tiles (Followed By, Contains, Starts With) accept only text
or styled text. Some tiles (=, <, >) accept any one of several data types
in one hole, but then only accept the same data type in the second.
For details on specific tiles, see Chapter 10.

Note: Helix RADE continuously checks the data types of
calculations throughout the entire collection. The data
type of the result of a calculation may change, depending
on what icons are inserted or what is typed into the tile’s
black holes. This error checking may also cause the aba-
cus icon to “pop out” of places where it is currently used
(such as templates and indexes) when a change to the
abacus makes the data type of the result incompatible
with that current use.

Black holes can also be opened by double clicking to reveal a dialog
box that accepts literal values. Depending on the tile and the calcula-
tion, this information may be:

• a number or integer.

• a text entry.

• a date.

• a flag value (yes/no; y/n; 1/0; true/false; t/f).
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Whatever the data type, the value that is typed into this dialog box
becomes a constant in the calculation.

If the tile works only with numbers or integers, the text data types
are dimmed. In many cases, the data type selection is limited to one
or two choices, based on the acceptable data types for the black
hole.

After typing the desired constant in the box, click the OK button.
Helix RADE then checks the data type of the entry. If it is not valid, a
message will appear at the bottom of the box telling you that some-
thing is wrong and that you must make a correction.

Tip: If you change your mind and no longer want to use a
literal value in a black hole or if you want to escape from
a situation where Helix is not accepting what you enter,
remove the value from the dialog box before closing it. 

When closed, the black hole displays at least a portion of
what was entered in the dialog box. Since the hole can
only show a few characters, the display may be clipped. If
there is more information than is showing in the hole,

three dots appear below the entry.

The entry in the right hole in the preceding illustration is $30,000.
Notice the three dots in the window that indicate that some of the
entry is not visible.

Some tiles, such as the Lookup tile, display a dialog of selection lists
when double clicked.

A complete list of the tiles, their functions, acceptable data types,
and the data type that results from the use of a tile, plus some exam-
ples of various calculations, can be found in Chapter 10.
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7.3.3 Printing and the Abacus Window

There are two commands for printing a calculation constructed in the
abacus window.

The first command is Print Scaled, which reduces the calculation in
size so that it fits on one standard page of paper.

For more information on Print Scaled, see sections 13.2 and 4.2.13.

The second print command is Print Paged, which prints the calcula-
tion full size, but divided into sections, if necessary, with each section
printed on additional pages. These individual sheets can then be
mounted next to each other to display the whole calculation.

Some printers, such as PostScript laser printers and ImageWriters (in
draft mode) will not print all of the graphic elements of the abacus
window. The only way to get a complete printout of an abacus on a
PostScript printer is to take a screen shot.
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Data 
Manipulation: 
Templates, 
Views, and 
Posting
Templates and views provide the end user’s interface 
to a Helix application. This chapter discusses creating 
templates for both data entry and listings as well as 
configuring the display of those templates on views. In 
addition, this chapter covers using posting to modify 
data not visible to the user.
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8.1 Template
Invoked by: dragging an icon from its icon well into the work area of
a relation window

Uses of: design forms to enter and display data

The template window is a design tool; its basic component is the rect-
angle. By drawing rectangles that contain text, pictures, or icons, you
can create a template that has the look and function you need. The
completed template can then be referenced from within another icon
(view, form query, or another template), where it serves as a blue-
print that provides all the information needed for a view window to
display a non-listing or listing form, for a template query window to
display a query form, or for another template to use it as a subform.

8.1.1 Components of the Template Window

The template window is divided into two parts, the palette on the left
side that contains everything used to design the form, and the work
area on the right where the actual design is created.

There are six tools at the top of the palette. The first tool (at the far
left), the Selection tool, is used to select areas of the template for var-
ious operations. It is used, for example, when selecting multiple rect-
angles. (See section 8.1.3.3.)

①

① Work area

②

② Selection list

③

③ Icon switches

④

④ Tools
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Use the five rectangle drawing tools to select the type of rectangle
(data, border, repeat, label, and command) to be drawn in the work
area. Click on a rectangle tool to select it; the selected tool remains
selected until you choose another tool.

The icon switches display selection lists of the icons available for use
in the construction of the template.

The abacus icon switch lists the names of all abaci defined in the
relation. The field icon switch lists the names of all fields in the rela-
tion. The template icon switch displays the names of all subform
templates in the collection. The sequence icon switch shows the
names of all sequence icons in the collection.

Templates can be modified when a view is open, but changes are not
seen on the view until you save the template. The template indicator
turns black if the template has been modified but not saved.

When you save the template by choosing Icon->Save or closing the
template window, the indicator is no longer inverted and all views
using the template reflect the change.

8.1.2 Quick Templates

Two commands on the Icon menu, Quick Entry and Quick List,
instruct Helix RADE to construct templates automatically. To use this
feature, click on each field icon in the relation window in the order
you want them to appear on the form. Then open a new template (or
one with a blank work area) and select one of the two Quick com-
mands. The popup menus for Quick Entry and Quick List let you
choose either custom names or icon names for display in label rect-
angles.

Helix RADE then constructs the template using all the non-inert fields
in the relation. After the template is done, rectangles can be added,
resized, moved, and so on, just like a template that has been con-
structed by hand.

Template modified indicator
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When you use Quick Entry or Quick List on a template, all flag fields
are displayed as text, even though their formats may be set to radio
button or check box.

Note: These two commands are similar to the automatic
form generation feature found in the view window (see
section 8.2.1), except that Quick Entry and Quick List con-
struct a template that can be modified. Selecting one of the
automatic forms in a view window produces a similar
form, but without a template that can be modified. 

8.1.3 Rectangles

Rectangles are Helix RADE’s visual design tool. There are five types of
rectangles, label, data, border, repeat, and command. In most cases,
you draw a rectangle in the template work area and then place some-
thing inside it. The type of rectangle determines what you can put in
the rectangle and what happens to whatever is placed inside the rect-
angle. The size and position of the rectangle determine where this
action takes place on the form.

8.1.3.1 Rectangle Components
All rectangles are drawn, selected, moved, opened, and resized in the
same way.

• The text insertion point appears in a selected command or label 
rectangle to mark the location where characters can be typed into 
the selected rectangle. Depending on the alignment set with the 
Style menu options (see section 4.10.4), the cursor appears in the 
upper left, top center, or upper right of the rectangle.

• The shaded drag bar appears when you select a rectangle. The 
cursor changes to an arrow when the mouse pointer is over the 

①

① Text insertion point

②

② Drag bar

③

③ Rectangle outline

④

④ Resize handle
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drag bar. If you then press and hold the mouse button, the drag 
bar turns black and you can move the rectangle and its contents. 
However, if a border or repeat rectangle is moved, any rectangles 
within them do not also move.

Tip: If you find grabbing the drag bar with the cursor diffi-
cult, go the √ menu and turn off the Grid option. This will
allow complete freedom of cursor movement, making it
easier to grab the drag bar. You can also move a rectangle
using the keyboard. (See section 8.1.3.3.)

• The rectangle outline defines the visible limits of whatever is con-
tained inside the rectangle. If the outline appears solid, the out-
line will be visible on a form that uses this template design. If the 
outline appears dotted, it will not be visible. (See the discussion 
of Frame Rectangle in section 8.1.3.4.)

Note: An exception to the preceding involves data rectan-
gles drawn on a template that is used for a query form.
When a query form is displayed, data rectangles always
have a solid border with rounded corners, independent of
whether they have solid outlines on the template.

• When you select a rectangle, a small resize handle appears in its 
lower right corner. By carefully positioning the cursor on this 
area, you can drag the corner of the handle to resize the rectan-
gle. The rectangle can also be resized using the keyboard. (See 
section 8.1.3.3.)
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8.1.3.2 Creating Rectangles

To draw a rectangle:

1. Select the rectangle type by clicking the appropriate rectangle 
tool on the palette. 

2. Move the mouse pointer into the work area. The cursor changes 
to a crosshair (+). 

3. Click to place the upper left corner of the rectangle.

4. Then drag to draw the rectangle in the template window.

When you release the mouse button, Helix draws the rectangle. It is
also selected.

With the exception of background rectangles (see section 8.1.3.4), no
two rectangles may overlap. This means that one rectangle may not
cut through the edge of another; some types of rectangles, however,
may surround others. If an attempt is made to draw a rectangle that

①

① Label rectangle tool selected

②

② Crosshair cursor ready for drawing
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cuts through another rectangle, no new rectangle will appear. (In
addition, the rectangle that was drawn over will be selected.)

A rectangle must be at least as high and wide as the largest character
in the font and font size selected for it. For example, a rectangle that
is to contain a 72 point font must be at least 12 grid marks high and
11 wide. If the rectangle is smaller than this minimum size it will dis-
appear as soon as it is drawn.

8.1.3.3 Selecting, Moving, and Sizing Rectangles
You can select more than one rectangle at a time. This is useful when
you would like to move a group of rectangles or change the attributes
of several rectangles at once.

You use the Selection tool to select multiple rectangles. Drawing
tools cannot be used to select multiple rectangles. Drag the Selection
tool to draw a dashed selection rectangle on the template; all rectan-
gles lying partly or fully inside this rectangle are selected.

Tip: If you want to select most of the rectangles on your
template, use the Select All menu command and then
Shift-click to deselect the rectangles that you do not want
included.

Tip: Selecting a repeat or border rectangle does not select
the rectangles within it unless you press the Option key
when selecting the rectangle.

When multiple rectangles are selected, their size boxes are not
enabled.

When the selection tool is active, clicking a rectangle selects or dese-
lects it, per Macintosh selection rules. This includes the use of the
Shift key to add or remove items from a multi-item selection. The
rectangles can be disjoint (non-adjacent) and of different types.

Once selected, a group of rectangles can be dragged. To drag a group
of selected rectangles, place the cursor on the drag bar of one of the
selected rectangles, hold down the mouse button, and move the
mouse. An outline of the group of rectangles is drawn as you move.
When the group is where you want it, release the mouse button.

Clicking outside the selected group will deselect all of the rectangles
simultaneously.
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You can also move selected rectangle(s) by holding down Command
and pressing an arrow key. If the Grid setting is off, the selected
object or objects move in 1 pixel increments; if the Grid setting is on,
selected object or objects move in 8 pixel increments.

You cannot move a rectangle or a group of rectangles over any other
rectangles. If you move rectangles to a place they cannot go, they
zoom back to their original locations.

Tip: Press the Control key to temporarily reverse the Grid
setting. Press the Shift key to snap the upper left corner of
the rectangle to the nearest gridmark.

Note: If you snap a group of selected rectangles to the grid,
only the first rectangle selected may be on a grid mark:
Helix preserves the relative distances between rectangles.

The contents of a repeat or border rectangle are moved only if
selected.

To resize a rectangle, drag the resize handle or press Com-
mand-Option and an arrow key. If the Grid setting is off, the rectangle
size changes in 1 pixel increments; if the Grid setting is on, the rectan-
gle size changes in 8 pixel increments.

Tip: Press the Control key to temporarily reverse the Grid
setting. Press the Shift key to snap the lower right corner of
the rectangle to the nearest gridmark.

8.1.3.4 Setting Rectangle Attributes
Various attributes can be assigned to a rectangle while it is selected.
If an attribute is not applicable to a particular type of rectangle, the
command that sets that attribute is dimmed when a rectangle of that
type (or the rectangle tool for that type) is selected.

When rectangles of different types are selected, the various √, Font,
and Style menu options are enabled for the rectangles of the type to
which they apply. For example, if a label and a border rectangle are
selected, the Font menu information refers to the label rectangle.

If a group of selected rectangles has conflicting attributes, styles, or
fonts, no menu items are checked. In this case, choosing a menu item
performs that command, where legal, on all appropriate selected
rectangles. For example, if four label rectangles are selected, two in
the foreground layer and two in the background layer, the Back-
ground item on the √ menu is not checked. Choosing the Background
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command moves all four rectangles to the background; choosing it
again moves all four rectangles (or at least those that can be legally
moved) to the foreground layer. For more on the Background com-
mand and the background layer, see sections 4.6.9 and 8.1.7.3.

Each rectangle tool on the palette retains the attributes of the last
rectangle drawn or selected and applies those attributes to a newly
drawn rectangle. If you set an attribute while a rectangle tool (but no
rectangle) is selected, all new rectangles drawn with the tool will
have that attribute.

Attributes can also be set through rectangle dialog boxes that you
access by double clicking a rectangle. You can find examples of rect-
angle dialog boxes later in this section.

In addition to the five attributes discussed below, there are several
attributes that apply only to specific types of rectangles (P# is Page
#, Background Conditional Color, Allow Click, Allow Tab, Allow Edit,
Allow Quick Query, Scrolling, Word Wrap, Keep Value, Travel, Auto-
Close View, and Conditional Sequences). These attributes are dis-
cussed in the section on their associated rectangle.

The attributes that apply to most types of rectangles include the fol-
lowing.

• Framing: The Frame Rectangle command on the √ menu controls 
the appearance of the rectangle outline. If the command has a 
check mark beside it, the rectangles a have solid outline when 
drawn on the template and displays a solid line on a form. If the 
command is not checked, the rectangle outline is invisible on a 
view and appears as a dashed line on a template. Framing applies 
to all types of rectangles.

• Printable: When you choose the Printable command on the √ 
menu for a rectangle, the rectangle appears on the form when the 
form is printed. If Printable does not have a check mark next to it, 
the rectangle appears on the screen when you open the template 
or the a view using the template, but does not appear when you 
print a form using the template. Printable applies to data, label, 
and command rectangles. For more information on this com-
mand, see section 4.6.3.

• Font and Style: The Font menu contains all of the fonts that are 
installed in your System. A template can have any number of 
fonts.

Use the Style menu to set the style, size, and alignment of text for
each rectangle. As well as the standard Macintosh commands for
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style, size, and alignment, the Style menu also contains a Custom
Size command. Custom Size opens a dialog box into which you
enter a custom size from 1 to 127 points. If a custom size has been
defined for a rectangle, the size is displayed on the menu next to
the Custom Size command when the rectangle is selected. (See
also section 4.10.3.)

Font and Style options can be chosen for data, label, and com-
mand rectangles.

• Color: You can define a customized color palette for each collec-
tion using the Current Colors dialog (accessed using the Color 
Preferences command). These colors can be applied to a rectan-
gle’s background, frame, and text (and, for data rectangles, to 
radio buttons and check boxes) by opening the rectangle’s dialog 
box or by choosing the Set Rectangle Color command. 

Tip: To specify colors for the non-rectangle components of
a window, use the Set Window Color... command.

Scale Picture: Use Scale Picture when you paste a graphic into a data,
label, or command rectangle. If the graphic is not the same size and/
or proportion as the rectangle, Helix sizes it proportionately to fit.
For more details, see section 4.6.1.

8.1.3.5 Duplicating and Deleting Rectangles
The Duplicate command, available in the Icon menu, duplicates a sin-
gle rectangle or a group of rectangles. 

To duplicate a rectangle, select the rectangle(s) to be duplicated and
choose Icon->Duplicate or press Command-D) The cursor changes to
show an outline of the duplicate rectangle(s) that you can place on
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the template by moving the rectangle(s) to the desired location and
clicking. 

Duplicated rectangle(s) are empty. Any label or icon assigned in the
original rectangle(s) is not duplicated.

Tip: The Shift and Control key grid modifiers that apply to
moving rectangles also apply to placing duplicate rectan-
gles.

Since the template window does not have a trash can, you can delete
a rectangle by sizing it down to nothing or by pressing Com-
mand-Delete. Deleting label and data rectangles causes their con-
tents to disappear; closing a border or repeat rectangle does not
affect anything that the rectangle may have been drawn around.

8.1.4 Data Rectangles

Data rectangles display stored data, provide places for entering new
data, or display the results of a calculation.

To draw a data rectangle, select the data rectangle tool and draw the
rectangle in the template’s work area.

You must then place either a field icon or an abacus icon in the data
rectangle.The rectangle references the field or abacus icon, allowing
the entry or display of data.

Note: Sometimes both a field and an abacus are placed
inside a data rectangle. For more information, see section
8.1.4.2.

To place an icon inside a data rectangle, select either the field or aba-
cus icon switch on the palette to display a scrollable icon list. Then,
select the desired icon from the list, drag its outline into the work
area, and drop it inside a data rectangle.
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In the following example, the field icon switch has been clicked, dis-
playing the list of names of all the field icons that have been created
in the relation.

The collection developer then selects the Book Title icon and drags
its outline into the data rectangle.

When the collection developer releases the mouse button, Helix
places the Book Title icon in the rectangle.

Releasing the mouse button in an area where the icon cannot be
placed causes the outline to zoom back to the icon list.
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You can also place an abacus icon inside a data rectangle. However,
while field icons placed inside of a data rectangle allow both the
entry and display of data, an abacus icon alone in a data rectangle
can only display data.

When a field and an abacus occupy the same data rectangle, the
result of the abacus’s calculation appears in the field as a default
value for data entry. This value is then stored when the user stores a
record, unless the data are changed by the user.

The stored value does not change, even if the result of the calcula-
tion changes at a later time. This is called a calculation retained field.
For more information, see section 8.1.4.10.

To place an abacus icon in a data rectangle, click on the abacus
switch to display a list of abacus icons that can be placed inside of a
data rectangle. Then drag and drop an abacus icon into the data rect-
angle where you want the result of the abacus’s calculation to
appear.

Users can move from one data rectangle to another in a data entry
form by pressing the Tab key. The tab order (the order in which data
rectangles are visited for data entry) depends on the position of the
rectangles on the template. The normal sequence is top to bottom
and left to right. This can be altered using border rectangles. See sec-
tion 8.1.5 for a more detailed explanation.

The √ menu offers some aids to designing forms on the template.
These aids—notably the Grid command—can help align data rectan-
gles precisely for the proper tab order.

You can use the Trim command from the Edit menu to resize data
rectangles. Trim sizes rectangles to fit the Example shown in the Dis-
play and/or data Entry format dialogs. Helix takes the selected font
and size into account when the trimming a rectangle. The Trim com-
mand has no effect on data rectangles containing Picture data type.

Trim can be used for label and command rectangles when they con-
tain pictures. Helix sizes the rectangle so that the picture fits exactly.

Helix does not move the top left corner of a rectangle when resizing.
If a data, label, or command rectangle is too small, the Trim com-
mand enlarges it to the appropriate size.

When the data entry format of a field is Check box or Radio button,
Helix determines the width of the space occupied by the field by the
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width of the longest label used. The height depends on whether the
field is a check box, two radio buttons, or three radio buttons. 

The data rectangle for a field formatted as a check box or radio but-
tons initially must be drawn large enough to contain the label and the
check box or radio buttons. Such a data rectangle cannot be resized
larger by selecting Trim.

An icon cannot be selected and dragged out of a rectangle. If you
place the wrong icon in a rectangle, select the correct icon from the
icon list and drag it into the rectangle. The original icon disappears
and the new icon takes its place. Because a field icon and an abacus
icon can both be placed in the same rectangle, this method only
works as long as the unwanted icon is the same type as the correct
one. Other changes may be made by opening the rectangle dialog.
(See section 8.1.4.1.)

A field icon can not be placed directly more than once in the same
template, although it may be used within calculations that appear in
other rectangles. Should you attempt to place the same field icon
more than once on a template, Helix displays an error message dialog
box when you close the template. This dialog box lets you go back
and correct the problem or close the template window anyway.

Note: Although you can close an improperly constructed
template, you will not be able to use it on a view.

Every data rectangle on a template must contain a field and/or an
abacus icon before the template can be used.

A data rectangle cannot surround or contain another rectangle.

You cannot type in a data rectangle on the template window.

There is no fixed limit to the number of data rectangles that you can
draw on a template, although it is possible to create a template that
will generate an error message saying it is too complex.

8.1.4.1 Opening the Data Rectangle Dialog Box
You can make any of the settings that apply to data rectangles from
the data rectangle dialog box. This is often the easiest way to config-
ure a data rectangle.
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To open a data rectangle dialog box, double click on a data rectan-
gle’s gray bar on a template. You can also open it by clicking it once
to select it and selecting Icon->Open.

The data rectangle dialog opens and displays commands from the √,
Font, and Style menus, and lets you define both the contents and the
attributes of the data rectangle.

Note: The selected data rectangle at the top of the dialog
is just a picture and is not meant to reflect current rectan-
gle attributes.

Four attributes available for the data rectangle are found only in this
dialog box: conditional color, horizontal scroll bars, vertical scroll
bars, and word wrap.

8.1.4.2 Rectangle Contents
You can place a field and/or abacus icon into a data rectangle by
selecting its name from on of the two the icon selection lists at the
left of the data rectangle dialog box. As soon as you select an icon in
one list, the other list displays only icons of the same data type.

8.1.4.3 Text Formatting
You can use the center portion of the data rectangle dialog box to
change the attributes and font specifications that were set when a
data rectangle was created.

8.1.4.4 Color
Color can make a template more attractive. It can also make the tem-
plate easier to interpret when related elements have the same color.
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To add color to a data rectangle, click the Color button to open the
Rectangle Color dialog box.

The four scrollable lists display all of the colors that are defined in
the Current Colors dialog box.

Choose from the Text list to set the default color of the label rectan-
gle text. A data rectangle need not contain a styled text field or aba-
cus to display colored text.

Choose from the Background list to set the background color of the
rectangle. A data rectangle does not have to be a background rectan-
gle to have a background color.

Choose from the Frame list to set the color of the rectangle frame. If
the rectangle is unframed, this setting has no effect.

Choose from the Control list to set the color of any radio buttons or
check boxes that the rectangle contains.

8.1.4.5 Conditional Color and Style
The color settings in the Rectangle Color dialog box set data rectan-
gle color regardless of the value of data in the rectangle. You can,
however, base the colors on the result of an abacus. For example, you
might want a currency value to appear in black if it is a positive value
and in red if it is negative. This is what Helix calls Conditional Color.

Conditional color is triggered by the output of an abacus that returns
a flag value (true or false). Whenever the abacus returns true, Helix
uses the conditional color settings. When the abacus returns false,
Helix uses the color settings in the data rectangle dialog box, if there
are any.
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To configure conditional color, click the Conditional Color button to
open the conditional data rectangle dialog box.

The list on the left displays all abaci with flag output. Click on an aba-
cus name; then click the Add button. Helix will check the output of
the selected abacus to determine whether to use the conditional
style settings.

Finally, set the text, color, and style options to be used when the aba-
cus output is true.

Note: Conditional color specifications always take prece-
dence over the rectangle’s own style and color attributes,
and over the settings of styled text fields and abaci. If no
conditional styles and colors exist, Helix uses styled text
abaci and field settings; if the rectangle contains data of a
type other than styled text, Helix uses the rectangle set-
tings.

8.1.4.6 Selection Attributes
Typically, all data rectangles containing a field icon are accessible
and editable on a non-listing form. However, there are times when
you don’t want a data rectangle containing a field icon to be accessi-
ble or editable.

For example, you may want to prevent users from modifying a field
containing a calculated default before the calculated value is stored
in the database. Form permissions set on custom menus (see section
6.4.5) allow you to make an entire form read only, but do not provide
protection for specific fields while allowing changes in others. Alter-
natively, the designer may wish to allow users to enter data into a
field but not be able to perform a quick query on that field.
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The selection attributes (Allow Click, Allow Tab, Allow Edit, and
Allow Query) set the precise actions that can be performed on any
given data rectangle.

Tip: Keep in mind that the selection attributes only apply
to a particular data rectangle and its contents on a particu-
lar form. The field icon itself is not affected by these
attributes; therefore, a field may have attributes on one
form that it does not have on other forms.

By default, all four options are enabled. They may be dis-
abled in various combinations to fine tune the selection,
editing, and query functions.

Deselecting all of the attributes makes the rectangle com-
pletely non-selectable and prevents both quick queries and
form queries on that field for that form. Without click, tab,
or edit, data cannot be entered or modified.

Note: Deselecting both Click and Tab makes Edit useless
and therefore makes the rectangle essentially non-select-
able as far as data entry is concerned.

Deselect Click to force the user to follow the tab order
established on the template.

Deselect Tab to allow the user to click in a field but still
exclude the field from the tab order. This can make it easier
for a user to avoid a field with a default value while allowing
the user to change the value if necessary.

Deselect Edit to allow users to perform a quick query on a
field but not edit its value. You may want to use this tech-
nique to prevent users from modifying a key field on which
the users will need to query.

Note: Posting, loading, and subscribing require the Allow
Edit attribute. If Allow Edit is checked, you can load, post
(except for Option 0), and subscribe to the field in the edit-
able rectangle of an entry form.

Note: Popup menus are not built for a field unless both
Allow Edit and Allow Click are selected.

Even if you have deselected Allow Edit, the Edit menu’s Copy com-
mand is still enabled if the rectangle is set for Allow Click or Allow



Chapter 8: Data Manipulation: Templates, Views, and Posting

8-20

Tab. This makes it possible to select the text and copy it, but not
change the contents of the rectangle.

To allow data entry into a field but prevent the user from
performing a query on it, deselect Allow Query. This could
be used to prevent unoptimized searches.

Any time that Allow Query is selected, that field will appear on any
form query that uses that template. In addition, if Allow Click and/or
Allow Tab are selected, a quick query can be performed on the field
as well.

8.1.4.7 Scrollable Data Rectangles
Data rectangles on entry forms can have horizontal and/or vertical
scroll bars. The default state is no scroll bars.

The minimum size for scrollable data rectangles is as follows.

Depending on the font, size, or style settings for the rectangle, the
minimum size may be larger. If the selected rectangle is too small,
you are alerted by a message in the bottom center of the data rectan-
gle dialog.

Helix prevents you from resizing a data rectangle on a template so
that it is too small to contain scroll bar(s). You cannot place a data
rectangle with scroll bars inside a repeat rectangle.

To add scroll bars to a data rectangle:

Vertical only 48 pixels (6 grid squares) high

Horizontal only 48 pixels (6 grid squares) long

Vertical and Horizontal 64 (48 + 16) pixels high and 64 (48 + 16) pixels long
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1. Double click a data rectangle to open it.
2. Select the Horz. Scroll and/or the Vert. Scroll check boxes and 

click ‘OK.’
3. Close or save the template. 
4. Open the a view that uses the template to see the scroll bars.

Note: A template in Preview mode (see section 8.1.10) dis-
plays the scroll bars associated with the data rectangle.

Activate the scroll bars on the view window by clicking either on
them or within the data rectangle.

8.1.4.8 Word Wrap
By default, Helix wraps entire words to new lines, just as word pro-
cessors do. However, if you deselect the Word Wrap check box,
entries into data rectangles continue horizontally for 32,767 charac-
ters (the maximum length for a field). You can still use a carriage
return to manually create a new line.

8.1.4.9 Keep Value
After a user presses Enter to store a record, Helix normally clears the
form in preparation for the next record. The only fields that might dis-
play values are calculated fields.

Keep Value for a field causes a form to remember
the last value entered for that field. This means
that the data are still displayed after the record
has been entered. When the user enters a subse-
quent record, Helix stores the value displayed in
a Keep Value field as part of the record, just as if
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it had been entered again. If the user wants a different value for that
field, he or she can type over the kept value. This feature is useful in
a form designed for data entry where a field tends to have the same
value over multiple entries.

You designate rectangles individually as Keep Value fields on a tem-
plate. To specify Keep Value for a rectangle, select the rectangle on
the template and then select √->Keep Value or click the Keep Value
check box in the data rectangle dialog box.

Note: Helix RADE must be in Full Mode and all views
using the template must be closed to change a Keep Value
setting.

Note: Keep Value fields are not permitted on a listing
form.

A Keep Value setting carries a value only to a clear form. It will not
affect previously stored values.

8.1.4.10 Calculation Retain
When an abacus icon is used in a data rectangle on a template, Helix
does not store the output of the abacus calculation when the record
is entered. Instead, the result of the abacus is always kept only in
main memory and therefore reflects any changes in the calculation.
This is desirable in many applications, since the display of the calcu-
lation result is always up-to-date and always reflects any changes
made to the components of the calculation.

To automatically store the output of the abacus icon, construct a
data rectangle that contains both an abacus icon and a field icon. The
abacus icon generates the data that appear on the form; the field
icon stores the data when the record is entered. Inserting one icon of
each kind into a data rectangle designates it as a Calculation Retain
rectangle.

A data rectangle can be used simultaneously as both a Keep Value
field and a Calculation Retain field. Data appearing as a result of the
Keep Value status has priority over the output of an abacus and is
displayed regardless of any calculation that is present. If the Keep
Value is undefined (for example, if the displayed data are erased) the
calculation value is displayed.

A data rectangle that has been constructed for Calculation Retain
cannot be contained within a repeat rectangle.
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When using Calculation Retain rectangles on a form, a user can type
data directly into the calculated field. This allows the editing of a cal-
culated display without having to change the other components in
the calculation. If it a users needs to store a value other than the cal-
culated value being displayed, he or she simply edits the displayed
value. To return to the current calculated value, the user deletes
whatever is being displayed by selecting the field and pressing the
Delete key.

When viewing previously entered records, fields that have an unde-
fined value and are designated as Calculation Retain display the cur-
rent value of the calculation. If the Shade Defaults option is set (see
section 4.6.20), these fields are displayed shaded. Pressing Enter
enters the calculated value into the record, replacing the undefined
value.

8.1.4.11 Format Override from the Template Window
You can override the entry and/or display format of a field and/or
abacus from the template window (template level formatting). For
instance, you can display a Flag field as radio buttons on an entry
form, and as Yes/No on a list.

The priority for formatting is as follows.

• If a format is defined for the data rectangle, that format takes pre-
cedence. 

• If no format is specified for the data rectangle, the format defined 
for any abacus in the data rectangle takes precedence. 

• If no format is specified for the abacus or data rectangle, the for-
mat defined for any field in the data rectangle takes precedence. 

• If no format is specified for the field in the data rectangle, the for-
mat defaults to Standard format.

To override a field or abacus format:

1. Double click on a data rectangle after the field or abacus icon has 
been placed in it.
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2. The data rectangle dialog opens.

3. Click the Custom radio button.
4. Click the Format button.
5. A data Entry Format dialog box for the icon opens.

6. Change the format options.
7. Click OK.

The format for the icon is now changed for this template only. The
default format of the icon remains as originally defined.

8.1.5 Border or Selection Rectangles

Border rectangles are utility rectangles. They are used in three ways
to influence the final appearance of an entry form.

• They can be used to provide a decorative border around label or 
data rectangles. When the Frame Rectangle command is on, a bor-
der rectangle can be used to place a border on the template 
around an area or group of label or data rectangles.
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• They can be used to limit the size of a list generated with a repeat 
rectangle. If you draw a border rectangle around a repeat rectan-
gle, the repeat rectangle displays records until it encounters the 
lower edge of the border rectangle. The list then continues on the 
next page.

The location of page breaks, however, is ultimately determined by
the size of the page rectangle, regardless of where a border rectan-
gle may be drawn. See section 8.1.11 for more information.

• Border rectangles can alter the tab order of data rectangles when 
the template is used as a non-listing (entry) form. Normally, press-
ing Tab visits rectangles in a fixed top to bottom, left to right 
sequence. However, border rectangles have priority in specifying 
which data rectangle is next after a tab. Surrounding a group of 
data rectangles with a border rectangle makes Helix advance 
through the rectangles enclosed by the border rectangle before 
traveling to any other rectangle. The following examples will illus-
trate some of the flexibility this can provide.

In the template below, the field icon names indicate the tab order of
the displayed fields.

With the addition of border rectangles, these same fields will be vis-
ited in reverse order, as indicated by the names of the Field icons.

The data rectangle contained within the uppermost border rectangle
is first in the tab order because it is the highest border rectangle on
the template.
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The next template has a columnar entry order as indicated by the
Field icon names.

Since the tops of all the border rectangles are at the same level, Helix
considers the one on the left first. All the data rectangles within the
left border rectangle are visited before any others.

You cannot type or paste into a border rectangle.

Border rectangles can surround any other rectangle, including other
border rectangles.

You can draw any number of border rectangles on a template, and
nothing needs to be placed inside them.

You cannot draw a border rectangle inside a data or label rectangle.

8.1.5.1 Opening a Border Rectangle Dialog Box
You can set the properties of a border rectangle from its dialog box.

Note: The selected border rectangle at the top of the dia-
log is just a picture and is not meant to reflect the current
state of the rectangle’s framing attribute.

8.1.5.2 Frame Width and Color
The Width item in the border rectangle dialog box is a popup menu
that lets you set the thickness of the rectangle’s outline from 1 to 10
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points. Choose the color of the rectangle’s outline from the scrolling
list of colors at the right of the dialog box.

The Sample box displays an example of the thickness and color you
choose.

8.1.5.3 Frame Visibility
Use the Frame Rectangle check box to determine whether the border
rectangle has a visible outline.

Use the Visibility check boxes to further refine the pages on which
the rectangle’s outline should appear.

8.1.6 Repeat Rectangles

The repeat rectangle instructs Helix to repeat its contents for each
record that can be displayed on a view. Drawing a repeat rectangle
around data rectangles creates a listing of the data in the field icons
and/or calculations that are contained in the data rectangles. A
repeat rectangle performs the equivalent of a Find First command fol-
lowed by a series of Find Next commands—see sections 4.7.4.1 and
4.7.4.2—that continue until all records that meet the criteria for dis-
play on the view are accessible. 

Repeat rectangles can be drawn around an entire form design. The
entire form then continuously repeats until every record is displayed.
If the entire display does not fit in a view’s window, Helix provides
scrollbars that the user can use to see the entire list.

Repeat rectangles can be used to create a subform template, a tem-
plate that can be embedded within another, larger template to create
lists within entry forms or other lists. The subform template can be
from the same relation as the host (outer) template, or from another
relation. Subforms are particularly useful in creating complex listing
reports. See section 8.1.9 for detailed information on subforms.

If a template has a repeat rectangle, any view using it is a listing form.
Data can be displayed, posted, deleted, printed, or dumped, but not
entered.

Note: Templates for a list form cannot be used for form
queries (see section 9.3.2).
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A data rectangle containing a field icon cannot be placed outside a
repeat rectangle on a template. Use a subform to mix a design con-
taining a list with an entry (non-listing) design. (See section 8.1.9.)

A data rectangle containing an abacus icon can be used outside a
repeat rectangle. In this case, a field icon can be used in one of the
Summary tiles, but nowhere else in a calculation (see section 10.6).
Also see section 8.2.4.4, Asynchronous Lists, for further restrictions
on the use of statistics calculations outside a repeat rectangle.

A template can contain only one repeat rectangle. After a repeat rect-
angle is drawn, the repeat rectangle tool on the palette dims and can-
not be used again unless you delete the existing repeat rectangle.

A repeat rectangle can be shrunk either manually using the resize
handle in the lower right corner or automatically using the Trim com-
mand. (See section 4.3.14.)

You delete a repeat rectangle in the same way as other rectangles.
Select it, then use the resize handle to shrink it until the resize han-
dle meets one of the opposite edges or select the rectangle and press
Command-Delete.

Tip: When you use the resize handle to shrink a repeat
rectangle that surrounds a group of data rectangles, the
outline of the repeat rectangle does not always move
along with the cursor. This is because Helix will not allow
you to draw a rectangle through another rectangle. The
rectangle outline moves visibly only when the cursor is
outside the boundary of another rectangle. Therefore, you
may need to move the cursor all the way to the left of a
contained rectangle before the right edge of the repeat
rectangle snaps over the contained rectangle. 

A repeat rectangle cannot be deleted if the template is currently
being used as a subform on another template. Remove the subform
from the host template first.

Tip: A repeat rectangle can be hard to select when it sur-
rounds other rectangles tightly. You can, however, select
the repeat rectangle by attempting to draw any other type
of rectangle around it.

The spacing between records in a list is determined by the size of the
repeat rectangle. Changing the size of the repeat rectangle changes
the spacing.
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8.1.6.1 Opening a Repeat Rectangle
When you double click on a repeat rectangle, the repeat rectangle
dialog box opens. Use this dialog box to set attributes and travel for
the repeat rectangle.

You can set the following attributes for a repeat rectangle using the
repeat rectangle dialog box.

• Frame Rectangle: Determines whether the rectangle has a visible 
border.

• linking an Entry form to a List/AutoClose View: You can link a data 
entry form to a list. When the user double clicks on a record in the 
list, Helix opens the data entry form and displays the clicked 
record. To link an entry form to a list, select the entry view name 
in the scrollable list under the view icon in the middle of the 
repeat rectangle dialog box. For more information, see sections 
8.1.6.2 and 8.2.4.2.

If you select AutoClose View, Helix closes the entry form automat-
ically the user presses Enter.

• Selectable: Determines whether a user can select one or more 
records. For more information, see sections 8.1.6.3 and 8.2.4.3.

• Travel: Lists can be formatted to repeat either vertically or hori-
zontally and either in one or multiple columns (rows for horizon-
tally repeating forms). The number of columns available is 
determined by the page and repeat rectangle sizes and any other 
objects placed on the template. The default setting for page size is 
8.5" x 11".

A repeat rectangle formatted to multiple columns will fill one page
with records before going on to the next page. (See also section
8.1.6.)
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8.1.6.2 Linking an Entry Form to a List
To link an entry form to the list, select its name from the view selec-
tion list.

Only non-listing forms appear in the list.

If you choose the AutoClose View option, the entry form closes auto-
matically when a user presses Enter. If it is not checked, the entry
form remains open until the user closes it.

For more information, see section 8.2.4.2.

8.1.6.3 The Record Selection Option
If you choose the Selectable attribute, users will be
able to select a subset of the records displayed on the
list. Once selected, the records can be printed,
dumped, deleted, or copied to the Clipboard.

For more information, see section 8.2.4.3.

8.1.6.4 Specifying Record Travel
The Travel attribute for the repeat rectangle determines whether
data repeats horizontally or vertically and in single or multiple col-
umns.

Single Vertical Column: The default travel is a sin-
gle vertical column, a layout that is commonly used
to format reports.
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The following illustration shows a simple template with label rectan-
gles at the top of the template and data rectangles arranged below
the labels and surrounded by a repeat rectangle. 

When displayed in a view, the template produces the listing below.
The data are displayed in table form and each record occupies a row.

Multiple Vertical Columns: To produce a listing
with multiple vertical columns, click the radio button
with two arrows pointing down in the repeat rectangle
dialog.

Column spacing is controlled by the spacing of the data and repeat
rectangles. The number of columns is determined by the repeat rect-
angle and template page size and whether there are other objects to
the right of the repeat rectangle. In the sample template shown

①

① Repeat rectangle surrounding data rectangles

②

② Dimmed repeat rectangle tool



Chapter 8: Data Manipulation: Templates, Views, and Posting

8-32

below, Field 1 determines the column spacing. Each column also has
labels. Page size is 8.5" x 11".

On the associated view, records fill up the first column and then go
back to the top of the page and fill the second column. When all col-
umns that will fit across the 8.5" page are filled, Helix adds a second
page and fills it in the same manner. Additional pages are created as
needed.

Single Horizontal Column: To select a single hori-
zontal column, click the radio button next to one
arrow pointing to the right.

There are three field icons in the repeat rectangle on the sample tem-
plate. Label rectangles appear on the left.

This produces a single column across the top of the page for each
field contained in the repeat rectangle. The number of records dis-
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played per page depends on the repeat rectangle and template page
size.

In this case, records 1 through 5 fit horizontally on the 8.5" page;
records 6 and through 10 appear on the next page, and so on. Helix
creates subsequent pages as necessary to display all records. In the
illustration above, records 1, 2, and 3 are selected.

Multiple Horizontal Columns: Collection develop-
ers often use multiple horizontal columns when the
repeat needs to be horizontal, such as in the case of 2
or 3-up labels.

In the example below, you can see the same template created for sin-
gle horizontal columns, with the travel changed for multiple horizon-
tal columns.

The view produced by this template shows the data in the field icons
repeating horizontally across the page. The data then wrap to a sec-
ond row on the current page, continuing until the page is filled.
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8.1.7 Label Rectangles

Label rectangles let you add titles, headings, field identifiers, explan-
atory text, and/or pictures to a template.

After you draw a label rectangle, it remains selected with a flashing
text insertion point. This indicates that characters can be typed into
the rectangle or that a picture can be pasted there.

Label rectangles are not restricted to short descriptive entries. They
also can contain long, extended blocks of text, simply by drawing the
rectangles large enough to contain the desired text. This text is then
repeated on every form that uses the template. You might, for exam-
ple, use large blocks of text to store the unchanging boilerplate por-
tions of form letters. A label rectangle can contain up to 32,500
characters.

Any number of label rectangles can be created on a template

Label rectangles do not need to have any contents.

Label rectangles cannot surround or contain any other rectangle.

Label rectangles can be used to create page numbers, using a special
command and format. (See section 8.1.7.2.)

You can specify framing, printing, and font/style attributes for label
rectangles.

A picture can be used as decoration on a form by pasting a picture
into a label rectangle. The size of the picture can be adjusted using
the Scale Picture command. 

To add a picture, draw a label rectangle, then select Edit->Paste.
Helix pastes whatever is stored on the Clipboard at this time into the
selected label rectangle, and the Clipboard’s contents become part of
the template design. The picture can also be placed in the back-
ground layer of the template. (See section 8.1.4.2.)

Label rectangles can hold only one type of thing at a time, either text
(regular or styled) or a picture. A label rectangle will not allow a pic-
ture/text combination unless the text is actually part of the picture. If
a label rectangle contains text, you can paste a picture into it after
selecting and cutting the text, or by just selecting the text and then
pasting. The text disappears and the Clipboard contents appear.
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8.1.7.1 Opening the Label Rectangle Dialog Box
The label rectangle dialog box is a way to quickly set attributes and
font specifications for any label rectangle on your template. To
access the dialog box, double click on the label rectangle.

The check boxes in the dialog box reflect the current attributes and
font specifications for the border rectangle. See section 8.1.3.4 for a
discussion of the Frame Rectangle, Scale Picture, and Printable
attributes and of font specifications. See section 8.1.4.4 for an expla-
nation of the Color button.

Note: The rectangle tools pictured at the top of the dialog
are just a picture to identify the type of rectangle on which
you are working. They do not reflect current rectangle
attributes.

8.1.7.2 Page Numbers
You can use a label rectangle on a template to automatically calculate
and display page numbers. To do so, use the P# is Page Number com-
mand, located in the √ menu.

Any label rectangle can be given the Page Number attribute:

1. Select the label rectangle.
2. Select √->P# is Page Number. The label rectangle then interprets 

the characters P# as a special page number symbol. 
3. Type upper case letter P and then # (Shift-3) in the label rectangle 

where you want the page number to appear. Only this combina-
tion is interpreted as a page number symbol.

Label on template Label on list form
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Notice that P# can be embedded in other text.

The P# is Page Number command is a rectangle attribute; as each
label rectangle is selected, the command shows the rectangle’s sta-
tus by the presence or absence of a check next to the menu selec-
tion.

Page numbers can appear anywhere on a form.

Page numbers can appear more than once on a form.

Note: The page number feature functions only when dis-
playing and printing listing forms, or when printing indi-
vidual records with multiple subform pages. Page
numbers on a normal non-listing form do not increment
when stepping from record to record using Find First, Find
Next, and so on.

You can number each record on a listing form by placing the P# label
rectangle inside a repeat rectangle. If the P# label rectangle is outside
of the repeat rectangle, Helix numbers each separate page. A form
can have a P# Label rectangle outside the repeat rectangle and one
within it, although the starting page number is the same for both.
(See section 4.5.7.)

On a non-listing form, page numbers increment only where a single
record spans more than one template page. Page numbers do not
increment from record to record.

On subforms, page numbers inside the subform do not increment for
each new line. They increment with each record represented by the
outer form. This number is always one unless the outer form is a list-
ing that includes the subform.

8.1.7.3 Template Layers and Background Rectangles
The template is divided into two layers, a foreground layer and a
background layer. Although not visually distinct, these layers have
different purposes and operate differently.

The foreground layer is primarily for template design work. You can
draw all types of rectangles in it, as long as they do not overlap.

The background layer is more of a graphic element. You place any-
thing that you want to show through to the foreground layer in the
background. 
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Only label rectangles can be placed in the background, but they can
overlap. It is as if each background rectangle is drawn on a clear
sheet of plastic; multiple sheets can be stacked on top of one another,
although objects in the rectangles are opaque. The only constraint on
the position of a background rectangle is that is must be wholly
within the page rectangle.

The foreground and the background layers do not interact. This
means that a label rectangle in the background does not stop a repeat
rectangle in the foreground; the display of multiple records continues
right over and past a background rectangle.

You place a label rectangle in the background layer using the Back-
ground command. You can also draw a rectangle directly in the back-
ground layer by choosing the Background attribute for the label
rectangle tool before you begin drawing.

Clicking on a background rectangle selects it and makes it fully visi-
ble. In a sense, a background rectangle behaves like an active win-
dow. While selected it temporarily appears in front of all other
rectangles on the template. When selected, a background rectangle
may be manipulated with the Bring to Front, Move Forward, Move
Backward, and Send to Back commands, may be dragged or typed
into, or may have a picture pasted into it in the normal fashion.

A label rectangle that is in the background layer can be moved to the
foreground layer via the Background command if and only if it meets
the constraints of position (non-overlapping) that apply to the fore-
ground layer. If it does not, Helix RADE beeps at you and the Why?
message explains that rectangles cannot overlap.

The framing for background rectangles lets you distinguish them
from foreground rectangles. Examples of both framed and unframed
rectangles are shown below as they would appear on the template. 

Tip: Deselecting the Graph Paper option will allow you to
see the differences between background and foreground
rectangles more clearly.
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8.1.7.3.1 Background Rectangles as Templates Within a Templates
One of the principles of efficient collection design is to use fewer
objects such as tiles, icons, and rectangles. Therefore, a useful appli-
cation of the background layer is to use it as a template within a tem-
plate for screen design.

As screens evolve, the designer typically creates two rectangles for
each piece of information, a label rectangle and a data rectangle.
Additional objects, such as border rectangles add more objects to
the template. To save on the number of objects used, take a screen
shot of your view and paste it in one large background layer. Then lay
only data rectangles and buttons on top of it. This is an easy way to
get beautiful button designs into your application.

To create the template within a template:

1. Take a screen shot of your view: With the view open, press Com-
mand-Shift-4. Then, when your cursor becomes a crosshair, hold 
down the Control key and drag diagonally to enclose the area you 
wish to shoot and release the mouse button.

2. Paste the screen shot into a graphic application such as Adobe 
Photoshop, DeBabelizer, Painter, or UltraPaint.

3. In the graphic application you selected, you can refine your 
design, moving rectangle place markers closer together. You can 
draw your rectangle borders on this template and then later draw 
unframed rectangles inside them in Helix RADE.

4. Reduce the size of your finished image: Remove any unnecessary 
color palettes and shrink the size of the image in kilobytes as 
small as possible. This facilitates its drawing to the screen, espe-
cially in Client/Server applications.

5. Paste the resulting image into the background layer of your tem-
plate in Helix RADE and put all your other objects on top of it.

8.1.8 Command Rectangles

Command rectangles create buttons (or hot spots) on forms. When
clicked, a command button executes a sequence. (See section 6.6 for
an in-depth discussion of sequences.)

Each command rectangle must contain at least one sequence for the
template to be valid. The size of the command rectangle determines
the size of the button that appears on the form. Like menu com-
mands, buttons are dimmed if the sequence they contain cannot be
activated.
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The text in the button can be conditional; it can say one thing if cer-
tain conditions are met, and something else if they are not. For more
information, see section 8.1.8.2.

In addition, an entire button can be conditional, visible and enabled
under certain circumstances, or invisible or dimmed the rest of the
time. This can be used to control the execution of the sequence(s)
the command rectangle contains, since sequences cannot be exe-
cuted from a dimmed or invisible button. For more information, see
section 8.1.8.3.

You draw a command rectangle like any other rectangle. Select the
command rectangle tool from the palette before drawing.

Command rectangles can be dragged, sized, and formatted. The
default settings are framed, printable, and centered, Chicago 12 font.
Command rectangles cannot be placed inside repeat rectangles, and
they cannot overlap other foreground rectangles.

In addition, command rectangles can contain pictures or text as well
as a sequence icon, or be placed over a picture of a button in a back-
ground rectangle.

To put a sequence into a command rectangle, first click on the
sequence icon switch on the template palette to display the list of
available Sequences. Then drag a sequence icon from the selection
list into the command rectangle. An alternate method is to double
click on the command rectangle and select the sequence from the list
that is displayed. If you are in Preview mode (see section 8.1.10), the
sequence icon will not be visible while the rectangle is selected. It is
visible when you are not in Preview mode.

The appearance of a command rectangle on the template and the
appearance of the corresponding button on the form may differ.

• If the command rectangle contains just a sequence icon, the but-
ton shows the name of the sequence. If the sequence icon is 
renamed, the text in the button shows the button’s new name.

• You can type styled or unstyled text into a command rectangle. 
On a template in Preview mode, the text is visible only when the 
rectangle is selected. The name of the sequence replaces the text 
if the text is erased.

• You can paste a graphic into a command rectangle. The rules 
applicable to pasting graphics into label rectangles apply; graph-
ics bigger than the rectangle are clipped and graphics smaller 
than the rectangle may show white space around the edges. You 
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can use the Scale Picture command to resize graphics to fit a com-
mand rectangle (see section 4.6.1) or the Trim command to resize 
the rectangle to fit the picture.

• If you type a single blank space into a command rectangle, the 
rectangle functions as a hot spot. On the template, the rectangle, 
exclusive of its framing, is transparent, and whatever is beneath it 
(the template grid or a background rectangle) is visible. Though 
invisible on the form, the sequence contained by the command 
rectangle is activated when a user clicks the hot spot. Command 
rectangles are invisible only if they contain one single space; oth-
erwise they are opaque.

The following pictures illustrate these four combinations. All rectan-
gles contain the same Print Form Sequence.

In each case, the command rectangle executes a Print Form
Sequence.

In the example shown, two of the command rectangles have the
Frame Rectangle attribute, but hot spots often look better if both the

Command rectangle
with sequence icon only

Command rectangle
with typed in text

Graphic pasted into
command rectangle

Hot spot command
rectangle with one space
typed in over background
rectangle with graphic
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command rectangle and the background rectangle containing the
graphic are unframed.

8.1.8.1 Opening a Command Rectangle Dialog Box
The command rectangle dialog lets you specify the sequence(s) that
run whenever a user clicks the command rectangle button, change
the rectangle attributes, font specifications, and specify conditional
options.

Choose the primary, unconditional, sequence for the rectangle from
the selection list at the top left of the dialog box. This sequence
always runs first, before any conditional sequences.

Tip: Even if you want all of your sequences to be condi-
tional, you still must select a primary sequence. A
sequence containing just the Null command can provide
the necessary “filler” for the primary sequence.

Click check boxes in the upper right corner of the dialog box to
choose command rectangle attributes.

①

① Unconditional sequence

②

② Rectangle attributes

③

③ Text formatting

④

④ Color settings

⑤

⑤ Options, including
conditional sequences

⑥

⑥ Visibility
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Set text formatting for the button using the controls in the center of
the dialog box.

Click the Color button to open a dialog box for specifying rectangle
text, background, and frame color.

Click the Options button to open the Command Rectangle Options
dialog box, which allows you to set up the command rectangle as a
conditional button and to specify one or more conditional sequences
for the button. For more information, see section 8.1.8.2.

Use the Visibility check boxes in the lower left corner of the dialog
box to specify the pages of a form on which the command rectangle
should appear.

8.1.8.2 Command Rectangle Options
Click the Options button in the command rectangle dialog box to
open the Command Rectangle Options dialog box.

The top half of the dialog controls the button’s appearance, both
what it looks like and whether it can be seen. You can change the but-
ton’s name, determine when the button is available and what will
happen when it is not, and choose what text appears in the button
for each state. The bottom half of the dialog lets you specify one or
more conditional sequences for the command rectangle.

To configure a conditional button, you use the following controls.

①

① Button name choices

②

② Conditional button selection list

③

③ Disabled button action

④

④ Conditional sequence triggers
⑤

⑤ Sequence selection list

⑥

⑥ Conditional sequence list
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• Button Name: If you leave the Button Name area empty, do not 
type anything in the command rectangle on the template, and if 
you do not enter a conditional name, the button displays the icon 
name of the unconditional sequence in Full Mode and its custom 
name in Custom Mode.

• Conditional button selection list: The conditional button selection 
list displays the fields or abaci in the relation that produce text 
output. The field and abacus icons at the top of the list act as 
switches to list their respective types of objects.

The chosen item controls when the button is enabled and option-
ally the text that appears in the button. For example, the following
abacus tests the condition FirstName = John.

If the = tile returns true for the record displayed on a form, then
the contents of the Then black hole (the text for the button when
it is enabled) appears in the button and Helix enables the button.
Otherwise, nothing appears in the button because the Else black
hole is empty and the button remains disabled.

Any text field or abacus that outputs text can be used to control
enabling and disabling a button, such as a Display or Username
tile. Tiles that output other data types can be filtered through the
Text tile.

To use the output of a field or abacus to set the name of an
enabled button, click the Use Abacus Output radio button in the
upper left of the dialog box.

Note: The settings in the top half of the dialog box control
only the text appearing on the button and not the function
of the button, which is determined by the sequence(s)
attached to it.

• Disabled button actions: Once you have chosen a field or abacus 
from the conditional buttons selection list, the dialog box displays 
the When Invalid radio buttons in the Button Name area. You can 
choose to have the button disappear by choosing the Disappear 
radio button. Alternatively, you can configure the button to 
appear dimmed with the same or alternate name by clicking the 
Dim Button with Name radio button and entering the name.
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Caution: If a conditional button becomes invalid and dims
(or disappears), it cannot be clicked, and cannot run any
of the sequences attached to it—unconditional or condi-
tional.

• Conditional Sequence triggers: The On Condition list in the lower 
left corner of the dialog box displays the fields or abaci (number 
or fixed point output) that are available to use as triggers for a 
conditional sequence. Helix uses the output of the chosen field or 
abacus to determine the number of times to run the sequence. If 
the output is 0, the sequence does not run. If the output is 1, the 
sequence runs once, and so on. Decimals are truncated.

Note: A conditional sequence depends on the button that
executes it. If the button is dimmed, the sequence will not
execute no matter what the output of the sequence trigger.

• Sequence selection list: The Run Sequence list in the middle of 
the lower half of the dialog box determines a sequence that Helix 
runs when the condition produced by the item chosen in the On 
Condition returns true. You can choose more than one sequence 
to be triggered on any given condition.

To attach a sequence to a condition, first choose the condition in
the On Condition list and then choose the sequence in the Run
Sequence list. The Add button appears. Click the button to trans-
fer the pair to the conditional Sequence list (labeled Final) at the
lower right of the dialog box.

If an item is selected in Final, the new pair is inserted above it. If
no item is selected, the new pair is placed at the bottom of the
list.

Conditional Sequences execute in the order that they appear in
the Final list, but after the unconditional primary sequence cho-
sen in the main command rectangle dialog.

• Remove: To remove a sequence/trigger pair from the list, click to 
select it. Then click the Remove button.

8.1.8.3 Conditional Button Example
This section walks you through an example using conditional but-
tons. Assume that a girls’ softball league has a registration applica-
tion. To prevent someone from entering the same girl twice, a
SmartSearch screen forces the user to check for the presence of the
name before proceeding with data entry.
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If the girl’s name is already in the Player relation, the application
should provide a direct route to that girl’s record. If it isn’t, the appli-
cation should provide an equally direct means of creating a new
record. The application can use a text style conditional button to say
something different and do something different depending upon a
given condition.

Since the conditions are “record exists” and “record does not exist,”
the collection developer can create three abaci in the relation con-
taining the SmartSearch.

The first controls the text of the button. If there is nothing in the
SmartSearch popup field, the button will say “New Player.” If the field
is defined, it will say “Get Player.”

Note: A further refinement of this button would replace the
field with an abacus that checks the value in the popup to
see if it locates a record in the Players relation.

The other two abaci are used as triggers to set off sequences. They
are constructed just like the Button Name abacus above, except that
instead of text in the Then hole, there is a fixed point value of 1.

The “Get” condition abacus is similar, except that it looks for a
defined value in the popup field.
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The collection developer creates two views in a relation containing
girls’ names. The first view is used to enter new Player records. It is
called “New Player”. The second one, used to retrieve existing
records, is called “Get Contact”. The second has an abacus query
selected in show selection mode to match the player’s record num-
ber to the global value of the SmartSearch field.

On the Smart Search template, the collection developer places a null
sequence inside a command rectangle. The collection developer
then configures the button as in the following dialog box.

Notice in the Final list that trigger names are separated from
sequence names by a delta (∆).

When this process is complete, the SmartSearch will show different
buttons with different functions depending upon whether the search
field is defined.

8.1.9 Subforms

Helix RADE can create subforms—listing forms that can be embed-
ded within another, larger form. 

Undefined:

Defined: 
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Note: The selection attributes (Allow Click, Allow Tab,
Allow Edit, Allow Quick Query) are not available for sub-
forms.

The subform (the inner form) is always a list. The host form (the
outer form) can be either a listing form or an entry form.

Operationally, a subform functions as a much enhanced Lookup tile.
While a Lookup tile can deliver one or more values for a single record
that matches a linking value, a subform can deliver many or all values
from multiple records that match a linking value. In other words, it is
a multi-valued lookup that can look up field values for multiple
records.

There are several stages in the creation of a subform. The typical
straightforward use implies the creation of at least two relations.
However, since a subform also requires a view icon, the final steps of
subform creation are outlined in the discussion of the view window.
(See section 8.2.)

To prepare templates for use on a view displaying a subform:

1. Determine where the subform will be created and where it will be 
used.

You design the embedded form (the subform) in a template that is
part of the relation with the detail data to be listed in the relation on
the many side of a one-to-many relationship. If, for example, you have
a relation for Clients and a relation for Visits, the date and a summary
of the nature of each visit are stored in the Visits relation. To have a
listing of each client’s visits, you construct the host template in the
Clients relation, and the subform, listing the visits made by each cli-
ent, in the Visits relation.

Tip: If data have a one-to-one relationship, a subform is
not needed. Use the Lookup Tile instead.

2. Prepare the subform. Create the appropriate rectangles. Then 
draw a repeat rectangle around the data (and, if you wish, the 
label) rectangles. This will be the subform.

The next step is to resize the subform. This is critical to the operation
of the subform. A subform must be smaller than its host form before
the subform name will appear on the template list in a template icon.
This means that the page size of the subform must be reduced, a two
step process:

3. Click outside the repeat rectangle to select the form rectangle. 
The form rectangle size of the list needs to be made smaller (see 
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section 8.1.11).You can do this by selecting Edit->Trim after 
selecting the form rectangle. The Trim command reduces the 
page size to the size of the repeat rectangle and pushes all rectan-
gles to the upper left of the template.

Next, to make this list effective as a subform, the form rectangle
should be enlarged so that there is room for more than one record.

4. Grab the form rectangle resize handle and drag down until there 
is sufficient space for the maximum number of records you 
expect to appear. For the Clients and Visits example, you would 
make the subform large enough to hold the maximum number of 
visits made by any single client. 

Another subform requirement is that there must be at least one
shared key between the two relations. That is, there must be at least
one field or abacus icon with equivalent values in each relation that
can be used to link the subform with the host form. In most cases,
the subform template’s relation will contain a foreign key that refer-
ences the primary key of the host form template’s relation.

5. If necessary, create the field or abacus in both relations that will 
be used to link the subform and host. Also create an index in the 
subform relation on the key field or abacus. For the Client and Vis-
its example, the linking values would be the values that uniquely 
identify a client, probably a client number. The linking field or 
abacus does not need to be displayed on either form.

6. In the host form relation, construct the host form template.
7. Insert the subform template from the other relation into the host 

template. First, select the template palette switch in the host tem-
plate. This displays the list of available subform templates. Sec-
ond, drag the template from the list in the same way that you drag 
any other icon. Place the subform template outline on the tem-
plate, moving it to where you want it to be. 

8. If the host form template is a listing form, place a repeat rectangle 
around host form data rectangles and the subform template.

Tip: You can remove a subform template from a host form
template by selecting it and pressing the Command-Delete
keys.

The template is now complete.

The final step before using the template is to set up the view icon to
properly see the created form. The View portion of the subform
requirements are provided in section 8.2.2.1.
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8.1.9.1 Opening a Subform from the Host Template
A subform can be modified from the host form’s template. To do so,
double click within the subform template outline on the host form
template. The subform template window opens.

8.1.9.2 Modifications to a Subform Template
When the subform template is made larger but the template is not
saved, a darkened area appears on the host form template indicating
the appropriate size for the larger subform. The actual rectangle con-
taining the subform is not resized on the host form template until you
save the subform template, either by selecting Icon->Save or by clos-
ing the template.

8.1.9.3 Subform Notes
Subforms can be embedded within subforms.

You can change the size of a subform after it is inserted onto a host
form. When resizing the subform page, Helix restricts the new size to
avoid overlapping a rectangle on the host form.

It takes Helix time to determine the data that should appear in a sub-
form when the host template appears on a view. The more subforms
on a form, the longer it takes to display the form.

If a host form does not contain a repeat rectangle the Find and Print
All command can be used to print out, one per page, the host and
subform information.

A user cannot type into a subform. Subforms are lists, and as such are
for display only. However, the host form can allow data entry. (For
more information, see sections 8.1.6.2 and 8.2.4.2.)

An interesting variation in the above is to make the host form the
view that opens when the user double clicks a subform record.
Assuming that the host form is a data entry form with data rectangles
for the same fields as those on the subform, this makes it possible to
edit a record from a subform list on the same form, without having to
open a separate data entry window.

Subforms allow the deletion of records which are linked to other rela-
tions. (See sections 4.7.7.1 and 4.7.7.2.)

Although usually from different relations, a host form and its embed-
ded subform can both be from the same relation. It is not a require-
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ment that a subform template be from a different relation than the
host form template. In this case, the shared key could be the same
field or abacus icon, but this is not recommended. An index is still
required on the linking field or abacus.

A typical use of a subform in the same relation is in an Employee rela-
tion where each employee has an employee ID and a supervisor ID.
You could link a listing of all supervisors, with a subform showing
employees supervised, employee ID = supervisor ID.

8.1.10 Previewing a Template

The Preview command under the √ menu lets a collection designer
view templates with sample entries in data and command rectangles.
This helps you to size rectangles correctly prior to opening a view
and thus helps speed the design process.



Template

8-51

The sample entry data displayed is the Example shown in the Display
Format and/or data Entry Format dialog boxes. 

You can see pictures pasted into command rectangles only in Preview
mode.

8.1.11 The Form Rectangle, Page Size, and Printing

When designing a form, the template makes a distinction between the
area of that form that will be printed on each page (the page size) and
the total area of a given form (the form rectangle). This means that a



Chapter 8: Data Manipulation: Templates, Views, and Posting

8-52

form can be designed that will print one record on two or more
pages, high or wide.

The items or data that comprise one printed page are indicated by
page lines. These are dashed lines that show where the printer will
break off on one page and begin printing on the next. The page lines
are set by the Page Setup dialog box.

There are two exceptions to page breaks occurring at the page line.

• When printing, the form rectangle takes precedence over the 
page size if the form rectangle is smaller than the page outline 
(for example, labels). In this case, the page breaks occur at the 
form rectangle.

• If a template contains a repeat rectangle, the list will not break at 
the page line, but will continue until Helix encounters the lower 
edge of the form rectangle.

8.1.11.1 Adjusting the Form Rectangle
If you scroll a template to the bottom right limits of the template win-
dow, you will see a change of dot pattern in the work area. This repre-
sents the lower right edge of the form rectangle or form design area.
Rectangles cannot be drawn in the denser dot pattern area, which
represents the space outside of the form rectangle.

When a template is created, its form size reflects the current setting
in the Page Setup dialog box. This means that when a template is first
created, the page lines coincide with the form rectangle.

①

① Page size

②

② Form rectangle

③

③ Work area

④

④ Resize handle
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The form rectangle cannot be moved. To adjust the form rectangle
size, first select it by clicking inside on the coarser dot pattern, or by
clicking outside on the finer dot pattern, or by drawing a rectangle
through its bottom or right edge. Once selected, its resize handle
appears. 

You drag the resize handle to shrink or enlarge a form rectangle, just
as you would any other rectangles. Selecting the Trim command
when the form rectangle is selected shrinks the form to the smallest
possible size.

8.1.11.2 The Printable Page
When thinking about printing something that uses a particular tem-
plate design, some help is available in determining how the informa-
tion will look when actually printed. Use the page lines (represented
by dashed horizontal and vertical lines that crisscross the form
design area) as guides. Generally, items that appear on one side of the
page lines will be printed on one page, and those on the other side
will be printed on another page.

Page lines are controlled by choices made with File->Page Setup. With
standard page sizes, you may have to enlarge the form rectangle to
see the dashed lines.

Page outlines change according to what you select in the Page Setup
dialog box.

8.1.11.3 Printing Multiple Page Templates and Forms
Helix RADE fully prints a form that is larger than the page lines. The
entire template area can be filled with adjoining dashed line rectan-
gles that correspond to whatever page size is selected in the Page
Setup dialog box. This grid of dashed page lines serves to delineate
where one page stops and another begins.

When a template spans an area larger than the page outline, the form
will be printed paged. Helix RADE constructs an image of all objects
within the form rectangle. It then divides the image into page size
pieces and sends the pages to the printer, starting with the upper left
corner followed by all the page-sized pieces in the vertical column
below. Helix RADE then prints the next vertical column to the right
and so on until the entire form rectangle has been printed. Blank tem-
plate area at the very bottom and the extreme right of the form rect-
angle is trimmed (in other words, not sent to the printer). For more
information see section 13.3.4.
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8.1.11.4 The Ruler
The ruler numbers at the top and left side of the window correspond
to the printable dimensions of the page, which is always slightly
smaller than the physical size of the paper. The ruler scale and the
printable area of the page are defined by the printing device and by
settings in the Page Setup dialog box.

8.1.11.5 Page Setup Notes
If the No Gaps Between Pages option in the Page Setup dialog box is
not checked, Helix generates a break in the printing around the
beginning and end of each page (1/2 inch at the top and 1/16 inch at
the bottom). The printer inserts spaces to jump past the break
between each page. Therefore, there are really only 10 7/16 printable
inches top to bottom on an 8 1/2 by 11 inch sheet of paper. This can
be changed by selecting No Gaps Between Pages in the Page Setup
dialog box for the ImageWriter.

Page Setup attributes are stored in the template. After a template is
tied to a form by selecting the template in the view selection display,
the page parameters set by the Page Setup dialog box can be con-
trolled additionally from the view window. If several forms use the
same template, they will all reflect the same Page Setup attributes.

The form rectangle for an existing template does not change size
automatically if you change the page size in the Page Setup dialog
box. To resize the form rectangle, you must open the template and
resize the Form rectangle by dragging the form’s resize handle. If you
create a template with the Letter page size and later choose Legal
size, the page lines will change, but not the form rectangle. The form
rectangle will still be set for Letter size and will have to be enlarged
on the template if it is to use the additional printable area.
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8.2 View
When you open a view icon, the view may be in one of three modes:
form setup (show setup) mode,

posting selection (show posting) mode,

or show data mode, where Helix displays a form on the view, ready for
use.

The form setup and posting selection modes let the collection devel-
oper specify a form that can then be displayed on the view. When a
form is displayed on a view, you can do the following.

• view stored data, either record by record or in a list of records

• print viewed data, either record by record or as a list of records

• enter new data into one or more relations

• modify data already stored in one or more relations

• delete data from one or more relations

• post data from one relation to another, or into the same relation

You configure a form to be used on a view by selecting the form com-
ponents in form setup mode. Then you configure any posting opera-
tions associated with the form in posting selection mode. The form
can then be displayed on the view. 
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8.2.1 Quick Forms

You can enter and view data without ever creating a template by
using Helix’s quick form feature, which creates a form using fields for
each (non-inert) field icon that has been created in a given relation.

To create a quick form:

1. Create a view icon and open it. It opens in form setup mode. 
2. Instead of selecting a template name, select Find First, Find Last, 

Find All, or Clear Form from the View menu.

If you select Find First, Find Last, or Clear Form, Helix creates an
entry form using field custom names (if any) or icon names (no cus-
tom names available) and performs the command you choose. The
form that becomes visible can be used for data entry, data modifica-
tion or deletions, or simply to view data one record at a time.

If you select Find All, Helix creates a listing form and a list of all data
in the relation appear. The field custom names (if any) appear along
the top of the form, with each field listed below. If a field has no cus-
tom name, Helix uses the icon name.

When in form setup mode, you can also select an index and/or query.
Those selections are then used for the form that Helix creates auto-
matically.

Before creating the quick form, click on the field icons in the order
that you want them to be displayed on the form.

If you create a no template quick form, Helix does not create an
accessible or permanent template. The invisible template is dis-
carded if you return the view to form setup mode by choosing
View->Show Setup. Having no template means that changes cannot
be made to the design of a quick form. See section 8.1.2, Quick Tem-
plates, for an alternative means of fast entry and viewing.

Abacus icons are not included in a quick form.

No post icons can be attached to a quick form.

Check boxes or radio buttons are not displayed on a quick view even
if a field’s data entry format was originally set as check boxes or
radio buttons. The data displays as “Yes” or “No.”
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8.2.2 Form Setup Mode

To use a form, it must first be configured for display on a view. Form
setup mode lets a collection designer configure a view using up to
three properties: a template, a query (either abacus, form query, or
power query), and an index. A template is the only required element.

You choose a view’s properties from three selection lists.

• The template selection list displays the names of all templates in 
the relation. The template selected for the form may be primarily 
for data entry, or one of several that have been created for the list-
ing of selected fields of data, or merely for the display of selected 
fields in a particular arrangement. No more than one template 
name can be selected from the list.

• The query selection list is actually three lists: abaci that return 
flag values, form queries, and power queries. The selection of a 
query limits the display of data to those data that meet the crite-
ria of the query. If you don’t select a query, Helix RADE displays all 
records in the relation. The three switches above the query selec-
tion list control the type of query that appears in the list.

• The index selection list determines the order in which data 
appear on the form. When you select an index by highlighting its 
name in the index selection list, Helix uses the order of the data in 
the index as a guide to the record display order. With no index 
selected, Helix RADE displays data in its own internal order, usu-
ally the order in which records were entered. (For more informa-
tion, see section 7.2.1.)

①

① Template selection list

②

② Query selection list

③

③ Index selection list
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You can select any template, query or abacus, and index combina-
tion for a view. After you have finished configuring the view, choose
View->Show Form to display the form. 

8.2.2.1 Subform Configuration
Subforms are discussed in the section on Templates (see section
8.1.9), but only up to the point of completing the form design.

Once you have designed the host form with its subform(s), you must
configure a view to display the form. 

When you select a template that includes a subform from the list of
templates in the template selection list, the window changes to
include subform selection.

Form setup mode now has eight selection lists.

Note: “Marching ants”: When working in form setup
mode, you may see rows of horizontally scrolling dots in
some areas of the window. These marching ants indicate
that something must be done to completely define the
form. Whenever the moving dot pattern appears in the
display window, a Why? message is available under the
Apple menu that explains the needed action. When no
marching ants are visible, the minimum requirements
have been completed for specifying a form and the Show
Form command is enabled.

①

① Host template selection list

②

③

③ Host query selection list
② Subform template selection list

④

④ Subform query selection list

⑤

⑤ Host form index selection list

⑥

⑥ Subform index selection list

⑦

⑦ Host form link selection list

⑧

⑧ Subform link selection list
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• Host template selection list: When you select a template that 
includes one or more subforms from the host template selection 
list, the form setup mode changes to allow the selection of sub-
form templates and the linking icons between the subforms and 
the host form.

• Subform template selection list: The subform template selection 
list contains the names of the subforms used on the host tem-
plate. If more than one appears, you must select each in turn to 
select the icons linking each subform with the host form. When 
you select a subform template, lists 4, 6, 7, and 8 list all applicable 
icon names that may be chosen to configure the selected subform 
template.

• Host query selection list: Use the host query selection list to spec-
ify a query (abacus, form, or power) that will limit records dis-
played on the host form. A selection from this list is optional.

• Subform query selection list: Use the subform query selection list 
to specify a query (abacus, form, power) that will limit records 
displayed in the subform. A selection from this list is optional.

• Host form index selection list: Use the host form index selection 
list to order the display of host form records. A selection from this 
list is optional.

• Subform index selection list: The subform index selection list has 
a different purpose than the host form index selection list. A sub-
form needs a link between itself and the host form, and that the 
link must be indexed. When you select the subform template, all 
the indexes (and their corresponding fields) that could be used to 
link the subform with the host form appear. Selecting an index not 
only specifies the order in which subform records are displayed, 
but also specifies the link between the subform and host form. 
When you select an index, Helix automatically selects the indexed 
field in the subform link selection list. Conversely, if you select a 
field, Helix selects the corresponding index in this list.

• Host form link selection list: Use the host form link selection list to 
select the host form linking icon. The icon switches at the top of 
the column display a list of either field or abacus icons. Choose an 
icon that contains equivalent values to the subform linking icon. 
You do not need a corresponding index as in the subform linking 
specifications.

• Subform link selection list: Use the subform link selection list to 
select the subform linking icon. Choose the icon from the subform 
relation against which the host form linking icon will be matched 
for the link. The icon switches at the top of the column display a 
list of field or abacus icons for both the host form link selection 
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list and the subform link selection list. Selecting a field or abacus 
icon automatically selects its index.

The linking icon chosen from the subform relation may have more
than one index built on it. For instance, you could build an index on a
field called Name using just the Name field, but you might also want
to build another index using both Name and another field that con-
tains a date value. This would allow not only the linking of the sub-
form to the host form on the Name field, but would also allow the
subform list to be displayed in date order for each instance of Name. 

Helix displays every index for the corresponding icon type (field or
abacus) when you select the subform template. If selecting the field
or abacus icon does not automatically select the correct index, you
will need to select the proper combination of index and linking icon
manually.

Tip: Clicking on the center gray bar after making selec-
tions for several subforms displays all the selections for
every subform.

When form setup mode contains a valid configuration, the marching
ants disappear and the Show Form command becomes available,
indicating that you can display the form.

8.2.3 Posting Selection Mode

The four columns in posting selection mode represent different post
triggers that specify when posting should occur for the form.

①

① Data Entry trigger

②

② Post All trigger

③

③ Print trigger

④

④ Dump trigger
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• Data Entry trigger: The selected post actions take place when a 
user enters or loads a new record, or the deletes or modifies of an 
existing record. This is the most commonly used trigger.

Note: The Data Entry trigger cannot be activated directly
by the Move From Volume and Copy From Volume com-
mands. The Enter command, which actually moves or cop-
ies the document, activates the post and therefore can be
used to trigger any posting actions that should occur dur-
ing the Move From Volume and Copy From Volume opera-
tions.

• Post All trigger: Selecting View->Post All triggers the posts in the 
Post All column for every record in a list. If the current form is a 
non-list form, the command changes to Find and Post All. In that 
case, the post functions take place for every record retrievable by 
the current form when a user selects View->Find and Post All.

• Print trigger: Any print command triggers the post functions 
selected in this column. This is often used to post a flag value into 
records showing that they have been printed.

Caution: Helix executes the posts in the print trigger col-
umn after each page has completed printing. If printing is
aborted before completion, only the records for which
printing has been completed will have had post functions
performed.

Tip: Avoid the use of Post on Print with subforms. If the
number of subform records causes the host data to repeat,
Helix may perform the posting more than once, introduc-
ing bad data into the database.

• Dump trigger: Helix performs the Post icons selected in the dump 
column when a record is dumped to a text file. This is similar to 
the print trigger in that it is typically used to insert a flag value 
into records indicating that they have been dumped.

Note: The Copy to Volume and Work on Document com-
mands activate the dump trigger.

You can select more than one icon at a time in the same column in the
posting selection lists. Drag the cursor up or down the list to select
adjacent names. Press the Shift key while clicking or dragging to
select or deselect icons without deselecting others.
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Two conflicting posts cannot be selected together in the same trigger
selection list. When an icon is selected, all conflicting icons in the
same list are grayed out.

Note: The issue of what constitutes conflicting posting
operations is a complex one. As an example of the type of
operations that conflict, assume that you have a post that
modifies Field A based on the value of Field B. You also
have a second post that modifies Field B based on the
value of Field A. The two post operations cannot be trig-
gered from the same form because there is no way to
make them work reliably together. Because they change
the values that each other needs to use, the results of such
a posting combination are unpredictable.

Clicking in the empty space below a list cancels all selections on the
list.

Every Post icon created in the relation appears in all four trigger lists
except for the data entry trigger. Post icons with Option 0 (see sec-
tion 8.3.3) selected do not appear in the data entry trigger list when
the icon posts into a selectable field on the form. This is because you
can either post to a data rectangle or type into a data rectangle, but
not both. If a data rectangle is selectable on a form, then you cannot
post a value to it.
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8.2.4 Show Data Mode

Once a form has been defined in form setup mode, you can use the
View->Show Form command to display the form in the view window.

The form indicator indicates whether or not the form is “hot” or
“cold”. Cold forms are discussed in section 8.2.4.5.

If the window is not large enough to display the entire form, either
use the grow box to enlarge the window, or use the zoom box in the
upper right corner of the window to enlarge the window to the largest
size possible.

If the form uses a template with a repeat rectangle, Helix RADE
retrieves the specified list of records. You can then…

• view the list by scrolling through it with the scroll bar.

• print the list by selecting the Print Form command from the File 
menu. (See section 4.2.10.)

• change the records displayed in the list by changing the query 
used on the form. If the collection developer selected a form or 
power query in the form setup mode, View->Open Query displays 
the query window so the user can enter new query values. (See 
sections 4.7.2.2 and 9.3.4.)

• delete all records from the list by selecting the View->Delete All. 
(See section 4.7.6.2.)

• cancel the display of the list. You can stop Helix when it is in the 
process of building a list by pressing Command-period when the 

Cold form indicator
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command cursor appears. This can be useful if you do not want 
to wait for the completion of a long listing before doing something 
else.

• trigger posting. You can trigger the post operations selected in 
the Post All column of posting selection mode by selecting View-
>Post All.

Tip: You can place check boxes and radio buttons inside a
repeat rectangle, but the boxes and buttons will display
for each record on the list and will be non-selectable.

If the form uses a template that does not have a repeat rectangle,
then you can…

• enter a new record.

• step through the selected records using the Find commands from 
the View menu. (See section 4.7.4.) 

• change the data in an existing record.

• print the form with the current selected record by using the Print 
Form command in the File menu, or print the form for all select-
able records by using the Find and Print All command in the File 
menu. (See section 4.2.11.)

• delete the currently selected record from the relation by selecting 
the View->Delete.

• trigger the selected post functions for all retrievable records by 
selecting View->Find and Post All.

“Retrievable records” refers to the set of records that satisfy the con-
ditions specified in either a query that was selected in form setup
mode or the conditions entered in a quick query. (See section 4.7.2.1
and Chapter 9.)

8.2.4.1 Entering or Changing Data
A user enters or changes data using a data entry form—a form that
does not contain a template with a repeat rectangle. (The opening of
an entry form can be triggered from a list; see sections 8.1.6.2 and
8.2.4.2.)

To enter a new record, a user types or pastes data into the fields in a
clear form, a form containing no data other than default values. 

If a record appears on a form, you can clear the form by choosing
View->Clear Form. 
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When a user presses Enter to store a new record, Helix clears the
form automatically, allowing the entry of another new record. (For
any exception, see the discussion of Option-Enter at the end of this
section.)

A user can select a field for data entry by clicking in the area defined
by the field’s data rectangle on the form’s template, unless Allow
Click has been deselected for that field. (See sections 4.6.5 and
8.1.4.6.) If the cursor is inside a field area that can accept data entry,
it changes from an arrow to an I-beam (see section 3.2.6), except for
those areas defined as picture data type. 

Some fields, such as those that contain abacus icons but no field
icons or those that have had Allow Click, Allow Tab, and Allow Edit
removed (see sections 4.6.5, 4.6.6, 4.6.8, and 8.1.4.6), cannot accept
entry from the keyboard. The cursor does not change shape when
inside these field areas, nor does pressing the Tab key select the
fields.

You can use the Tab key to advance to the next entry field. However,
fields can be excluded from tab order by deselecting Allow Tab. (See
sections 4.6.6 and 8.1.4.6.)

Tip: If no field has been selected on a view, pressing Tab
selects the home field, the first field for which Allow Tab
has been selected.

Caution: Do not use the Return key to move to the next
field. Return does not advance the text insertion cursor to
the next field area. Instead, it enters a carriage return as
part of the data being entered into the field. You must use
the Enter key on the numeric keypad to store a record and
the Tab key to move to the next field.

When leaving a field area, Helix validates the data in the following
ways.

• Helix first checks the value against the field’s data type. If the data 
are not of the correct type, Helix sounds a beep and provides a 
Why? message.

• Helix next checks any validation that is specified for the field. If 
the data do not meet the validation criteria, Helix sounds a beep, 
selects the contents of the field, and provides a Why? message. 
(See section 7.1.5 for more information on data validation.)
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• Finally, Helix checks any format specifications that have been 
chosen for the field. Helix redraws the entry to conform to the 
specified format.

An invalid entry must be corrected before Helix will allow tabbing to
the next field. However, a user can select another field by clicking in
it with the mouse pointer. If the Shade Invalid Fields option is on,
Helix shades a field with invalid data if the user selects another field.
Under no circumstance does Helix allow entry of the record into the
database with invalid data in a field.

In general, the tab order in a form moves from top-left to bottom-
right. If the top edges of the rectangles are precisely on the same line,
the cursor advances from left to right. However, if the alignment var-
ies, you may find that the cursor visits fields in what may sometimes
seem to be an out-of-order sequence. (See section 8.1.4 for more
information on the tab order of data rectangles.)

If the form is larger than the window in which it is displayed, the win-
dow scrolls automatically as the user moves the cursor from field to
field with the tab key. This eases the use of very large data entry
forms.

When the user changes the contents of a field area (either entering
new data or modifying existing data) Helix reevaluates all visible
dependent calculations as soon as the user selects another field.
This may involve the complete redrawing of any dependent sub-
forms.

When the user tabs out of the last selectable field on a form, the cur-
sor returns to the first field on the form into which a user can tab.

You can hold down the Option key when pressing the Enter key or
when choosing View->Enter. If you do so, Helix does not clear the
form after storing the record. Instead, the record remains visible.

Tip: The preceding is especially useful in a Client/Server
application when, for example, a Max+1 based calcula-
tion (see section 10.6.1.9) is being used to number items.
The final value of the Max+1 calculation cannot be deter-
mined until a user presses the Enter key because other
users can be entering records at the same time. However,
if a user uses Option-Enter, the final value of the calcula-
tion remains visible and can be used, for example, if an
order entry clerk needs to give a customer the assigned
invoice number.
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Holding down the Option key during a Replace operation (which usu-
ally follows a Find) inhibits the normal behavior (advancement to the
next record). Instead, the values of the modified record remain visible
on the screen. The user must then perform a manual Find operation
to view the next record or choose View->Clear Form to enter a new
one.

You can obtain the same effect as holding the Option key when press-
ing Enter in a sequence by using the Static Enter command. The
Option key cannot be used to make an Enter step in a sequence into
an Option-Enter, however, because the use of the Option key when
executing a Sequence controls the presentation of dialogs (see sec-
tion 6.6.6).

When a user performs a clear form on an entry form, the flag fields on
that form are undefined unless the field has been given a default
value. An undefined flag can be displayed several ways. A check box
that is undefined is displayed as a grayed box. A radio button that is
undefined has the Undefined button selected in a three button dis-
play or has no button selected in a two button display. A text format-
ted flag field is empty when undefined.

As an alternative method to selecting a check box or radio button
with the mouse, you can use the keyboard to enter data into a flag
field, regardless of the data entry format of the field. Pressing the Y, T,
or 1 key selects “yes” and choosing N, F, or 0 selects “no.” If you give
new label names to the yes and no options (such as Complete and
Incomplete) you could press C for yes and I for no. If the collection
developer did not select Custom Labels Only, you can type Y, T, or 1,
or N, F, or 0 in addition to the first letter of the label name. Press the
Delete key to set radio buttons or check boxes to undefined.

Changing the font, style, or color of a styled text field is equivalent to
modifying data.

8.2.4.2 Opening an Entry Form from a List
If a collection designer has attached an entry form to a list, the mouse
pointer changes to the Retrieve cursor ( , see section 3.2.8) when
you move the mouse pointer over the records in the list. Double click-
ing anywhere in a record opens the preselected entry form and dis-
plays the record.
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The attached entry form must be displayed on a view.

The record can now be modified or deleted. If the collection devel-
oper chose the AutoClose option in the repeat rectangle dialog box,
the entry form closes automatically when the user presses Enter,
chooses View->Replace, or clicks the Replace button in a dialog box.

Because any command available on a menu can be used while such
an entry form is open, a user can clear a form and enter a new
record. Keep in mind, however, that the use of the Enter command,
or the Enter key or button in a dialog box, closes the form if the Auto-
Close View option was selected in the repeat rectangle dialog on the
template.

8.2.4.3 Selectable Lists
A user can select one or more records on a selectable list and then
dump, post, print, copy, or delete those records.

Select a single record by clicking on it.

There are two ways to select multiple records.

• To select a range of adjacent records, click on the first (or last) 
record to set the anchor point. Then Shift-click on the last (or 
first) record. Helix selects all records between the two anchor 
points automatically.



View

8-69

To deselect groups of records, Shift-click. The Shift-click operation
bases the new range on the last anchor point.

You can also select a range of records by drag-selecting them,
including dragging across page boundaries. The rules regarding a
Shift-clicked range also apply to a drag-selected range.

• To select multiple records, click the first record and then Com-
mand-click each subsequent record. Individual records can be 
deselected by Command-clicking.

When you select and double click one or more records, one entry
form opens (see section 8.2.4.2) and displays the first record selected
on the list. The Find commands step through the remaining records
in the order of selection. Helix ignores any query or index attached to
the entry form opened from a user selectable list. In addition, any
records you might enter using the view after performing a Clear Form
will not be selected on the list, and therefore cannot be retrieved with
a Find command on the entry form. Edit->Clear Selections returns the
entry form to its attached query and index.

Tip: Edit->Select All Records or drag-selecting is more effi-
cient for large numbers of records than shift-clicking.

Deselect a single record by Command-clicking on it. To deselect all
selected records, click outside the bounds of the repeat rectangle.

8.2.4.4 Asynchronous Lists
When you open a list in Custom Mode, the list builds in the back-
ground. You can switch to a entry form or another list while the first
list is building. You can stop background list building by closing the
list. Any command buttons on the list are dimmed until the list is
complete. Multiple asynchronous lists can build simultaneously.

A list will not build asynchronously if…

• you are in Full Mode.

• the list is opened by a sequence.

• the list has an Abacus outside the repeat rectangle that contains a 
Summary tile—with the exception of Lookup Summary—a Sub 
tile, a Form tile, or a positional tile.

8.2.4.5 Cold Forms
When used as a Client/Server application, Helix constantly updates
all open forms on the network. This is a form of concurrency control.
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Its purpose is to ensure that no one makes decisions about modifying
data based on data that may have been modified by another user.

Note: In earlier versions of this manual, Helix’s updating
of all open forms was incorrectly called referential integ-
rity. Referential integrity is a data integrity rule that states
that all non-null foreign keys must reference existing pri-
mary keys. It is a way of ensuring consistency among the
logical relationships in the database and can be enforced
through field validation using an abacus containing a
Lookup tile.

You can turn off Helix’s constant updates on a form-by-form basis by
deselecting the Keep Current command from the √ menu (see section
4.6.22).

Helix calls this type of form a cold form. Helix does not update
a cold form with changes made by other networked users
while the form is open on the screen. A cold form’s indicator
is black.

The major justification for using a cold form is to improve perfor-
mance. The constant updating of all open forms consumes network
bandwidth and slows down all operations. This is one reason why
Client/Server users should be advised to keep the smallest possible
number of forms open. However, there is a real danger of concur-
rency control problems, in particular, the loss of data that occurs
when a users makes an update that does not take into account
another user’s update, with a cold form. It is therefore up to each col-
lection designer to determine when the increased performance with
a cold form justifies the risk of lost updates.

To refresh a cold form, use the Refresh command or click the form
indicator. The Refresh command is a special use command that is
accessible only from a custom menu.

When a form query is attached to a cold form, the records displayed
on the cold form do not update until the user issues a Refresh com-
mand, even when the form query is hot.

8.2.5 The View Menu

The View menu contains commands that are integral to using views.
See section 4.7 for a detailed explanation of these menu items.
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8.2.6 Form Memory

When a user opens a view, Helix remembers the specifications cho-
sen for the view. The user can then select another view and choose
different specifications. Helix remembers the following form proper-
ties.

• Form selections: Helix remembers the selections made in form 
setup mode.

• View display: Helix remembers the mode in which you last used a 
view and reopens the view in that mode the next time you use the 
view. There is one exception. For more information, see section 
8.2.7, Invalidated Views.

• Dump and load parameters. Helix remembers the options you 
choose when you perform either Dump All... or Load. The selected 
form remembers these options, regardless of future option 
changes for other forms. Of course, the specified options for a 
form can be changed at any time. Simply open the form and then 
make the option changes.

• Shade Defaults, Shade Invalid Fields: Helix remembers the state of 
the Shade Defaults and Shade Invalid Fields menu options for each 
form. The next time someone uses the form, Helix uses the previ-
ously selected properties.

• Page Setup: When a collection developer makes selections in the 
Page Setup dialog box for a template, Helix remembers the dialog 
box settings. This includes special label printing parameters set 
up with the Custom Paper command. The choices made for this 
template affect other forms that use the same template but do not 
affect other forms using a different template.

• Page numbers: Helix stores page number specifications, including 
the starting page number, with a view. To use this option, first 
select an open form. The Starting Page # command is then avail-
able in the Set menu. Select the command and change the number 
in the text edit box as desired.

• Selected records: Helix remembers the record displayed on a data 
entry form and any records that are selected on a listing form.

8.2.7 Invalidated Views

Sometimes one of the icons used on a view becomes invalid as the
result of changes made to the structure of the collection. If this hap-
pens, any view using the icon will also become invalid. If Helix RADE
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is in Full Mode when someone opens this invalidated view, Helix dis-
plays the view in form setup mode with the invalid icon deselected. If
Helix RADE is in Custom Mode, Helix dims any menu items that use
the view. The menu items cannot be used until a collection developer
modifies the form so that it is configured with valid icons.

8.2.8 View Window Notes

The selections made in the form setup mode or posting selection
mode can be changed in Full Mode. You can deselect items in a col-
umn by pointing the cursor to the white space below the last entry in
the column and clicking.

Various interruptible actions may occur that display the Command
cursor (see section 3.3.1). You can stop these actions by pressing
Command-period. In most cases the form closes.

When a view icon is selected in the relation window, selecting
View->Show Setup goes directly to the form setup mode. You can use
this technique to avoid delays when trying to change forms that are
currently displaying a listing.

If data have been entered or modified but the record has not yet been
stored, and the user closes the view, clears the view, or issues the
Post All or Find command, an alert appears to give user the opportu-
nity to store the data before Helix closes the window. Otherwise,
Helix discards the changes.

8.2.9 Custom Windows

The custom window feature lets a collection designer choose among
six window types and as many as seven attributes to change the
appearance of view and form query windows.

The six window types are document, alert, plain, shadow, invisible,
and rounded. The attributes that can be turned off or on are close
box, zoom box, horizontal scroll bar, vertical scroll bar, grow box,
status box, and show page boundaries.

The Icon->Set Window Type command is available when you have
selected at least one view or form query icon in a relation window,
and the relation window is in the foreground.

If the selected icons’ windows are open when you choose Icon->Set
Window Type, these windows close automatically if no data have
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been entered or modified. If data have been entered or modified, a
dialog box appears asking if you want to save the changes made to
the window. If you select Yes, Helix stores the entered or modified
data and closes the window. If you select No, the window closes with-
out storing the data. Selecting Cancel aborts the Set Window Type
command.

You can set the same window attributes for multiple windows at once
by selecting multiple view and/or form query icons.

8.2.9.1 Window Types

The icons displayed in the Window Type column represent the
options available for the border of the selected view or form query
window(s). Select a window type by clicking on the desired icon.
Whatever border type and attributes you choose apply to all view
and/or form query icons selected in the relation window.

8.2.9.2 Window Attributes
The items listed under the Window Attributes column let the collec-
tion designer change the appearance of the view or form query win-
dow(s) within the window borders. If an attribute’s check box is
deselected, that particular attribute is not displayed.
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Here is a typical view window with its attributes labeled.

In this example, the scroll bars could be removed because the view is
used to display only a small amount of data. The scroll bars therefore
serve no purpose.

To remove the scroll bars, deselect both the horizontal and vertical
scroll bar check boxes. When a user opens the view, it appears as fol-
lows.

Different window types have different window attributes. For exam-
ple, the plain window type has no place for a close box or a zoom
box. Consequently, if you choose plain as the window type, Helix

①

① Close box

②

② Zoom box

③

③ Show page boundaries

④

④ Vertical scroll bar

⑤

⑤ Grow box

⑥

⑥ Horizontal scroll bar

⑦

⑦ Status box
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dims the check boxes for the close box and zoom box attributes,
making the attributes unavailable.

Tip: When you close the Set Window Type dialog box, all
windows that closed automatically when you opened the
dialog box reopen. The windows may reopen behind the
relation window, so you may need to move or close the
relation window to see the custom forms.

8.2.9.3 Custom Window Color
The Icon->Set Window Color lets a collection designer change the
color of various parts of a view or form query window.

Choosing Icon->Set Window Color opens the Window Colors dialog
box.

The color specified for background determines what will show in the
areas of the form not occupied by rectangles. This is not the same as
the color of a background label rectangle.

Frame specifies the color of the outline of the window.

Title Bar controls the color of the background of the title bar. This
setting is most prominent on solid colored title bars, such as the
rounded type.
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8.2.9.4 Custom Window Design Notes
The Close command is available from the menu and in sequences
even when a window is designed with no close box.

You can use the window area where a scroll bar is normally located
for content, such as label or data rectangles, only if you also sup-
press the grow box, and, for the horizontal scroll bars in a view, the
status box.

To facilitate design in Full Mode, you can resize windows with no
grow boxes. Position the cursor in the lower right hand corner of the
form where the grow box would normally be and hold down the
Option key. The window can be then resized as if it had a grow box.

Similarly, if you hold down the Command and Option keys in Full
Mode, the cursor changes to a move window cursor so that you can
move a window without a title bar.
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8.3 Post
The post icon lets users and application designers set up forms in
which certain form operations (in particular, enter, delete, print, and
dump all) make modifications to data not viewed on the screen. For
example, a window that generates an invoice can automatically sub-
tract the quantity of each item sold from the appropriate inventory
records through the use of posting. Similarly, changes in a customer’s
order can result in misordered items being added back to stock while
the newly ordered items are subtracted, all automatically through
posting.

All data manipulation in Helix RADE is ultimately form based. Ordi-
narily, when you put data onto a form and store it, Helix creates a
record in the relation where the entry form resides. Posting, however,
lets records other than the one being manipulated on the screen by a
user be changed or created at the same time. The records affected by
the post may be in the same relation, or in any other relation in the
collection.

Caution: Posting is a very flexible and powerful tool. For
this reason, a collection designer should test posting func-
tions thoroughly to avoid unwanted changes in the data-
base. Helix RADE contains safeguards against certain
types of logical errors in posting, but the very nature of
posting requires the ability to affect unseen records auto-
matically. Application designers should make sure that
posting is having the desired effects under all circum-
stances.
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8.3.1 Components of the Post Window

The Post icon window consists of four primary components:

• Posting tile: The posting tile is a specialized Lookup tile that iden-
tifies the records that will be affected by the post.

• Options dialog box: Posting options determine whether records 
should be modified, created, and/or deleted.

• AutoOpen View dialog box: The AutoOpen View dialog box deter-
mines which, if any, form opens when posting occurs.

• Triplet select and display area: The triplet selection and display 
area determines which actions should be performed on which 
field or abacus icons.

8.3.2 The Posting Tile

A collection developer uses the posting tile to specify which record
or records should be the target (destination) of a posting function. In
a general sense, the posting tile operates much like a Lookup tile (see
section 10.11.1) in that it finds specific records in another relation
based on matches between values of linking icons, but for the pur-
pose of adding or changing data in them rather than retrieving data.

The posting tile differs from a calculation tile of the type found inside
an abacus in that it is defined through the use of a dialog box instead
of by dragging objects into the black holes of the tile. Icons specified

①

① Posting tile

②

② Options

③

③ AutoOpen View

④

④ Triplet select and display area
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in the posting tile dialog box appear in the tile’s black holes when you
close the dialog box. 

To open the posting tile dialog box, click on the tile or on the Set Des-
tination button to the right of the tile.

Each posting tile hole is represented in the dialog box by an icon
selection list.

• The right list contains the names of all relations in the collection. 
Select the relation that contains the target records (the recipients 
of the posted data). This will be the target relation.

• The middle list contains the names of possible linking objects 
from the current (source) relation. You can choose either a field or 
abacus icon as the source linking object. Clicking on the icon 
switches above each list causes the list to display icon names cor-
responding to the switch type.

• The left list contains the names of possible linking objects in the 
target relation. This list remains empty until you choose a target 
relation. At the top of the list are icon switches that control the 
display of either field or abacus icon names.

Note: Document and picture type fields do not appear in
linking lists because they cannot be used as the linking
field in a posting operation.

①

① List of relations in the collection from which you choose the target relation

②

② List of all possible linking objects (fields or abaci in the source relation

③

③ List of all possible linking objects (fields or abaci) in the target relation

④

④ Radio buttons that determine whether the post affects the first matched 

record or all matched records
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The icons selected in the left (target icon) and middle (source icon)
selection lists must be of the same data type. If you choose an icon
that has a data type different from an icon already selected in the
other list, Helix deselects the icon in the other list.

If you have selected an icon and then click the switch at the top of
the list to display the other icon type, the name of the first selected
icon appears just above the listing area. This lets you see the current
selection while viewing the name list of the other type.

The posting tile finds and performs the specified posting operations
on the record(s) in the target relation for which the value of the tar-
get icon link (first hole) is equal to the value of the source icon link
(second hole).

You do not need to fill in all three holes of the posting tile. The post-
ing options (see sections 8.3.3 and 8.3.7) available depend on which
holes are defined and which holes are undefined. There are three
functional states possible.

• If all three holes are filled then posting creates, modifies, or 
deletes target records according to the selected posting option. 
This is the typical usage.

• If the third hole (relation) is defined but the first hole (target link) 
is not filled, then Helix can only create a new record in the target 
relation. Since incomplete linking values are provided, no match 
with existing records is possible. Therefore, posting cannot mod-
ify or delete existing records. The second hole can be filled, how-
ever. Helix RADE then creates a record in the target relation only if 
the icon in the second hole has a defined value for the currently 
selected record (conditional posting). 

• If the Relation hole (third) is undefined (black), Helix performs an 
Option 0 post. With Option 0 posting, Helix assumes that the cur-
rent relation is the target and that the current record is to be 
modified. Helix therefore posts to the last stored record. If the 
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second hole is filled, then posting occurs only if the icon filling the 
hole has a defined value for the currently selected record. 

Some combinations of icons and black holes are either logically
impossible or meaningless and are not allowed by the posting tile.
For example, since the first hole is dependent upon the last hole, a
selection of only the first, or only the first and second holes is impos-
sible. Also, specifying only the first and last hole is meaningless, since
there is no value in the second hole (source icon) for comparison. If
the tile dialog box is not valid, Helix dims the OK button.

The two posting tile buttons determine whether a post affects one or
many records.

• Post First directs the posting tile to stop after finding the first link-
ing match. The first matching record then becomes the target of 
posting. This is the default setting.

• Post Every directs the posting tile to continue searching after the 
first linking match is located and posted. Helix posts to every 
record in the target relation that has a linking match. In other 
words, Post Every posts to multiple target records.

The icons selected in the posting tile dialog box provide a search key
to select whole records to be modified. You specify the actual fields
affected by posting in the triplet selection/display.

8.3.2.1 Posting Tile Notes
If the OK button in the posting tile dialog box is dimmed, you have
chosen a target relation and link but no source link.

Linking icons can pop out of the posting tile holes if you change the
icon’s internal structure. The post icon is invalid until fixed. There are
three possible causes.

• The data type of the icon has changed, making it incompatible 
with the other linking icon.
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• A target abacus icon has changed so that it now contains a Form 
tile.

• A field icon used as a linking icon has been made inert.

A tile with a popped out icon causes an alert to appear when you
close the post window.

8.3.3 Post Options

The post options control when a post operation creates, modifies,
and/or deletes records. Helix has two basic data entry operations,
enter/replace and delete. Correspondingly, posting can do two things
to target records, create/modify and erase. There are four possible
combinations of form events and posting functions, plus one special
case (Option 0).

Note: When you trigger a post operation through Print,
Dump All, or Post All, Helix initiates posting as if source
record(s) were being entered. Therefore, those items that
apply to enter/replace also apply to Print, Dump All, and
Post All.

Note: The Copy To Volume and Work On Document com-
mands activate the Post on Dump trigger.

Options changes are made with the Options dialog box. To access
the Options dialog box, click the Select Option button or click on the
Option display area located below the Select Option button.

The top of the dialog contains the four option switches. Each switch
is divided into two areas. The top area contains the post operations
Helix performs if the form action is enter/replace; the bottom area
contains the post operations Helix performs if the form action is
delete. 
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If the posting tile contains no target relation, the Set Options button
remains dim and Helix selects Option 0 automatically as the post
option.

The posting options are as follows.

• Option 0—Current record posting: Option 0 posts modify the cur-
rent record. It is available only when the posting tile does not 
have a target relation and cannot be selected from the Options 
dialog box. You can use Option 0 to post only to fields in the 
record that are either non-selectable on the form or do not appear 
on the form.

Option 0 posts are done before any other posting operations
attached to a view. Thus, the results of an Option 0 post can be
used by other non-Option 0 posts.

To select Option 0 after choosing another option, deselect the
relation in the posting tile dialog box.

• Option 1—Modify only: Option 1 posting assumes that all of the 
records being updated already exist. If Helix cannot find a record 
that satisfies the linking icons, no posting occurs.

• Option 2—Modify on Delete, or Create or Modify on Enter: If Helix 
finds a linking match, it performs the posting operations on the 
existing record. If there is no linking match, Helix creates a new 
record in the target relation and performs the posting operations 
on that newly created record. If the source record is deleted, then 
any previous increment and decrement operations performed on 
the target record are undone (see section 8.3.6). Option 2 is the 
default option because it is the most common choice for posting 
to records in other relations.

• Option 3—Erase on Delete; Create or Modify on Enter: If the user 
deletes the source record, Helix RADE deletes the target record. 
Otherwise, on enter, Helix RADE modifies an existing record if it 
finds a linking match, or creates a new record if there is no linking 
match.

• Option 4—Create or Modify on Delete; Erase on Enter: Option 4 
posting has the opposite effect of Option 3. If a user deletes the 
source record, Helix RADE modifies the target record if there is a 
linking match. Otherwise, Helix creates a new target record. If the 
user enters or modifies a source record, Helix RADE deletes an 
existing target record with a linking match.

Option 4 posting can delete records from the source relation as
they are being dumped, printed, or posted to another relation.
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8.3.3.1 Posting Option notes
The posting tile finds target records. Options specify how Helix RADE
should handle target records, either creating a new record, modifying
an old record, or deleting an old record.

When you close the Option dialog box, Helix displays the option you
chose in the Options display area.

8.3.4 AutoOpen Forms

The lower right of the Options dialog box contains a selection list
that lets you choose a default target form, called an AutoOpen form,
for Options 2, 3, and 4. An AutoOpen form is a target record form that
opens automatically during posting. A user can then enter data into a
target relation. When you select a target form in the Options window,
its view icon appears in the post icon window.

For example, assume that a user is entering an order that will be
stored in the Orders relation. However, the customer placing the
order is a new customer and therefore has no data in the Customers
relation. When the user attempts to store the order, an AutoOpen
form opens, presenting a data entry form for customer entry. The
user enters the customer data, stores it, and returns to entering the
order. This is much more convenient for the user than requiring him
or her to locate a menu item for a customer form.

The Options window of each post icon contains an AutoOpen form
selection list that lists the names of views available in the target rela-
tion. Choose a view from this list to designate the AutoOpen form.
Helix will then display the form’s view icon in the Posting Option area
in the post icon window.
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Once you have selected a form as an AutoOpen form, Helix opens the
form during option 2, 3, or 4 posting when it cannot find a posting tar-
get record. If Helix finds a target record, the AutoOpen form does not
open.

Opening an AutoOpen form suspends normal posting. Helix opens
the AutoOpen form, the user enters data into the form, and presses
Enter to store the data. However, Helix does not restart the posting.
When a user returns from an AutoOpen form after storing data, Helix
has not stored or deleted the source record. The user must store or
enter the source record to restart posting. Data entry therefore
becomes a three step process: Store or delete source data, store tar-
get data, store or delete source data.

8.3.4.1 AutoOpen Form Notes
An AutoOpen form must be an entry form, not a listing form.

A post icon can have only one target relation, and only forms in that
relation are available as AutoOpen forms. 

When you select an AutoOpen form under Options 2, 3, or 4 and a tar-
get record is not found, the form opens automatically for certain com-
binations of an input command (enter, replace, delete) and an option
(2, 3, 4). Specifically, an activated AutoOpen form opens in eight of
the 10 cases labeled “Create, do” in Table 8.9.

Any source data values posted with the insert operators appear on
the opened form, if the appropriate fields are present. Usually such
inserted values include a search key that links the source record with
a target record in the relation containing the AutoOpen form. While
that form is open, a user can enter data values in the other fields on
the form, which are really fields of the target relation.

When an AutoOpen form opens, data entry becomes a three step pro-
cess (attempt to store source form data, store AutoOpen form data,
store source from data). This is also true for replace under options 2,
3, and 4 in the five cases indicated in Table 8.9. When a target record
is not found during an option 4 post with an AutoOpen form, deleting
a source record also requires three steps (attempt to delete source
form record, store AutoOpen form data, delete source form record).
Helix does not complete posting and entry (replacement, deletion) of
the source record until the third step is taken.

An AutoOpen form must be displayed on a view to work. If it was last
closed in form setup mode or posting selection mode, posting occurs
as though no AutoOpen form were selected.
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AutoOpen forms are not triggered by print, post, dump all, load, or
delete all, but are triggered by option 4 deletes.

A given target field can receive data directly from an entry on an
AutoOpen form, and then subsequently receive further data from
posting by the source form. (For example, a post might add two num-
bers.) In general, it is not a good idea to both enter and post data to
the same field using the numerical (non-insert) operators with
AutoOpen forms. More commonly you use the insert operators to
place values in fields on the AutoOpen form (for example, a customer
ID), and then let the user enter data in the remaining fields. Also,
Helix does not display values posted with the numerical operators
on an AutoOpen form, but posts them during the final source entry
step to the record created by storing the AutoOpen form.

If you are using an AutoOpen form with option 3 posting, do not sub-
sequently change the source record search key with replace. If you
do, be aware that you may be losing the nonposted data in that
record. When you change the search key and no target record exists
with the new key, Helix RADE deletes the old target record and cre-
ates a new target record using the replacement data. Nonposted
fields are not passed through to the new record.

8.3.5 Triplet Selection and Display

In the lower left corner of the post window is a
compound selection list. This three part list
defines each item of source data, each target
field in the target relation, and the operator
that determines the posting operation to be
performed for each target field. This combina-
tion of three items is called a posting triplet,

and the compound list where you define triplets comprises the trip-
let selection and display.

You can switch the triplet selection/display between two operational
states, one for triplet selection where you can view only one triplet
construction at a time (selection view), and one for displaying a list of
all completed triplets (display view). Before you make any selections,
the list appears in its display view, with no operators showing.

The target field list on the right displays all fields in the target rela-
tion. Select each field into which you will be posting, one at a time.
When you select a field, the corresponding possible triplet operators
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appear in the middle list and applicable source icons appear in the
left list.

The triplet operators in the middle are the post operators that are
applicable to the selected target field. During triplet construction this
area is blank until you select a specific target field, in which case the
list displays an array of operators from which you can choose. In dis-
play view, you can see all completed triplets, in which case the list
shows only the operator selected for each triplet.

The left hand list contains source data, represented by either field or
abacus icon names, that may be selected to supply the source data
that are to be posted to the target field. During triplet construction,
this area remains blank until you select a target field name in the right
list. When you are constructing a triplet, Helix displays only the field
or abacus icon names having a data type compatible with the target
field. To switch from one icon list to the other, click on the icon
switch at the top of the list. If an icon name is already selected in the
other list, the selection appears at the top of the list for reference.

In display view, Helix shows all completed triplets. Items of a different
type than the selected icon switch are shaded.

8.3.5.1 Triplet Selection Example
In the following example, assume that you have defined the post tile
and selected option 2 posting. Although this example mentions spe-
cific post operators, they are not described here. For a detailed expla-
nation of each operator, see section 8.3.6.

When you select a field icon in the right (tar-
get) list, the compound list shifts to detail view,
in which the left list shows all of the field or
abacus icons of the same data type in the
source relation. The left icon list specifies
source data items that are to be used by the
posting operation. 

The icon selected in the source relation must be of the same data
type as the icon in the target relation, except that a date target field
allows both date and number types in the source relation. These
rules are enforced by the behavior of the two icon lists. Note that the
source icon can be either a field or an abacus. The icon switch at the
top of the left list allows display of either a list of field icons or a list
of abacus icons of the appropriate data type.
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In the compound list to the left, someone has
selected a target field called 01-[N] Record …
in the right list. This field has a number data
type. Therefore, selecting it causes six source
fields of the same data type to appear in the
left list.

When you first select an icon in either the left or middle list, march-
ing ants (horizontally scrolling dots) appear in both lists to remind
you that one of these is still unspecified. Once you make a selection,
the marching ants stop, and the posting operation for that target field
is complete. 

In this example, posting will insert a new num-
ber into a field (01-[N] Record …) using the
Insert New (Insert in a created record) opera-
tor ( ). First, you select the source abacus
(Next Nº). Marching ants appear because the
operator has not been selected.

Selecting the Insert New operator ( ) com-
pletes the posting specification for this pair of
source and target fields.

To go back to the display view, click in the
empty space below the field icon names in the
right (target) list. The selected combination of

source field (or abacus), posting operator, and target field appears in
a single line.

You do not need to switch to display view after
each triplet selection.

Repeat the preceding process for each target
field that is to be modified by this posting icon.

To specify that a target field should not be
changed by this posting, either do not select it in the display view, or
if it was previously specified in the display view, select it again and
deselect the source and operator choices. Specifications for a given
target field can be changed at any time by selecting it again.

Source field and abacus icons selected for posting are now displayed
in the left list. With the field icon switch selected as shown above,
field icon names are displayed normally and any selected abacus
icon names appear lightly shaded in the same list. Selecting the aba-
cus switch shades any selected field icon names.
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8.3.6 Post Operators

The post operators are represented by the column of symbols,
seen here at the left, in the middle of the triplet selection and dis-
play area. Each operator specifies how the source field is to
affect the target field. Operators include addition, subtraction,
two combinations of increment and decrement, insert into newly
created target record, and insert into either a created or modi-

fied record.

While post options specify how Helix RADE should enable or limit the
changes to the target record as a whole, the post operators specify
the individual posting action taken by each item of source data on
each target field.

These six posting operators work in conjunction with the five post
options discussed in section 8.3.3, the linking target field, and the
data type of the target field. In other words, the operators available
for a specific target field depend on the data type of the target field
(regardless of whether the target field is also the target linking field)
and the selected post option.

The operators can be divided into two types: four single action oper-
ators (addition, subtraction, insert on create, insert on both create
and modify), and two dual action operators (increment, decrement)
that have a before (undo) and after (do) action.

The add/subtract and increment/decrement operators only have
meaning for number and fixed point fields and abaci. For other data
types, you can use only the insert operators can be used.

The six post operators are as follows:

•  Increment a value by the source value.

Increment is one of the two dual operators. When you replace a
source value, the increment operator can performing two sepa-
rate operations in sequence: a before or undo operation that uses
the data as they previously existed in the source record, and an
after or do operation that uses new or changed data in the source
record.

When the user stores a new record, the increment operator incre-
ments the target field by the value of the current source data.
However, if the target field has been previously incremented by a
source value from the current record and a user subsequently
replaces the value in the source record, then the increment opera-
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tor first decrements the target field by the value that the target
field was previously incremented. In other words, if the target
field in the target record has already been posted to from an exist-
ing source record, and if the value of the source data are changed
or modified, Helix RADE backs out, or undoes, the old incre-
mented value from the target field and increments again, using
the new value.

This dual action feature lets you keep accurate posting target
totals no matter what data manipulation occurs to source records
that have already contributed to the total. As an example, assume
the following sequence of actions.

1. A target field contains a value of 10.
2. A user enters a new record containing a source data value of 3. 

The post operation increments the target field in the target record 
by 3. The new value in the target field is 13.

3. Sometime later, the user retrieves the source record and changes 
the source data value is changed to 4.

4. When the source record is stored in the relation, the post opera-
tion first subtracts 3 (the old source value) from the target field 
and then increments the target field by 4. The target field value is 
now 14.

The increment operator is available only when the target field has
a number or date data type.

•  Add entry value to a value

The add operator adds the source value to the target value. If you
are replacing or deleting the source value, Helix does not decre-
ment the target field value by the previous source value first.

This operator is available only when the target field has a number
or date data type.

•  Insert in a created or modified record

This insert operator assigns the source value to the target field,
inserting the value if the target field is empty or replacing the
value if one is already there.

This operator is available for all target fields regardless of data
type.

•  Insert in a created record
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This insert operator assigns the source value to the target field
only if the target record is created by the posting function.

This operator is available for all target fields regardless of data
type.

•  Subtract source value from the target field

This operator subtracts the source value from the target value. If
the you are replacing or deleting the source value, Helix will not
increment the target field value by the previous source value first.

This operator is available only when the target field has a number
or date data type.

•  Decrement a value by the source value

This operator decrements the target field by the source value.
This is one of the dual operators and has a double action, undo
and do, just as the increment operator. See the increment operator
for a detailed explanation of the operations performed by these
two operators.

This operator is available only when the target field has a number
or date data type.

8.3.7 Post Summary

A completed specification for a post function is an interaction of the
individual specifications in each of the post icon’s three areas (post
tile, option, and triplets). This section summarizes those interac-
tions.

• The post tile specifies to which target records, if any, the post icon 
should apply the specified post functions. Which holes in the post 
tile are defined, if any, and which holes are left undefined, if any, 
determine what options are available. 

Define the post tile before any other part of the post icon.

• The post option specifies how Helix should behave given specific 
user actions and circumstances. For example, Helix’s actions dif-
fer when the post tile finds a target record and when it does not 
find a target record. Post actions also differ when the user deletes 
a source record, or enters or replaces a source record. 
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Certain definitions of the post tile preclude certain post options.
Table 8.1 shows the interaction between a specified post tile and
the options available for it.

Select the post option second, after the post tile has been defined,
since option choices depend on the state of the post tile.

• The Triplet selection/display specifies which fields are to receive 
source data, how they are to receive it, and from where the 
source data is to come. Interactions exist between the source 
icons and the target field, the target field and post operators, and 
the linking target field and the operators.

The source icon must have a data type compatible with the target
field. This means that if the target field has a text data type, only
those source icons with a text data type can be posted to the tar-
get. Using an abacus with the appropriate conversion tile solves
most compatibility problems, but be sure that the data existing in
the relation can legally be converted to the target field data type.

The operators available for a target field depend on the data type
of the target field. If the data type is text or flag, then only two
operators are available: Insert and Insert on Create only. Number
and date data types have all six operators available.

Note: If the target field is also the target linking field, then
the only operator allowed is Insert on Create only. This is
because the linking target field must not be allowed to
change while posting is occurring. This means that when
you select a linking target field in the triplet selection/dis-
play and you choose post option 1, then no post operators
will be shown in the center column.

Target Link Source Link Target Relation Options

empty empty empty 0

empty filled empty 0

empty empty filled 2,3

empty filled filled 2,3

filled filled filled 1,2,3,4

Table 8.1 Post tile states and available posting options
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8.3.8 Posting and Data Validation

Data validation is active only at the posting source. Helix bypasses
validation that may have been specified for the target fields when
those fields are posting targets. Therefore, you must take care at the
source record to ensure that when data are posted, they are not
invalid data from the target record’s point of view.

Caution: No validation is in effect when posting using the
Post All, Print, or Dump All triggers.

8.3.9 Posting: Technical Reference

This section is a reference guide to posting actions in Helix RADE. It
assumes a general familiarity with Helix RADE post options and oper-
ators. You will find an exploration of the concept of before and after
operations as well as a table that provides a definitive reference for
the numerous possibilities of posting actions/reactions.

Posting operators specify exactly how source field or abacus data are
to be posted into a given target field. There are six posting operators,
four of which perform a single operation and two of which are dual,
performing two operations in sequence.

The two dual operators are increment ( ) and decrement ( ), each
capable of performing two separate operations in sequence: a before,
or undo, operation performed on the data as they previously exist in
the target record, and an after, or do, operation performed on the cor-
rected record. This dual nature allows these operators to undo a pre-
vious posting and then do a current posting when a user changes the
data in a source field.

For example, suppose you reduce an inventory quantity of 500 by fill-
ing an order for 100 using the decrement operator. The inventory
value for that item is now 400. Later, the customer increased the
order to 200, and the 100 is replaced by 200 in the source relation.
The decrement operator first adds back, or increments, the inventory
by 100 to undo the original posting (100 + 400 = 500). Then it decre-
ments the corrected order quantity by 200 to do the new posting, giv-
ing a final inventory count of 300 (500 - 200 = 300).

The four single operators are addition ( ), insert on create or modify
( ), insert on create only ( ), and subtraction ( ). Create and modify
refer to the creation or modification of whole target records, of which
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the posted target field will be a part. The actions of these single oper-
ators are defined as “do” operations.

You can find a summary of the effects of the six posting operators in
Table 8.2.

8.3.9.1 The Big Posting Picture
Posting in Helix RADE involves interactions between the six posting
operators described, five posting options, four classes of triggers,
and the data. These interactions are summarized in Table 8.9.

Options work on entire records rather than individual fields and
specify general types of functions permitted at the record level, such
as creating a new record, modifying an existing record (do and
undo), or deleting an existing record.

There are four classes of posting triggers, based on the logic of their
interactions with the options: whether Helix should modify an exist-
ing record or create a new one. Changes in posting search keys
(icons in the posting tile) and the possibility that a target record may
not exist create additional possibilities. Three of the trigger classes
involve data entry: enter (or load), replace, and delete. The fourth
trigger class is a combination of print, post, and dump all, all of
which are data export functions. This grouping of the posting is dif-
ferent from that presented in the posting selection mode (see section
8.2.3), which triggers particular post icons.

In contrast, the information in Table 8.9 shows what a given posting
icon will do when configured with a given option and set of opera-
tors. For example, “undo” alone in Table 8.9 means that only the
undo operations of the increment and decrement operators are
enabled, and that none of the “do” operations will work in that case.

Operator Do Operation Undo Operation

Increment Decrement

Addition Subtraction

Insert on create or modify

Insert on create only

Subtraction

Decrement Increment

Table 8.2 Post operator summary
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Trigger Link is Option 0 Option 1 Option 2 Option 3 Option 4

Enter

Found do do do doa delete

Not Found create, dob create, dob

Replace

b = ac
Found do undo, do undo, do undo, do delete

Not Found create, doa, b create, doa, b

b ≠ a

b Found undo b undo b delete bd do be

b Not Found create b, dob,e

a Found do a do a do aa delete a

a Not Found create a, dob create a, dob,d

Delete

Found undo undo delete doa

Not Found create, dob

Print, Post, Dump

Found do do do do delete

Not Found create, do create, do

Table 8.9 Posting summary

a. Odd situations—for example, a previously created target record not found or a 
target record found unexpectedly. See section 8.3.9.2.

b. In these eight cases of “Create, do,” if a collection developer has selected an 
AutoOpen Form in the options window, Helix opens that form automatically for 
additional data entry. Helix posts data appearing on this AutoOpen form (usu-
ally a search key put there by an insert operator) to the target record in the 
relation with the AutoOpen form, and stores any other data entered on the 
AutoOpen form in that target record when the user presses Enter. This returns 
the user to the original source form but does not store the source record. To 
complete operations on a source record after the AutoOpen form has closed, 
the user must select the enter, replace, or delete command a second time. This 
stores the source record, and posts any additional source fields of data (those 
involving increment, addition, subtraction, or decrement) to the newly created 
target record. If the collection developer has not selected an AutoOpen form in 
the Options window, Helix creates a new target record normally and performs 
the selected “do” operations. (See section 8.3.9.3.)
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Conversely, “do” alone means that only “do” operations are enabled.
For example, the increment operator performs identically to the
addition operator since no “undo” operations are allowed. “Undo,
do” means that all operators are fully functional. “Create” and
“delete” refer to the creation and deletion of whole records.

Posting triggers and different logical cases involving their use appear
in the left hand columns that label the rows. The five posting options
appear across the top. In the table, “Found” and “Not Found” refer to
target records, as do all cells with contents. An empty cell in the
table means that Helix RADE does nothing in that case. For the rows
associated with replace, “b” refers to the target record and search
key before the replace, and “a” refers to the target record and key
after the Replace.

8.3.9.2 Odd Situations
Odd situations are cases in which a target record was previously cre-
ated but now cannot be found, or in which you attempt to create a
record and find that the record—one with the same search key—is
already in the database. In some of these cases, Helix RADE takes no
action. This section describes the five cases in which Helix RADE
does take action.

• Case 1—Option 3, Enter, Found: You do not expect to find a target 
record because the purpose of option 3 is to create records, such 
as invoice detail lines, whenever source records are stored. If 
Helix RADE does find such a record, it updates the record with the 
“do” operations.

c. b = target record and search key before a replace operation; a = target record 
and search key after a replace operation.

d. Be cautious when using replace to change a search key under option 3. Typi-
cally this involves the following condition: b ≠ a, b Found, a Not Found. In other 
words, you have replaced the search key and no record exists with the new key. 
Under this condition, Helix RADE deletes the old target record (delete b) and 
creates a new target record using the replacement data (create a, do). However, 
non-posted fields are not passed through to the new record. This can be a prob-
lem for records with data that are typed in, such as data entered on an 
AutoOpen form. In general, if using an AutoOpen form with option 3, do not 
change the search key with replace. If you do, be aware that you may be losing 
nonposted data.

e. In cases of option 4 replace only, the “do” operations use the original source 
data present before the replace was performed. With all other options, “do” 
operations use the source data present after the replace.
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• Case 2—Option 2, Replace, b = a, Not Found: Use of the replace 
command assumes that there is an existing source record and 
implies, with Options 2 and 3, that there is a corresponding target 
record created by those options. If Helix fails to find a target 
record, it indicates an error: The target record probably has been 
deleted inadvertently. Helix RADE recreates a target record, with 
the same key in this case, using the current replacement data. 
Running totals do not include any values stored before this recre-
ation by replace, but the record otherwise appears normal.

• Case 3—Option 3, Replace, b = a, Not Found: Same as Case 2 
above.

• Case 4—Option 3, Replace, b ≠ a, a Found: Changing a search key 
by replacing data using Option 3 is comparable to storing a new 
record; you don’t expect to find a target record with that key. If 
Helix RADE finds one, it updates the record with the “do” opera-
tions, rather than creating a new record as it would normally.

• Case 5—Option 4, Delete, Found: One function of Option 4 is to 
create a target record using data from a source record that is 
being deleted. Normally this creates a new target record, effec-
tively duplicating the deleted source record. If a target record with 
that key already exists, Helix RADE updates the record with the 
“do” operation.

8.3.9.3 AutoOpen Forms and Posting
AutoOpen forms were designed to allow easy entry of additional data
in a target relation, sometimes to a different relation from the current
target. For example, in the course of entering invoices in an Orders
relation, you might want to trigger a customer data form in a Custom-
ers relation, update it, and return to the order entry. This is particu-
larly useful for invoices to new customers who may not be in the
Customers relation. 

Part of the specification of a post icon is the choice of a target rela-
tion. Forms (views) in that relation then become available for selec-
tion in a list in the options window. A given post icon can have only
one target relation and only forms in that relation are available as
AutoOpen forms. Selecting a form in the list links the form to the post
icon so that the form can be opened during posting.

When an AutoOpen form opens, normal posting is suspended. Helix
opens the AutoOpen form, the user enters and stores data using that
form, and then normal posting can resume.
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For example, suppose that a user enters data in a source record and
presses the Enter key. Under Option 2 or Option 3, if Helix does not
find a target record and an AutoOpen form is linked to the post, that
form opens automatically. In fact, an activated AutoOpen form opens
in eight of the ten cases labeled “Create”, do in Table 8.9. Any source
data values posted with the insert operators appear on that form if
the appropriate fields are present. Usually such inserted values
include a search key that links the source record with a target record
in the relation containing the AutoOpen form. While that form is
open, a use can enter data values in the other fields, which are really
fields of the target relation.

Pressing the Enter key a second time stores all the values present on
the AutoOpen form in a record in that target relation. This action
does not create a source record, but does return you to the view in
the source relation, where you can now proceed to complete the fill-
ing in of the form, if necessary.

Pressing the Enter key a third time stores the source record and at
the same time triggers any post icons selected for it. Helix then posts
any noninsert source fields—those involving increment, addition,
subtraction, or decrement—to the target record that was just cre-
ated by storing the AutoOpen form data. The creation or deletion of
records by other post icons as specified in the table also occurs at
this time. A given target field can receive data directly from an entry
on the AutoOpen form and then subsequently receive further data by
the way of posting from the source form.

Therefore, when you select an AutoOpen form under Options 2 or 3
and Helix cannot find a target record, data entry becomes a three
step process. This is also true for replace under Options 2, 3, and 4 in
the five cases indicated in the table. Under Option 4, delete also
requires three steps (delete source data, store AutoOpen form data,
delete source data) if you selected an AutoOpen form.

Caution: If a user is allowed to replace a search key in an
existing source record under Option 3, and an AutoOpen
form was used as part of the original record entry, all tar-
get data typed into the AutoOpen form can be lost. Typi-
cally, this will involve the condition b≠a, b Found, a Not
Found. In other words, you have replaced the search key
and no record exists with the new key. Under this condi-
tion, Helix RADE deletes the old target record (delete b)
and creates a new target record using the replacement
data (create a, do). This new record does not include the
extra (nonposted) data that a user added manually to the
old target record through the AutoOpen form. In general,
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if using an AutoOpen form with Option 3, do not change
the search key with replace.

AutoOpen forms are not triggered by print, post, dump all, load, or
delete all, but are triggered by delete in Option 4.
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Queries: Quick, 
Form, and Power
This chapter looks at three ways to restrict the data 
that appear on a form. You perform Quick Queries in 
a view. Form queries and Power queries can be 
attached to view windows in form setup mode and 
later opened by users who add search values and 
criteria.
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9.1 Introduction
One important feature of any database is the ability to ask it ques-
tions, that is, to search for a particular subset of data. To be able to
do this, there must be a way to define the specific data you want to
see.

Helix has a great deal of flexibility in its search capability, because it
has four different, but interrelated, ways to specify categories of data
and to locate information.

• Quick Query—to conduct an on the fly search of a field. Quick 
queries are covered in section 9.2.

• Form Query—to specify complex search criteria on multiple fields 
using a template defined form. Form queries are covered in sec-
tion 9.3.

• Power Query—to specify complex search criteria on predefined 
lists of multiple fields and abaci. Power queries are discussed in 
section 9.4.

• Abacus Query—to search for the presence or absence of records 
that meet predefined conditions. Any abacus that returns a flag 
value can be used as an abacus query. You can find a complete 
discussion of abacus tiles and abacus construction in Chapter 10.

These four queries represent increasing levels of power and complex-
ity in their search abilities. Using these separately or in combination,
you can query a single field, multiple fields, or entire records. You can
also specify multiple search criteria and even search for data that
aren’t in the database. You will find a summary of the characteristics
of all four types of queries in Table 9.1.

Quick Query

Query construction Command-G while in an entry 
form field

Search based on one field

Compared to literal value

Search between two values? no

Construct OR statements? no

Define criteria in Custom Mode? yes

Table 9.1 Query comparison summary
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Form Query

Query construction open a query window and select 
an entry form template

Search based on multiple fields/abaci on that 
template

Compared to literal values

Search between two values? yes

Construct OR statements? no

Define criteria in Custom Mode? yes

Abacus Query

Query construction create an abacus with a flag out-
put

Search based on multiple fields/abaci in the rela-
tion

Compared to fields, abaci, or literal values

Search between two values? yes

Construct OR statements? yes

Define criteria in Custom Mode? no

Power Query

Query construction select a group of fields and 
abaci, then combine them into a 
search statement

Search based on multiple fields/abaci in the rela-
tion

Compared to fields, abaci, or literal values

Search between two values? yes

Construct OR statements? yes

Define criteria in Custom Mode? yes

Table 9.1 Query comparison summary
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9.2 Quick Query
Quick Query is a convenient method for specifying search criteria
while using a non-listing form. With Quick Query, you can avoid
switching between different windows to define a search. You can
specify one search parameter. Once you have specified that parame-
ter, commands such as Find First operate as though this were the
selected query, or in addition to a selected query. Quick Query is not
available for picture or document fields.

To activate Quick Query, select a selectable field on a data entry
form. Then select View->Quick Query to add a quick query definition
dialog box to the top of the form.

Note: If you choose the Quick Query command immedi-
ately after typing in a new record or modifying the fields of
an existing record, Helix displays a dialog box asking you
if you want to save your changes.

The Quick Query definition dialog box contains the name of the field
selected on the form, a column of available operators, and a data
entry line for entering the search key. The Cancel button closes the
Quick Query dialog.

The flashing text insertion point indicates that you can enter search
criteria into the oval area of the data entry line.

You can enter criteria using any of the acceptable formats for the
field; Helix translates the characters to the format of the field. For

①

① Field name

②

② Operators

③

③ Entry space for search key
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example, in a number field formatted to display percentages, you
should enter 1 for the value 1%.

Choose an operator to define how the search criteria should be com-
pared with the stored data in the selected field. These operators
work the same way as the operators used with the form query icon
window (see section 9.3). The operators are dependent on the data
type of the selected field.

Fields with a text or styled text data type have three operators. Fields
with number, fixed point, and date data types have similar operators;
you can select any two from the three available to define the search
comparison operator. A field with a flag data type has only one oper-
ator choice. Fields with a picture or document data type are not
searchable, although they can be found by using information con-
tained in other fields.

9.2.1 Quick Queries with Abacus or Form Queries

You can choose whether to add the constraints of a selected icon in
the query column of form setup mode to quick query search criteria.
If a query has been selected for this form, its name appears along the
bottom of the quick query definition dialog box.

If you select the Also Use check box, the query selected for the form
works in addition to the quick query. When you issue a Find com-
mand, Helix finds only records matching both the quick query crite-
ria and the selected query criteria.

The query that is selected in form setup mode can be bypassed by
deselecting the Also use check box. The search then takes place as
though no query were selected. You can also eliminate the quick
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query temporarily by clicking the Cancel button, which closes the
quick query dialog box.

For security reasons, a collection designer might want to lock a query
to a form, preventing users from viewing, changing, or deselecting the
criteria. This can easily be done with two commands, Allow Query
Bypass and Lock Quick Query. These commands are available only in
Full Mode, and affect only Custom Mode.

Lock Quick Query removes the Cancel button from the quick query
dialog, so that Custom Mode users will not be able to close the quick
query dialog. 

Lock Quick Query also disables the quick query command, so that a
different field cannot be used for the query.

Lock Quick Query can be used to give users a way of performing
quick queries on non-selectable fields. To do this, construct the tem-
plate initially with the field to be queried left selectable. After you dis-
play the form on a view and lock the quick query, reopen the
template and make the quick queried field non-selectable.

Use the other command, Allow Query Bypass, to remove the Also use
check box from the quick query dialog. Users will not have the option
of deselecting the Query.
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Both of these locking commands can be used on the same form. If
you deselect Allow Query Bypass and select Lock Quick Query, the
form window will appear as follows.

For further discussion of the Lock Quick Query and the Allow Query
Bypass commands, see sections 4.6.19 and 4.6.18.
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9.3 Form Query
The Form Query window makes use of any non-listing template
design—such as a template that is used to enter data. The Form
Query window lets a collection developer select a template that then
appears in the window as a query form. A user can open each field on
the query form to enter values and operators that create an expres-
sion against which data are evaluated. Helix then displays data that
meet the criteria in the expression on the view to which the query
form is attached.

All you need to do to create a form query is to select the template for
the query. After making the selection, you can close the form query
icon’s window. The name you give to the form query icon then
appears in the form setup mode window of all views in the relation
when you select the form query switch.

Whenever you choose a form query for a view, Helix restricts the data
displayed on the view by the criteria in the form query. By the same
token, a form query has no effect until it is selected for a specific view
in that view’s form setup mode.

The same form query can be selected for any number of views and
for any type of form, regardless of whether it is a list or nonlisting
form.

A form query does not affect data entry in any way. It only restricts
data display to those records that meet the requirements specified
on the query form.

Nonetheless, it is usually best not to have a query selected when
entering data because the Find commands operate under the query
restrictions. For example, if after storing a record you want to see it
again to check for errors, the Find Last command will not necessarily
find the last record stored. Instead, it will find the last record that
conforms to the query specification.

It does not matter whether all of the fields that were given restric-
tions on the query form are displayed on the view. Helix has access to
all the fields in the relation, including those that are not on the cur-
rent form and is therefore able to restrict records based on fields that
are not currently visible.
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9.3.1 Components of the Form Query Window

The Form Query window has two components.

• Template selection list: The template selection list at the left of 
the window contains the names of all non-listing templates in the 
relation. A user does not see this area when opening the form 
query window in Custom Mode.

• Query form window: The query form window will contain the 
query template and provides an interface for users to choose 
fields into which they will enter search criteria. The window is 
filled with dots before you select a template. These are not the 
same as the graph paper dots in the template window. They 
merely indicate an empty query window. 

9.3.2 Selecting a Template

Select the template for the query from the template selection list.

The template design becomes visible in the window. Fields (areas
that were inside data rectangles on the template) are now sur-

①

① Template selection list

②

② Query form window
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rounded by ovals. If some of the fields are not visible, the query form
window can be scrolled or resized.

Note: If a Data Rectangle’s Allow Query attribute is dese-
lected on a template, it will appear in the query form win-
dow only when the query is opened in Full Mode; it will be
invisible (and therefore not editable) in Custom Mode.

There is a separate oval for every data rectangle on the template. A
user cannot type directly into the ovals, but they can be opened with
a single click. To specify a query for any field, place the cursor inside
the outline of the desired field and click. The oval then opens to
reveal a query dialog box.

9.3.3 Components of the Query Dialog Box

The query dialog box is arranged so that it is read from top left to
bottom right. Despite its appearance, there are really only four com-
ponents in the dialog box.

• Field or abacus icon: The icon represents the field or abacus for 
which you are entering search criteria. The icon name becomes 
the first part of the query phrase being developed in the dialog 
box.

• Operator buttons: The operator buttons represent the relation-
ships that Helix can use to test data in the field. The major group 
of buttons (12 in this example) appear next to and below the field 
icon. The operator buttons available depend on the data type of 
the field.

①

① Field icon

②

② Operator buttons

③

③ Comparison value

④

④ Secondary clause
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Make a choice by clicking on one of the radio buttons. This opera-
tor becomes the second component of the query phrase.

Examples: [field name] is equal to

[field name] starts with

The default operator is All. This means that all values stored in this
field can be displayed because no operator has been selected. An All
field does not play a role in limiting which records are found in a
search.

Helix provides the Contains, Is found within, and Starts with opera-
tors only for text and styled text fields. 

• Comparison value: The text box at the top right of the dialog box 
provides a space for a comparison value, a value against which 
Helix compares stored data. If you have selected an operator 
other than All, Defined, or Undefined, type a value in this box. 
Helix compares this value to the data stored in the database. This 
is the third, and possibly final, component of a query phrase. If 
you have chosen an operator other than Defined or Undefined, 
you must enter a comparison value. If a flashing insertion point 
does not appear in the text box, click inside the box.

Examples: [field name] Contains electrochemical

[field name] is not equal to London

[abacus name] is less than 25000

If you select All, Defined, or Undefined and type a value into one of
the boxes, a message appears at the bottom telling you that a com-
parison value requires an operator other than All, Defined, or Unde-
fined. 

• Secondary clause: The secondary clause is a second logical 
expression connected to the first expression by AND. When a sec-
ondary clause is present, data must meet both criteria to be 
retrieved. A secondary clause is optional, and is typically used to 
specify a range of values. The secondary clause box has its own 
four operator buttons. These buttons are not selectable unless 
you have selected one of the four similar operators from the first 
group. To type into the second box, first click inside of it to get an 
insertion point.

To find which records fall between two values, first select one of
the last four operators on the left (less than, less than or equal to,
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greater than, greater than or equal to). As soon as one of these is
selected, two of the operators on the right will become selectable.

Examples: 

[abacus name] is greater than 35 and is less than 64

[field name] is less than or equal to Simpson 
and is greater than Porter.

When you use the relationship operators with text, Helix evaluates
data based on alphabetical order. By default, Helix is not case sensi-
tive. Therefore, A and a are the same, and so on.

Helix enables the second set of operators when they are usable.
Because of their size and shapes, the difference between disabled
and enabled may be difficult to see if you are using System 7. Only
two of these operators are ever available at the same time. They are
always opposite signs from the operator selected on the left.

When you close a query dialog box, the oval area displays its query
expression. Only a portion of the expression may be visible, depend-
ing on the size of the oval. The query expression may be shown in a
different order than the way it was entered. It is still the same expres-
sion.

The Revert button in the query dialog box returns the settings in the
dialog box to their state when you opened the dialog box.

If you have constructed an invalid query, Helix will display an error
message at the bottom of the query dialog box.
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9.3.4 Form Query Example

The example above shows a query dialog box configured to find all
the records in which the data in a date field fall between 1/1/95 and 1/
31/95. The query reads: Find the records where [Date] is greater than
or equal to 1/1/95 and is less than or equal to 1/31/95.

The query that was defined in the dialog box for the date field
appears in the field oval when you close the dialog box. Helix dis-
plays it as a formula that means the same as the query expression
above, even though it looks different.

You can now click on another field oval to display a dialog box for
that field. You can open any number of fields and enter a query spec-
ification. When more than one field has a query expression, Helix
retrieves only those records that satisfy all criteria.

Note: Users can modify query criteria and update the
records displayed without closing either the query form or
the display form.

9.3.5 Cold Query

You can create cold queries, just as you can create cold forms. This
means that Helix will not update the records displayed as a result of
the query until the user explicitly requests it. A cold query increases
performance, but also runs the risk that the user may make modifica-
tions to data or make decisions based on data that have been
changed by other users.
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The procedures for forming a cold query are similar to making any
other form cold.

9.3.5.1 Making a Form Query Cold
To create a cold Query, follow the steps outlined below.

1. Drag a template icon into the relation window and name it.
2. Draw the data and label rectangles required on the template.

3. Close the Template.
4. Drag a form query icon into the relation window and name it.
5. Double click the form query icon to open it and select the appro-

priate template.
6. Deselect √->Keep Current. The cold indicator in the lower left cor-

ner of the query window turns to black, indicating that this is a 
cold query.

When you select a different template, the query becomes hot. To
make it cold, deselect √->Keep Current.

Cold query indicator
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9.3.5.2 Using a Cold Query
To use a cold query:

1. Open the form to which the cold query is attached. 
2. Open the query form.
3. Set criteria in one or more fields.

The form to which the query is attached does not automatically
update.

There are several ways to update the form to which the query is
attached.

• Close the Query window.

• Click on the cold indicator in the bottom left of the query window.

• Choose Refresh from a menu.

The form updates to display the records meeting the query criteria.

Follow the same procedure when you change query criteria.

9.3.6 Form Query Window Notes

A user can provide search criteria for any of the fields on a form
query template.

Each additional search expression further limits the records that
Helix displays.

When a list type of form is open with a query selected, the list auto-
matically reflect any changes in the query form as soon as the user
closes the query dialog box.

When a nonlist type of form is open with a query selected, changing
the criteria in the form query initiates the last search operation that
was used with the form. For example, if a user or sequence per-
formed a Find First when the form was last selected, a change in the
query form causes a Find First operation for the form. If Find Last
was the last operation, then another Find Last will take place.

If a form query icon is picked as part of a view setup, it cannot be
removed from the relation window until it is deselected or the view
that uses it is discarded.
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You can use the tab key to switch between typing in the comparison
value box and typing in the secondary clause box.

Helix performs data type checking on what you type into the compar-
ison value and secondary clause boxes. If the field is a number type,
for example, only numbers are allowed in either box. This checking is
performed when you click OK or press the Return key to close the
dialog box.

If an error was made, a message appears at the bottom of the query
dialog box. The entry must be corrected before the query dialog can
be closed.

If a Query is using a field and that field is subsequently deleted from
the template used by the query, Helix automatically deletes the field
from the query. Similarly, if you select a different template in the
query window and the new template does not contain a field or aba-
cus that is currently a part of the query, Helix removes that search
expression from the query.

When using query values for a number field formatted for percent-
ages, Helix translates the entered value to the format of the field. For
this reason, enter 1% as 1 and not as 0.01.

Note: This differs from an abacus query, where 1% should
be entered as 0.01.

When performing queries on decimal fields, remember that calcula-
tions and comparisons are based on the stored rather than the dis-
played value.
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9.4 Power Query
A power query is a hybrid that combines the strengths of the form
query and the abacus query. A power query gives you the ability to
construct easily modified query expressions containing complex,
multi-variable criteria using simple expressions connected by AND
and OR.

The power query also overcomes the limitations of other types of
queries. Unlike the form query, which is limited to comparing the
field/abacus to a literal value, the power query can compare the field
or abacus to another field or abacus. And unlike the abacus query,
which can only be defined in Full Mode, power query criteria can be
defined in Custom Mode by the user as well.

9.4.1 Components of the Power Query Window

The PowerQuery window has two purposes. First, it provides a place
for a user to enter search criteria. Second, a collection developer
uses it to select fields and abaci that can be used in developing a
query expression The components of this window as they appear to
user are as follows.

①

① Searchable items list

②

② Operators list

③

③ Reference items list

④

④ Literal value box

⑤

⑤ Link radio buttons

⑥

⑥ Cold query indicator

⑦

⑦ Winnow button

⑧

⑧ Clear button

⑨

⑨ Completed query statement
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• Searchable items list: After winnowing (discussed in section 
9.4.2.1) this list shows the items that can be queried. Indexed 
fields and abaci (those that appear in the first hole of an index 
window) are in boldface type. Click on an item to select it for the 
query.

• Operators list: After the user selects an item in the searchable 
items list, the operators list displays the appropriate operators 
for the data type of the searchable item. Click on an operator to 
select it.

• Reference items list: After the user selects an item from the 
searchable items list, the reference items list displays the items to 
which the searchable item can be compared. Indexed fields and 
abaci (those that appear in the first hole of an Index window) are 
in boldface type. Click on an item to select it.

• Literal value box: A user can type a value into the literal value box 
rather than selecting an item from the reference items list. Press-
ing Tab, closing the query, or choosing a link (see the next para-
graph) transfers characters from the text box to the search 
statement. Helix performs data type validation on the typed in 
value. If it is not compatible with the search item’s data type, 
Helix generates a Why? message and does not transfer the value 
to the search statement.

• Link radio buttons: Click on And or Or to create query statements 
containing more than one logical expression.

• Cold query indicator: If the indicator is black, the Query is cold 
and the search will not begin until the user explicitly requests it 
by clicking on the indicator (or choosing the Refresh command 
from a custom menu). See section 9.4.2.4, Making a Power Query 
Cold, for more information.

• Winnow button: Click the Winnow button to open the selection 
list definition dialog and choose the items that will be available in 
the searchable items and reference items lists. The Winnow but-
ton does not appear in Custom Mode.

• Clear button: Click the Clear button to clear all query selections, 
including the contents of the completed search statement text 
box.

• Completed search statement text box: Displays the query state-
ment. Select a phrase of the query statement to modify it (see sec-
tion 9.4.4).
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9.4.2 Creating a Power Query

To set up a power query, you must be working in Full Mode. (They
can be used in Full Mode or Custom Mode.)

There are three steps to creating a
Power Query:

1. Drag a power query icon from its 
icon well into a relation window 
and name it.

2. Double click to open the power 
query icon.

3. Select the set of fields and abaci 
to be made available in the 
power query.

4. Attach the power query to the 
form(s) that will be using it.

9.4.2.1 Selecting Fields and Abaci for a Power Query
Before making a power query available to users, you must choose
which fields and/or abaci the user can place in a query expression. To
do so:

1. Double click the power query icon to open the power query win-
dow. 

2. Click the Winnow button to open the selection list definition dia-
log box.

The selection list definition dialog box has the following controls:

①

① Item type radio buttons

②

② Field selection list

③

③ Abacus selection list
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• Item type radio buttons: The item type radio buttons let you indi-
cate the list to which selections in the lists at the right of the dia-
log box apply. You can make separate selections for the 
searchable items list and the reference items list.

In addition, you can select permanent items to prepare search cri-
teria that Helix applies before the user adds his or her own crite-
ria. Helix displays only records that meet all permanent item
criteria. These criteria function in Custom Mode like an abacus
query—invisible to and unchangeable by the user. Helix displays
only those fields and abaci that produce a flag value in the perma-
nent items selection list.

Note: If a user creates a search statement that contradicts
the permanent item, Helix displays no records. 

• Field selection list: The field selection list contains the names of 
all the text, number, date, and flag fields in the relation. Select 
items by drag-selecting or Shift-clicking; deselect all items by 
clicking on the white space below the last item.

• Abacus selection list: The abacus selection list contains the 
names of all abaci in the relation with text, number, date, and flag 
output. Select items by drag-selecting or Shift-clicking; deselect 
all items by clicking on the white space below the last item.

Note: When you select the permanent items radio button,
Helix displays only flag output abaci in the abacus selec-
tion list.

9.4.2.2 Example: Selecting Power Query Items
The following example walks you through the process of creating a
complete power query.

1. Drag a power query icon into the relation window and give it a 
name.

2. Double click on the power query icon to open it.
3. Click the Winnow button to display the selection list dialog box.
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4. Helix selects the Searchable radio button. Shift-click to select the 
fields on which you want the user to be able to search.

Depending on their output, you may also wish to designate some
or all of your abaci as searchable.

5. Click the Reference Items button, and choose reference items.

Although this particular example uses only abaci as reference
items, your collection may have fields that you wish to specify as
reference items.

Tip: Note the abaci named “1” and “4” (and others)
above. These are simple number tiles that output values
that exactly match values in a popup or values that would
logically be used in a power query expression. If you want
to use the equals operator in a power query, consider cre-
ating a set of abaci like this for the values a user is most
likely to enter. The user can then click on an abacus name
in the reference items selection list rather than typing in a
literal value.
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6. Choose permanent items (optional). These act beneath the power 
Query; in other words, permanent items are conditions you set 
that can only be changed in Full Mode.

7. Click the OK button to close the Item Selection dialog.

9.4.2.3 Attaching a Power Query to a Form
Like a template or abacus query, you attach a power query to a view
in the view’s form setup mode window. When a power query is
attached to a form, that power query opens when a user selects the
Open Query command.

Note: Because the Open Query command triggers either a
form query or a power query, only one can be attached to
a view at a time.

To attach a power query to a form:

1. Select the form’s view icon and select View->Form Setup.
2. Click the power query icon switch at the top of the middle list to 

display a list of all power queries in the relation.
3. Choose the power query from the selection list.

4. Select the Show Form command to view the form.

9.4.2.4 Making a Power Query Cold
Queries can be either hot or cold. A hot query finds records immedi-
ately; a cold query searches only when you tell it to do so.

Since each change in a hot query immediately affects the forms with
which it is associated, setting multiple criteria in a hot query associ-
ated with an open listing form can be time consuming as you wait for
the list to recalculate as you define each criterion. In contrast, the
cold query does not calculate the list until you give it the command
to do so, either by clicking on the form indicator in the lower left cor-
ner or by choosing the Refresh command from a custom menu.
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To make a power query cold, pull down the √ menu in full mode while
the query window is active. A check mark in front of Keep Current
indicates that the window is hot. Choose the Keep Current command
to remove the check mark. The form indicator in the lower left corner
of the query window turns black, indicating that this is now a cold
query.

9.4.2.5 Invalid search statements
To prevent invalid search phrases (such as Date = yes) changing the
data type of a field or the output of an abacus automatically deletes
expressions containing that field or abacus from power query search
statements. This is analogous to icons popping out of abacus black
holes. In certain instances Helix also removes the changed item from
the selection lists.

If you change the data type of a field contained in a
search statement phrase, Helix removes expres-
sions containing that field from the search state-
ment, and provides the dialog box at the right:

If the field is still a valid data type for a power
query (that is, it is text, styled text, number, fixed
point, date, or flag) it remains in the selection lists.
If it has changed to picture or document, Helix
removes it from the selection lists.

If you change the output of an abacus without adding or deselecting
tiles (for example, you change the output of an If-Then-Else tile by
dragging new icons to the Then and Else holes) Helix removes expres-
sions containing that abacus from search statements and provides a
dialog box similar to the one shown above for Fields will appear.

If the Abacus output is still a valid data type for a power query (that
is, text, styled text, number, fixed point, date or flag) it remains in the
selection lists. If it has changed to picture or document, Helix
removes it from the selection lists.

If you change the construction of an abacus so that its output is unde-
fined (for example, by adding a new, unconnected tile to the abacus
construction window) Helix deletes search statement expressions

hot query

cold query
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containing the abacus and removes the abacus from the selection
lists. If the power query window is open, Helix closes it.

Queries cannot be performed on tiles that depend
on list content or record position. Therefore, if
you change the construction of an abacus so that
it contains a Form or Previous tile, Helix deletes
search expressions containing the abacus and
removes the abacus from the selection lists. Helix
also displays the dialog box at the right.

Abaci containing any of the following tiles cannot
be used in power query search expressions: Form
Count, Form Count For, Form Total, Form Total For, Form Average,
Form Average For, Form Minimum, Form Minimum For, Form Maxi-
mum, Form Maximum For, Form Previous, Previous, and Previous
For.

9.4.3 Using a Power Query

A power query can be used in Full Mode or Custom Mode. You con-
struct a complex search statement using one or more logical search
expressions. Helix then retrieves just those records in which field
and/or abacus values meet the criteria in the search statement.

Note: Like the Form Query, any criteria set in Full Mode
for a particular user will carry over when someone opens
that user in Custom Mode.

To use a power query, you do the following:

1. Select an item (field or abacus) to be searched from the search-
able items selection list.

2. Choose an appropriate operator from the operators list.
3. Choose an item from the reference items list or type in a value to 

which the first item is to be compared.
When you click on an item in the searchable items selection list,
operators appropriate for that data type appear in the operators list,
and reference items of compatible data types appear in the reference
items selection list.

As soon as you choose the reference item in the third column (or
type a value and press Tab), the query expression appears in the
statement box in the lower right corner of the power query window.
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4. If you want to define another criterion, click the And or the Or 
radio button to insert the logical operator, and repeat steps 1–4 as 
many times as needed.

The search statement area scrolls when a search statement becomes
too large for the text box. You can also resize the entire power query
window in order to see the entire statement.

5. If the query is cold, click the form indicator or use the Refresh 
command to apply the query to the form.

6. When you have finished with the power query, click the close box. 
The power query continues to affect the records displayed on the 
list.)

Helix will now search for and display records that meet your criteria.

Note: When performing a search, Helix logically evaluates
all expressions linked by And first, followed by all expres-
sions linked by Or. 

If you try to close a query that has an incomplete search statement,
the window reverts to its last correct content.

9.4.3.1 Example Power Query Search Statement
To perform a power query:

1. Select the first item from the Search this item: column.
2. Select an operator from the for when it: column.
3. Select a reference value from the this item column.

Helix displays the completed criteria in the completed search state-
ment box.
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4. Add a logical operator by clicking on the And or the Or radio but-
ton.

You can continue to build the statement, using multiple And and Or
links.

You can type a literal value in the text box instead of choosing an
item from the this item column. Pressing Tab transfers what you have
typed from the text box to the search statement.

Tip: To select all of the text in the text box, use Com-
mand-A.

9.4.4 Modifying a Power Query Search Statement

You can modify a power query search statement at any time,
although selection lists can only be modified in Full Mode. You can
edit or delete selected expressions or you can remove the entire
statement by clicking the Clear button.

A power query actually has two edit modes: an explicit edit mode
and an implicit edit mode.

Implicit edit mode occurs immediately after a user enters a search
expression, while the components of that expression are still
selected in the selected lists. Any changes to the search item, opera-
tor, reference item, or literal value box contents are immediately
reflected in the search phrase. This is an implicit edit because Helix
modifies the expression even though it is not selected. To get out of
implicit edit mode, select an And or Or link, or go into explicit edit
mode. Normally you will create a line, modify it as much as you want,
and then click either the And or Or button (even though one may be
selected) to move on to a new line.

You enter explicit edit mode whenever you select an existing expres-
sion in the search statement. You can then modify the phrase by
choosing a new search item, operator, reference item, or editing the
text in the literal value box. To get out of explicit edit mode, deselect
the query statement by clicking in the white space of the search
statement area.

9.4.4.1 Selecting an Expression
When you open the power query, the selection lists are blank.
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Click on the expression that you want to edit. Helix highlights the
components of that expression in the selection lists.

9.4.4.2 Editing an Expression
To edit an expression in a search statement, first select the expres-
sion.

Then select a new item, operator, or link, or edit the text in the literal
value box.

If you choose a search item with a different data type, Helix turns the
expression blank but selected until an operator and a reference value
are chosen.

9.4.4.3 Deleting All or Part of the Search Statement
To delete all or part of a search statement, select the expression that
you want to delete. Then press Option-Delete. If the expression is
blank (has no contents), click in the white space at the bottom of the
search items selection list.
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To delete the entire search statement, click the Clear button.

To delete what is in the literal value box, select all of the text using
Command-A or the mouse. Then press the Delete key. 
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Calculation Tiles
This chapter is a summary of the Helix calculation 
tiles that can be used to construct data manipulation 
procedures within an abacus. You will also find a 
general discussion of the abacus icon and the use of 
the various tiles.
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10.1 Introduction
This chapter presents all of the abacus calculation tiles, grouped by
functional category.

You will find each tile pictured either alone or
nested with others. Its operation is presented
in a few sentences, along with its input (black
holes) and output (the tile’s arrow) data types.
This information is summarized in a table like
the one shown here:

The letters under the Input heading represent
the acceptable data types for the tile’s black
hole(s). The Output column contains the data
type of the value that flows out of the tile’s arrow given the input data
types. This sample table is for a tile with two black holes. The rows of
the table represent all the legal possible combinations of input data
types. All tiles always have only one output value. 

The abbreviations for the data types used in the summary tables are
as follows: text (T), keyword (K), styled text (ST), number (N), fixed
point (FP), date (D), flag (F), picture (P) and document (Doc). In the
first line of the table example shown above, for example, you can see
that two number values in a particular abacus tile produce another
number value as output. However, when you combine a number value
with a date, the result is a date.

The descriptions of many tiles also have example constructions in
text form. For these constructions, curly braces ({ and }) indicate
black holes. If the black hole contains an icon, the icon name appears
in double quotes. Constructions that include more than one tile are
indicated by nested curly braces.

10.1.1 Tile Input Sources

Depending on the data type (and the structure of your collection),
input for the black hole of a calculation tile can come from one of four
possible sources:

• A field icon

• An abacus icon

• The arrow of another tile
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• Direct input of a literal value into the black hole. When you dou-
ble click on a black hole, Helix opens a value dialog box. You can 
then type a value.

For example, if a tile requires a date
value in one of its black holes, the
source of that date can be either a date
field, an abacus with a date output, a
tile with a date output, or direct entry
of a date value into the black hole.

Many tiles have more than one black
hole. Holes are always indicated in left-
to-right order. For example, “N N > N”
means that the first and second holes
in the tile require number values to
yield a number output. Similarly, “T T T
> F” or “D D D > F” or “F F F > F” is the description of a three hole tile
where holes 1, 2 and 3 can be either text, date or flag, but all input
must be the same data type.

Some tiles have no black holes. Their input is based on a system
(UserName, Today) or view (Form Count) parameter rather than a
value. The data type of these tiles has no input designation.

10.1.2 Tile Output

Tile output means that a value of a specified data type flows out the
arrow at the bottom of the tile. This information is useful when deter-
mining whether you can place the arrow of one tile into a black hole
in another.



Display

10-5

10.2 Display
The tiles in this section display literal values and user name values
without manipulating them in any way.

10.2.1 Display

The Display tile returns whatever it contains. It is commonly used to
generate a default value for a field on an entry form, and can contain
any type of data. The Display tile provides a method for including lit-
eral values anywhere in an abacus calculation. 

For documents, Helix displays the document icon and name.

Note: The Display tile is different from the Picture tile,
which outputs a picture of the first page of a document.

10.2.2 UserName

The UserName tile returns the name of the current user. The tile is
undefined if there is no current user. Submenus output the name of
the user on the top menu.
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This tile can be used to identify users with transactions by storing
the user name along with other data values.

The UserName tile cannot be used in an index, but may be used with
computed defaults, queries, and posting.
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10.3 Numeric Operations
Helix provides a variety of tiles that manipulate numeric values.
These range from simple arithmetic operations to complex financial
calculations.

10.3.1 Arithmetic Tiles

Four tiles perform the basic arithmetic operations.

10.3.1.1 Addition

The Addition tile has two functions. It either gives the sum of two
numbers, such as {“Base Price”} + {“Sales Tax”} returning the
amount due, or it adds a number to a date, where {“Rent Date”} +
{Rent Period”} gives the expected date of return.

10.3.1.2 Subtraction

The Subtraction tile subtracts the second value from the first. If the
two values are dates, as in {“Completion Date”} – {“Starting Date”},
the result is the number of days between the two dates, which will be
negative when the second date is later than the first. Finally, subtract-
ing a number from a date, as in {“Presentation Date”} – {“Lead
Time”} gives a date, in this example the last date on which the
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project can be started. A date cannot be subtracted from a number,
as {7} - {“Today”}.

10.3.1.3 Multiplication

The Multiplication tile returns the product of two numbers. {“Gross
Pay”} * {“F.I.C.A.”}, for example, calculates the amount withheld
for Social Security.

10.3.1.4 Division

The Division tile divides the first value by the second. {“Base Hits”}
/ {“Times at bat”}, for example, gives the average hits per trip to the
plate. As with the Multiplication tile, the Division tile accepts only
numeric values in its black holes.

10.3.2 Mathematical Tiles

The mathematical tiles perform mathematical functions typically
found in programming language libraries.
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10.3.2.1 Absolute Value

The Absolute Value tile always returns a positive number. The tile
changes negative numbers to their positive equivalent; positive num-
bers are unaffected. Abs {-27} has a value of 27, as does Abs {27}.

10.3.2.2 Round

The Round tile rounds off a numeric value to the nearest integer.
Round {2.3} becomes 2; Round {2.6} becomes 3.

When Helix encounters a 5 to the right of the decimal point, it uses
the digit to the left determine the direction of the round. If the digit to
the left is odd, Helix rounds the number up; otherwise, Helix rounds
down. Thus, Round {13.5} and Round {14.5} both return values of 14.

10.3.2.3 Round to Nearest

The Round to Nearest tile rounds the number in the first hole to the
nearest multiple of the number in the second hole.
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For example, if you need a multiple of ten, you would put 10 in the
second hole. Therefore, Round {27} to nearest {10} would produce
30.

10.3.2.4 Square Root

The Square Root tile finds the square root of a number. √ {9} returns
a value of 3. This tile accepts only positive numeric values as input.

10.3.2.5 Integer

The Integer tile truncates a numeric value at the decimal point. Inte-
ger {3.8} returns 3, as does Integer {3.2}. This tile should not be
confused with the Round and Round to nearest tiles.

The Integer tile can be used, for example, to create an abacus that
generates a page count for a report. Legal documents, as well as
many other types of reports, often have a legend that says “Page 3 of
12 pages” as a header or footer.

The procedure requires a combination of several abaci. First you
need to know how many lines appear on a full page of a list. 

Assume that you have a listing form that contains 33 records on a
page. If the entire report contains 67 records, the list will be three
pages in length: two full pages of 33 records and one partial page of
one record.
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 Construct an abacus containing only the
Form Count tile to determine the total number
of records in the report.Then construct an
abacus that takes the Form Count tile and
divides it by 33 to get the total number of

pages in the report (2.03). Next, place that abacus inside
an Integer tile to derive the integer portion of the number
of pages. In this example, that integer is 2.

The next step is to construct the aba-
cus shown at the right. This abacus
says that if the total number of pages
(2.03) is greater than the integer por-
tion of that number, than the number
of pages is the integer plus one (or 3);
otherwise, in that rare instance when
the form count is an exact multiple of
the number of records per page, the
answer is the integer by itself. In the
Followed By tiles, the first hole con-
tains the word of with one space after
it; the second hole contains the word
pages preceded by a space. The final step is to place this abacus in a
left justified data rectangle on the report template immediately to the
right of a label rectangle that is formatted for P# is Page Number and
contains the words Page P#.

10.3.2.6 Fraction

The Fraction tile does the opposite of the Integer Tile. It returns only
the portion of a numeric value that is to the right of the decimal
point. Fraction {2.13} returns 0.13.
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10.3.2.7 Negation

The Negation tile reverses the sign of a number. A positive number
becomes a negative number and a negative number becomes posi-
tive.

Accounting applications may find this a valuable asset. For example,
taking the negative of zero produces a display of -0, which functions
as a normal zero.

10.3.3 Trigonometric Tiles

Four tiles perform various trigonometric functions.

10.3.3.1 Sine

The Sine tile returns the sine of an angle. This tile assumes that the
angle is expressed in radians. 

Tip: To convert degrees to radians, divide by 57.29577951
(which is 360/2π)
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10.3.3.2 Cosine

The Cosine tile returns the cosine of an angle expressed in radians.

10.3.3.3 Tangent

The Tangent tile returns the tangent of an angle expressed in radians.

10.3.3.4 Arc Tangent

The Arc Tangent tile computes the arc tangent of a number. The
result is expressed in radians.

10.3.4 Exponentiation Tiles

The exponentiation tiles perform exponentiation and reverse expo-
nentiation functions.
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10.3.4.1 To Power Of (Exponentiation)

The To power Of tile raises the number in the first hole to the power
of the number in the second hole. For example, {2} to power of {3}
produces a result of 8 (2 x 2 x 2). This tile is only for number and
fixed point data types.

10.3.4.2 Log (Common Logarithm)

Log returns the common (base 10) logarithm of a number.

10.3.4.3 Ln (Natural Logarithm)

The Ln tile returns the natural (base e) logarithm of a number.

10.3.5 Financial Tiles

Two tiles perform commonly encountered financial calculations.
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10.3.5.1 Compound Rate

The Compound Rate tile returns a number that—when multiplied by
the original amount invested—gives the value of the investment at
maturity.

Given a periodic interest rate, r, and the number of periods, number,
Compound Rate returns (1+r)number, which is the principal plus
accrued compound interest on an original investment of one unit.
This is also called future value.

You insert the interest rate into the first black hole and the number of
times interest is compounded into the second. To evaluate an oppor-
tunity to invest for five years, at an annual interest rate of eight per-
cent compounded monthly, the computation would be {“Principal”}
* {Compound rate {{8%}/{12}} {{“Years”} * {12} times}.
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10.3.5.2 Annuity Rate

The Annuity Rate tile returns a number that is the present value fac-
tor of an ordinary annuity.

Given a periodic interest rate, r, and the number of periods, number,
Annuity Rate returns (1-(1+r)-number÷r. The tile finds the lump sum
investment required for you to receive a regular income in the
amount and frequency you specify.

Suppose you want $100/month for 12 months. How much would you
have to deposit so that you will receive $100/month throughout the
year, assuming an interest rate of 5.25% compounded monthly? The
calculation for this example is shown in the illustration above.

The input to the first hole is 5.25% per annum, compounded monthly
(therefore divided by 12 to get the effective rate). The second hole
contains “12” for 12 monthly payments. The abacus then multiplies
the result of the Annuity Rate tile by the $100 amount of regular pay-
ments to you, giving $1,166.56. This is the amount you would have to
deposit originally to receive $100/month for a year.
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10.4 Text Operations
Helix allows you to manipulate text data in several ways. You can
search text fields, combine text fields, and extract text from fields.

10.4.1 Text Search Tiles

Three tiles search for matching characters in text and styled text
fields.

10.4.1.1 Starts With

The Starts With tile returns either True or False. It tests the text in the
second hole for a match with the beginning of the text in the first
hole. For example, {“Description”} starts with {Revolutionary} is
True if the text in the Description field reads “Revolutionary rapid
application development environment called Helix RADE.” The tile is
not case sensitive, and only text can be tested.

10.4.1.2 Contains

The Contains tile searches for the presence of the text in the second
black hole anywhere within the contents of the first black hole. The
result is True if the second text is found anywhere within the first.
{“Name”} contains {ed} is True for the names Edward, Ted and Fred-
erick, for example. Contains is not case sensitive. Text is the only
valid input.
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10.4.1.3 Ends With

Ends With tile is in the same family as the Starts With and Contains
tiles, returning a result of either True or False. In this case, Helix tests
the end of the text field in the first hole for a match with the entire
second text. {“Company”} ends with {Inc.} might be used to check for
corporations in a database, for example. Ends With is not case sensi-
tive. Text is the only valid input.

10.4.2 Text Manipulation Tiles

Three tiles arrange the appearance of text data. Programmers refer
to this stringing together of text as concatenation.

10.4.2.1 Followed By

The Followed By tile pastes one string of text on the end of another.

If the Last Name field contains Washington and the First Name field
contains George, then {{“Last Name”} followed by {, }} followed by
{“First Name”} produces “Washington, George.” 

Both of a Followed By tiles’s black holes must be defined. If they are
not, the output of the tile is undefined. If, in the above example, noth-
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ing had been entered in either the First Name or Last Name field, then
the tiles would return no value. (For an alternative, see Followed/Or,
section 10.4.2.3).

10.4.2.2 New Line

The New Line tile returns a carriage return. Any text following it
starts one line down and at the left of the containing rectangle. New
Line is often used in conjunction with the Followed By tile, such as in
{{“Company”} followed by {New Line }} followed by {“Address”}.

Tip: As the New Line tile is often used in many abaci, it is
generally a good idea to create an abacus containing just
this tile and use it in place of the New Line tile in other
abaci you create. This helps cut down on the overall num-
ber of resources that Helix uses, making your collection
smaller and more efficient.

10.4.2.3 Followed/Or
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The Followed/Or tile is much like the Followed By tile, with one
important difference. Only one black hole needs to be defined before
the tile can return a value. {“First Name”} Followed/or {“Last Name”}
returns just the first name if the last name is undefined, just the last
name if the first is undefined, and both names if both are defined. Fol-
lowed/Or is commonly used in tandem with Followed By.

As an example, assume that you are creating a mailing label and that
a relation has a field for Title that is only occasionally defined. If you
just used the fields on a template, then the records for which there
was no title would have a blank line in the label.

To solve this problem you can build the label in an abacus, using the
Followed By, Followed/Or and New Line tiles. The segment of the cal-
culation that handles the title problem would be {“Title”} Followed
By {New Line}. In the cases where there was no title, you would not
get the new line because both sides of the Followed By must be
defined before it produces any output. You would run this tile into a
Followed/Or tile, which would continue on with the rest of the calcu-
lation. The calculation would not be disturbed when the Followed By
was undefined.

10.4.3 String Manipulation Tiles

There are a number of tiles that manipulate strings of text, either
modifying the case of the characters, extracting characters, counting
characters, or finding the length of a text string.

10.4.3.1 Upper Case

The Upper Case tile converts text to capital letters. Although it can-
not be used to test for uppercase, it can be used to convert data for
storage. For example, it will convert text to all uppercase when post-
ing. You can also use the tile to display stored data in all uppercase.
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10.4.3.2 Lower Case

The Lower Case tile converts upper case or mixed text to lowercase
letters. Although it cannot be used to test for lowercase, it can be
used to convert data for storage. For example, it will convert text to
all lowercase when posting. You can also use the tile to display stored
data in all lowercase.

10.4.3.3 Mixed Case

The Mixed Case tile capitalizes the first letter of each word in the field
or abacus or text typed in its black hole. Although it cannot be used
to test for mixed case, it can be used to convert data for storage. For
example, it will convert text to mixed case when posting. You can also
use the tile to display stored data in mixed case.

Note: Mixed Case uses the same algorithms for determin-
ing a word as the keyword feature.

10.4.3.4 Length
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The Length tile returns the number of characters in a block of text. If
you need to know how many letters there are in a name, you might
use something like Length {“Full Name”}.

10.4.3.5 Extract

The Extract tile pulls a substring from a block of text. The first two
black holes contain the starting and ending character positions of
the text to be extracted. The rightmost black hole contains the
source text.

For example, Extract{3} through {5} from {“Zip Code”} produces the
last three digits of a 5 digit ZIP Code.

A more general way to accomplish the same thing would be Extract
{{Length {“Zip Code”}} – {2}} through {Length {“Zip Code”}} from
{“Zip Code”}, which returns the last three characters regardless of
the length of the string.

10.4.3.6 Locate

The Locate tile returns the starting position of a substring of text.
The first black hole contains the text to be located, the third hole
contains the source text, and the middle block hole contains the
character position at which the search is to begin.

As an example, assume that the field Text holds the sentence,
“Dolores, I need ten dollars.” The tile Locate {Dol} starting at {1} in
{“Text”}, the tiles return an answer of 1, because that is the charac-
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ter position of the first match found. If the tile instead contains
Locate {Dol} starting at {2} in {“Text”}, you get an answer of 21,
which is the position of the first occurrence of “dol” after the starting
position of 2. 

Tip: A more general way of finding the second occurrence
would be to add 1 to the result of the first Locate and use
this new value in the “starting at” hole of a second Locate
tile.

The Locate tile is not case sensitive.

10.4.4 Keyword Search Tiles

Two tiles search for matching words specifically within keyword
fields. The text operation tiles can also be used with keyword fields.

10.4.4.1 Word Starts With

Word Starts With is in the same family as Starts With, Contains and
Ends With, but can only accept a text field for which the keyword
option has been selected. The tile returns a result of either True or
False. In the sample tile above, Helix is testing a keyword field called
Adjective for a word beginning with “blue.”

For more information, see section 5.1.1.3, Keyword/Edit Keyword.

10.4.4.2 Word Equals
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Word Equals returns a result of either True or False based on
whether the word in the second black hole is found within the key-
word field in the first black hole.
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10.5 Date and Time Operations
The tiles described in this section find, display, and manipulate dates
and times.

10.5.1 Date and Time Retrieval

Three tiles read dates and/or times and display them without further
manipulation.

10.5.1.1 Today

The Today tile returns the value of the date on the system clock. It
does not read the time of day. If the selected date format includes
time, the time appears as 12:00 AM.

The Today tile can be used in calculations, such as {Today} + {7},
which returns the date seven days from the current system date.

10.5.1.2 Form Time

The Form Time tile returns the time that a user accesses a view.

The most common use of this tile is on an entry form. When the user
opens the form, the Form Time tile retrieves the time from the system
clock. The time is not updated as long as the form is open; it is recom-
puted only after the user issues an Enter, Replace, Delete, Find, or
Clear Form command.
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Tip: Because Form Time marks the time a new operation
starts, it can be used to mark the beginning of a transac-
tion.

10.5.1.3 Post Time

The Post Time tile returns the time the Enter key or other posting
trigger—such as Print or Dump—was used. If there is no posting
attached to a form, Post Time is the time when the Enter key is
pressed.

Tip: Because the Post Time tile marks the time that an
entry operation takes place, it can be used to mark the
end of a transaction in time.

10.5.2 Date and Time Extraction

The tiles in this section extract individual portions of a date and time
value.

10.5.2.1 Day of Week
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The Day of week tile returns a number that represents the day of the
week for a date. Sunday is day 1, and Saturday is day 7.

Tip: If you create a relation that contains the names of the
days of the week along with their corresponding numbers,
you can Lookup {“Name”} for {“Number”} = {Day of Week
{Today}} in {“Days”}, which gives you today’s name. This
is very useful for internationalizing a collection.

10.5.2.2 Day

The Day tile extracts the day of the month from a date. For example,
Day {5/11/85] returns a value of 11.

10.5.2.3 Month

The Month tile extracts the month number from a date. For example,
Month {9/12/79} returns a value of 9.

10.5.2.4 Year
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The Year tile returns the year portion of a date. For example, Year
{3/27/2001} returns a value of 2001.

Tip: By default, Helix interprets a two digit year input of
20 through 99 as twentieth century dates (1920–1999) and
00 through 19 as twenty-first century dates (2000–2019). If
you need to enter a year that is outside that range, type
the full four digit year.

10.5.2.5 Hour

The Hour tile returns the number of the hour contained in a date
value. It has a value ranging from 0 (midnight) to 23 (11 PM). Helix
uses military time. For example, if the Hour tile returns 14, the hour
is 2 PM.

10.5.2.6 Minute

The Minute tile returns the number of the minute contained in a date
value. It has a value ranging from 0 (on the hour) to 59 (one minute
before the next hour).
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10.5.2.7 Second

The Second tile returns the number of the second contained in a date
value. It has a value ranging from 0 (on the minute) to 59 (one second
before the next minute).

10.5.3 Date and Time Assembly

The date and time assembly tiles take the individual parts of a date or
time and combine them into a format for display or storage in a data-
base.

10.5.3.1 Month, Day, Year

The Month, Day, Year tile takes three numbers as its input and
merges them into a single date.

The first value must be a number between 1 and 12, inclusive. The
second hole can contain any positive number. The third hole must
contain a four digit number.

If the number in the second hole is larger than the number of allow-
able days in the month of the first hole, the tile adds the difference
between the value in the second hole and the maximum days allowed
for the month to the date, adjusting the month and year if necessary.
For example, Month {12} Day {33} Year {1994} returns a value of Janu-
ary 2, 1995.
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If you are trying to construct a date and the value of the year is only
two digits, add 1900 or 2000, whichever is appropriate: Month
{“Month#”} Day {“Day#”} Year {{2000} + {“Year#”}}.

10.5.3.2 Hour, Minute, Second

The Hour, Minute, Second tile takes three numbers and merges them
to create a time of day. The first number must be between 0 and 23,
inclusive. The second and third numbers must be from 0 to 59, inclu-
sive.

10.5.3.3 Date, Time

The Date, Time tile combines the results from a Month, Day, Year cal-
culation and an Hour, Minute, Second calculation. The result is a date
with the time attached.

10.5.4 Date and Time Intervals

The Delta (∆) tiles return the interval between two dates and/or
times. 

The output of a ∆ tile is a whole number; there is never a fractional
portion. The numbers are rounded to whatever unit is being used,
which can create some interesting anomalies. For example, the differ-
ence between July 2, 1993 11:59:59 PM and July 3, 1993, 12:00:00 AM
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is one second; it is also one minute, hour, day, and so on, depending
on which of the ∆ tiles is performing the calculation.

If you want a fractional result, use a smaller ∆ tile and divide the
result by the appropriate number. For example, for fractional days,
divide the ∆ Seconds tile result by 86,400.

10.5.4.1 ∆ Seconds

The ∆ Seconds tile calculates the difference in seconds between two
dates. The result is always a whole number that is negative if the date
in the right black hole of the tile is later than the date in the left black
hole.

10.5.4.2 ∆ Minutes

The ∆ Minutes tile calculates the difference in minutes between two
dates. The result is always a whole number that is negative if the date
in the right black hole of the tile is later than the date in the left black
hole.
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10.5.4.3 ∆ Hours

The ∆ Hours tile calculates the difference in hours between two
dates. The result is always a whole number that is negative if the date
in the right black hole of the tile is later than the date in the left black
hole.

10.5.4.4 ∆ Days

The ∆ Days tile calculates the difference in days between two dates.
The result is always a whole number that is negative if the date in the
right black hole of the tile is later than the date in the left black hole.

10.5.4.5 ∆ Weeks

The ∆ Weeks tile calculates the difference in calendar weeks between
two dates. A calendar week begins on a Sunday. The result is always
a whole number that is negative if the date in the right black hole of
the tile is later than the date in the left black hole.
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Helix considers a calendar week to run from Sunday to Saturday.
Therefore, if two dates fall within the same week—even if they are six
days apart— ∆ weeks is 0; if they fall in different weeks—even if they
are only one day apart—the ∆ weeks is 1.

10.5.4.6 ∆ Months

The ∆ Months tile calculates the difference in months between two
dates. The result is always a whole number that is negative if the date
in the right black hole of the tile is later than the date in the left black
hole.

10.5.4.7 ∆ Years

The ∆ Years tile calculates the difference in years between two dates.
The result is always a whole number that is negative if the date in the
right black hole of the tile is later than the date in the left black hole.
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10.6 Summary Tiles
The following tiles perform a variety of functions, all of which depend
on counting or summarizing data. The first group acts on all data in a
relation, the second on a selected subset of data in a relation, and the
third on just the data on a form.

10.6.1 Entire Relation Operations

The ten tiles in this section evaluate all the records in a relation,
although not all of those records may be used in a calculation.

10.6.1.1 Count

The Count tile returns the number of records in the relation.

10.6.1.2 Count For

The Count For tile counts the number of records in a relation that
meet a specified condition. The “for” hole accepts only flag type
input. The tile counts each record for which the flag is true.

For example, if you wanted to know how many of your customers are
dentists who live in Omaha, you could use: Count for {{{“City”} =
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{Omaha}}” and {{“Occupation”} = {Dentist}}}. The abacus containing
these tiles returns the number of records that had a value of Omaha
in the City field.

10.6.1.3 Total

The Total tile returns the total value of a field or abacus for all
records in the relation. Total {“Hours Worked”} returns all the hours
worked by all employees in the current relation.

10.6.1.4 Total For

The Total For tile returns the total value of a field or abacus for all
records that meet the specified criteria. For example, to see the total
sales of barcode readers in Florida you could construct an abacus
like: Total {“Quantity”} for {{{“Item”} = {Reader}} and {{“State”} =
{Florida}}}.
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10.6.1.5 Average

The Average tile returns the average value of a field or abacus
throughout a relation. Helix totals all values and then divides by the
number of records in the relation. For example, assume that a rela-
tion has 10 records, eight of which have values in a number field; the
value is undefined in the remaining two records. If the total of the val-
ues in the eight records is $160, the average tile returns $20 (160÷8).

10.6.1.6 Average For

The Average For tile returns the average value of a field or abacus for
records that meet the criteria specified in the “for” hole. Average
{“Time”} for {{“Job”} = {WELDING} considers only those records for
which the job was welding.

See Count For, section 10.6.1.2 for more information.

10.6.1.7 Minimum
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The Minimum tile finds the smallest value entered for a given field or
abacus. Helix evaluates dates chronologically, choosing the earliest
date as the minimum, False is always the minimum for flag data. Helix
evaluates text alphabetically, choosing the alphabetically first value
as the minimum. Text evaluation is not case sensitive.

10.6.1.8 Minimum For

The Minimum For tile returns the minimum value for a given field or
abacus among records that meet the criteria specified in the “for”
hole. For example, Min {“Date”} for {{{“Company”} = {Apple}} and
{{“Price”} > {30}}} returns the first date on which Apple Computer’s
stock closed at higher than 30 points.

10.6.1.9 Maximum

The Maximum tile finds the highest value entered for a given field or
abacus. For example, {{Max {“ID#”}} + {1} can be used to calculate
the next ID number to be assigned. Helix evaluates dates chronologi-
cally, choosing the latest date as the maximum. True is always the
maximum for flag data. Helix evaluates text alphabetically, choosing
the alphabetically last value as the maximum. Text evaluation is not
case sensitive.
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Note: An Undefined {“Field”} becomes {1} can be placed
into the hole of the Max tile to provide the first number in
a Max + 1 calculation.

10.6.1.10 Maximum For

The Maximum For tile returns the maximum value for a given field or
abacus among records that meet the criteria specified in the “for”
hole.

For example, to find the largest volume of incoming calls for either a
Sunday or a holiday, you could create an abacus containing: Max {“#
of calls”} for {{{Day of Week {“Date”} = {1}} Or {“Holiday?”}},
assuming that Holiday? is a flag field.

10.6.2 Sub Tiles

The sub tiles look up and summarize data for a subset of the records
in a relation. They are typically used to provide control break reports,
reports that group data according to matching values in a field and
compute summary data for each group.
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10.6.2.1 Sub-Count For

The Sub-Count For tile is a shortcut for a combination of Count for
and Lookup Summary. You can use it when there is only one condi-
tion on the data to be included in the count and when that condition
involves an equality.

You fill the black holes in the same manner as a Lookup tile. The right
black hole specifies the desired (target) relation and is the first hole
to be filled. The left black hole holds the field or abacus that acts as
the link in the target relation, and the middle black hole contains the
link from the current relation.

10.6.2.2 Sub-Total For

The Sub-Total For tile is a shortcut for a combination of Total For and
Lookup Summary. You can use it when there is only one condition on
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the data to be included in the total and when that condition involves
an equality.

You fill the black holes in the same manner as a Lookup tile. The right
black hole specifies the desired (target) relation and is the first hole
to be filled. The left black hole specifies which field or abacus is to be
totaled, the second black hole from the left contains the field or aba-
cus that will act as the link in the target relation, and the third black
hole from the left contains the link from the current relation.

The first hole must contain a numeric value; the second and third
holes may contain any data type except picture or document as long
as they are the same.

10.6.2.3 Sub-Average For

The Sub-Average For tile is a shortcut for a combination of Average
For and Lookup Summary. You can use it when there is only one con-
dition on the data to be included in the average and when that condi-
tion involves an equality.

Note: This tile has a Use From tile built into it, in the sense
that the third hole will contain the value from the current
record.

You fill the black holes in the same manner as a Lookup tile. The left
black hole specifies the desired (target) relation and is the first hole
to be filled. The right black hole specifies which field or abacus is to
be averaged, the second hole contains the field or abacus that acts as
the link in the target relation, and the third hole contains the link
from the current relation.
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The first hole must contain a number or a fixed point field; the sec-
ond and third holes may contain any data type except picture or doc-
ument as long as they are the same.

10.6.2.4 Sub-Minimum For

The Sub-Minimum For tile is a shortcut for a combination of Mini-
mum for and Lookup Summary. You can use it when there is only one
condition on the data to be included in the average and when that
condition involves an equality.

You fill the black holes in the same manner as a Lookup Tile. The left
black hole specifies the desired (target) relation and is the first hole
to be filled. The first hole specifies which field or abacus for which
you want the minimum value, the second hole contains the field or
abacus that acts as the link in the target relation, and the third hole
contains the link from the current relation.
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10.6.2.5 Sub-Maximum For

The Sub-Maximum For tile is a shortcut for a combination of Maxi-
mum for and Lookup Summary. You can use it when there is only one
condition on the data to be included in the average and when that
condition involves an equality.

You fill the black holes in the same manner as a Lookup Tile. The left
hole specifies the desired (target) relation and is the first hole to be
filled. The first hole specifies the field or abacus for which you need
the maximum value, the second hole contains the field or abacus that
acts as the link in the target relation, and the third hole contains the
link from the current relation.

10.6.3 Form Tiles

Rather than evaluating every record in a relation, the form tiles look
at just the records displayed on a form.
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10.6.3.1 Form Count

The Form Count tile counts all records that currently appear on a
form. In other words, Form Count returns the number of records that
meet the conditions of the query attached to a view.

10.6.3.2 Form Count For

The Form Count For tile counts all records currently appearing on a
form that also meet the criteria in the tile. Form Count for {{“Name”}
starts with {J}}, for example, counts the names that start with J
within the set of records that meet the criteria of the form’s query.

10.6.3.3 Form Total

Output
N

Input Output
F N

Input Output
N N
FP FP



Summary Tiles

10-45

The Form Total tile calculates the total value of a field or abacus
based the set of records that meet the criteria of the form’s query.

10.6.3.4 Form Total For

The Form Total For tile totals the values of a field or abacus for all
records currently appearing on a form that also meet the criteria in
the tile.

See Total For (section 10.6.1.4) for more information.

10.6.3.5 Form Average

The Form Average tile calculates the average value of a field or aba-
cus based on the set of records that meet the criteria for the form’s
query.

See Average (section 10.6.1.5) for more information.

Input Output
N F N
FP F FP

Input Output
N N
FP FP



Chapter 10: Calculation Tiles

10-46

10.6.3.6 Form Average For

The Form Average For tile averages the values of a field or abacus for
all records currently appearing on a form that also meet the criteria
in the tile.

See Average For (section 10.6.1.6) for more information.

10.6.3.7 Form Minimum

The Form Minimum tile finds the smallest value of a field or abacus
based on the set of records that meet the criteria of the form’s query.

See Minimum (section 10.6.1.7) for more information.
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10.6.3.8 Form Minimum For

The Form Minimum For tile finds the minimum value of a field or aba-
cus for all records currently appearing on a form that also meet the
criteria in the tile.

See Minimum For (section 10.6.1.8) for more information.

10.6.3.9 Form Maximum

The Form Maximum tile finds the largest value of a field or abacus
based on the set of records that meet the criteria of the form’s query.

See Maximum (section 10.6.1.9) for more information.
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10.6.3.10 Form Maximum For

The Form Maximum For for tile finds the maximum value of a field or
abacus for all records currently appearing on a form that also meet
the criteria in the tile.

See Maximum For (section 10.6.1.10) for more information.
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10.7 Data Type Conversion Tiles
One of the ways to get around tile data type restrictions is to convert
data before sending it into a black hole. For example, if you want to
use a date in a concatenation, you must first convert it to text. The
following six tiles convert one data type into another. 

10.7.1 Text

The Text tile converts other data types to text for use with tiles that
require text type data. For example, if you wanted to display a sen-
tence at the bottom of a report that says “Printed on February 13,
2000” where the date and time are supplied by a Form Time tile, you
would create a statement that says {“Printed on “} Followed by {Text
{“System Clock”}}. The date, February 13, 2000, is the result of the
System Clock abacus that contains a Form Time tile formatted to dis-
play the data spelled out completely.

All data types except picture and document can be converted to text.

10.7.2 Styled Text
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The Styled Text tile converts any field type except picture or docu-
ment to styled text format.

The black hole in the Styled Text tile can accommodate a Field or
Abacus of any type listed in the Input/Output chart for this tile
(above) or it can take direct input by double clicking in the black
hole.

To format the output of a Styled Text tile, double click anywhere on
the tile or its arrow to open the Assign Style to Text dialog box.

You could use a Styled Text tile, for example, with an If-Then-Else tile
to display positive and negative numbers on a list in different colors
and/or text styles. 

Note: When using Styled Text tiles in a series of Followed
By tiles (such as when creating a mailing label), every
black hole must be filled with a Styled Text tile, even if the
tile only contains a space.

10.7.3 Number

The Number tile converts other data types to numbers.
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For example, many shipping companies use some form of zone for
billing and/or marketing research purposes. A zone might be a text
string (such as North, South, East, or West) or it might be a number.
When used as a number, it is usually some form of code in that ship-
ping company’s computer system.

With Helix RADE, you can accommodate this type of data variance by
storing the zone as text. If you later want to use a numeric zone in a
calculation of shipping charges, you can convert it to a number and
then use the result of the conversion in any necessary arithmetic
operations.

When converting text into a number, it must be entered in the form of
a legal number. Some acceptable forms are:

• 5.7

• $56

• $92.50

• 8.8799103E14

• (10861)

A date cannot be converted into a number.

A fixed point value can be converted into a number when you need to
use that number in non-fixed point calculations.

Number tiles are often used to convert flag data into number data.
For example, assume that a teacher used a flag field for Extra Credit.
This way, a check box or a radio button could be used in the applica-
tion’s user interface to indicate whether a student earned extra credit
on a particular assignment.

When preparing a grade sheet, the teacher could use the calculation
{“Test Score”} + {Number {“Extra Credit”)) to obtain final scores. In
the special case of a Flag field, the Number Tile returns 1 for True and
0 for False. 

If the value in the Number tile’s black hole is undefined, output is also
undefined.
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10.7.4 Fixed Point

The Fixed Point tile converts other data types to fixed point. As with
the Number tile, when converting text to a fixed point, the text must
be in an acceptable numeric form. 

A date cannot be converted to a fixed point value.

Note: To be converted to fixed point, number or text char-
acters must fall within the acceptable range for Fixed
Point, i.e., ±107. Extremely long decimals will be trun-
cated when converted to fixed point.

10.7.5 Date

The Date tile converts text to a date, provided the text is in a legal
date form. Examine the format options of the date data type (see sec-
tion 5.6) to see the accepted forms.
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10.7.6 Flag

The Flag tile converts other data types to a flag. If you are converting
a Number, it must have a value of either 1 or 0. Numerical values
other than one or zero give an output of undefined (neither true nor
false). 

If, for example, you wanted to see a list of all records where a number
or fixed point field had a value of one, an easy way to do that would
be to place that field in a Flag tile abacus and select that abacus as
the query for the list.

Text must match one of the formats given for a flag field.

A Date cannot be converted to a flag.
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10.8 Document Manipulation
The tiles that deal with the special nature of document fields fall into
two groups: those that extract information from a document (Docu-
ment Name, Document Create Date, Document Storage, Document
Modify Date, Document Type, Document Size, Document Path, and
Picture), and those that produce documents with modified attributes
(Change Document Name, Change Document Type, Change Docu-
ment Path, and Change Document Modify Date).

10.8.1 Document Name

The Document Name tile returns the document name as it appears on
the document’s icon.

10.8.2 Document Create Date

The Document Create Date tile returns the date and time that the
document was created. An abacus containing this tile can be format-
ted to display the date only, time only, or the date and time.

Input Output
Doc T

Input Output
Doc D



Chapter 10: Calculation Tiles

10-56

10.8.3 Document Modify Date

The Document Modify Date tile returns the date and time when the
document was last modified. An abacus containing this tile can be
formatted to display the date only, time only, or the date and time.

10.8.4 Document Type

The Document Type tile returns an eight letter code; the first four let-
ters represent the file type and the second four are a creator code.

For example, a Microsoft Word document’s code is WBDNMSWD; a
QuarkXPress Template is XTMPXPRS, and a Quark document is
XDOCXPRS.

10.8.5 Document Size
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The Document Size tile returns the size of the document in bytes. An
abacus containing this tile can be formatted by clicking the Format
button in the abacus window tool palette.

To convert to K (kilobytes), divide the output by 1024.

10.8.6 Document Path

The Document Path tile returns the pathname for a document, from
the top level directory down through all hierarchal levels. The direc-
tory and each subdirectory (folder) are separated by a colon (:); the
pathname also ends with a colon.

10.8.7 Document Storage

The Document Storage tile returns a text string, either “Internal” or
“External”, indicating the storage format for the document.
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10.8.8 Change Name To

The Change Name To tile returns a copy of the document with a new
name.

10.8.9 Change Type To

The Change Type To tile produces a document with a type and cre-
ator that matches the eight letter code in the second hole of the tile.
The first four letters are the file type and the second four are the cre-
ator code. The type determines which application Helix opens in
response to the Work on Document command; therefore, changing
the type changes the application that Helix opens. As with the
Change Name To tile, Helix changes the type on a copy of the docu-
ment.
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10.8.10 Change Document Pathname To

The Change Pathname To tile returns a document with a pathname to
match the pathname in the right black hole of the tile. The directory
and each subdirectory (folder) must be separated by a colon (:); the
pathname must end with a colon.

This tile can be used in conjunction with the Document Name tile to
construct a pathname to direct documents to a specific folder on the
user’s drive. As with Change Name To and Change Type To, Helix
changes the path on a copy of the document.

10.8.11 Change Modify Date To

The Change Modify Date To tile returns a document with a modifica-
tion date that matches the date in the right black hole of the tile.

As with Change Name To and Change Type To, Helix changes the date
on a copy of the document.
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10.8.12 Picture

The Picture tile returns a picture of the first page of an internally
stored document that has been saved as text only, PICT, or EPS. Place
an abacus containing the Picture tile in a data rectangle on a tem-
plate and scale the image to fit.

To allow the picture to display without distortion, make sure the data
rectangle has the same proportions as your page size.

For example, to scale an 8-1/2” by 11” page at 25%, the rectangle
should be 1-7/8” by 2-1/2”; at 50%, the rectangle should be 3-3/4” by
5.”

For externally stored documents, Picture tile returns the text string,
“Not available”.
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10.9 Relationship and Logical Operator Tiles
The relationship and logical operator tiles let you build logical
expressions against which data can be evaluated. All of these tiles
return either true or false.

These tiles can accept values of any data type except Picture or Doc-
ument. However, the values being compared must be of the same
type. 

Because the relationship and logical operator tiles all return a flag
value, they are very useful when used as abacus queries to restrict
the records that appear on a form.

Note: For decimals, comparisons are based on the stored
value rather than the displayed value.

10.9.1 Equal To

The Equal To tile returns true when the values match and false when
they do not. You can find an example in the discussion of the If-Then-
Else tile (see section 10.10.1).

The Equal To tile can be used with a keyword field. However, the
records retrieved must exactly match the text string typed into the
second hole. In other words, when used on a keyword field, Equal To
requires that the entire contents of a keyword field match the con-
tents of the second black hole in the tile.

For example, if you are attempting to locate a record whose keyword
field says “I need to do this today”, the Equal To tile must contain
exactly those words, with exactly the same punctuation and spacing.
An attempt to match a single word, such as “today,” does not produce
a match. You could, however, retrieve in this way using the Word=
tile.
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Because Helix maintains more digits of precision than typically
appear on the screen, decimal numbers should be tested with a three
hole inequality tile as described in sections 10.9.7, 10.9.8, 10.9.9, and
10.9.10.

Caution: The Equal To tile performs a logical test for
equality. It is not the equivalent of a programming lan-
guage assignment operator and cannot be used to assign
a value to a field.

10.9.2 Not Equal To

The Not Equal To tile is the opposite of the Equal To tile. It returns
true when the values do not match and false when they do.

10.9.3 Less Than

The Less Than tile returns true when the value on the left is less than
the value on the right.

Tip: When working with Greater Than/Less Than tiles, it
may be helpful to remember that the tile returns true
when the symbol points to the smaller value.
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10.9.4 Less Than or Equal To

The Less Than or Equal To tile returns true when the value on the left
is either equal to or less than the value on the right.

10.9.5 Greater Than

The Greater Than tile returns true when the value on the left is
greater than the value on the right.

Tip: When working with Greater Than/Less Than tiles, it
may be helpful to remember that the tile returns true when
the symbol points to the smaller value.

10.9.6 Greater Than or Equal To
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The Greater Than or Equal To tile returns true when the value on the
left is greater than or equal to the value on the right.

10.9.7 A Less Than or Equal To B Less Than or Equal To C

This tile returns true if the value of the middle hole is either equal to
or between those of the other two holes.

For example, {Dallas} ≤ {“City”} ≤ {Ft. Worth} is true when the
value of the City field is Denver, Evanston, Dallas, or Ft. Worth and
false when it is Chicago, New York, or Los Angeles.

10.9.8 A Less Than B Less Than C

This tile returns true if the middle hole has a value between those of
the other two holes and false if it does not.

For example, {Dallas} < {“City”} < {Ft. Worth} is true when the
value of the City field is Denver or Evanston and false when it is Chi-
cago, New York, Dallas, Ft. Worth, or Los Angeles.
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10.9.9 A Less Than or Equal To B Less Than C

This tile returns true if the value in the first hole is less than or equal
to the value in the second hole, and if the value in the second hole is
less than the value in the third hole.

10.9.10 A Less Than B Less Than or Equal To C

This tile returns true if the value in the first hole is less than or equal
to the value in the second hole, and if the value in the second hole is
less than the value in the third hole.

10.9.11 And
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The And tile accepts only flag input. If both input values are true,
then the tile returns true. If one or both of the inputs are false, then
the tile returns false.

For example, if you wanted to find a dog owner who lived in New
York, you could use {{“City} = {New York}} And {{“Pet”} = {Dog}}.

10.9.12 Or

The Or tile accepts only flag type input. If either or both of the input
values are true, the tile returns true. If both input values are false, the
tile returns false. Either hole can be undefined. If the defined hole is
true, the tile returns true.

If, for example, you were a Los Angeles company evaluating prospec-
tive employees, you might look for one who {“Owns a car?”} Or
{“Lives in LA?”}. The result is true if the candidate owns a car, lives
in LA or both.

10.9.13 Not

The Not tile reverses the value of flag data.

A landlord might require that a tenant Not {“Own a pet?”}. If “Own a
pet?” is true, the tile returns false.
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10.10 Conditional and State Test Tiles
The conditional and state tiles evaluate, compare, and/or change the
condition of data. These tiles include If-Then-Else, Defined, Unde-
fined, Undefined Becomes, Unique, Smaller of, and Larger of.

10.10.1 If-Then-Else

The If-Then-Else tile returns one of two possible results, depending
on whether the logical expression in the first hole is true or false. The
first hole must contain flag data; the second and third holes can be of
any type, as long as they are the same.

For example, a sales manager might need to determine quarterly
bonuses: If {{“Sales”} > {“Quote”}} Then {{“Commission”} +
{“Bonus”}} Else {“Commission”}:

Either the second or third hole can be left empty, as in If {{“Line#”}
= {1}} Then {“Invoice#”} Else { }. This construction returns the
invoice number when the line number is 1, and is undefined for the
other line numbers.

Note: In cases where the value in the “If” hole is unde-
fined, the tile itself becomes undefined and Helix does not
consider the “Else.” 
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Tip: Undefined output is useful for triggering conditional
button display. For more information, see section 8.1.8.3.

The construction If {{“Date”} < {1/1/95}} Then {Last year} Else
{This Year} does not return “This Year” when the content of the Date
field is undefined. (The Undefined Becomes tile can come in handy
here.)

An “If” can be used within another “If,” as in If {{“Room”} = {Conser-
vatory}} Then {If {{“Suspect”} = {Prof. Plum}} Then{Lead pipe}
Else {Wrench}} Else {Rope}:

If the second hole is undefined, tile output is undefined when the first
hole is true. If the third hole is undefined, tile output is undefined
when first hole is false.

10.10.2 Defined

The Defined tile tests for the presence of a value. It returns true when
it finds a value. For example, you could use this tile when you wanted
to display a message on a form after a name had been entered into a
field: If {Defined {“Name”}} Then {That’s a nice name.} Else { }.

Note: The Defined tile itself can never be undefined, even
if nothing is placed in its black hole!
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10.10.3 Undefined

The Undefined tile tests for the absence of a value. When there is no
value, the tile returns true. As with Defined, the tile itself is never
undefined.

10.10.4 Undefined Becomes

The Undefined Becomes tile acts somewhat like a filter to prevent
fields from being undefined. If a value is present in the field in the
tile’s left black hole, the value passes through the tile without being
changed in any way. If the field has no value (in other words, is unde-
fined), then the field takes on the value in the tile’s right black hole.

Any data type can be used, but both holes must be of the same type.
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10.10.5 Unique

The Unique tile returns a value of true when a value is unique for the
field in its own relation.

One use of Unique is in validation, either to prevent a unique value
from being entered or to force a unique entry. For example, to force a
unique entry, you could use the following expression in an abacus
that would be used as field validation: If {Unique {“Bookcode”}} Then
{ } Else {That code is already taken}.

10.10.6 Smaller Of

The Smaller Of tile compares two values of the same type and returns
the lesser of the two. If the two values are the same, the tile returns
the value. The tile evaluates text alphabetically, with “ABC” being
smaller than “B.” For dates, the earlier date is the smaller. With flags,
Helix considers false to be less than true.
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10.10.7 Larger Of

The Larger Of tile returns the larger of the two values placed in its
holes.
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10.11 Lookup Tiles
Lookup tiles retrieve data based on matching conditions specified by
the collection developer.

10.11.1 Lookup For

The Lookup For tile retrieves the con-
tents of a field or calculation in a record
that has already been stored in the col-
lection. That record may be in any rela-
tion within the collection, including the
relation where the Lookup For is con-
structed.

The Lookup For tile is different from
most other tiles. You fill in the fourth
hole first. To do so, double click any-
where on the face of the tile to open the
following dialog box.

Select the relation to look into (the tar-
get relation) from the list of relations at
the right of the dialog box (under the
heading “in”). Only relations can be
placed in the fourth hole.
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Tip: Clicking an icon at the top of a list in the lookup tile
dialog box activates the list. You can then type letters to
speed select anything in that slot. 

Once you have selected the target relation, you can fill in the leftmost
hole (under the heading “Lookup for”) to indicate the field or abacus
whose value you want the tile to retrieve. Use the icon switches at
the top of the list to toggle the list between field and abacus names.

The second and third holes tell Helix how it should identify the
record from which it should retrieve a value. The second hole con-
tains the value in the target relation (the target key) that Helix should
match to the value in the third hole. To select the target key, choose
a field or abacus from the second list from the left (under the heading
“Target key =”).

You can fill the third hole in one of three ways.

• Choose an abacus or field in the source relation (under the head-
ing “Source key =”).

• Close the dialog box and then drag a field or abacus from the 
selection list in the abacus’s window.

• Close the dialog box and then double click the third hole in the 
tile to open the value dialog box where you can type a literal 
value. You can also click the Constant button to open the same 
dialog box.

As an example, assume that your database has two relations: a cus-
tomer relation that stores names, addresses, and account numbers,
and a log of day-to-day dealings with these customers. The relations
are related in a primary key–foreign key relationship based on the
customer ID number.

When a user enters data into the second relation, all he or she needs
to type is the ID number; the remainder of the customer data are
stored in the customer relation. However, to help the user be sure
that he or she has entered the correct ID, the data entry form can dis-
play information about the customer such as a name and address.
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This is precisely the function that the Lookup tile performs. Lookup
{“Name”} for {“ID #”} = {“ID #”} in {“Customers”} looks in the cus-
tomer relation for a record where the ID number matches the ID num-
ber typed on the data entry form. The tile then returns the contents
of the Name file from the record it finds.

Tip: You can significantly enhance the performance of the
Lookup tile by building an index on the target key. In the
above example, you would want to index the ID # field in
the customer relation.

Caution: If the target relation contains more than one
record with the same target key value, the Lookup tile
finds only one of these records. The assumption that the
tile will find the “first” of multiple records with the same
linking value may not be valid when using this tile. To list
multiple target records with the same target value, you
need to use a subform (see section 8.1.9).

10.11.2 Lookup Summary

Use the Lookup Summary tile to get the results of a summary opera-
tion performed in another relation. Summary operations are those
that are not specific to a record, such as Total, Total For, Maximum,
Maximum For, Minimum, Minimum For, Average, Average For, Count,
Count For, and so on.
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Often the summary you are looking up depends on a value from the
current record to complete its calculation. The Use From tile comes
to the rescue and performs that function.

As an example, assume that you have two relations, Customers and
Orders. Whenever you open a data entry form in the Customers rela-
tion, you want to see the total of all the orders the customer has
placed, but the data about the orders are in the Orders relation. To
solve the problem, you create an abacus called Customer Total in the
Orders relation. You then use Lookup {“Customer Total”} Summary in
{“Orders”}, which gives you the total for the specific customer’s
orders.

10.11.3 Use From

The Use From tile has two major uses.

• It can retrieve a value from the record currently displayed on a 
data entry form. For example, it can grab a value that identifies a 
group of records for which you want to compute a subtotal. 

Assume that you want to see the total sales for the date visible on
a data entry form in an Orders relation. To compute the total
sales for that specific date, you need to use the Use From tile to
include that date in the calculation. When you place an abacus
containing the tiles at the beginning of this section in a data rect-
angle on the data entry template, Helix examines each record in
the Orders relation, with the date on the left of the Equal To tile
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containing the value from a stored record and the date in the Use
from tile containing the date from the record displayed on the
form on which the abacus appears. 

If you did not use the Use From tile, and just used {“Date”} =
{“Date”}, Helix would not know that you wanted to use the date
on the form. Both Dates would contain the value from the stored
record, so the two dates would always match and Helix would
compute the total for all records in the relation.

• Use from can also retrieve a value from a template. A typical such 
use is to restrict the records that appear in a subform based on 
data entered by the user on the same form. The host form allows 
the user to enter a value into an inert field. When the user presses 
tab, the value in the inert field restricts the records that appear in 
a subform on the template. In this case, you attach the abacus 
query containing the Use From tile to the subform. The tile then 
looks out to the value from the host form relation, grabbing the 
value the user entered.

To prepare a Use From tile:

1. Double click on the right hole to open a dialog box that displays a 
selection list. The relation and template switches at the top con-
trol the contents of the list. Choose the source for the tile’s value 
from one of the lists.

2. Fill the left hole by dragging a field from the selection list in the 
abacus window.
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10.12 Positional Tiles
The tiles in this category find values depending upon the relative
position of either stored records or the records displayed on a form.
The Previous tiles find a value by searching through existing records
(either in the relation or on a form, depending on the specific tile) in
descending positional order beginning from the location of the cur-
rent record. 

The previous record is the record that is placed before the current
record in a specific ordering, as indicated by the index specification
for the form on which an abacus containing the tile has been used.
However, whether the tile searches all the records in the relation or a
subset of the records depends on the specific tile in use.

In any case, the records available to this search are only the ones
positioned before the current record. If an index is selected for a form
that includes an abacus containing this tile, Helix uses the index
selected for that form to determine the record ordering. If no index is
selected, Helix uses the order in which records were entered.

Practically speaking, the previous record is that record which imme-
diately precedes the current record on a list. On a non-listing form,
the previous record is the record that would be found by using the
Find Previous menu command.

Note: Since the Previous tiles reference the ordering of
existing records and an unentered record has no place in
that ordering, a Previous tile displayed on an entry form
will not have a defined value for the unentered record.

10.12.1 Previous

The Previous tile finds the value of a field or abacus that is present in
the record previous to the current record. Although the ordering of
the records depends on the index selected on the form that includes
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the tile, Helix considers all records in the relation when finding the
previous record. This means that the previous record is not neces-
sarily a record that can be displayed on the form. In other words, the
previous record may not meet the conditions in the query attached
to the form.

For example, when used as a query for a listing form, this query
allows only one instance of the same name to be displayed if the
form bases its display on an index built on the Name field. In other
words, the list displays only unique names.

Tip: Because there is no previous record in relation to the
first record on a list, Undefined {“Name”} becomes
{False} can be used to allow the display of the first
record. See the discussion of the Form Previous tile (sec-
tion 10.12.3) for more information.

10.12.2 Previous For

The Previous For tile finds the value of a field or abacus from the
record previous to the current record that meets the specification
plugged into the right black hole. Although the ordering of the
records depends on the index selected on the form that includes the
tile, Helix considers all records in the relation that meet the criteria
in the right black hole when finding the previous record.

As an example, consider the tiles at the beginning of this section. On
a list, the calculation displays the previous Call Date for an entry
with a matching name. Such a calculation is not bound by the current
form query (it bases its search on all records in the relation) and can
search records not appearing on the list. 
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Tip: Because there is no previous record in relation to the
first record on a list, Undefined {“Name”} becomes {False}
can be used to allow the display of the first record. See the
discussion of the Form Previous tile (section 10.12.3) for
more information.

10.12.3 Form Previous

The Form Previous tile finds the previous value of a field or abacus
from the previous record. Helix bases its search on the set of records
that meet the criteria of the form’s query. The index selected for the
form, if any, determines the ordering of the records.

The example shown at the beginning of this section can be used to
suppress duplicate name entries on a list. The Form Previous tile
delivers the Name value from the previous record to the Equal To tile,
where it is compared to the same field value in the current record. To
provide for displaying the first name in a list, the calculation treats an
undefined comparison as false.

The If-Then-Else tile then switches between displaying nothing (unde-
fined) if the name in the current record is the same as the name from
the previous record, or displaying the field value for the current
record if the current name is different from the previous name. The
abacus containing the entire calculation is then placed in a data rect-
angle on a template.
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10.13 Queries
Searching for specific records, screening groups of records, listing a
subset of records, or batch posting from selected record groups—all
of these are examples of operations that usually imply the presence
of a query.

A query is a calculation that returns a true or false value. When a
query becomes an attribute of a form, only records that meet the
query conditions (the calculation test delivers true) can or do appear
on that form.

There are four direct query avenues available in Helix. The differ-
ences lie in the presentation of the tools used in building the query
calculation and reflect varying degrees of convenience versus power
and complexity.

1. Quick Query: A quick query can query according to only one crite-
rion at a time (except when a defined form query is also attached 
to the form). It has a very limited range of operators but is the eas-
iest to construct, and is handy when you need to ask a simple 
question.

2. Form Query: A form query can select records containing values 
that fall within a specified range. It has more operators than a 
quick query but no Or statements. You attach a form query to a 
view when in form setup mode.

3. Abacus Query: An abacus query is any abacus calculation that 
returns a flag value. You attach the query to a form when the view 
is in form setup mode. An abacus query allows complex logical 
expressions that include Or statements such as “Find all custom-
ers for Jiffy Clean or Jiffy Spiff who live in Idaho.” Abacus queries 
can only be constructed and/or modified in Full Mode.
Some classes of tiles are particularly useful in abacus queries, in
particular the comparison tiles (see section 10.9). These tiles
accept various inputs for comparison, returning true, false, or
undefined. In the context of a query attached to a form, note that
Helix treats an undefined query result as a false result.
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Any abacus that returns a flag value can be used as a query.

When choosing specifications for a form in form setup mode,
Helix makes all abacus icons of the correct type available for
selection in the query column (the center column with the three
icons at the top in the illustration above). Clicking the abacus
switch displays the names of the available abacus queries.

4. Power Query: The Power Query is a hybrid of the form query and 
the abacus query. Like the abacus query, you can construct com-
plex And/Or statements; unlike the abacus query, these state-
ments can be modified in Custom or Client/Server Mode. For 
more on the Power Query, see section 9.4.
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10.14 Tile Reference

10.14.1 Visual Tile Reference
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10.14.2 Speed Select

You can speed select tiles while in an abacus window. Typing one or
more characters selects the first tile beginning with those letters;
pressing Tab moves to the second tile, and so on.

The pages contain a list of the order in which tiles are selected if you
type only the first letter and Tab. An asterisk (*) indicates that there
is more than one way to select the tile.
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A

And*
Absolute Value
Arc Tangent
Annuity Rate
Average
Average For

C

Contains*
Cosine
Compound Rate
Count
Count For
Change Name To
Change Path To
Change Mod. To
Change Type To

D

Date
Defined
Day of Week
Day
Date/Time
Doc. Name
Doc. Create Date
Doc. Mod. Date
Doc. Type
Doc. Size
Doc. Path
Doc. Storage

E

Ends With*
Extract

F

Fixed Point
Flag
Followed By*
Followed/Or*
Fraction
Form Count
Form Count For
Form Total
Form Total For
Form Average
Form Average For
Form Minimum
Form Minimum For
Form Maximum
Form Maximum For
Form Previous
Form Time

H

Hour
Hour/Minute/Second

L

Long Integer
Length
Lower Case
Locate
Larger Of
Logarithm (common)
Logarithm (natural)
Lookup
Lookup Summary
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M

Mixed Case
Month
Minute
Month/Day/Year
Minimum
Minimum For
Maximum
Maximum For

N

New Line
Not

O

Or*

P

Picture
Previous For
Previous
Post Time

R

Round
Round to Nearest

S

Styled Text
Starts With*
Smaller Of
Sine

Second
Sub-Count
Sub-Total
Sub-Average
Sub-Minimum
Sub-Maximum

T

Text
To Power Of*
Tangent
Today
Total
Total For

U

Upper Case
Undefined
Undefined Becomes
Unique
Use From
UserName

W

Word Starts With*
Word =*

Y

Year
Display
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Option-J

Delta Seconds*
Delta Minutes*
Delta Hours*
Delta Days*
Delta Weeks*
Delta Months*
Delta Years*

Option-V

Square Root

Option-Space Bar

Display

Hyphen

Subtraction*
Negation (-)

Space Bar

Addition
Subtraction
Multiplication
Division
Word Starts With*
Word =*
Starts with*
Contains*
Ends With*
Followed By*
Followed/Or*
Equality (=)
Not Equal (≠)
Less Than (<)

Less Than or Equal To (≤)
Greater Than (>)
Greater Than or Equal To (≥)
Greater Than or Equal To • and
Less Than or Equal To (≥, ≤)
Greater Than • and Less Than (>, <)
Greater Than or Equal To • and
Less Than (≥, <)
Greater Than • and Less Than or
Equal To (>, ≤)
And*
Or*
To Power Of*
Delta Seconds*
Delta Minutes*
Delta Hours*
Delta Days*
Delta Weeks*
Delta Months*
Delta Years*



Chapter 10: Calculation Tiles

10-90



Reference

Chapter

Helix

11

Document 
Management
This chapter describes how to exploit Helix’s 
implementation of BLOB (Binary Large Object) 
technology to create workflow applications with 
integrated document management capabilities.
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11.1 Introduction to Document Management
One problem many computer users share is the need to keep track of
the documents on which they are working, especially those docu-
ments that are written and maintained by more than one person. Peo-
ple transfer copies of documents from one machine to another using
disks, over a local area network, and over the Internet. 

Because more and more of the work we do involves the production of
electronic documents, the need to control and manage this prolifera-
tion has increasingly become a priority for many businesses as well
as individuals. Using Helix’s Binary Large Object (BLOB) technology,
you can create workflow management applications that reduce the
proliferation of documents and focus on getting each one processed
through the cycle from start to finish.

Helix uses this BLOB technology to define a document data type (see
section 5.9). A document field can be used to store, retrieve and,
most importantly, to open and manipulate an application or docu-
ment from within Helix. Documents can be maintained either within a
collection (internal storage) or externally using alias files that point
to the original document.
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11.2 Document Storage Options
Helix offers three storage options for docu-
ments—always internal, always external, and
format on demand (the user decides with
each document stored). You can reach these
options by clicking the Storage button in an
open document field icon.

When you click the Storage button, a dialog
opens from which you can select the storage
location: Always Internal, Always External, or
Let Me Decide.

When displayed in a collection, document icons indicate
their storage location. External documents are shown with a
small disk in the lower right corner, while internal documents
are shown with a small collection icon in the lower right cor-
ner.

11.2.1 Always Internal

The default storage option is Always Internal. Such documents are
stored within the collection and can be accessed only through the
collection in which they are stored.

The biggest drawback to internally stored documents is that they can
cause a collection to grow to become very large, very quickly.

11.2.2 Always External

External document storage allows you to store documents outside
the Helix collection. Such documents can be stored on any mount-
able volume including AppleShare volumes, hard disks (either your
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own or one elsewhere on the network), floppy disks, CD-ROMs, and
other removable media.

Helix maintains a reference to the document’s physical location that
it uses when a user requests an Open, Print, Work On, Delete, or
other command affecting the document field. If the volume on which
the document resides is not currently mounted, Helix attempts to
mount it or directs the user to do so.

If you want to maintain distinct versions of externally stored docu-
ments, you can program a Helix application to do so or you can allow
Helix to do it automatically by clicking the Keep Versions check box.
For more on versioning, see section 11.3 later in this chapter.

11.2.3 Let Me Decide

The third storage option allows the user to decide what storage for-
mat is to be used on a case-by-case basis. The decision is made just
before copying the document into the collection. This option allows
for a mixture of internal and external documents in the same docu-
ment field.

When the user chooses Copy From Volume, a file selection dialog
opens with radio buttons at the top for the two storage formats. The
default storage is internal.
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If you want to maintain versions of documents, you can program that
function into the Helix application yourself. However, if you’re going
to do your version control only with externally stored documents,
Helix can perform this function. Select the Keep Versions for External
Documents check box.
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11.3 Document Versions and Version Control
Click the Keep Versions check box under Always External or the Keep
Versions for External Documents check box under Let Me Decide to
initiate document versioning within Helix. Each time Helix performs a
Work On Copy or Work On Original command, Helix creates a new
version of the document and appends characters to the document’s
name establishing the document’s identity and version number.

The first character following the document name is }. The second is
an alpha character from a to z signifying the collection that is refer-
encing the document. The third and fourth characters are two digits
from 00 through 99, signifying the version. 

Note: If you are using two collections whose documents
are stored on the same storage device(s), contact Helix
Technical Support for instructions on changing the collec-
tion referencing character.

By default, only the most current version is available automatically to
a Helix collection. However, you can program version tracking into
the collection to access older versions based on the version codes.

Caution: Because there is no requirement that the docu-
ments be accessed using the Helix collection in which the
reference is stored, changes can be made to documents
outside Helix. This can result in incorrect version number-
ing. And, if a document name is changed, the versioning
trail will be broken.

Commands that act upon original documents (Work on Original,
Open Original, Transfer Original, and Delete Original) act upon the
current version of the document. They do not backtrack the version
trail to the document that was initially copied into Helix.
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11.4 Moving Documents
Externally and internally stored documents can be moved from one
location to another. This can be done in one of two ways.

When the reference is brought into Helix using a Copy from Volume
command, click the Move File button in the file selection dialog.

A second file selection dialog opens from which you can select the
new location for the original document (the one you are copying into
the collection).
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11.5 Working with Documents
The commands found under the Docs menu deal specifically with
working with documents. They are discussed here and in section 4.8.

11.5.1 The Document Pathname

Helix locates external documents by storing a pathname to the file’s
storage location. A pathname begins with the volume name—the
hard drive or other storage medium—and then traces the file down
through the hierarchy of folders. The different parts of the pathname
are separated with colons.

When you move a document into Helix, Helix remembers pathname.
Helix uses this remembered pathname whenever you initiate some
action, such as Work On, Print, Open, Delete, Update, and so on.

Tip: It helps to think of the pathname as an address that
would allow the document to be found from anywhere in
the universe. For example, you could express your address
as a pathname by saying Milky Way Galaxy: Solar System:
Earth: North America: USA: New York: 800 Fifth Avenue:
Apt. 213C.

11.5.2 Copy From Volume

Copy From Volume brings a copy of a document into a document
field, leaving the original document unchanged.

To perform a Copy From Volume, first select the document field on a
form by clicking on it once. Then choose Doc->Copy From Volume.

Note: Undefined document fields are highlighted when
selected. If the field contains a document, the document
name and its related icon, if available, are inverted.

A standard file dialog appears so that you can select and copy any file
accessible to your Macintosh. Move through the folders until you find
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the document that you want. Select it and then click the Copy File
button.

For internally stored documents, Helix checks to make sure that
there is enough space on the disk for the document. If there is, space
is allocated for the document. For externally stored documents, a ref-
erence is brought into the collection. In either case, Helix retrieves
the document’s icon and name and displays them in the document
field.

Tabbing out of the document field triggers any calculations that dis-
play information about the document.

Helix does not move the document (or reference) into the collection
until you select the Enter command, or press the Enter key. At that
point, Helix checks to make sure that the document still exists and
then moves a copy of, or a reference to, it from the volume into the
collection.

A thermometer appears during the transfer of a document into Helix.
The transfer can be interrupted by holding down the Command key
and typing a period. If the transfer is interrupted, the form reappears
as it was before you selected Enter. Data in inert fields remain and no
data are posted for forms with Post on Enter triggers.

To distinguish between documents that have not been transferred
into a collection on a form from those that have, unentered docu-
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ments appear as grayed icons; transferred documents appear as nor-
mal icons.

11.5.3 Move Into Collection

Move Into Collection, available only for internally stored documents,
copies a document into a collection and then deletes the original doc-
ument from wherever it is stored. This two step process is used to
ensure that the original remains untouched in the event of a system
failure during the Move Into Collection operation.

The Move Into Collection dialog box appears above. As with Copy
from Volume, you can cancel the operation by typing Com-
mand-period.

Note: To distinguish documents that have not been trans-
ferred into the application on a form from those that have,
unentered documents appear as grayed Icons; transferred
documents appear as normal icons. See the pictures in
section 11.5.2.

11.5.4 Copy To Volume

Copy To Volume places a copy of the document on a selected volume.
The copy is then separated from Helix and can only be brought back

Entered and not selected

Not entered and not selected

Entered and selected

Not entered and selected
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into Helix using a Copy from Volume or Move Into Collection com-
mand.

After you choose Copy To Volume, Helix presents a standard Save
File dialog box.

Use this dialog box to choose the destination for the document.

The destination is preset to the file’s original location (if it still
exists). The folder where the Helix application is stored becomes the
default destination if the original path is no longer accessible
(because a folder was deleted, renamed, or moved) or does not exist
(because the document was loaded into your application from a dif-
ferent workstation or file system).

You can change the path from the default before copying the docu-
ment.

The Save File dialog box displays the file’s original name. The name
of the copy can be changed by typing a different name in the Save
File dialog box before the copy is made. Doing this does not affect the
original or stored document that is being copied.

If a document with the same name already
exists in the location where the copy is being
placed, Helix displays the standard Replace?
dialog box.

After selecting the path, initiate the transfer
operation by clicking the Copy File button or pressing the Return key.

Helix displays a thermometer during the transfer. The process can be
interrupted by typing Command-period.
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Helix checks the document as it is being transferred. If the document
is not copied intact to the selected destination, Helix displays the fol-
lowing dialog box.

Usually, the best choice is to click on the Redo button. This repeats
the Copy To Volume procedure and transfers the document again. A
dialog box appears asking if you wish to replace the existing (and
possibly damaged) copy. Choose Redo.

The Abort button removes the copy of the document from the vol-
ume and terminates the Copy To Volume command.

The Continue button finishes the Copy To Volume procedure with the
current document. You can then open and examine the document to
see if it is undamaged.

11.5.5 Work On Commands

The Work On Copy and Work On Original commands perform similar
functions. Only Work On Copy is available for internal documents.
Both commands are available for external documents and allow you
to look at and work on a document without quitting your Helix appli-
cation. After you complete work on the document, the revised docu-
ment (or reference to the revised document) can be returned to Helix
automatically.

11.5.5.1 Work On Copy
The Work On Copy command launches the application that created a
document, creates a copy of the document, and opens it in the appli-
cation so you can make modification to the copy.

Three conditions are necessary for Work On Copy.

• The Work On Copy command must be available either on a menu 
or in a sequence attached to a button.
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• The application in which the document will be opened must be 
present and available to the local workstation.

• There must be sufficient main memory and disk storage space to 
open the application and the document. 

Selecting a document and choosing the Work On Document com-
mand (or double clicking on the document field) begins a sequence
of operations.

• Helix moves a copy of the document to the hard drive folder that 
contains the Helix application.

Helix checks the document as it is
being created on the drive. If damage is
detected or suspected, the dialog box
at the right appears.

In most cases, the best choice is to
click the Redo button to transfers the
document again. A dialog box appears
asking if you wish to replace the existing (and possibly damaged)
copy.

The Abort button cancels the operation; the document’s applica-
tion will not be launched.

The Continue button proceeds with the operation.

• The Finder becomes the active application.

After the document has been copied and verified, the following
dimmed dialog box opens, indicating that you are switching out of
Helix.

• The document opens in the application in which it was created 
for the user to edit or examine.

If the application is not available, the Leave It, Retrieve It dialog
remains open, but no other action occurs. Click Retrieve It.

Caution: If you will be replacing the original in your Helix
application’s database with the edited document, do not
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rename or move the copy with which you are working.
(This includes performing a Save As within the opened
application.) Doing so changes the document’s pathname
and Helix will not be able to find it when you attempt to
move it or copy it back to the Collection.

Caution: Saving a document from within its native applica-
tion saves it only to the local drive. The document is not
saved in the Helix collection until you complete the next
step.

• After you make changes to a document, save it using the docu-
ment’s native application, and quit the application, Helix closes 
the dialog box with the Retrieve It option selected automatically. 

• Press the Enter key to store the changed document (or reference 
to the changed document) in the collection.

When you make changes to a document
and save it to disk using the document’s
native application but don’t quit the
application, Helix displays the dialog box
at the right.

You have the option of either aborting the
operation (that is, not replacing the existing document or reference
in the database with the new version) or Retrieving (replacing the
version currently in the collection with the new version). If you do
not want to bring the changed document (or reference to the
changed document) into the collection, select Leave It.

After selecting Retrieve It, you must press Enter to store the new ver-
sion of the document (or reference to the new version) in the collec-
tion. With either option, Leave It or Retrieve It, Helix instructs the
Finder to delete the document.

If you change a document but don’t save
it and then quit the document’s native
application, the dialog box to the right
appears. You have the option of returning
the unchanged document (or its refer-
ence) to the collection using Retrieve It or
not returning it using Leave It. With either
option, Helix instructs the Finder to delete the document copy from
the desktop.
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If you change a document but don’t save
it using the document’s native applica-
tion and leave the application running,
the dialog box at the right appears. The
options and implications are the same as
if you quit the application. (See the pre-
ceding paragraph for details.)

11.5.5.2 Work On Original
Available only for externally stored documents, Work On Original
performs as described in the preceding section (Work On Copy) with
the exception that Helix does not make a copy of the document. Any
changes are applied to the original, which is opened in its current
location rather than being copied to the local drive.

11.5.5.3 Open Document Commands
The Open Copy and Open Original commands are similar to the Work
On commands. The Finder launches the document’s application and
opens the document so it can be viewed, edited, and so on. The dif-
ference is that the document (or its reference) is not returned to
Helix. The document is separated from Helix and remains in the loca-
tion in which it was opened. No versions are tracked by Helix.

11.5.6 Documents in Calculations

Although arithmetic operations are not possible for document fields,
several tiles accept documents in their black holes. They are If-Then-
Else, Lookup, Defined, Undefined, Undefined Becomes, Display, Pic-
ture, and Use From. (Documents are, of course, accepted in the docu-
ment tiles; see section 10.8 for more information.)

Note: The comments in this section that apply to docu-
ment fields also apply to picture fields.

If-Then-Else (document accepted in the last two holes): Returns one
of two documents based on the truth of the expression in the first
black hole.
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Lookup: Retrieves a document based on a linking condition. A docu-
ment field can be placed in the first hole.

Defined: Returns flag output based on whether a document field
contains a document.

Undefined: Returns flag output based on whether a document field
is empty.

Undefined Becomes: Provides a default document if the value in a
document field is undefined.

Display: Displays a document’s name and icon.

Display Picture: Returns a preview, or thumbnail, of the first page of
a document.

Note: The Display tile returns an image if the document’s
file type is PICT, TEXT, or EPSF. TEXT files will display the
first page of text. EPS files must include a PICT preview.
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For example, the Display Picture tile might be used on an entry form
to provide a thumbnail of a document created in a drawing program:

Use From: Retrieves a document from the current record displayed
on a template or from the current record in a relation. Accepts a doc-
ument in first hole.

Many other tiles can be used in conjunction with the document spe-
cific tiles. For example, you could create a calculation using the
Starts With and the Document Name tiles as shown below.

Or you could place a concatenation of the Doc Name and the Doc.
Mod. Date into a Unique tile to prevent duplicate documents from
being created.
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Importing and 
Exporting Data
This chapter explains how to move data into and out 
of Helix applications using the Load, Dump, Publish, 
and Subscribe functionality within the Helix 
environment.
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12.1 Introduction
The Dump All, Dump Form, Dump Selections, and Load commands
provide a fast way to move large amounts of data into and out of
Helix. Dump provides a way to copy data out of a relation (export);
load moves data into a relation (import).

12.1.1 Delimiters

All of the data that you enter by typing on your keyboard (text, num-
bers, dates and flags) are initially strings of characters, regardless of
the type of field in which the data will be stored. Helix translates the
data into the appropriate data type for you. 

When Helix performs a dump, it copies all of the characters in each
field of each record being dumped and then writes down what it has
copied into a text file outside of Helix. This file is called a dump file.

You can dump from an entry form or a list.

Dumping does not affect your stored data in any way.

As Helix makes the dump file it inserts special characters, called
delimiters, that mark the end of each field and the beginning and end
of each record.

Why do you need delimiters? Imagine what a book would be like if
there were no spaces between words, no capitalization, and no peri-
ods at the end of sentences. It would be one long string of letters, and
so would your dump file if not for delimiters. 

In a book, the words of a sentence are separated by spaces; capitali-
zation indicates the beginning and a period marks the end of the sen-
tence. In a dump file, the data that make up one record are separated
by field separators; a start character marks the beginning of a record
and a stop character marks the end of the record.

Just as there is no prespecified length to a word, there is no prespeci-
fied length to a Helix field. Without delimiters, you can not easily
determine where one field or record ends and another begins. There
may be instances where you want to create a dump file without delim-
iters, e.g. when creating Fixed Length Record or markup language
output, and Helix can accommodate this, but typically you need
delimiters to keep the data organized.
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During a dump, Helix starts by copying the characters in the first
field of the first record. When it is done with the first field, it places a
field separator character (by default a Tab) in the dump file and then
starts copying the characters of the second field of the first record,
and so on. When it comes to the end of the first record’s fields, it
places a Stop character delimiter (by default a Carriage Return) and
then starts working on the second record, and so on until all records
have been copied.

Note: Even if a record is blank or a field is undefined,
delimiters are still placed in the dump file.

If a flag field is formatted as check box or radio button, the data
dumped from the field will be its label name. If Complete and Incom-
plete are used instead of Yes and No, then the words Complete and
Incomplete will be dumped to the text file.

When you have finished with the dump, you can open the dump file
in a word processor or text editor. The dump file is a plain text file in
ASCII format. It contains no special font, size or style specifications.

If your text editor shows invisible characters, such as Tabs and Car-
riage Returns, you will see the delimiters as well as the data.

12.1.2 Controlling the Dump File

Helix will dump whatever data (except picture) you choose to dis-
play on a form in the order that they are displayed.

Although this discussion of dump uses listing forms as an example,
the concepts and procedures apply to entry forms as well. During a
Dump All from an entry form, Helix essentially performs a Find First,
then a series of Find Next operations to step through the records.
Helix dumps every record that would be found through these search
commands. Therefore, if you have a query selected, only those
records meeting the query criteria (and therefore appearing on the
list) are included.

Note: Helix cannot dump the contents of picture fields.
Although document fields also are not alphanumeric,
there is a way to dump and load their contents. See sec-
tions 12.2.2 and 12.3.3 for more information.

When you open a list that has no index or query attached, Helix dis-
plays all of the records you’ve entered in the order in which they
were entered.
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If you dumped from a list, then opened the dump file in a word pro-
cessor and displayed invisible characters, the dump file might look
like the following.

If you decide to sort the list by ID#, a dump would then create a dump
file that looks like the following.

If you add a query to restrict the list to records whose zip codes start
with 600, and changed the index to sort by last name, the dump file
would look like the following.

12.1.3 Dump Commands

There are three dump commands: Dump All, Dump Form, and Dump
Selections.

The Dump Form command is available in a sequence and as a custom
menu item. Its function is to dump only the records showing on the
screen.
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If some of the records on a list are selected (see section 8.2.4.3) and
you perform a dump operation, the dump file varies according to
which dump command was chosen.

For example, for the list shown below with three records selected,

the Dump Selections command creates the following file.

The Dump All command creates this dump file.

Note: Dump Selections does not use the index selected for
a list, but instead dumps records in the order in which
records have been selected from the list.

12.1.4 Dump—Other Considerations

The examples shown here have used very simple forms. Dump also
handles forms that contain abaci, subforms, and document fields; for
more information, see section 12.2.4.
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12.1.5 Load

Load is the reverse operation of dump; it reads characters from a text
file and stores them in new records on an entry form one field at a
time. It moves to the next field whenever it encounters a field separa-
tor (delimiter) in the text file; it stores the current record and starts a
new record whenever it encounters a stop character.

Load performs data type checking and validation as it reads the char-
acters, making sure that what it’s trying to put into a field can be
stored there. If the data fail a data type or validation check, Helix gen-
erates an error. (Error handling during load is discussed in section
12.3.5.)

12.1.6 When to Use Dump & Load

Only Helix RADE, Helix Client, or Helix Runtime can dump and/or load
data. Generally, performance will be much faster in Helix RADE or
Helix Runtime than in Helix Client because you will not be transmit-
ting data over a network.

There are three situations in which you might want to transfer data
using dump and load:

• Between collection or relations within Helix: For example, you 
might create a new collection that could use data from a relation 
in an existing collection.

• Between Helix and another application: Dump data from Helix 
when you want to use it in another application. You might do this 
if, for example, you want to examine some of your data using a sta-
tistics or graphing program.

• Between your Macintosh and another computer: Load data into 
Helix to use Helix’s special capabilities. For example, if you are 
working with text or numbers on a mainframe, you are likely to 
find it cumbersome to make changes. You can download the data 
into Helix to make editing easier. You can subsequently dump the 
cleaned data and upload it back to the mainframe.

12.1.7 Load vs. Publish and Subscribe

Data can be published from Helix and Helix can subscribe to data
published from other applications, including Helix. Subscribing to
data brings it into the collection as if you were performing a load.
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Subscribing to edition files in Helix is somewhat different from sub-
scribing in other applications. In Helix, subscribe performs an auto-
mated load. Subscribed records are not modified when the edition
file is changed. Instead, a new copy of the record is entered into the
Helix collection. Use posting to modify previously subscribed
records.

Subscribe To is available on an open entry view as long as the view
does not contain a document field.
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12.2 Dump

12.2.1 Dump Checklist

Before you dump, it helps to give some thought to what you need to
accomplish.

• What fields do you want to dump?

• In what order do the fields need to appear?

You can control what fields are dumped and the order that they
are dumped by changing the location of data rectangles on the
dump form’s template. You can dump all or some of the fields in
the relation. If you want to dump all fields, you can use a quick
entry form, a quick list form, or the entry form that you use for
data entry. 

Alternatively, you can make a special dump template that contains
just the fields you want dumped in the order that you want them.
One way to accomplish this is to use the Quick Entry command
(see section 4.4.7). This command automatically builds an entry
form for you, including all of the fields in the relation. You can use
this form as a base and then delete the fields you don’t want.
Examine your abacus icons to see if there are any you also wish to
include. These abacus icons can then be easily added to the form.

• What records do you want to dump?

You can control which records are dumped using a query (abacus,
form, or power) or by selecting records on a listing form.

• Do you need the records to be in a particular order?

You can control the order in which records are dumped by chang-
ing the dump form’s index, or if you are selecting from a list, by
the order in which you click on the records.

• Are there special requirements for the delimiters?

If your dump file is to be used as a load file by someone else, by
another application, or on another platform, are there any special
requirements for the Field delimiters and record separators? Any
of the delimiters can be changed (see section 12.2.4).
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12.2.2 If Your Records Contain Documents

Document fields can be dumped from a Helix collection just like any
other field. There is, however, a difference between the result of a
dump for records without document fields and records with one or
more document fields. In the former case, the dump process creates
a single ASCII text file containing the data from the fields. 

When document fields are involved, however, Helix creates multiple
files: one for each document being dumped, plus the standard dump
file (sometimes in this context known as a control file). As well as con-
taining all the nondocument data, the dump file has data about each
document that has been dumped. Helix places these data (a filespec)
into the dump file in the document field’s place as the document
itself is copied to the desktop.

The filespec is the document’s location (called the pathname) fol-
lowed by the document’s name. For example,

Main:Helix 4.5.3:Pictures:All Tiles

identifies the document All Tiles in the folder Pictures within the
folder Helix 4.5.3 on the volume Main.

You can control where the dumped documents are placed. (See sec-
tion 12.2.4 for more information.)

12.2.3 Dump All: Step by Step

To dump all the records that appear on a list or that can be displayed
on an entry form:

1. Design a template with the fields and abaci you want to dump, in 
the order that you want them dumped.

To dump data from Helix, you create a new template or use an exist-
ing form that contains the fields you want dumped. Any item that has
been entered or will appear in a data rectangle (with the exception of
pictures) can be downloaded this way.

Helix dumps only the items within data rectangles. If the form also
has label rectangles, the contents of those rectangles are not
included.

2. In a view icon’s form setup mode, choose the template design 
from step 1.
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You can also select a query to control which records are dumped and
an index to control the record order.

3. Select View->Show Form.

The Dump All command is now available in the File menu. You can
select it at any time the dump form is visible and its window is active.

4. Select File->Dump All.

The Dump dialog box appears.

5. Type a name for the dump file and choose a location for it.
6. If you want to use the default Dump All options, go to step 7.

If you want to change the default Dump All options, click the Options
button. (See section 12.2.4 for a discussion of dump options.)

7. Click the Dump button to start the Dump All process. After dump-
ing is complete, Helix clears a data entry form.

12.2.4 Dump Options

The Dump Options dialog lets you specify the layout of your text file
and how Helix will behave during the dump process. The default set-
tings in the dialog are:

• Stop on error.

• When dumping, do not dump field headers.

• Remove field separator characters and Carriage Returns from 
within fields being dumped.

• Do not remove stop characters from within fields being dumped.

• Do not use a start character.
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• Use a Tab (ASCII character 9) as a field separator (inserted 
between fields).

• Use a CR (ASCII character 13) as a stop character to indicate the 
end of the record (inserted between records).

• Place dumped documents in their original locations.

• If a document with the same name already exists in the location 
specified for the dump, ask before replacing the old document 
with the new file.

To change the default options, click the Options button in the Dump
dialog box to open the Dump Options dialog box.

The dump options that you can configure using the Dump Options
dialog box include the following:

• Error Options: Helix performs a check of the integrity of each 
record being dumped. If there are document fields in the records, 
Helix also performs a check of each document’s integrity. There 
are three actions/reporting options available should Helix detect 
an error in a record.

Stop terminates the dump. Helix displays an alert stating “An
error has been detected during dumping. Operation aborted.”

Ignore field tells Helix to skip the field if it fails an integrity check.
At the end of the dump process, Helix displays a dialog box telling
you how many such rectangles were skipped.

①

① Error options

②

② Include/strip check boxes

③

③ Delimiter character selection lists

④

④ Document location radio buttons
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Ignore record tells Helix to skip the entire record containing the
faulty rectangle and/or document. At the end of the dump pro-
cess, Helix displays a dialog box informing you how many records
were skipped.

• Include/Strip Check Boxes

The Include Field Headers tells Helix to dump the field or abacus
names on the dump form along with the data. These headers are
dumped prior to the data using the same delimiters selected for
data. When you dump from a form containing one or more sub-
forms, Helix dumps multiple rows of headers, the first for the host
form and then one record for each subform.

The strip boxes control the removal of separator and stop charac-
ters within contents of a field. When a box is checked, Helix
removes whatever is selected in the list for that delimiter when it
is encountered within a field.

By default, Helix strips field separators and carriage returns
because in typical data entry, carriage returns in a field are some-
times the result of a mistake (for example, the user pressed the
Return key instead of a Tab to advance to the next entry). When
reloading this information, these extraneous Carriage Returns can
produce errors.

If you want to preserve carriage returns within fields to be
dumped, be sure to click the Strip Carriage Returns check box to
deselect it. You should also change the default for the stop char-
acter if you plan to reload this file back into Helix.

Note: Helix still writes field separators and stop characters
outside of (in other words, between) fields to the dump
file.

• Delimiter character selection lists: Helix gives you the option of 
specifying which characters, if any, you would like to use as delim-
iters. (See section 12.4.1 for a full definition.) The range of options 
available lets you specify parameters for the transfer of data files 
generated by a wide range of applications and machines.

Three types of delimiter characters can be placed automatically in
a dump file to separate data in your text file:

• A start character for the file

• A separator character to separate fields

• A terminator or stop character to separate records
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Specifying a start character instructs Helix to insert this character at
the head or beginning of each record. The default setting is to have
no start character.

Specifying a field separator instructs Helix to insert this character
between each field within each record. The default is HT, a horizontal
tab.

Specifying a stop character instructs Helix to insert this character at
the end of each record. The default is CR, a carriage return.

For each of the three delimiter types, a delimiter character is not
required. To deselect the delimiter, click on the delimiter list and
drag the pointer off the list to the right or scroll to the bottom of the
list and click below the last item in the character list (ASCII character
255).

For a list of delimiters and their ASCII equivalents, see section 12.4.

• Use the Document Location radio buttons to select the path to 
store dumped documents.

On Original Path specifies the path currently associated with the
document in the Helix collection. If the original path is not avail-
able (for example, if the document was entered into Helix from
another Macintosh), the dumped documents are placed in the
folder selected for the dump file.

The other document location option is With Control File. In this
case, Helix stores all files in the folder used for the dump file.

• The If Document On Disk buttons determine what will happen if 
Helix encounters a document with the same name and pathname 
as a document being dumped. The pathname and the other non-
document data are dumped to the dump file.

When you select the Replace option, Helix replaces the document
already on the drive with the document being dumped.

When you choose Skip, Helix retains the document on the drive
and does not dump the duplicate (i.e., it is skipped).
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If you select the Ask option, Helix displays the following alert
when a document being dumped already exists.

This message interrupts the dump process until you select a but-
ton. The alert appears for each preexisting document.

When you have selected the options you want, the selected form will
remember these options, regardless of options selected on other
forms. This feature makes it easy to preset forms for data to be
dumped on a regular basis.

12.2.5 Notes on Dump

Calculations can be dumped. Any data rectangle on a template that
contains an abacus icon (a calculation) dumps the output of the aba-
cus for each dumped record.

Styled text data dumps as plain ASCII text.

A calculated field containing a summary tile (such as Total) should
not be dumped from an entry form. Because calculations using these
tiles produce their answer based on the entire relation (not a particu-
lar record) every record will contain the same answer. Such calcula-
tions can be dumped from a listing form by placing the abacus
outside the repeat rectangle or from an entry form containing a sub-
form by placing the abacus on the host form.

The physical layout of the data fields on a form determines the
arrangement of the data in the text file. This arrangement is in the
order in which the cursor travels when a user presses the Tab key
(top to bottom, left to right). It pays to check this order before using a
form for dumping. Since the cursor does not visit fields that display
only the result of a calculation, you can figure out the order of these
fields according to their alignment on the form or add an inert field to
each field containing an abacus to include the data rectangle in the
tab order.
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When dumping from an entry form or list that contains a subform, for
each record the dump file contains the host form data rectangles
plus the respective fields from the subform. Helix dumps all host
form fields first, followed by the subform fields.

If a subform spans multiple pages, Helix dumps the host form data
for the first page only.

Dumping from a host form containing only inert fields produces an
empty dump file.

Labels and other form decoration cannot be dumped.

You can switch to another application while Helix is dumping data.
Simply click in a window belonging to another application or click on
the Macintosh desktop. Helix will continue to dump while in the
background.

A Dump from a form in an empty relation results in an empty dump
file unless you have chosen the Include Field Headers option.
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12.3 Load
A load operation copies data stored in a delimited text file into a Helix
relation. Load uses a data entry form and acts much like automated
data entry.

12.3.1 Load Checklist

To prepare for loading data:

1. Look at the source file.
View the source file in your word processor with invisibles turned
on. If necessary, change the font and Tab spacing so that the data
are easy to interpret. Note the order, number, and data type of
fields, even if many are blank. What delimiters are used? If the
load file was created by Helix using the dump defaults, there will
be Tabs between fields and a Carriage Return at the end of each
record.

2. Compare your notes from Step 1 to the template you plan to use 
for the load form.
Do the data types of the source file and the load form match up?
The names of the fields on the load form do not matter. What is
important is that the data types of the fields match those of the
source file.

Note: The load form cannot be a list; it must be an entry
form.

3. If necessary, construct a special data entry form that corresponds 
to the data in the load file. 

Caution: Keep in mind that once data is loaded into a
field, its data type is set and cannot be changed: Changing
the data type of a field erases all of the field’s data. 

Tip: Before loading data that has been dumped from flag
fields with custom labels, be sure to format the flag field
into which you are loading as the custom label (for exam-
ple, Complete and Incomplete). If the flag field were still
formatted as Yes and No, all the records that contain Com-
plete and Incomplete would cause errors during a load.

Tip: If for some reason you cannot determine the appropri-
ate data types for a source file, you can load as text, look
at the newly loaded records for each field, create a second
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set of fields of the right data type, then perform a Post All,
filtering the text of the first set of fields through the appro-
priate conversion tile. 

4. Think about what you want to do if problems arise (error 
options).
An error occurs when Helix encounters a data type mismatch,
when the value being loaded can’t be converted to the data type
of the field into which it is to be stored. Do you want to stop the
load when this happens? Do you want to skip fields with bad data,
or do you want to skip the entire record if a field in it contains bad
data? The latter two options do not report errors until the load
operation is completed, although Helix beeps the computer’s
speaker each time it rejects data.

Tip: If you have a possible data type mismatch that affects
all of the data in a particular field, you might wish to
select the first option, so that you don’t have to wait until
the load is complete to correct problems. Keep in mind,
however, that if you stop a load in progress, all records
loaded at the point you stop the load will remain in the
database. 

Tip: If you think the files are set up accurately or want to
skip the occasional bad piece of data while still loading
the good data into records, the last option may be best.
Query to find records with undefined values after the load
is complete.

Caution: If Helix encounters any errors when loading and
you want to attempt the load again, you must delete any
records that did get loaded; otherwise you will have dupli-
cates. The simplest way to do this is to display the newly
loaded records on a list and then perform a Delete All.

12.3.2 Creating a Load File in a Word Processor

If you want to create the load file in a word processor or text editor,
follow these rules:

• Each field entry you type must have a designated separator char-
acter at the end.

• The last entry for a record must end with a designated stop char-
acter.
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• The files must be saved as text only.

For many applications, you need not worry about putting in separa-
tors and terminators. Most spreadsheet, statistics, graph, and similar
applications create an export file with tabs between fields and a Car-
riage Return at the end. In these instances, you merely indicate that
you want a text only file and create the load file.

The existence of either of the designated delimiter characters any-
where in the file can throw off the loading process, because every
time Helix sees a separator it moves on to the next entry field, and
every time it sees a terminator (stop) character it performs an Enter
command.

For example, you may have a mailing label list with names and
addresses. Such a list often has a Carriage Return at the end of each
line of the address and two more Carriage Returns between
addresses. You will need to reformat such a list so that there are Tabs
between the lines of an address and a single Carriage Return at the
end of the address. Alternatively, you can choose a different stop
character to indicate the end of a record.

If you use other applications to manipulate data prior to loading that
data into Helix, keep in mind that some applications (for example,
Microsoft Excel) place quotation marks at the beginning and end of
any Field containing a comma. You will need to remove the quotes
prior to using the file as a load file.

12.3.3 Loading Documents

Load can be used to import records containing documents into Helix
Collections.

Like Dump All, load also involves the filespecs (the name and path-
name) for the documents to be loaded as well as any non-document
fields in the records.

Helix creates a filespec automatically when you perform a dump from
a form containing document fields, so if you are loading from a previ-
ously dumped file, you will not need to do anything special.
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If, however, you are loading records from another application, you
will need to write the filespecs for the documents in the load file
using a text editing program.

In the example above, there are five data fields and one document
field for each record. The triangles represent Tabs and the ¬ repre-
sents a Carriage Return signifying the end of the record. As discussed
in the section on dumping documents (12.2.2), the pathname of the
document, not the document itself, is in the text file. The pathname
for the first record (Hard Drive:Seybold:Beach) indicates that the
document whose name is Beach can be found in the folder Seybold
on the disk named Hard Drive.

12.3.4 Load: Step by Step

To perform a load:

1. Create a form with a data rectangle and an associated field for 
every value you want to load.

Note: You cannot load into a data rectangle containing
only an abacus; such fields will be skipped during load-
ing. Helix also ignores label rectangles.

2. With the form open, select File->Load.
3. An Open File dialog box appears to let you choose the name of 

the text file from which you want to load data.
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4. If you do not need to change the default load options, go to step 5. 
To change the load options, click the Options button. See section 
12.3.5 for details.

5. Click the Load Text button to initiate loading from the text file 
selected in the Open File dialog box.

12.3.5 Load Options

The Load Options dialog lets you specify how Helix will read your
incoming text file. The default settings in the dialog are:

• Stop on error.

• The load file does not include—and therefore does not load—field 
headers.

• The load file does not use start characters.

• The load file uses a Tab as a field separator (Tab between fields).

• The load file uses a CR as a stop character to indicate the end of 
the record (Carriage Return between records).

• If documents are to be loaded, the document filespec in the load 
file lists their original locations.

Unlike the Dump Options, you must specify field and record delimit-
ers.

To change the load Options, click the Options button in the load
Open File dialog box to open the load Options dialog box.

①

① Error options

②

② Check to include field headers

③

③ Delimiter selection lists

④

④ Document location options
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The Load Options dialog box gives you control over the following
characteristics of a load:

• Error options: As Helix loads records, it checks the data type of 
the incoming data for compatibility with the data type of the field 
into which it is being loaded.

Text fields can receive text, styled text (although it does not retain its
style), number, integer, date, or flag data. The latter three data types
are converted to text strings.

Number fields can receive numbers only. The only alpha character
accepted is the letter e and only if it is part of a number correctly for-
matted in scientific notation (e.g., 1.4e6).

Fixed point fields can receive numbers only in the range of ±107. If
the number contains more decimal places than specified in the fixed
point format, Helix truncates the extra digits.

Date fields accept only dates, times, or text strings formatted as a
date or time.

Flag fields accept only the characters 1, 0, y, n, yes, no, t, f, true, or
false, or a string that starts with or exactly matches the custom
labels defined for the field.

Picture fields cannot accept loaded data.

Document fields accept only documents or document pathnames.

There are three options that determine what will happen if the data
type of an incoming datum is not compatible with the data type of
the Field into which it is being loaded.

- Stop: Terminates the load. An alert stating that “An error has 
been detected during loading. Operation aborted.” appears.

- Ignore Field: Helix ignores the data and skips the field. At the 
end of the load process, a dialog box appears telling you how 
many fields were skipped.

- Ignore record: Helix skips the entire record containing the 
incompatible piece of data. At the end of the load process, a 
dialog box appears telling you how many records were 
skipped.

• Include field headers: Selecting the Include field headers option 
indicates that the top line of the load file lists the field names of 
the data in the file. When you select this option, Helix ignores the 
first row of the file (the field header row). This means you do not 
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need to edit a load file when loading from a program that automat-
ically dumps headers.

If the load file is from a form with one or more subforms, it will con-
tain multiple rows of headers. Helix will generate an error when it
attempts to load the second row and the On error option selected for
the load will occur. For instance, if you selected Stop On error, the
load will terminate when Helix encounters the second row of head-
ers. When you have selected Ignore field, Helix ignores the headers
because they use the same delimiters set for the data. When you have
selected Ignore record, Helix skips the row.

Caution: None of the above applies when all fields are
text. In that case, Helix can’t distinguish between a header
and valid data.

• Delimiter selection lists: For a discussion of delimiters (including 
start characters, field separators, and stop characters), see sec-
tion 12.1.1.

The settings you select in the delimiter selection lists must match the
delimiters used in the incoming file.

Specifying a start character tells Helix to begin loading data at this
point in the text file. Helix ignores any characters that occur between
the stop character of the previous record and the start character of
the current record.

Specifying a field separator tells Helix to interpret this character as
the end of one field and the beginning of another.

Specifying a stop character tells Helix to interpret this character as
the end of a record and to perform an Enter.

For a list of delimiters and their ASCII equivalents, see section 12.4.

• Document location options: The Document location options tell 
Helix where to look for the documents to be loaded. When you 
select the on original path button, Helix retrieves the document 
using the pathname specified in the load file. Use the with control 
file option when the document to be loaded is in the same folder 
(directory) as the load file.

When you have selected the options you want, the load form will
remember those options, regardless of options selected on other
forms. You can therefore preset forms for data to be loaded on a regu-
lar basis.
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12.3.6 Notes on Load

You cannot load into a data rectangle that contains only an abacus; it
will be skipped.

The physical placement of the data rectangles on a load form tem-
plate determines the order in which the data are loaded (see section
8.1.4), but the order can be modified to some extent (see section
8.1.5).

During the loading process, Helix updates any calculations or list
forms that are open and have fields dependent on the data that are
being loaded as the data are entered. This can significantly slow
Helix’s performance. For best overall performance, close any forms
other than the load form that make use of the fields into which data
are being loaded and ensure that the load form does not contain any
calculations.

You can stop loading at any time by pressing Command-period. The
loading process cannot be resumed. The Command cursor appears
during a load, but you may not be able to see it unless you move the
mouse.

If there are more fields per record in the text file than you have on
your form, Helix skips the extra fields in the text file during a load.

If there are fewer fields per record in the incoming text file than are
on the form, Helix leaves the remaining fields undefined.

You can switch to another application while Helix is loading data.
Simply click in a window belonging to another application or click on
the Macintosh desktop. Helix will continue to load while in the back-
ground.
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12.4 Delimiter Characters
If you wish, a start character can be selected, changed, or deselected
from the appropriate list. (Start characters are not required.)

•Separator and stop characters can be changed, but each must have
a character designation, otherwise the OK button will be dimmed.

•Non-printable characters between 0 and 127 are represented by
standard ASCII mnemonics in the scrollable lists. The characters
above 127 are represented by their ordinal value (in decimal).

•Note to non-programmers: CR = Carriage Return (ASCII 13), and HT =
Tab (horizontal tab or ASCII 09). Refer to the table at the end of this
section for more information.

Any ASCII character is a valid delimiter.

12.4.1 Delimiter Reference Table

Abbreviation Full Name

NUL null

SOH start of heading

STX start of text

ETX end of text

EOT end of transmission

ENQ enquiry

ACK acknowledge

BEL bell

BS backspace

HT horizontal tab

LF line feed

VT vertical tab

FF form feed

CR carriage return

SO shift out

SI shift in

DLE data link escape

DC1 device control 1

DC2 device control 2
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DC3 device control 3

DC4 device control 4

NAK negative acknowledgment

SYN synchronous idle

ETB end of transmission block

CAN cancel

EM end of medium

SUB substitute

ESC escape

FS file separator

GS group separator

RS record separator

US unit separator

DEL delete (at end of printable character list)

Abbreviation Full Name
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12.5 Publish and Subscribe
Helix supports Publish and Subscribe. You can publish Helix data and
subscribe to data published from other applications, including Helix.
Subscribing to data brings it into the collection as if you were per-
forming a load. Therefore, unlike the more typical implementation of
Publish and Subscribe, subscribing is not dynamic.

Note: Publish and Subscribe use the dump/load delimiter
set. Unfortunately, there is no direct way to set the delimit-
ers. To establish delimiters, you must perform a dump or
load, setting the delimiters as desired. Publish and Sub-
scribe will then use the existing dump/load delimiter set.

12.5.1 Publishing Data

As with other applications, publishing from Helix creates an edition
file. The data in the edition file are in the same order and same format
as the listing form from which the edition was create. For example, if
three fields—first name, last name, and phone number—appear in
that order on the list, the data are published in that order. This is
much like the dump file created when you perform a dump (see sec-
tion 12.2).

12.5.1.1 Creating a Publisher
You can only publish from list views. You also cannot publish from a
view containing a picture field. Publishing from a list containing a
document field creates a dump file as described in section 12.2.2,
Dumping Records Containing Documents.

To begin publishing, open the list and choose Edit->Create Publisher.
The New Edition dialog box appears.

Choose a location for the edition file and give it a name. Click the Pub-
lish button to create the file.



Chapter 12: Importing and Exporting Data

12-28

12.5.1.2 Publisher Options
To set publishing options, choose Edit->Publisher Options after your
have created the first edition file. The Publisher Options dialog box
appears.

The Publisher Options dialog box provides the following settings and
functions:

• Publisher to popup: The Publisher to popup lists all current edi-
tion files. Choose the edition file whose options you want to set.

• Cancel Publisher button: Click Cancel Publisher to stop publish-
ing from the list selected in the Publisher to popup. The dialog 
box closes.

• Automatic check box: Checking the Automatic check box causes 
editions to be sent automatically when changes are made to the 
list. 

• Send Editions radio buttons: The Send Editions radio buttons 
control when Helix updates the edition file. Currently, only Manu-
ally is available. Helix sends editions only when you click the 
Send Edition Now button. On Save is not implemented currently.

Tip: The Publish Now command, available for use in
sequences, is equivalent to choosing Send Edition Now.

• Date displays: The Latest Edition and Last Change dates indicate 
the date of the edition selected in the popup and the date it was 
last changed.

①

① List of all published edition files

②

② Cancels publishing to the selected edition file

③ When clicked, updates editions automatically

③

④

④ Determines when edition files are updated

⑤

⑤ Displays edition dates

⑥

⑥ Save data changes to an edition file
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• Send Edition Now button: Use the Send Edition Now button to 
send editions when you have selected the Manually radio button.

12.5.2 Subscribing to Data

Subscribing to edition files in Helix is somewhat different from sub-
scribing in other applications. In Helix, subscribe performs an auto-
mated load. Subscribed records are not modified when the edition file
is changed. Instead, Helix loads a new copy of the record into the col-
lection. 

Tip: Use posting to modify previously subscribed records.

The Edit->Subscribe to command is available whenever an entry form
is the active window and that form does not contain a document field.

12.5.2.1 Subscribing to an Edition
Choose Edit->Subscribe to to begin subscribing to a previously pub-
lished edition. The Open Edition dialog box appears.

Locate and select the edition file to which you want to subscribe. A
preview of the data in the selected edition file appears at the left of
the dialog box. Click the Subscribe button to begin loading data from
the edition file.

Caution: If you have selected automatic updates for the
edition file, you will receive updates to the file automati-
cally without further intervention on your part. However, if
you don’t pay attention to when and how records are
being loaded, you may end up with more than one version
of the same record and/or duplicate records. Therefore,
you need to be very careful about allowing edition files to
load automatically.

Helix accepts editions only when the subscribing view is open. Note
that switching to setup mode while in Full Mode breaks the subscrip-
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tion link even when updates are automatic. You must choose
Edit->Subscribe to again to reconnect to the editions file.

12.5.2.2 Subscriber Options
By default, edition files update the collection automatically. Every
time you open a form that is set to be updated automatically, Helix
checks the time the edition file was last updated. If the edition’s mod-
ification time is more recent than the last time the form was opened,
Helix loads the edition’s data, without notice, into the form. There is
no checking for duplicate records. You may therefore want to change
the automatic updating to manual. This is one of several options you
can set from the Subscriber Options dialog box.

To change the options, choose Edit->Subscriber Options. The Sub-
scriber Options dialog box appears, giving you access to the follow-
ing settings:

• The Subscriber to popup menu: The Subscriber to popup menu 
contains all edition files to which the collection has subscribed 
and by default displays the last edition file to which you sub-
scribed. To change the edition to which the options will apply, 
choose a different edition file from the popup.

• Cancel Subscriber button: Clicking the Cancel Subscriber button 
cancels the subscription for the view and closes the dialog box.

• Get Editions radio buttons: The Get Editions radio buttons let you 
determine whether Helix loads editions automatically each time 
the edition file changes or manually when you click the Get Edi-
tion Now button.

①

① List of all subscribed edition files

②

② Cancels subscribing to the selection edition file

③

③ Determines whether editions are loaded automatically or manually

④

④ Opens the application that created the selected edition file

⑤

⑤ Triggers the loading of the selected edition file
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• Open Publisher button: Clicking the Open Publisher button opens 
the application that created the edition file and closes the dialog 
box.

• Get Edition Now button: The Get Edition Now button triggers load-
ing of the selected edition file.

Note: Subscriber options can be changed only after select-
ing Edit->Subscribe to (see section 12.5.2.1).
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13.1 Introduction
Helix provides a range of commands for making hard copies of data,
form images, and design components.

You print by selecting one of the print commands found in the File
menu. The names of these commands change depending upon what
kind of window is active, and indicate the types of printing available
at that time.

In addition, you can use three interrelated commands in the File and
Set menus to adjust various parameters. These three commands are
File->Page Setup, Set->Custom Paper, and Set->Starting Page #.When a
collection is open, the commands Page Setup and Custom Paper are
usually available. Page Setup is available whenever the active window
can be printed.

Page Setup specifies how the printer handles a page, and involves the
size and shape of the paper.

Custom Paper lets you change the paper sizes displayed in the Page
Setup dialog box (ImageWriter printers only).

Starting Page # lets you set the starting page number when you use
P# is Page Number (see section 4.6.10) on a template to supply page
numbers for a form (see section 8.1.7.2).

When you issue a print command, Helix displays a dialog box that
asks for more information, except when the print command is used in
an optional sequence (see section 6.6.6).

This is where you select the print quality, page range, and so on. For
example, the Page Range option lets you print a portion of a listing.
Templates, non-list forms, and scaled abacus icons are all one page
print jobs. In these cases, specifying any page other than page one
prints nothing.

While printing, the following dialog box appears on the screen.

It contains a thermometer that indicates approximately how much of
the job has been completed and three buttons that let you cancel the
print job or pause it temporarily and then continue.
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The thermometer advances by increments as each page is printed. It
appears completely filled as the last page of the job starts printing.

When you choose Pause, printing continues until the printer’s buffer
empties.

Pause is not available when printing on the LaserWriter.
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13.2 Page Setup
Page Setup lets you select print specifications such as page orienta-
tion and page scaling. The Page Setup dialog box that you see
depends on the current printer driver. In addition, Helix provides
some special options for the ImageWriter printer series of dot matrix
printers.

Tip: You can select a printer driver in the Chooser or, if
using Mac OS 8 or higher, by highlighting the printer icon
on the Desktop and selecting Set Default Printer in the
Printing menu.

13.2.1 Page Setup for LaserWriter 8 Printer Drivers

The Page Setup dialog box for the LaserWriter 8 printer driver pro-
vides the following options.

• Page Attributes: Use the Page Attributes popup menu to prepare 
printing for different page styles, including but not limited to, 
print output, file output, PDF output and other types.

• Format for: Use the Format for popup menu to select the printer 
you want to use.

• Paper: Use the Paper popup menu to select the paper size.

• Orientation: Click the icon with the vertical arrow to print in por-
trait orientation (taller than wide) or the icon with the horizontal 
arrow to print in landscape orientation (wider than tall).

• Scale: Enter a percentage by which the image should be reduced 
or enlarged. The default is 100% (actual size).

Refer to your Macintosh manuals for complete information on the use
of this dialog box.
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Helix uses the page size and orientation chosen in the Page Setup
dialog box for the page outline that appears in a template window.
The page outline is a visual reference for the printable area. This
rectangle changes every time you modify the page setup. Also, rulers
change if printer resolution changes. (See section 13.4 for more infor-
mation and section 8.1.11 for illustrations of how the page outline is
used when designing a form.)

Each template has its own page setup specification. When you
choose File->Page Setup, the template remembers the selected
parameters. You can therefore have different page setup specifica-
tions in a collection.

13.2.2 Page Setup for ImageWriter Printer Drivers

The ImageWriter Page Setup dialog box provides the following
options.

• Paper size: You can select one of six choices for an ImageWriter 
printer. These choices are in turn based on the sizes available 
from the Custom Paper dialog box discussed in section 13.2.3. 
Regardless of the driver, the paper size is always present to the 
default or standard size for the printer unless changed by the 
user. Helix forms always remember the printer and settings 
unless the collection is transferred to an environment with differ-
ent computers and printers.

• Orientation: Printing can be oriented either vertically on the page 
(portrait), or horizontally (landscape) for wider forms or 
pictures.

• Special Effects: With an ImageWriter printer driver, use the Tall 
Adjusted setting to print correctly proportioned figures and pic-
tures oriented vertically on the page. An item can be printed half 
size by using the 50% reduction option. The No Gaps Between 
Pages option allows printing continuously over page breaks.

Refer to your Macintosh manuals for complete information on the
use of this dialog box.

Helix uses the page size and orientation chosen in the Page Setup
dialog box for the page outline that appears in a template window.
The page outline is a visual reference for the printable area. This
rectangle changes every time you modify the page setup. Also, rulers
change if printer resolution changes. (See section 13.4 for more infor-
mation and section 8.1.11 for illustrations of how the page outline is
used when designing a form.)
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Each template has its own page setup specification. When you
choose File->Page Setup, the template remembers the selected
parameters. You can therefore have different page setup specifica-
tions in a collection.

13.2.3 Custom Paper

The File->Custom Paper command lets you select up to six sizes of
paper from among twenty-nine possibilities. Selected sizes appear in
the Page Setup dialog box as available paper choices only when print-
ing to an ImageWriter. The sizes correspond to the most commonly
used labels, sheets of paper, index cards, and so on.

Custom Paper lets you set the most commonly used paper sizes for a
given application. This command should be used only when you need
a paper size that is not available in Page Setup.

The Custom Paper dialog appears as follows.

Select the sizes to be used by clicking on the boxes. An X appears in a
box when it is selected.

The six default choices appear with an X in the box beside each
description, and also appear with the descriptions in bold type
(except for Letter 8-1/2" x 11", which is permanently selected and
always dimmed). Because only six size options can appear in the
Page Setup dialog box at any one time, and since Letter is a perma-
nent selection, you can choose a maximum of five additional sizes in
the Custom Paper dialog box.

When you have reached the maximum number of choices, Helix dims
the remaining sizes. No other size can be selected until a previous
choice is deselected by clicking in its box.
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A few of the descriptions in the Custom Paper dialog box are too long
to be fully displayed in the Page Setup box. Therefore, they appear
clipped.

The Standard Paper Size options are the ones you typically encoun-
ter when using Page Setup. Some of the more unusual options in this
category are for printing on the 7x9 Pad, envelopes, Rolodex cards,
and a domestic Federal Express air bill.

The Label Sizes and Custom Sizes options show the exact height of
many standard labels and papers. Some of the smaller sizes may look
unfamiliar since label manufacturers often round off the measure-
ments. Actual label sizes and the sizes they are commonly referred to
by are as follows:

15/16"=1 inch label

1-7/16"=1-1/2 inch label

1-15/16"=2 inch label

2-15/16"=3 inch label

The Label Size and Custom Size options tell the printer the top-to-
bottom size of a page. It is up to you to limit the width to what you
need when drawing rectangles on a template. Measure the paper on
which you want to print and then use the template ruler to determine
the width of your design. The ruler permits very accurate measure-
ments of the finished product. Just be sure to choose the correct
page setup options for the template before constructing the tem-
plate. This ensures the proper ruler size, page lines, and so on.

You will probably have to experiment with the available page sizes to
arrive at the precise paper alignment before printing. You will also
need to experiment with the measuring and spacing of template rect-
angles so that they align properly with a preprinted paper stock.
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13.3 The Print Commands
Printing involves a group of commands that appear in the File menu.
The exact names of these commands change according to which type
of window is active.

13.3.1 Printing View Windows

When working with a form in a view window, the File menu reads as
shown below.

• Print Form prints the selected form. The form and any data 
present in the data rectangles print in full, even if not fully visible 
in the window. 

Note: There is an exception to the preceding. If a rectangle
has been flagged nonprintable on the template, it will be
visible on the screen but will not appear when the form is
printed. For more information, see sections 4.6.3 and
8.1.3.4.

• Find and Print All can be used with a data entry form to print 
every record in the relation that can be displayed on the form. 
This command performs the same as Find First, Print Form, Find 
Next, Print Form, Find Next, Print Form, and so on, stepping 
through each record. It also results in much the same output as if 
the form was surrounded with a repeat rectangle. The difference 
is that each record printed advances the printer one page and 
page numbers follow a different ordering. (See also P# is Page 
Number in section 4.6.10.) The records print including any decora-
tions and labels that are present on the form.
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If you have typed modified data on a form but have not stored the
data before choosing Find and Print All, the following dialog box
appears.

You can store your changes by pressing Enter, discard your changes
and return to a clear form, or cancel the command.

13.3.2 Printing Abacus, Collection, and Relation Windows

When working in an abacus, collection, or relation window, the File
menu reads as shown below.

• When working in an abacus window, you can use File->Print 
Scaled with an ImageWriter to print the entire calculation on one 
page. The size of the tiles will be reduced, if necessary. 

• Print Paged prints the calculation full sized, breaking it into sev-
eral pages, if needed. These pages may then be placed side-by-
side to view the entire calculation. See sections 4.2.13, 4.2.14, and 
7.3.3 for more details.

Tip: With Mac OS 8.0 and higher, you can print the entire
abacus window by pressing Caps Lock-Command-Shift-4
and clicking anywhere in the abacus window. This creates
a PICT file on your hard disk that can be opened, printed,
or otherwise utilized. If you are using desktop printing,
you can drag this file directly to the desktop printer icon.

• When working in the collection or relation window, use File->Print 
Scaled with the ImageWriter to print the entire window on one 
page. The icons will be reduced in size, if necessary.
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• Use File->Print Paged to print to either an ImageWriter or a Laser-
Writer. Windows that are in View by Icon mode print full sized, 
broken into several pages if necessary. When printing collection 
windows that are in View by Name or View by Kind mode, Helix 
places a title bar containing the collection name and a page num-
ber above the header. When printing relation windows, both the 
collection and relation name appear in the title bar.

Tip: Although the width of a collection or relation window
is 11 inches, there is no horizontal paging when using
File-->Print Paged in View by Name or View by Kind mode.
To print the entire width of these windows you should
print in landscape orientation.

13.3.3 Printing Templates

When working in the Template window, the File menu reads as shown
below.

• Selecting File->Print Template prints an entire template, even if 
some of it is not visible in the window. This can be handy for lining 
up the form you are designing on a sample of the paper chosen.

The dashed line rectangle on a template is the page outline. The size
of this rectangle is determined by settings in the Custom Paper and
Page Setup dialog boxes. It is drawn on the template to show what
area of the template is on the page, given the current paper size and
orientation. 

13.3.4 Printing Multi-page Templates and Forms

Helix can print a form that is larger than the page outline that can be
seen on a template. This makes it possible to set up a special form for
printing that could, for example, be used to step through a database,
printing a form letter and an invoice on separate sheets, all in one
operation.
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The entire template area is bounded with adjoining dashed line rect-
angles that correspond to whatever page size is selected in the Page
Setup dialog box. This grid of dashed lines serves to delineate where
one page stops and another begins. If any printable rectangle in the
template is just a hair outside of the page outline, Helix is forced to
print a separate page just for that little bit.

If material exists anywhere on the template or form, it is printed
along with any blank page sections that may fall in between. A blank
page appears wherever an empty page area separates printable
material on the template.

This function also prints out templates in a paged fashion. Helix
prints a template that spans an area larger than the page outline rect-
angle in a segmented sequence, upper left corner first, followed by
items below. The template prints vertically, column by column, until
complete.
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13.4 Printing Documents
File->Print Document is similar to Work on Original. After launching
the application in which the document was created, Helix triggers the
File->Print command for that application.

The print dialog for the document’s application opens. Make any nec-
essary changes in the dialog box and press Enter to initiate printing.

When printing or spooling is complete, the application quits automat-
ically and switches you back to Helix so that you can reply to the
Waiting for Work on dialog box.

Helix performs the verification described for Copy to Volume and
Work On while copying the document to the drive for printing. If Helix
detects any damage, a dialog box appears (see section 11.5.5).
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13.5 Printing Query and Index Windows
There may be times while working in Helix that you wish to print the
contents of a query or index window. Although there are no direct
commands for printing these windows, you can create a permanent
record or hard copy using the screen capture capabilities of the Mac
OS. Select Mac OS Help while the Finder is the active application and
search for “screen shot.”

Note: These commands are valid as long as none of your
utility programs, such as screen capture program or a
macro program, override the built in functions.
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13.6 Label Printing
When printing labels on continuous feed label stock, the trick in
designing the Template is to treat each label as a page. To success-
fully print labels:

1. Select the desired label size using File->Page Setup. If the size does 
not appear in the dialog box, use the Custom Paper command to 
install the size in the Page Setup box.

2. Choose No gaps between pages in the Page Setup dialog box. This 
ensures the proper spacing between labels.

3. Design a template for the label. Use the dashed line border of the 
page outline as a size reference.

Tip: If using 2, 3, or 4-up stock, use a repeat rectangle with
horizontal travel to place more than one label on each
line.

4. Place the data rectangles in the desired positions and add label 
and border rectangles if desired.

5. Close the template and open a view icon.
6. Choose the label template name.
7. Optionally select an index and/or a query name in the form setup 

mode to specify an order for your labels and/or print only labels 
with data that meet specific logical conditions.

8. Select View->Show Form. You can print only when a form is show-
ing and its window is active.

9. Select File->Find and Print All. This steps through the data and 
prints one label for each record.

To print sheet fed label stock, do the following:

1. Set the page size to the size of the label stock.
2. Design a list template for a single sheet of labels.

Tip: You can use either vertical or horizontal travel for
multiple column stock. Horizontal travel prints labels in
left to right, top to bottom order. Vertical travel prints each
page top to bottom, then left to right. Labels are printed in
order according to the index selected in Show Setup.

3. Close the template and open a view icon.
4. Choose the label template name.
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5. Optionally select an index and/or a query name in the form setup 
mode to specify an order for your labels and/or print only labels 
with data that meet specific logical conditions.

6. Select View->Show Form. You can print only when a form is show-
ing and its window is active.

7. Select File->Find Form. This prints the “list of labels” the same as 
it would print any list.

Tip: You may have to turn off the template grid to draw
and place the repeat rectangle so that it spaces the labels
accurately. The layout accuracy of Helix is precise only to
one point (e.g. 1/72"). If this precision is not adequate to
properly print on your label stock, select File->Page Setup,
set the scale to 50%, and create your layout at double the
actual size. This will increase the precision to 1/144". You
may have to experiment with other levels of scale to
match the offset of your particular label stock.

Tip: When testing the alignment of sheet label stock, use
your printer driver’s range option to print page 1 to 1 to
avoid having to cancel the print job or wait while the
entire list is printed.

Tip: Take a sheet of your label stock and outline the edges
of some or all of the labels with a pencil, pen, or marker.
Then, when testing the form, you can print on plain paper.
Lay the plain paper printout over the label stock, and hold
both sheets up to the light to check placement.
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13.7 Printing Notes
If you select the Chooser while running Helix, immediately select
Page Setup and confirm the page settings so that Helix can format
documents correctly for the printer that you are using.

Helix is compatible with the Apple LaserWriter. However, due to a
technical idiosyncrasy, the LaserWriter will not print calculations
from an abacus window. Templates, forms, lists, and pictures print
correctly.
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This chapter discusses issues related to saving 
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14.1 Saving Collections
Although Helix has significant built in protection against system fail-
ures—even against someone pulling the plug on your computer—it is
still in your best interest to actively and continually protect your col-
lections. Using the commands described in this section will help
ensure that work will not be lost.

Four commands dealing with saving data are located in the File menu:
Save, Save As, Revert to Saved, and Save & Log.

Another command, AutoSave, can be found in the Set menu.

14.1.1 File->Save

You can save a Helix collection at any time using File->Save.

If a collection has not been saved, File->Save works like File->Save As,
presenting a Save File dialog box asking you to name and locate the
collection.

After a collection has been saved for the first time, File->Save updates
the collection with all of the work that has been done since the last
save.

14.1.2 File->Save As

You can save a Helix collection at any time using File->Save As.

For a new collection, File->Save As functions the same as File->Save.

For a collection that has already been saved, File->Save As presents a
Save File dialog box asking you to name and locate the collection.
Helix closes the collection with which you were working without sav-
ing any changes and creates a new collection including any changes
since the last Save or Save As. 

All work will now be performed in the new collection; you are no
longer working with the collection that you opened originally. You
have instead created a collection that you can use as a safe,
untouched backup to your working document. To go back and work
on the original collection, you can close the present one and reopen
the original.



Chapter 14: Collection Management

14-4

14.1.3 File->Revert to Saved

File->Revert to Saved is available any time after a collection has been
saved.

Use File->Revert to Saved to discard any changes you have made.
The command restores you to the last saved version of the collec-
tion.

Note: File->Revert to Saved goes back to the last saved
version, no matter how the Save was performed. If you
have AutoSave enabled, you might not be able to revert to
a specific version.

14.1.4 File->Save & Log

You can find a discussion of log files in section 14.2.

14.1.5 Set->AutoSave

You can choose Set->AutoSave any time after a collection has been
saved. AutoSave performs Save operations automatically to bring the
current collection up to date and protect work from loss. 

Choosing Set->AutoSave opens the following dialog box.

By default, AutoSave is disabled (off). No automatic saving of the col-
lection occurs. To use this automatic protection feature, click the
Enabled radio button.

Since AutoSave may temporarily interrupt current work, you can
adjust two timing parameters.

With the Save and Clear Caches? option selected, a save operation
will be followed by one in which Helix clears the memory caches, as
though the application had been saved and then quit.
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14.1.5.1 AutoSave After
The AutoSave After slider controls the interval between automatic
saves. The interval can vary from one minute to several days.

Beyond basic safety considerations, the best setting depends on the
amount of work done over a given period of time. The lower the set-
ting, the more protected you are. Decide what level of work loss you
would be willing to accept in the event of a failure such as a power
outage. Then balance this against the frequency of potential work
interruptions from a save.

For typical data entry work, a setting of 4 hours (about half a day’s
work) is probably sufficient in most cases. This causes Helix to inter-
rupt work only once during the day and means that the worst case
failure would result in a half-day loss.

For collection design work or data that are difficult to enter, consider
a shorter time such as 30 minutes or one hour. This limits the
unsaved exposure. The potential delays while saving are also shorter,
as there are fewer changes to be recorded.

For work that should be exposed to the minimum possible risk, con-
sider using the logging feature described in section 14.2. In addition,
you may want to use the lowest AutoSave setting (one minute). By
adjusting the Idle Delay Wait control (explained in section 14.1.5.2),
you can tailor saving so that it allows uninterrupted completion of
various length operations.

Caution: Use high settings of several days or a week with
caution. If a significant amount of work is being done, it is
at risk for this extended period. Also, the amount of time it
takes to bring the collection up-to-date is greatly increased.

14.1.5.2 Idle Delay Wait
Use the Idle Delay Wait slider to fine tune the AutoSave function for
the minimum amount of inconvenience. When the AutoSave interval
expires, Helix waits at least the amount of time specified for the Idle
Delay Wait before the AutoSave actually takes place. 

The calculation of the wait time begins after each user or program
action. User actions include keyboard entries or mouse clicks. Pro-
gram operations include completion of functions such as Dump,
Load, and Print.
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A selection of five seconds for Idle Delay Wait means that Helix does
not start an AutoSave operation unless five seconds have elapsed
with no user activity. This prevents saving during periods of active
typing or mouse usage.

Tip: To strictly enforce the AutoSave time increment,
adjust the Idle Delay Wait to a lower setting.

Lower settings result in tighter enforcement of the AutoSave interval,
but could result in more inconvenience to the operator. since the
save could take place while typing in a record.

Higher settings ensure that saving does not take place during periods
of activity, but could mean that the AutoSave interval is extended by
an indefinite period. For example, if the Idle Delay Wait is set to 30
seconds, but there is no computer quiet period that extends 30 sec-
onds in a given work day, then Helix does not AutoSave at all, even if
AutoSave After is set for 2 minutes.

The best settings for these two AutoSave parameters can only be
determined by your needs over a period of time. Observe the collec-
tion in use to determine if the current settings provide the most pro-
tection for the least inconvenience and make adjustments as
necessary.

Helix tries to warn you that an AutoSave is pending by flashing the
title of the menu that contains the Save command. (In Custom Mode,
this command can be just about anywhere.) If there is no Save com-
mand available in any menu, Helix flashes the File menu’s title. The
rate at which the menu title flashes is inversely proportional to the
amount of idle delay left to expire. In other words, the closer to start-
ing an AutoSave, the faster the menu title flashes.

The AutoSave timer does not override the Idle Delay Wait timer.
When the AutoSave timer expires, Helix waits at least the Idle Delay
Wait time. For example, assume that the Idle Delay Wait timer is set
for 30 seconds. If at the instant the AutoSave timer expires Helix has
been idle for 15 seconds, Helix waits 15 more seconds before initiat-
ing the AutoSave.

14.1.5.3 AutoSave and Memory
When Helix is processing tasks, memory can fill up. Exactly when and
how is not very predictable. In particular, sometimes a big load does
not fill up memory—and sometimes it does. The exact criterion is the
extent to which Helix is reusing empty space within a collection. If
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you do a big Delete All followed by a load, that is a very good way to
ensure a memory full condition.

These memory full conditions do not cause Helix to crash; they
merely slow Helix down to a snail’s pace. Performing a Save clears
this condition.

Helix can detect this condition, and if AutoSave is enabled—it doesn’t
matter what time interval— Helix performs a Save operation to clear
the memory full condition. Places where this can happen are exactly
the places where the cloverleaf (interruptible) cursor is visible. This
is a good reason to have AutoSave enabled. You may want to set the
interval to several days to provide for automatic clearing of memory
jams.
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14.2 Logging
Logging is a method of protecting work against loss due to system,
machine, or power failures. A log file is a document created by Helix
that records all data transactions made in a collection. A collection
that is recording its transactions is considered to be logging.

Logging is available after the collection has been saved and named
for the first time, is available only in Custom Mode, and records data
transactions but not design work.

For the purpose of this chapter, a transaction is an elementary action
within Helix. For example, an entry form that Posts on Enter to three
target Relations involves four transactions: the entry of the record
and the three posts.

14.2.1 How Logging Works

To begin logging, choose File->Save & Log when a collection is in Cus-
tom Mode. At that time, Helix asks you to specify a new file for use as
a log file. Helix creates the file and stores the fact that logging is
active in the collection, along with the name of the log file. Helix then
saves the collection just as if you had selected the File->Save. 

From this point on, all data transactions are recorded in the log file in
addition to being recorded in the collection. The difference is that the
log file is kept relatively up to date on the disk so that no more than
the last two transactions will be lost in a power failure.

Exactly how many transactions might be lost depends on where you
are in the transaction. If you are between transactions, only the last
one will be lost. If you are in the middle of a transaction, then two will
be lost—the one on which you are working and the previous one.
Keep in mind that each posting operation is a separate transaction; if
you crash while working on a form that has post icons attached,
check each target relation as well as the source relation.

Whenever you perform a Save, Helix clears the log file of all recorded
transactions. In other words, the log file contains only those transac-
tion completed since the previous save.

If you choose File->Revert to Saved, the collection reverts to the con-
dition at the last save. This includes an empty log file, given that Helix
had just performed a save. File->Revert to Saved therefore erases any
data transactions since the last save from the log as well as the col-
lection.
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When you close the collection, Helix clears the log file again. It
doesn’t matter whether you chose to save the collection because the
effect is the same: an empty log file. However, the collection is still
marked for active logging. When you open the collection again, log-
ging resumes.

If the system crashes when logging is active, the log file is safe. The
next time you open this collection, Helix knows that logging was
active and that the collection was not properly closed. If Helix cannot
locate the log file (for example, you moved the log file into a different
folder) Helix displays an Open File dialog box asking you to locate
the log file. Helix then applies the log file to the collection and recov-
ers transactions completed since the last save.

Tip: It is a good idea to duplicate the collection and log
file before opening the collection and allowing Helix to
apply the log file.

In rare instances you may crash while applying a log file. If this hap-
pens, you should drag the original log file and the copy of the collec-
tion to the Trash and rename the copy of the log file. Thus, if you
have Collection A and Log A (duplicated as Copy of A and Copy of Log
A), toss Copy of A and Log A and rename Copy of Log A as Log A. You
can now reduplicate these icons and proceed with the recovery pro-
cess.

Helix will usually recover all but the last transaction. In some rare
instances, Helix may actually recover the last transaction but not
know it. If the crash occurred while a record was being stored, Helix
may lose two transactions—the one that was being stored and the
previous transaction. Unless the volume containing the log file was
damaged, Helix never loses more than the last two transactions.

These lines
represent work
(changes)

SAVE SAVE

When you reopen
the collection after
a crash, Helix
applies the work
stored in the log
file to the
collection.
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When the reload of the data transaction is complete, Helix saves the
collection automatically, restarting the log file in the process.

At the conclusion of recovering transactions from the log, Helix dis-
plays the number of transactions applied. This may be helpful in
some situations in which you have an external reference such as an
independent phone log or a paper invoice. Helix then warns about
losing the last one or two transactions as a final reminder to make
sure you check the collection for the last work completed before the
crash.

It is possible, though not very likely, for a log file or collection to be
damaged in a crash. This can occur when the cause of the crash was
a failure of the disk volume storing one or both of the files. In this
case, Helix applies as many transactions as possible, although it is
most likely that none of the log file will be usable. Helix tells you that
files are damaged and how many transactions were applied. In this
case, you have three choices: take what you’ve got and continue, take
what you’ve got and turn off logging, or cancel the attempt to open
the collection.

When logging is active, File->Save & Log command is replaced by
File->Save & Stop Logging, which stops logging, performs a save, and
deletes the log file.

Logging cannot be active in Full Mode. If logging is active and you try
to switch to Full Mode, Helix asks you what you want to do. You have
two choices, cancel the attempt to change to Full Mode or turn off
logging prior to switching to Full Mode. If you choose to turn off log-
ging, Helix stops logging, performs a save, and deletes the log file.

You can delete the File->Save & Log command when creating a user’s
menus. This does not mean that this user cannot have logging active;
it only means the user cannot start logging, and more importantly,
cannot turn off logging.

Removing the commands to start and stop logging from a set of cus-
tom menus can impact a user’s access to a collection. When a user
without logging commands opens a collection in which logging is
active and then cannot locate the logging file, that user does not have
the option to turn off logging and proceed without logging. The only
option that user has is to cancel opening the collection. The reason
for this is that the old log file is the last guarantee that there are no
lost transactions to apply. Helix’s assumption is that a user who does
not have authority to run without logging also does not have the
authority to bypass this check.
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14.3 Helix Reliability and Recovery
Helix provides four safeguards for the integrity of a collection. These
are:

• Helix modifies a collection file only during a save operation. 
Therefore, the original collection is protected from damage or loss 
in a crash. Helix appends new data to the end of an existing collec-
tion, but still remembers the original length of the file. Although a 
collection may seem larger after a crash if you check the file size 
using the Finder, as soon as you open the collection, Helix 
restores it to its previous size.

If a new collection was not saved prior to a system failure, Helix cre-
ates an icon called Helix RADE Data. This icon represents a scratch
file of the collection; it is of no use and should be discarded.

• Since the protection described above means that any changes to 
the data that occurred between the last save and the crash will be 
lost (they were not written to the collection and may well have 
been in memory) Helix provides a method of double recording 
data transactions so that they are stored in a log file that contains 
no less than all data transactions except the last one. At worst, 
you will lose no more than the last completed transaction and any 
transactions that were in progress at the time of the crash. Helix 
automatically processes these transactions and applies them to 
the collection the next time it is opened. (See section 14.2 for 
details on using logging.)

• The AutoSave feature provides a method of initiating a save of the 
current work automatically, based on the elapsed time since the 
last save. (There are side effects to this; see section 14.1.5.) You 
don’t have to remember to do regular saves; Helix does them for 

SAVE SAVE

All work since
the last save
is lost.

This icon is useless
and should be
discarded.
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you. This is especially important for an unattended Helix applica-
tion.

• Helix alters the original collection only during a save. At this time, 
the collection is vulnerable. To avoid any possible problems in 
case of a crash during a save, before modifying the original collec-
tion Helix writes data to a special recovery file that looks like a St. 
Bernard. If something interrupts the save operation before com-
pletion, Helix can restart the save and complete it by using the 
information in the file with the St. Bernard icon.

Caution: You must not move, rename, double click, or
throw away the St. Bernard icon. In addition, do not
rename any of the folders on the Desktop or the disk
itself. If you rename anything, Helix will not be able to
find the St. Bernard icon.

Apply the Recovery file to your collection before running it
through the Utility or Update Collection.

Caution: Although there are several ways that Helix safe-
guards your collection, this does not eliminate the need
for backups!

There are crashes and there are crashes. The reliability implementa-
tions described here should protect against all but two classes of
crashes.

• The mass storage medium (in other words, the disk drive) may be 
physically damaged. If your only copy of a collection cannot be 
read because the disk surface is damaged, the collection is gone 
for good.

SAVE DURING
SAVE

When you reopen the
collection, Helix uses
the contents of the
recover icon to restore
the collection.
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• If the Macintosh or other associated hardware (for example, disk 
controller, memory chips) malfunctions, irreparable damage to 
the collection may occur. If memory is bad, it is very likely your 
collection is beyond repair. Similarly, if the SCSI port starts drop-
ping every other bit, the collection is probably unrecoverable.

In addition, the Helix recovery files may fail if the disk driver, to opti-
mize performance, does not write immediately to disk but instead
caches information.

In summary, your collection is only as good as the hardware on which
it runs.

The only protection from these types of crashes is to keep a current
backup of your collection on a separate medium, either tape, other
removable media, or a different hard disk. Backups should be made
as often as possible according to the activity of your collection. An
old backup is often as useless as a collection on a damaged disk.
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14.4 Recovery
Recovering from an interrupted save is easy. After a crash during a
save, a St. Bernard recovery icon appears somewhere on a mounted
hard disk. As long as this recovery file has not been deleted,
renamed, moved, or double clicked, Helix performs a recovery auto-
matically when you reopen the collection. Simply double click on the
Collection, not the St. Bernard icon, to recover. 

If logging was active, work loss will be minimized as discussed in sec-
tion 14.2.1. 

A note concerning disk space and the special safety file: As you con-
tinue to work in a collection, you will be using up disk space, even if
you are not adding data. When adding or modifying data, Helix will
use up to twice the amount of disk space usually needed for these
operations. Using the save command brings the collection up-to-date
and releases the space consumed by the temporary safety file.
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14.5 Low Disk Space Warning
When the amount of unused disk space becomes significantly low,
Helix displays a warning that you should quit Helix and make some
more room on that disk. 

If you continue to work in a collection after the warning, there might
not be enough free space left on the disk for Helix to quit safely, espe-
cially if you have been entering pictures or large blocks of data or cre-
ating icons.
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Performance 
Notes
This chapter explains some of the internal workings 
of Helix to assist you in making decisions about 
collection design and construction, as well as an 
explanation of memory allocations set at the factory 
and recommendations for use in the field.
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15.1 The Object Manager and Memory
At one time, Helix Collections were limited to 2500 “tiles, icons and
rectangles” because of limitations of the Macintosh Resource Man-
ager. Within Helix, certain Macintosh Resource Manager functions
have been replaced with the Helix Object Manager. This Manager is
transparent to the user, but results in greatly improved icon manipu-
lation. The icon limit is now in the tens of thousands. The exact num-
ber depends on the amount of memory available and other factors.

Nonetheless, the performance of collections with very high object
counts deteriorates with lower amounts of available memory.
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15.2 Abacus and Query Optimization
Helix tries to perform queries and calculations in the most efficient
manner possible. Before actually executing a query or evaluating an
abacus, Helix attempts to optimize the operation, to find the best way
to accomplish its work. The way in which you construct queries and
abaci can impact Helix’s optimization success. In this section you will
therefore read about how Helix makes its optimization decisions.

15.2.1 Summary and Lookup Calculations

Helix temporarily stores the values from statistical (summary and
lookup) calculations. These stored values can dramatically speed up
the redrawing of a form.

When Helix displays a form containing a summary or lookup calcula-
tion, it does not recompute the abacus if another form or dialog box
is placed over it and later moved to make the original form visible
again.

If a calculation is used more than once for a form, Helix retains its
value after the first computation, making it available for subsequent
calculations. For example, if the same total is used in more than one
calculation, make a separate abacus containing just the Total tile and
place that abacus wherever that value is needed.

If a calculation is used in more than one place in a rela-
tion, consider using the Common Calculation option. (See
section 4.6.23.)

There are two situations when Helix does not retain the stored value
of a statistical calculation.

• If a form is closed and then reopened, Helix computes all calcula-
tions, including summaries and lookups.

• Helix always recomputes calculations, including summaries and 
lookups, when the data they use are changed.

15.2.2 Query Optimization

Helix uses one of two methods of query optimization, depending on
the type of form to which the query is applied. Listing forms use the
more sophisticated of the two and require more trust than under-
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standing. Entry forms require a better understanding of both the goal
and the method of query optimization employed.

The core concept of query optimization is the comparison of a vari-
able (field or abacus) with a suitable index, and a constant. When the
variable is in the top hole of the index, the index is suitable. A con-
stant is anything typed into the black hole of a tile or the result of any
of the following tiles.

• Count tile

• UserName tile

• Today tile

• Use From tile

• Lookup tile under the following circumstances:

- Hole 3 must be a constant

- Hole 2 must be indexed

- Holes 1 and 2 cannot contain Lookup, Summary, or Use From 
tiles

• any other tiles that have constants in each hole

The goal of optimization is to do less work. The slowest way for the
program to solve a query (to find the records that satisfy the query’s
criteria) is to evaluate every record in the database one at a time. A
faster way is to divide the query into two parts (terms). This allows
the records to be divided into those which obviously do not match
the query and those that may or may not match the query.

Helix divides the records into the parts very quickly using the
indexed variable mentioned above. The records in the strip of
records passing the indexed part of the query can be evaluated one
at a time to see if they satisfy the remainder of the query.

The two methods of optimization mentioned above vary from each
other in how they determine where to divide the query. Queries on
lists will simply find the best place to create the smallest initial strip
of records. Entry forms depend on the actual order of the tiles and
their connections used in the Abacus to divide the query and, there-
fore, the records.

15.2.2.1 Creating Optimized Queries
An abacus used as a query must contain a tile or combination of tiles
returning a flag value. When used in an abacus, the following tiles
create queries that can be optimized.
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• Equals (=) Constant = Variable
Variable = Constant

• Starts With Variable starts with
Constant

• Three holed Constant < Variable > Constant
inequalities
(tiles with
two >, <, =>, or <=)

• Two holed Constant < Variable
inequalities Variable > Constant
(tiles with
one <, >, =>,
or <=)

• Defined Defined Variable

• Undefined Undefined Variable

The tiles listed above are, mathematically speaking, terms of a Bool-
ean expression. The And, Or, and Not tiles can be used to connect the
tiles (terms) listed above and do not interfere with query optimiza-
tion when used as shown below.

• And When either side (term) is optimizable

• Or (Lists and When both sides (terms)
Subforms only) are optimizable

• Not (Lists and When the hole (term)
Subforms only) is optimizable

15.2.2.2 Entry Form Query Optimization
In the optimization scheme for entry forms, Helix uses the tiles listed
in the preceding section in the priority shown when suitable indexes
exist on the variables. That is, Helix assumes that the Equals tile is
better (it will find fewer records) than the Starts With tile; a three
holed inequality is better than a two holed inequality, and so on.

For example, if you use the following query on a data entry form,
Helix always optimizes on State=CA rather than Income > 1,000,000
because the Equal tile is at the top of the priority list. This occurs
even though there may be 300 records for California and only 30 mil-
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lionaires in the database: Helix first retrieves the 300 records for Cali-
fornia sequentially and then extracts the millionaires from that 300.

What happens when tiles of the same priority level are involved?
Helix evaluates tiles from bottom to top, left to right.

When you add another Equal tile to the example query, Helix opti-
mizes on Name=Joe, rather than State = CA because Name=Joe is on
the left of State = CA.

15.2.2.3 List/Subform Query Optimization
In general, any query used on a list or subform can be optimized
using one or more indexes when the last tile in the abacus is not a
Contains, Is Found Within, or an If-Then-Else tile. In addition, Helix
optimizes queries with Or or Not tiles.

The priority of tiles discussed in the preceding section does not
apply to listing forms and popup menus. Helix performs optimization
based on the distribution of data, not on the priority level of the tiles
used. Rather than assuming the Equal tile is better, Helix reviews the
data to determine where the fewest records exist.

Using the example from the preceding section, Helix realizes that
there are 300 records for California and only 30 millionaires and opti-
mizes the query on the Is Greater Than tile; Helix first retrieves the
30 millionaires sequentially and then extracts the Californians.
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If you add another Equal tile, Helix reviews the data to determine if
the fewest records will be retrieved by Income > 1,000,000, Name =
Joe, or State = CA.

15.2.2.4 Quick Query Constant Change
If you are performing a quick query on a field and change the query
value, the query does not have to be recomputed and the data can be
displayed very quickly. This optimization is in effect only when nei-
ther the queried field nor the query operator is changed.
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The Helix 
Client/Server 
Toolkit
This chapter describes how to successfully develop 
and deploy Helix applications for use in environments 
where more than one user needs to access the same 
data at the same time.
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16.1 Introduction
A Helix multiuser installation has two parts: the server that hosts a
collection and one or more clients that visit the hosted collection
over an AppleTalk network.

Helix Server uses ADSP (Apple Data Streaming Protocol) for inter-
machine communications. These protocols are sent along any com-
patible physical network layer. For example, you can use UTP Cate-
gory 5 Ethernet cabling, LocalTalk cabling, or PhoneNet cabling.

The network connection must support AppleTalk. Helix cannot use
TCP/IP, IPX, or any other network protocol. Any machines that are to
access the server must also be connected to the same network. 

The server is distinguished from the clients that access the Helix col-
lection by the following.

• The Helix application must reside on a storage device that is local 
to the Server.

• The server is the only machine that performs calculations on the 
information in the collection.

In this sense, Helix is a true client/server application. The client
sends data manipulation requests to the server, which are in turn
processed by the server. The results are sent back to the client for
formatting and display only.

One consequence of client/server architecture is that the overall
speed of the application for all clients is affected by the speed of the
processor, the amount of RAM, and the speed of the hard disk of the
server.

16.1.1 Cooperative Processing

Helix Server performs all the calculations required to prepare data
for display on the forms used in the application.

The server and clients maintain visual integrity among windows
(unless the Collection designer makes a window cold; see sections
8.2.4.5 and 9.3.5). During client/server access, windows open on any
machine accessing the collection update as required if the data dis-
played is affected by entries or changes made to forms on other visit-
ing clients.
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You construct the applications that users access with Helix Client
using the current version of Helix RADE or you update a collection
from a previous release with the Helix Update Collection utility appli-
cation. These applications must contain at least one User with a cus-
tom menu. More typically, there are several users (each with their
own custom menus) or the various types of clients and functions on
the network.

16.1.2 Application Icon Change

When a Helix collection has been opened and saved by Helix Server,
the collection icon changes to the Helix Server icon (center left). The
icon change signifies that the application was last used with Helix
Server. If you double click the icon, the Mac OS uses the Helix Server
application to open the collection.

If you open the icon with Helix RADE and save changes, the icon
changes back to the Helix RADE form (top left). Similarly, if you open
it with the Helix Engine (see Chapter 17), it will change back to the
Runtime icon (bottom left).

See section 2.3.1 for more information.

The icon change is effected by changing the Creator Code
for the collection. The three Creator Codes are HXPD
(RADE), HXPS (Server), and HXPR (Runtime Engine).
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16.2 Server Requirements
The minimum requirements for Helix Server are…

• one Macintosh computer with parity memory and a hard disk run-
ning at least Mac OS 7.5.5.

• a network connection.

• Helix Server software.

Each Helix Server accepts clients up to the number of nodes covered
by the server license. This number is measured as simultaneous
access. If your copy of the Helix Server software is licensed for four
nodes, up to four machines may gain access to or log in to the server
at any given time. However, there is no limit to the number of
machines on which the client software can be installed.

The server machine itself should not be used to access the collection
for either data entry or reporting, as this will compromise any opera-
tions attempted from other clients accessing the server. Additionally,
Helix Server should not be run in the background or share the
machine with mail servers or other network services.

Take care to assure that the System Folder on the server is limited to
system extensions supplied by Apple. Any third party extensions or
other software may cause extension conflicts with the Helix Server.

The computer used as the server must have a local hard disk that
provides sufficient disk space for the application. Given that Helix
creates a scratch and (if logging is turned on) a log file when the col-
lection is open, the local volume must provide space for these as
well.

To improve performance, you may increase the RAM cache via the
Memory Control Panel. Increasing this number may slightly improve
performance further, but drastic increases are likely to have little or,
in some cases, adverse affects.
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16.3 Running Helix Server
Helix Server is the portion of the Client/Server Toolkit that makes a
Helix collection available to users on a network. You need one copy of
Helix Server for each collection that is to be accessible to clients.

16.3.1 Serving an Application

To serve an application and make it available to clients on a network,
double click the Helix Server icon and then choose File->Open.

An Open File dialog box appears. Select the application you want to
use from the list and click the Open button.

As soon as the menu bar appears on the screen, the collection can be
accessed by clients.

16.3.2 The Network Cursor

When running Helix Server or Client you will often see a special net-
work wait cursor (two small Macintosh computers representing the
network) that appears when information is being transferred
between a client machine and the server, or when information
needed by a client is delayed because of a busy network. The net-
work cursor may also appear when there is a break in the network
and the client tries to reestablish the link.

You must wait until the network wait cursor returns to a typical Helix
cursor before you can perform any operations on your machine.

16.3.3 Quitting Helix Server

To shut down a Helix Server, choose File->Quit.

Helix Server asks if you want to save or discard changes made since
the last save. In most cases, you will want to save changes.
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If you attempt a shut down while clients are visiting, the following
dialog box appears telling you the number of clients remaining and
offering you the following alternatives:

Clicking Cancel leaves the application open. 

If you click Quit, Helix Server sends a message to the client(s) still
working in the application (see section 16.6.5). The Terminate User
Access dialog box appears on the server:

If the server waits with the Terminating Network Access dialog box
displayed, Helix automatically shuts down when the final client
leaves the network.

Choosing Abandon ejects users from the database and continues the
shut down. Try to limit use of the Abandon button to exceptional
conditions. Although no damage occurs if you use it, changes clients
are currently making to the application are not saved to disk.
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16.4 Setting Up Helix Client
To prepare client machines to visit a collection over a network, copy
or distribute the Helix Client application to all client machines. There
are three principal ways to do this.

• Put the Helix Client on a removable disk or cartridge and physi-
cally taking it from machine to machine.

• If you purchased Helix on a CD-ROM, take the CD-ROM to each 
machine for installation.

• Put a copy of the Helix Client application in a shared folder on an 
AppleShare volume that is accessible to all your users and allow 
them to simply copy it to their desktop from that folder.

The Helix Client application can be copied as many times as needed
to any machine which can be used to visit a Helix server. However,
remember that a Helix server can accept only as many clients simul-
taneously as are covered by your Helix Client/Server Toolkit license.

The Helix Client application writes a local copy of relevant applica-
tion structures from the server to the disk of the client machine. The
size of these files will vary according to the size and complexity of the
structure of each application visited.
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16.5 Accessing a Helix Application
To access a Helix application with the client software, double click on
the Helix Client icon. The cursor changes to the Helix Wait cursor and
the Helix Client splash screen appears briefly. When the splash
screen disappears, Helix Client draws the menu bar across the top of
the screen. 

Three commands are available on the File menu.

16.5.1 Visit

Choosing File->Visit displays a dialog box from which a user can
choose a collection to visit.

Using this dialog box to select a served collection is similar to using
the Chooser to select a resource in a specific zone. When the dialog
box opens, Helix Client selects the computer’s current zone automat-
ically. The Helix applications available in that zone appear in the
scrollable list on the left. The cursor may flash briefly to the network
cursor when this dialog box is open.

To look up servers in another zone, select that zone.

Tip: You can deselect the current zone by clicking on
another zone or by clicking in the white space beneath the
last zone. If no zone is selected, Helix reselects the current
zone automatically.

You can visit any application, in any zone, from any machine on the
network if you know its location and any required passwords.

After a user selects an application, the cursor alternates between the
Wait cursor and the Network cursor until one of the User Name Selec-
tion dialog boxes appears.
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16.5.1.1 User Name Selection
There are two ways to identify a user. The method available depends
on the design of the application.

• With User Name Security turned off, you are presented with a 
scrollable list of available users. Select your user name then click 
on the Select button, or double click on your user name.

• With User Name Security turned on, you are required to type a 
valid user name into the following dialog box.

Note: If there is only one user for the application, neither
of these dialog boxes appears.

16.5.1.2 Passwords
If access to the user you have selected is password protected, you
must supply the password before Helix Server grants access to the
collection. The following dialog box opens after you have selected or
typed the user name.

Type your password. Masking characters appear instead of the char-
acters you type. If you enter the password correctly, Helix draws the
menu structure for the user you have chosen across the top of the
screen.

Caution: Passwords are case sensitive. If your password is
joe (all lowercase letters), neither Joe nor JOE will work.
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A Helix developer may choose to create passwords for access to both
the collection and for specific users. This provides two levels of secu-
rity for those users.

A network manager for a Helix application being used in Client/Server
mode may choose to design these same levels of security for all users
in the workgroup sharing the application. The network manager has
the additional option of controlling passwords or allowing the users
to create and change their own.

If you need to track user activity and information, you can design
your collection to track that information by using a combination of an
Option 0 post, the UserName tile, and a Form Time tile.

Since people can forget their passwords, Helix’s user setup procedure
makes it easy to simply remove the user’s password and create a new
one (see section 6.4.3.2).

Passwords can be changed by a user in Custom Mode only if the User
Password or Edit Users command is present in the user’s menus. This
is determined by the design of the application. You must enter the old
password correctly once before you can set the new one.

You should be careful in handling your passwords and be sure that
unauthorized users do not know them. In addition, there is no way to
access a collection if you forget a collection password. 

If a user enters an incorrect password, Helix Client returns to the
opening menus. The user must then choose File->Visit again.

If the user enters the correct password and this is the first time the
user has visited the collection, Helix Server downloads the structure
of the collection to the client machine. The downloading is complete
when the cursor returns to the arrow and the menu bar is drawn
across the top of the screen.
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16.5.1.3 Clients Per User Name
If more than the authorized number of clients attempt to log on to a
single user, an error message appears to the user(s) who exceed the
limit.

Click Cancel to return to the Visit dialog box. Click Try Again to retry
the connection using the same user name or another user name.

16.5.2 Open

The first time a client visits a server, Helix Server downloads the
structure of the application to the client machine. At the end of each
session, the client can save this structure as a Saved Structure file
(also known as an Instant Visit icon) on a local hard disk (see section
16.6.1). The user can then double click this icon to reconnect quickly
to the Server, bypassing the connection dialog boxes.

Note: If structural changes have been made to the applica-
tion between client visits, a dialog box appears informing
the user that his or her local structure is out of date and
need to be updated. Clicking OK downloads the updated
structure to the client’s saved structure (see section
16.6.3).

The File->Open invokes a standard file selection dialog from which
the client can select among saved structure files present on his or
her workstation.

16.5.2.1 When the Server Cannot be Found
If the zone or name of a server is changed, a client will not be able to
connect to it from a saved structure file. Should this occur, the nor-
mal Visit dialog box opens so that the user can select the correct
zone and application.
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16.5.2.2 Going From One Collection to Another
To visit a different collection, choose File->Leave. The Leave com-
mand brings back the basic Helix Client menu. You can then choose
File->Visit or file->Open and select a different collection to access.
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16.6 Leaving an Application or Quitting Helix Client
When a user has finished working with a Helix collection over a net-
work, he or she leaves the collection and usually quits the Helix Cli-
ent application.

16.6.1 Leave

Once a user has visited or opened an application, they can exit by
selection File->Quit as in any Macintosh application. Alternatively
they can also Leave the collection without quitting the Helix Client
application. Leave lets the user terminate their access to a Helix
Server without quitting the Helix Client.

User access to the Leave command is under control of the collection
designer. When constructing custom mode menus, put the Close Col-
lection command on user menus if to allow to Leave without quitting
Helix Client.

Helix Client does not allow a user to shut down a Helix
Server. When the Close Collection is found on a user’s
menu, Helix Client inserts the Leave command. Helix
RADE displays Close Collection for this menu item when
the collection is Custom Mode.

Caution: If you are entering or modifying a record, you
should make sure to complete the entry before leaving.
Normally the Save Changes? dialog box appears, giving
you the opportunity to save or discard the record, but the
collection designer may have removed the normal add
and replace permission for the user and is using Enter
Override to perform data entry. If this is done, the data
will not be stored and no warning will be issued.

If the user has been visiting a server, Helix Client displays the Save
this structure before quitting? dialog box when the user chooses File-
>Leave.

If this is the first save for the collection at this workstation, a Save File
dialog box appears so that the user can specify the file and folder in
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which the structure should be saved. The default folder is the folder
in which Helix Client is located. The default name is the network
name of the application.

Helix Client opens a Replace existing...? dialog box if a saved struc-
ture file with the same name already exists in the selected folder.

16.6.2 Quit

To exit Helix Client and return to the Finder, choose File->Quit. You
will be given the same options for saving the structure as discussed
in section 16.6.1.

Tip: If you are entering or modifying a record you should
click on the close box of the window before quitting. This
will give you the opportunity to save or discard the record.

16.6.3 Structural Changes Made in Full Mode

Each time an application is saved in Full Mode, it is stamped with a
new signature to ensure that the old saved structure files are invali-
dated. When this occurs, Helix Client displays the following dialog
box:

Click OK to reload the new structure. Clicking Cancel returns you to
the Client’s menu bar.
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16.6.4 Abandoning the Server

By pressing the Command, Option, and Period keys simultaneously,
you can escape Helix Client without using either the File->Leave or
File->Quit commands.

This method is considered a last ditch measure and should only be
used in extreme situations. It can be used if your machine becomes
hung for some reason and you cannot choose menu commands. The
Command-Option-Period combination displays the following dialog
box.

If you select the Quit button, any data that you have typed but not
entered are discarded. You return to the Finder without going
through the normal Helix close routines. You must restart the client
machine by selecting Special->Restart before attempting to revisit
Helix.

Tip: Files in use (such as an ASCII file being used for load-
ing) during abandoning may remain flagged as in use and
therefore not accessible. To unlock all such flagged files,
restart the machine.

16.6.5 Network Shutdown

If a you are working with a served collection at the time someone
begins to shut down the server, the following dialog box appears on
the your screen.
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In this situation, you should finish working on the current record and
then quit Helix Client.

If the server shuts down while you are working, this following dialog
box appears.

Clicking on the OK button returns you to the Finder. If you were work-
ing on a record, data that were typed but not stored are not saved.
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16.7 Monitoring Application Activity
Helix provides information on network activity and performance for
both the server and the client.

16.7.1 Server Information

Select the File->Server Info or File->Full Mode Info to access the
Server Information window.

Tip: The Server Information window is a cold window that
does not detract from network performance. In other
words, the information is accurate as of the moment the
you open or update the window, but Helix Server does not
update it automatically as saves occur or clients log on or
off. To get current values, click the Update Info button or
close and reopen the window.

The Server Information window provides the following information.

• Server Macintosh network name and collection name: The name 
of the collection and the network identity of the Macintosh on 
which it resides. 

①

① Server and collection name

②

② License information

③

③ Registration information

④

④ Server information

⑤

⑤ Memory usage information

⑥

⑥ Collection and recovery file location

⑦

⑦ Click to save the collection

⑧

⑧ Click to save the collection and clear the

data cache

⑨

⑨ Click to update the contents of the window

⑩

⑩ Click to dump the contents of the window to a text file
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Note: Under System 6, the Macintosh name is specified in
the Chooser; under System 7 or later, it is the name speci-
fied when the System software is installed or in the Shar-
ing Setup control panel.

• Helix Server license information

• registration information

• Server information: If the collection has just been opened, the 
Last Save, Avg. Save Length, and Last Save Length values are 
undefined (blank). 

• memory usage information

Note: Object Free Memory is analogous to the white space
left on the Helix Server thermometer that appears when
you select Apple menu->About this Computer in the
Finder. If the Object Free memory value is low, you may
run out of memory during lengthy Load, Post, or Print All
operations.

• collection and recovery file location: If logging is active, the log 
file location appears also.

• Save Collection button: Clicking this button is the same as select-
ing File->Save.

• Save and Clear Cache button: Whenever any operation that 
involves records occurs (for example load, dump, finds, queries) 
the data involved are placed in a data cache maintained by Helix. 
This cache is designed so that frequently accessed data are more 
readily available.

There are times, however, when the data cache ends up contain-
ing data that will not be used in the foreseeable future. Alterna-
tively, the cache may become so large that the time saved by
retrieving data from the cache instead of disk is eaten up by the
manipulation of a very large cache. In these cases, Helix will
noticeably slow down over time and stay slow.

Click the Save & Clear button on the Server Information window
to save the Collection and clear the data cache.

Note: Save and Clear Cache can also be executed from a
Sequence (see section 6.6.4) or as part of the AutoSave
process (see section 14.1.5).

• Update Info button: Clicking this button refreshes the information 
displayed in the Server Information window.
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• Dump Info button: Clicking Dump Info exports the currently dis-
played values to a text file. When you click the Dump Info button, 
a Save File dialog box appears to let you select the name and loca-
tion for the server info file. The default name is Server Info fol-
lowed by the current date and time; the default location is the 
folder in which the collection resides.

A server info file for the above collection might look like the follow-
ing.

This text file can be opened in any word processor. (The ¶ symbols in
the preceding illustration are carriage returns; the arrows are Tabs.)

16.7.2 Client Information

The Client Information window provides data about
clients visiting the collection. To display the window,
choose File-> Client Info. The Client Info command is
available for use in custom menus, but is only
enabled in Helix Client/Server.

Like the Server Information window, the Client Infor-
mation window is a cold window that does not

detract from network performance. In other words, the information is
accurate as of the moment the window was opened or last updated,
but does not update automatically as clients log on or off or change
users within a session. To get current values, click the Update Info
button or close and reopen the window.
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The Client Information window provides the following data.

• Server information: Identifies the server to which the client data 
apply.

• Active clients list: The active clients list displays the names of cli-
ents that are visiting when you open or refresh the Client Informa-
tion window. 

This list will always display current information on a client by cli-
ent (machine by machine) basis. If someone logs on as User A,
then selects the Set User command to change to User B, the Client
Information window will then list that client as User B when the
window is refreshed.

If the Client Information window is opened on a client, that cli-
ent’s user appears italicized.

• Client visitation data: This scrollable list shows every session log 
on and log off for every client since the collection was opened. 
The data remains until it is cleared, you close the collection, or 
you quit Helix Server.

The data does not include changes of user during a session. It
shows who (what user) the client was when he or she logged off.
For example, if a client logged on at 9 AM as User A, used Set User
at 1 PM to change to User B, and then logged off at 4 PM, the visi-
tation data would show User B logging on at 9 AM and logging off
at 4 PM. However, the Active Clients list would have shown User A
from 9 AM to 1 PM, and User B if the window was opened or
refreshed after 1 PM.

①

① Server information

②

② Active client list

③

③ Client visitation data

④
④ Log off button

⑤

⑤ Update data in the window

⑥

⑥ Clear selected data

⑦

⑦ Dump client data to a text file
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• Log Off button: This button is enabled on a server when you 
select a user in the Active Clients list. Clicking the button logs the 
client off. On a client, the current user’s name is in italics. If this 
user is selected, the Log Off button is dimmed.

A dialog appears on the client machine explaining that the client
has been logged off.

Caution: Using the Log Off button has the same conse-
quences for the selected client(s) as a network Abandon
from the server, data that have not been stored and post
all, dump, print, and load operations in progress are termi-
nated immediately.

• Update Info button: Refreshes the information displayed on the 
Client Information screen.

• Clear Info button: This button is enabled when you select one or 
more lines of the visitation data. Clicking this button deletes 
selected visitation data.

Tip: You can select multiple lines by dragging or Shift-click-
ing.

• Dump Info button: Exports the currently displayed client data to a 
text file. When you click the Dump Info button, a dialog box 
appears to let you specify the name and location for the Client 
info file. The default name is Client Info followed by the current 
date and time; the default location is the folder in which the col-
lection or client structure file resides.

The Client Info file provides the collection location and name, the
time it was started, who was logged on at the time the Dump was
performed, and the visitation record.

A Client Info file is very similar to a Server Info file (see section
16.7.1).
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16.8 Making Your Application User Friendly
While it is always important to have a simple, clear, and logical user
interface design for a Helix application, a user friendly design is never
more important than when that application is being used in a cli-
ent/server environment.

The single user of a Helix RADE application is most often the collec-
tion designer. If something isn’t clear or not working properly, the col-
lection designer can make any necessary changes without disrupting
a workgroup. In those cases where a collection designer has created
an application for a single user other than himself, interface design is
a more significant issue.

The most important part of making your application user friendly is
the development of a good interface. This section includes a general
discussion of the principles of good Helix interface design and pro-
vides some examples of techniques that you can use in your own
applications.

The simplest way to make your application more user friendly and a
great place to begin is to create online help. Helix provides several
ways to do this.

16.8.1 Constructing a Custom Help File

Helix RADE provides a way to create your own messages and instruc-
tions, and have them appear any time the Custom Help command is
selected from the Apple menu.

The application that incorporates Custom Help messages into Helix
appears as a picture of a worker in overalls with a tool in each hand.
This application is not included in the software distribution package,
but is available by contacting Helix either by phone or by email, or it
may be downloaded from the Helix web site.

Custom Helper uses a text file that is formatted in a specific way to
create the messages that appear in Custom Help. Any errors in the
setup of a Custom Help file can cause strange results when a user
chooses the Custom Help command. Once you have created the Cus-
tom Help file, you transform it to the format Helix expects with the
Custom Helper application. The resulting file looks like a few pieces
of luggage.

You place the Custom Help file in the System Folder or in the folder
where Helix RADE, Helix Server, or Helix Client is installed to make
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Custom Help available. Otherwise, Helix dims the Custom Help com-
mand.

Caution: There can only be one file named Helix RADE
Custom Help. If one already exists when you run the Cus-
tom Helper application, the existing file will be replaced
by a new file.

When you construct a Custom Help file, you specify the following.

• The title of the entry: This title can be picked from the Custom 
Help menu to display the main entry in a scrollable window.

• The main entry: This is the information, tips, instructions—what-
ever you want to include.

These two segments are specified by placing curly braces ({TEXT})
around the entries. Each part must begin and end with these sym-
bols. The Help windows display text in Geneva 9 point plain type.
Any special characters you can type with the Geneva font will appear
in the window.

16.8.1.1 Constructing a Help File Using a Word Processor
To prepare a Help file using a word processor:

1. Open a new text document in your word processor. Begin with an 
opening curly brace ({) and then type in the title. End with a clos-
ing curly brace (}).

Note: There is a 255 character limit to a title, although the
help window will display only the first 20 or so characters.

2. Type an opening curly brace ({) to designate the beginning of the 
main entry. Type in the text. You can use Tabs and Return to 
arrange the text in any manner. Each Tab advances the equivalent 
of 5 spaces. This is not adjustable.

Note: Helix ignores any characters between the ending of
the title and the beginning of the main entry.

3. When the entry is complete, type a closing curly brace (}). 
4. Repeat steps 1 through 3 until all entries have been added to the 

document.
5. Save the document as text only. This is important, since the Cus-

tom Help application can find only text files.
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6. Double click on the Custom Help application Icon. The Custom 
Help program launches and displays an Open File dialog box list-
ing all text files in the current folder.

7. Locate the text file containing the Help entries and double click on 
the file name. Custom Helper will then try to make this file into a 
Helix Custom Help file.

There are no error checking functions in Custom Help. If you have
made an error in setting up the file, you will not know it until you try
to use Custom Help within Helix RADE or as a client on a Helix net-
work.

16.8.1.2 Using Helix RADE to Create a Custom Help File
If you will be preparing Custom Help files for many different collec-
tions, then it may be easier to design a small Helix collection for cre-
ating Custom Help source files. To do so:

1. Create a relation with two fields, Title and Topic.
2. Place the two fields in data rectangles on a template.

Format the data rectangles as Geneva 9 point plain font. The Title
field rectangle should be two inches long or less. The Topic field
can be very large—extending to the full page or longer, or with
scroll bar attributes checked.

3. Display the template on a view.
4. Use the form to enter the title and topic of each of your entries. 

Press Return after each Title/Topic entry.
5. Make an abacus using several Followed By tiles that contain the 

necessary curly brace symbols: [{] Followed By [“Title”] Followed 
By [}{] Followed By [“Topic”] Followed By [}].

6. Create a form with only the abacus from Step 3 displayed.
7. Use the Dump All command to dump the data to a text file.
8. Run Custom Helper using the dumped file as input.

16.8.2 Constructing Help Inside Your Application

You can also use Helix RADE itself to build custom help into your
application. It can be done in two principal ways: using data to drive
the Help or using templates, views, and sequences. Either method
requires you to create a separate relation named Help.
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16.8.2.1 Using Data to Drive Help
Suppose you wanted different help available for different types of
users. You could use the methods described above to create Custom
Help files for each different user or class of user. This is an efficient
method, but inefficient when it comes to adding or editing the help
information.

A more efficient method is to create a field for each user’s record in a
user global relation called Prototype. Build each user’s access to
your application from a specific user prototype.

Next, create a relation named Help. In this relation, create fields
named Subject and Text for the Help information itself and another
Field (with an Index) called “Prototype.”

Tip: For extra emphasis, your Text field can be a styled
text field.

Now you can create Help entries targeted to each type of user. Create
an abacus in the Help relation that says {“Prototype”} = {{Lookup
{“Prototype”} for {“UserName”} = {UserName} in {User Global}} to
match the appropriate help for each user.

Create a listing form with this abacus as its query. Create a Sequence
with this view inside it and place the sequence in the Apple menu—
or the Help menu for System 8.x—and assign it a command key
equivalent of H (for Help).

In your Network Manager user, you can place an entry/edit form for
this information so that you can edit the help or add information at
any time while the collection is in use by Helix Server.

16.8.2.2 Using Templates, Views and Sequences
One way to create context sensitive help is to use a template contain-
ing your help text in a label rectangle. You can use different fonts and
styles and even pictures. Create sequences that open each Help win-
dow and place them in buttons on templates. Type Help in the button
or get creative and use pictures.
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The Helix 
Runtime Toolkit
This chapter discusses the uses of the Helix Engine 
and the Collection Converter.
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17.1 What is Helix Runtime?
Helix Runtime is designed for people who wish to create and distrib-
ute Helix based applications to any Macintosh owner, regardless of
whether the end user owns Helix RADE. Licensing the Helix Runtime
Engine provides an economic alternative to owning multiple Helix
RADE licenses when there is a need to run several applications in sin-
gle user, Custom Mode only.

The Helix Runtime Toolkit is comprised of a pair of specialized devel-
opment tools:

1. The Collection Converter changes collections into a form that pre-
vents unauthorized users from accessing Full Mode, even if they 
have access to Helix RADE.

2. The Helix Runtime Engine is a low cost, single user version of 
Helix with no development capabilities.

Converted collections can be run with Helix Engine,
RADE, or Server.
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17.2 Preparing to Create a Runtime Application
Typical Runtime development follows this path:

1. Use Helix RADE to create a collection. The collection must contain 
one or more sets of custom menus. The collection also must be 
saved in Custom Mode.

2. Use the Runtime Converter to change the collection into a Run-
time application.

Note: Conversion is optional. Collections do not have to
be run through the Converter to be opened with the Helix
Engine.

Caution: If you distribute a Collection with a Runtime
engine with the intent of having the end user examine the
collection (for example, as a demo) and you do not pro-
cess the collection through the Runtime Converter, you run
the risk of enabling Full Mode access should that user
attempt to open the collection using Helix RADE instead of
the Runtime Helix Engine.

3. Distribute the Runtime Helix Engine along with the Runtime appli-
cation to users who do not own any Helix application. Helix RADE 
owners will be able to open the collection without the Engine.

4. The end users use the Runtime Helix Engine, The Helix Cli-
ent/Server Toolkit, or Helix RADE to execute their applications.

Runtime applications can be returned to you for modification. Use
the Runtime Converter to unconvert applications back into normal
collections. Unconverted collections can then be opened with Helix
RADE directly from the Runtime Converter by selecting Full Mode
from the Set Menu. You can then alter the structural design as
needed.

Note: Applications can be unconverted only by the Con-
verter with the same serial number that was originally
used to convert them.

Use the Runtime Converter to reconvert the collection into a Runtime
application.
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17.3 Using the Collection Converter
The Helix Runtime Converter is a utility application that adapts a
Helix Collection to the Helix Runtime environment.

The Helix Runtime Converter is the key tool for the Runtime devel-
oper. Its restrictions are outlined in your Helix Runtime License
Agreement.

While you do not have to convert collections to use the Helix Engine,
there are benefits to you in doing so.

• You can set an expiration date on an application.

• You can control the content of the opening screens.

• Each Helix Runtime Converter is serialized and licensed to a spe-
cific individual or company.

• Converted collections (referred to interchangeably as applica-
tions) work with a Helix Engine as well as with Helix RADE and 
Helix Server. Applications can be serialized and have an expira-
tion date; they may also be set to unlimited duration. The default 
setting is 30 days.

The main Converter dialog box controls both conversions and uncon-
versions.

The controls and text boxes function as follows.

• Collection Licensee text box: Enter up to 4 lines of information in 
the Collection Licensee text box to personalize a copy of the appli-
cation. Insert the name and any other identifying information 
about the person, company, or group to whom the application is 
sold or licensed.

• Collection Licensor text box: Your name and information (maxi-
mum of five lines) goes in the Collection Licensor text box. The 
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information in this box identifies the creator of the Runtime Appli-
cation.

The information in the two text boxes appears when the user
launches the application, and in the Get Info and expiration dialogs.

• Convert Collections and UnConvert Collections radio buttons: 
These buttons, located at the bottom of the Converter main dia-
log box, control the current function of the Converter.

- When you select Convert Collections, the Converter trans-
forms Helix collections into Runtime applications. The dialog 
box appears as shown earlier.

- When you select UnConvert Collections, the Converter 
changes Runtime applications back into Helix collections. As 
no information concerning the licensee, expiration date, tele-
phone number, or Collection Serial Number are needed in this 
mode, these items are not visible.

• Copy and Convert button: The Copy and Convert button appears 
dimmed (and nonselectable) until you have typed at least one 
character into the Licensee text editing box. When you click the 
Copy and Convert button, Helix copies the collection and con-
verts the copy, leaving the original collection intact and unmodi-
fied.

• Convert: The Convert button begins the direct modification of a 
collection. Although conversion of an original collection is possi-
ble with this button, it is rather risky. If a system failure occurs or 
the Macintosh loses power during this process, the collection 
could be damaged beyond recovery. When using Convert, always 
make a backup copy of the collection first.

• Change Collection S/N: The Change Collection S/N button lets the 
designer set the serial number of the next application to be con-
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verted. The designer can supply this number using the following 
dialog box. 

The Converter increments the serial number by one for each col-
lection modified. The Converter supplies an initial Next Collection
Serial Number of 0. You can use serial numbers of nine digits or
less.

17.3.1 Converting a Collection

To convert a collection:

1. Click the Copy and Convert button. Helix displays an Open File 
dialog box so you can choose the collection.

2. Find the collection and click the Convert button. A Save File dialog 
box appears so you can locate and name the converted collection.

Tip: Be sure to use a different name for the converted col-
lection than was used for the original collection. If you
don’t, you’ll be presented with a standard Macintosh
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Replace? dialog informing you that you’ll be replacing a
document with the same name.

3. After naming the collection, you must either click Convert again 
or press either the Enter or Return key on your keyboard. This 
completes the conversion process.

During the conversion process, the Converter displays messages
explaining what is happening. Events include opening the collection,
checking it, copying it, and modifying it.

Remember that to be converted, a collection must be in Custom
Mode. Since the Converter cannot tell this without opening the col-
lection, all collections appear selectable. Should you select a collec-
tion in Full Mode, one from an older version of Helix, or one that is
too badly damaged to open or modify, an alert appears to inform you
of the problem and stops the process. The Converter does this
checking before performing the copy operation of Copy and Convert
and therefore produces no copy of the file.

Note: The second method of modifying a Collection is to
use the Convert button. This performs exactly the same
modification as the Copy and Convert button, but operates
directly upon the selected collection. Convert is provided
for cases where disk space is limited. As stated earlier,
this can be risky, as the collection could be damaged and
made unusable by a system failure or power loss during
conversion. Be sure to make a backup copy of the collec-
tion prior to using this method.

The following chart summarizes the relationships between the differ-
ent applications in the Helix product family and their use with Helix
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collections and collections that have been processed through a Run-
time Converter.
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17.4 Opening An Application with the Runtime Engine
The Helix Runtime Engine is a very specialized version of Helix that
does not include the Rapid Application Development Environment.
Because of this, the Engine is slightly smaller than Helix RADE. Run-
ning an application with the Engine is not discernibly different from
running the same collection in Custom Mode with Helix RADE or visit-
ing it as a client.

The Helix Runtime Engine permits data manipulation only. An Engine
user can view, enter, replace, delete, dump, load and print data.

The Helix Runtime Engine does not provide access to Full Mode. The
Engine user cannot alter the structural design of an application.

The Helix Runtime Engine is provided to Helix professionals so they
can distribute usable applications without requiring the user to own
Helix RADE or any other Helix application product. Contact Helix
Technologies to determine the requirements for obtaining copies of
the Runtime Engine.

You use the Engine much as you would use Helix RADE. When you
launch the Engine Icon, File->Open lets you select from all Helix Run-
time applications as well as Helix collections in Custom Mode.

If you double click a Helix Runtime application in a Finder window,
the Engine launches automatically and the application opens in its
desktop environment.
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17.5 Unconverting a Collection
The unconverting process is similar to converting. However, when
you open a converted collection with the Converter, the radio but-
tons have changed to Copy and Unconvert and Unconvert.

During the unconversion process, the Converter displays messages
explaining what is happening. Events include: opening the Collection,
checking it, copying it, and modifying it.

For the designer’s protection, the Converter can only unconvert
applications it originally modified—in other words, by a Converter
with the same serial number. It cannot unconvert an application mod-
ified by a Converter with a different serial number.

The Unconversion process is summarized in the following diagram.

To modify an Unconverted collection, open it as you ordinarily would
using Helix RADE. You may then modify the collection in any way.
After saving your changes, simply close the collection and begin the
conversion process as described above, unless you do not wish to
reconvert it to a Helix Runtime application.
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17.6 Expiring Collections
If you want a converted collection to run for a limited amount of time,
enter a number in the Collection to expire in text box in the Con-
verter dialog box.

When a collection has expired, a dialog box appears informing the
user. The dialog box displays the name of the collection licensee as
well as the name of the collection creator (in other words, the person
to whom the Helix Runtime Converter belongs). The collection can-
not be opened.

If a collection expires while in use, the expired dialog box appears,
but the user can continue working in the collection, with interrup-
tions for the dialog again every few minutes.

This is a very benign sort of expiration. An expired collection can be
opened merely by setting the Macintosh clock prior to the expiration
date. In this case, however, values or application functions that
depend on the correct calendar date will, of course, be incorrect.
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Collection 
Maintenance
This chapter contains an examination of issues 
relating to backing up and using Helix’s utilities to 
keep your collections in top working condition.
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18.1 The Importance of Backing Up
There can be no simpler way to state the importance of backing up
than to say that if you don’t back up and you lose your work, you can
lose everything.

18.1.1 What is Backing Up?

Backing up is a term referring to a degree of comfort. As the old say-
ing goes, “There’s backing up and there’s backing up.”

At its core, backing up refers to the making of a copy of a document.
You back up a paper system by making copies of every document on
paper. You back up a computer system by making an electronic copy
of each electronic document.

What you use to store your backup copy is immaterial to the issue of
backing up. As long as you are confident that your medium is reliable,
you can use it.

Once you have this copy of your work, the next part of backing up
involves having a procedure in place to take it offsite at regular inter-
vals. This is to prevent a disaster in the event someone steals all your
computer equipment or your building burns down with your comput-
ers and your backups in it.

18.1.2 Why Back Up?

If your house burned to the ground and you didn’t have a copy of
your work somewhere, you would have to recreate it all from mem-
ory. If your computer was stolen or broken and you had to get a new
one, how would you get your work from the old machine to the new?

Backing up gives you some security because it is your first line of pro-
tection against data loss. But backing up does not guarantee data
integrity. That is the job of the Helix Utilities (see sections 18.2 and
18.3). 

Backing up also is not a substitute for proper collection management
procedures (as detailed in Chapter 14), but rather it is an extension of
it.

Backing up should be considered a duty by anyone charged with the
responsibility of running a computer. Backing up is so important that
you should even have backup copies of your backup copies. Many
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organizations keep three generations of backup copies. When you
make a new backup, you reuse media containing the oldest of the
three copies. This way, you always have two extra copies in reserve,
just in case something happens to the most recent.

How often should you back up your collection? That depends on the
activity of your database and how much risk you are willing to take.
In an active environment, where data are continually being modified,
you may want to back up once or twice a day. This is especially true
if you can’t afford to lose data. However, if your collection isn’t modi-
fied very often, then less frequent backups may be satisfactory. 

Backing up can be a tedious process. Users may not want to do it.
You must therefore balance the risk of losing data with the discom-
fort factor of the people who need to perform backups.

18.1.3 Successful Back Up strategies

Not only must you back up, but you must have a strategy for backing
up! Consider it to be like a plan that you must stick to religiously. Suc-
cessful back up strategies involve three aspects:

• Constant devotion to your plan.

• Rotating your media.

• Making three copies.

Constant devotion means you will never be caught without a good
last backup copy you can turn to that is not too old to be useful. The
disaster always occurs on the day you forgot to back up.

Media for backup may be tapes, fixed hard disks, removable hard
disks, writable CD-ROMs, or removable storage devices. Rotating
media means two things above all:

• You use a different media set each time you back up. If you 
backup every day, you might have one disk for each day of the 
week. Every Thursday, you back up on the Thursday disk.

• You periodically evaluate and replace the media. Although mag-
netic media do last several years and CD-ROMs even longer, all 
storage devices do wear out in time. Nothing could be as horrify-
ing as having to go to yesterday’s backup and discovering it can’t 
be read. Use a utility application appropriate for the medium you 
use for storage to determine that your disks are in good shape. 
You might go as far as making sure that your copies copy back to 
your source before dispersing them.
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If you make three copies of your work, you actually have four. That’s
because you always have your original, wherever it is. You can man-
age the copies in the following way. One copy stays onsite in a safe.
One copy goes home with you from work or goes outside your home
if you work at home. One copy goes right on your hard disk drive.

Be careful what you are backing up. In particular, make certain that a
Helix collection is undamaged before you copy it to backup media. If
your Helix collection is damaged and you back up the damaged file,
you run the risk of erasing a good, although older, copy of the collec-
tion with a damaged collection that can’t be opened. 

You should always run your collections through the Helix Utilities
prior to backing them up. However, because running the Utilities can
be time consuming, a lot of users don’t test their applications every
day, but only after they have crashed or frozen, or only periodically
(like once a week or once a month).

Since disasters can occur while you are running the Helix Utilities, it
is useful to make a backup copy of what you are about to test prior to
testing it (preliminary backups). 

One useful strategy is to make two folders anywhere on your hard
drive. In one you keep the last copy that passed through all the Helix
Utilities successfully. You could call that LGC for last good copy. In
the other folder, you option-drag to create a copy your collection and
logfile over whatever copy it contains just prior to testing it. This
way, you have another copy to test in the event of a power outage
damaging the original beyond usability and you don’t have to go to a
backup medium for it. When the testing is successful, you can copy
the resulting application over both copies prior to copying them to
your backup media.
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18.2 The Helix Utility
The Helix Utility is a stand alone program that combines a number of
functions. It can automatically repair, compress, provide size infor-
mation, and break all indexes in a collection.

18.2.1 Installing the Helix Utility

The Helix Utility is part of the Full Installation as described in section
1.2, Installing and Updating Helix Software.

18.2.2 Version Compatibility

The Helix Utility is designed to be backwards compatible with collec-
tions created with older versions of Helix, but you can not use an
older version of the Helix Utility newer collections. Regardless of the
version of Helix you run a collection under, you should always use
the latest available version of the Helix Utility on your collections
because it will have more repair capability that its predecessors.

18.2.3 Opening a Collection

Before Helix Utility can check a collection Helix Utility must be able to
open and read the contents of the collection.

To open a collection:

1. Quit all other Helix applications. The Helix Utility can not examine 
a collection if it is open with another Helix product.

Tip: Be sure to make a backup copy of your collection
before you open it with the Helix Utility.

2. If the Helix Utility is not open, double click on the Helix Utility 
icon.

3. If you want to compress (remove empty space from) one or more 
collections, chose File->Compression Available.

4. Choose Open from the File menu, or type Command-O. An Open 
File dialog box appears from which you can choose the collection 
to work on. After selecting the collection, click Open or double 
click on the collection name.
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You cannot use an older utility with a newer collection. If you do, the
following dialog box appears.

5. A dialog box appears explaining that you should be using a copy 
of the collection.

If you are working with a copy, click OK, I have a backup.

If you are working with the original, click Cancel. Quit Helix Utility
and make a backup of your collection before proceeding.

6. A thermometer appears indicating the progress of reading the file. 
For large collections, the wait can be lengthy.

18.2.4 Data Damage Check

A data damage check looks for problems in the data stored within
the collection.

1. Choose Tools->Data Damage Check or Type Command-A.

Tip: Type Command-A while the collection is being read;
the Data Damage Check automatically begins as soon as
the file has been read.
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2. A thermometer appears indicating the progress of examining the 
file:

3. When the Data Damage Check is finished, Helix Utilities displays a 
dialog box that tells you the results.

Tip: If the dialog box indicates that repairs need to be
made, make the repairs, then run the Collection through
the Data Damage Check again (and again, if necessary)
until the Utility displays a dialog box indicating that there
are no detectable problems. The Utilities sometimes give
false reports of either fatal damage or no damage after
other repairs are attempted. The no detectable problems
dialog and the fatal damage dialog should be ignored
unless it is the only dialog box that appears during the util-
ity pass.

4. Close the collection (select File->Close Collection or Type Com-
mand-W) if you want to examine other collections. Alternatively, 
you can quit the Helix Utility. This will also close the collection.

If you fail to close the collection or quit the Helix Utility,
you will get an error if you try to open the collection with
another Helix application. If you get an error after running
Helix Utility, select Helix Utility from the Applications
menu and quit, or restart the computer.

18.2.5 Compress Collection

The Helix Utility lets you compress collections to reduce their size.
During the normal course of adding and deleting information, unused
space may accumulate within a collection. When data are deleted, the
space they occupied in the collection is available for reuse. When
data are added, Helix reuses the empty spaces before expanding the
size of the collection. But for the sake of efficiency, Helix will often
skip over small gaps in a working collection.

The Compress Collection function removes these gaps, shrinking the
overall size of the collection in a process very similar to hard disk
defragmentation.
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Collection compression does not need to be done on a routine basis.
Typically it only needs to be done only if you have deleted large
amounts of data and you do not expect to add much data in the near
future.

In certain instances, collection compression can improve the perfor-
mance of a collection. If your collection occasionally takes a very
long time to save, compression may correct the problem.

Compressing a collection can be dangerous; many internal objects
are moved, making it possible that one or more could be damaged in
the process. It is critical that both the Helix Utility’s Data Damage
Check and Update Collection’s Structure Check report no problems
with the collection before compressing it.The hardware and OS
should also be in good condition. An external effect, such as a power
fluctuation or transient noise on a SCSI cable, could be fatal.

To compress a collection:

1. Open the Helix Utility. 
2. Select File->Compression Available.
3. Select File->Open Collection and choose the file you wish to com-

press.

Tip: Before compressing a collection, be sure to check its
structure with Helix Update Collection. Then in the Helix
Utility, examine it using the Data Damage Check com-
mand prior to compression. Compress Collection should
never be used on a damaged collection.

4. After checking for damage, choose Tools->Compress Collection or 
type Command-M.

5. Helix Utilities prompts you to select a folder for the new, com-
pressed Collection and gives you the opportunity to name the 
new collection. The default folder is the folder in which the collec-
tion being compressed resides; the default name is Compressed 
“Collection Name”.
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6. Specify the location and name for the compressed collection and 
click the Save button to begin the compression process.

There is a waiting period while the compression occurs. A thermome-
ter advises you of the progress of the operation.

For a large collection the wait can be lengthy. At the end of the pro-
cess, a dialog box tells you that the process was successful and noti-
fies you that you should test the compressed collection prior to using
it.

Tip: Type Command-Q while the collection is being com-
pressed and the Helix Utility will quit as soon as the com-
pression is done.

After creating a compressed collection, it is wise to run the Helix Util-
ity’s Data Damage Check on the new collection. If the Helix Utility’s
Data Damage Check reports damage in a compressed collection that
passed Data Damage Check immediately prior to compression, con-
tact Helix Technical Support for assistance.

18.2.6 Break All Indexes

Break All Indexes invalidates every index in the collection, requiring
them all to be rebuilt the next time the collection is opened in Helix
RADE, Server, or Engine. Unless you have a specific reason for break-
ing all indexes, you should do this only when instructed to do so by
Helix Technical Support.

Tip: Breaking all indexes is useful if you want to create the
smallest possible file without deleting data. Break All
Indexes followed by a Data Damage Check will result in
all of the space formerly occupied by indexes being
marked as unused. Compressing this collection will result



Chapter 18: Collection Maintenance

18-12

in a much smaller file. If you need to compress a file to
send via the internet or so it will fit on a removable disk,
this will make it as small as possible. Keep in mind that
the next time the collection is opened the indexes will
rebuild, and the collection size will increase accordingly.

18.2.7 Autofix Options

The ability to disable the various types of autofixing should on be
done only under instruction of Helix Technical Support. Disabling
these options can prevent the Helix Utility from fully repairing a dam-
aged database.
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18.3 Helix Update Collection
Helix Update Collection is a tool that you use to update collections
that have been created in earlier versions of Helix. More importantly,
the application also checks the structural integrity of collections.

Caution: Once you have updated a collection, you cannot
use it with an earlier version of Helix.

18.3.1 Launching Update Collection

You can launch Helix Update Collection by dragging a collection icon
and dropping it onto the Helix Update Collection icon, which
launches the application and opens the dropped collection. You can
also double click directly on the Helix Update Collection icon and
select File->Open to open your collection. When you do, you’ll be pre-
sented with the following warning dialog.

Tip: Always make a backup copy of your collection before
running Update Collection. If the process is interrupted in
any way, the collection will be unusable.

18.3.2 Memory Requirements

Helix Update Collection prefers to have as much memory as possible
at its disposal, especially when updating large collections.

If you do not have enough memory available to run Helix Update Col-
lection, you will see a dialog box indicating how much more memory
you need and asking if you still want to open it using the available
memory.
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In this situation, it is generally advisable to make sure that Helix
Update Collection is the only application running apart from the
Finder. Even then, you may find performance of this application and
the Helix Utility more reliable if run when all extensions are disabled.

Tip: While not a strict requirement, you should always ver-
ify the integrity of the data in the collection by using the
Helix Utility prior to the updating or structural analysis
and repair performed by Helix Update Collection.

18.3.3 Attempting to Open an Out-of-Date Collection

When you double click on a Helix collection icon that was last used
with a previous version of Helix, an Apple Event update process
begins.

In this process, your Macintosh runs the Helix Translator automati-
cally (if necessary, for versions of Helix prior to the first native Pow-
erPC version, version 3.5) and Helix Update Collection.

Normal Helix installation puts all of these applications in the appro-
priate locations for this process to work smoothly. However, if the
application and the utility are not in the same folder, the Apple Event
update procedure will not be able to locate these applications. In
that event, the following dialog appears.

When this happens, go to the applications themselves and launch
them or reinstall your Helix applications and try again.
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18.3.4 Using Helix Update Collection to Check a Collection

Once a collection has been updated, subsequent running of the Helix
Update Collection application on the same collection triggers follow-
ing alert:

If you select Check Structure, Helix Update Collection verifies the
integrity of the Collection. Alternatively, you can click Cancel to abort
the operation.

18.3.5 Helix Update Collection and Fonts

For collections updated from Double Helix 3.0 or earlier, Helix Update
Collection introduces font management by name instead of number.

If you update a collection from a system containing font numbers that
are not in the collection (reference fonts that are not loaded in the
system) Update Collection substitutes Geneva for the original fonts.

18.3.6 Collection Maintenance Notes

There is no proper order for running the two utility applications. For
some time, users have been advised to run the Helix Utility prior to
running Helix Update Collection, but this is not a hard and fast rule.
There are situations when running Helix Update Collection first can
effect repairs that might not otherwise be possible.

Some users have noted that running Helix Utility first reports fatal
damage that the Helix Update Collection Structure Check appears to
be able to repair. No collection can be considered sound unless it
passes through both Helix Utility and Update Collection without
reporting any errors. If you are updating to a new version, try follow-
ing this order of operations:

1. Verify structural integrity with the old version of Helix Update Col-
lection’s Structure Check
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2. Verify data integrity with the new version of Helix Utility.
3. Update structure with the new version of Helix Update Collection.

If you are checking a collection already in the current version, try the
following order of operations:

1. Verify data integrity with Helix Utility.
2. Update structure with Helix Update Collection.

If errors are reported in one utility, run the other. Then run the first
one again to see if the error still exists.



Reference

Appendix

Helix

A

Default Set of 
Keyword 
Exclusions



Chapter : Default Set of Keyword Exclusions

-2



-3

The following table contains the default set of characters that Helix
ignores in keyword fields. You can change these characters using a
ResEdit template that you can obtain from Helix Technical Support.

Tab | § … >

Carriage return • fi <

Non-breaking space ‡ ; fl +

Á (2 stroke) ß ? ® ©

À (2 stroke) Œ @ ™

Ó (2 stroke) œ „ ! [

ÿ (2 stroke) ‚ ´

space

- ‰ ” \ ¨ —

Å # ] ≠ “ Ê

$ ^ À % –

¿ ‘ Ë & ¡

‘ É ’ ¬ ÷

( √ ° Î { }

) ~ ƒ Ï

∆ / Ó , ¢ «

Ô £ » ≤ ≥

 Ò Ú Ù ˆ \

¨ ¯ ˘ . ¸
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External Access to a Helix collection is provided through a group of
proprietary Apple Events (AEs, for short). To understand this appen-
dix, you should be familiar with programming with Apple Events.

An external application can send, receive, and delete records in a
Helix collection using Apple Event calls. The external application can
be an existing application that can create and send custom Apple
Events or it can be a custom application written in any programming
language that can be compiled into a Macintosh application.

Note: Helix cannot initiate Apple Events; it can only
receive them. As such, external access is controlled totally
by the external application.

The external application can be located on either the same or a differ-
ent machine as Helix. If the external application is located on a differ-
ent machine, then program linking must be enabled on the computer
running Helix. In this case, all AE servers will be visible through the
PPC Browser or an IPCListPorts call. 

Tip: To restrict the AE servers to Helix only, pass a Filter
function, containing ‘HXPD’ (RADE), ‘HXPS’ (Server), or
‘HXPR’ (Runtime) as the first 4 bytes of the name.port-
TypeStr of the PortInfoRec, to the PPC Browser.

External Access to Helix, when available, is limited to 1 machine
access to Helix RADE Custom Mode or the number of registered Helix
clients that are allowed concurrent accesses to Helix Server.

An external application accesses Helix data through a form in the col-
lection. Helix must be running while data access is occurring,
although an external program could send an open doc event to the
machine where Helix resides to launch a Helix application. The form
identification consists of five items:

• Collection Name

• User Name

• User Password

• Relation Name

• Form Name

If the Helix collection contains more than one form that meets the
identification criteria, then there is no way to know which form the
external application will use.
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You can perform three operations with external access: retrieve data,
store data, and delete data. These operations correspond directly
with the basic Helix operations of the same name. Since Helix does
not initiate AEs, Helix cannot reflect real time updates to data once
an external application has retrieved data. In other words, the data
received by an access will be cold as of the moment the data are
sent.

There is currently no provision for specifying queries with Apple
Event access. Helix uses whatever query is on the form accessed by
the external application. Similarly, an external application cannot
specify any posting. However, an external application triggers what-
ever posting that is attached to a form when it performs a store oper-
ation. In all cases, a protocol or other error aborts the offending call
and causes an error message to be sent to the calling program. Thus,
all external programs must be prepared to handle errors.

Whenever an external program causes Helix to submit a task to the
Helix scheduler, the external program receives a ProcessID. This Pro-
cessID is the only link to that task. Whenever an asynchronous task
is outstanding, that access should periodically poll Helix with the
ProcessID asking if the task is complete. Since there is no mechanism
to allow Helix to initiate an AE, it is the external program’s job to poll
for completion. For best results, place a delay of a second or two
between any two completion polls. If the access is connecting to a
form that is time consuming to open, allow for a longer delay.
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B.1 Retrieve
When an external program sends a retrieve call to Helix, Helix sub-
mits the task to the Scheduler for asynchronous processing and
returns a ProcessID to the external program. When Helix receives a
‘done?’ request from an external program and the task is done, Helix
sends a reply to the access containing the following information:

• Number of host records retrieved

• Field delimiter char (from form’s Dump/Load options)

• Record delimiter char (from form’s Dump/Load options)

There is never a start character involved in an AE retrieve, regardless
of a form’s Dump/Load options.

To retrieve a record, the external program needs to send a GetRow
request. There are three types of GetRow requests. The first sends
back the form’s header information, as in the Dump command. The
second sends back all data outside of the form’s repeat rectangle.
The third sends back all the data inside the form’s repeat rectangle or
all the data if there is no repeat rectangle. For this last request, the
record number to retrieve (relative to this operation), the number of
records to retrieve, and the subform tabbing control—even if there
are no subforms— must be specified in the request for Helix to know
exactly what data to send.

Caution: If you are using a form that has no repeat rectan-
gle, a type 2 request returns no data

When the retrieve operation is done, the external program must send
a Cancel request. Helix terminates any pending or active operations
that the external program has initiated and releases the memory
used because of the external access. If you do not terminate an exter-
nal access in this way, Helix becomes sluggish and may run out of
memory. 

Note: In the Apple Event implementation for Helix ver-
sions 4.5.5 and earlier, posting does not occurs on
Retrieve. AE Retrieve appears to be functionally similar to
a Helix dump, but it behaves more like “open a list.” This
behavior is expected to change future versions.
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B.2 Store
To send data to Helix, an external program sends a Store request to
Helix. This is not an asynchronous request. Include the data to store
in the request. There is no limit to the number of records that can be
stored with a single request, but to keep other Helix Clients function-
ing properly, you should send no more then 10—or less in larger user
sites—records in a single request.

Remember that all Posts on data entry are triggered as the data are
stored.

The format of the data must be ASCII with no start or stop characters.
Pictures and documents may not be sent. The physical field separa-
tors must correspond to the settings in the dump/load options.

There are two types of store calls. The one time store is used for
infrequent store requests and is an all-in-one call. The batch store
involves the steps of setup, store, and cleanup. Failure to adhere to
this ordering causes the store operation to fail.

The batch store setup phase consists of a call specifying the form to
use for storing data. Helix returns a ProcessID. After receiving a store
call, Helix performs basic form table construction. Helix does not
release the setup after the store operation, which saves time for
batch stores because the setup is a sometimes lengthy process. An
external program then can perform a group of store operations, fol-
lowed by a cancel call. Again, failing to cancel will result in detrimen-
tal performance for other Helix clients.

Helix’s reply to a store request of either type includes a list of Bool-
ean flags. If the nth record has been successfully stored, the nth flag
is true; otherwise, it is false. With this system, an external program
can trap and handle errors.
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B.3 Delete
A Delete request can only be granted after a retrieve request has
been completed. A GetRow reply contains a record identifier that can
then be used as a parameter for a Delete request. 

Caution: The record identifier is a number, but do not per-
form arithmetic or any other operations on it to get a dif-
ferent record identifier to use. Adding one to a record
identifier will not get you the next record consistently
enough to be of any use.

A Delete request can contain up to 10 record identifiers. When Helix
receives the request, it begins locking records. If for any reason all
the records cannot be locked, the operation aborts with no effect. If
an error occurs during the delete phase, all records before the error
occurred are deleted. The results of the operation will be contained
in the reply.
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The following assumes familiarity with Apple Events in general. Addi-
tional helpful information can be found in:

• Inside Macintosh, vol. 6:

- Chapter 5: The Event Manager

- Chapter 6: The Apple Event Manager

- Chapter 7 (7-1 to 7-23): The PPC Toolbox

• Inside Macintosh, InterApplication Communication:

- Chapter 1: Introduction to InterApplication Communication

- Chapter 3: Introduction to Apple Events

- Chapter 4: Responding to Apple Events

- Chapter 5: Creating and Sending Apple Events

There are eight separate requests that can be sent to Helix. All proto-
type lines are listed as they would be used in MetroWerks C++. You
can find a small sample of how to use the calls (in the Apple style) at
the end of the protocol listing.

To create an Apple Event use:

AECreateAppleEvent (kHelxEventClass, kHelxEventID, 
theTargetAdd, kAutoGenerateReturnID,
kAnyTransactionID, theApple Event);

where
 kHelxEventClass = ‘HEEC’;

// Helix custom Event Class

 kHelxEventID = ‘HEEI’;
// Helix custom Event ID

All Apple Event requests must have a transaction/request code con-
tained in a keyword parameter named ‘TYPE’ with typeLongInteger
as the descriptor type for the keyword.

Use AEPutParamPtr to add this parameter to the Apple Event:

AEPutParamPtr (theAppleEvent, ‘TYPE’, 
typeLongInteger,&AEcode, 
sizeof(AEcode));

The majority of Apple Events require a descriptor list which will be
filled in with specific information depending on the type of request.

Use AECreateList to create an empty descriptor list:

AECreateList (NULL, 0, false, theDescList);
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Use AEPutPtr to add items into the descriptor list:

AEPutPtr (theDescList, 0, typeChar, 
&CollectionName, 
sizeof(CollectionName));

Use AEPutParamDesc to attach a descriptor list to an Apple Event:

AEPutParamDesc (theAppleEvent, keyDirectObject, 
theDescList);

Use AESend to send an Apple Event to Helix. A reply will be expected
in every Apple Event send to Helix. The third parameter, AESend-
Mode, must be set to:

kAEWaitReply + kAENeverInteract + kAEWantReceipt

The rest of the parameters are AE Client application dependent.

AESend (theAppleEvent,theReply,kAEWaitReply +
kAENeverInteract + kAEWantReceipt, 
kAENormalPriority, kAEDefaultTimeout,
NULL, NULL)
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C.1 Retrieve
Request Code = 100.

Create an empty descriptor list for the Apple Event which will be
filled in with the form identification information.

Use AEPutPtr to fill the descriptor list. The order in which items are
filled into the descriptor list is critical.

C.1.1 Reply

When AESend returns, use AEGetParamPtr to extract any System or
Helix error codes.

AEGetParamPtr (theReply, keyErrorNumber, 
typeLongInteger,  returnType, 
&errNum, sizeof(errNum), actSize);

where errNum is the error code. If errNum is negative, then a system
error has occurred. If errNum is positive, then a Helix error has
occurred.

If there is no error—in other words, errNum = noErr—then use
AEGetParamPtr again to extract the Process ID that later will be used
for ‘GetRow,’ ‘Delete’ and ‘Cancel’ requests.

AEGetParamPtr (theReply, keyDirectObject, 
typeLongInteger,returnType, 
&ProcessID, sizeof(ProcessID), 
actSize);

Item Description Descriptor type

1 Collection Name typeChar

2 User Name typeChar

3 Password typeChar

4 Relation Name typeChar

5 Form Name typeChar
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C.2 Done
Request Code = 120.

Create an empty descriptor list for the Apple Event.

Use AEPutPtr to fill the descriptor list. The order in which items are
filled into the descriptor list is critical.

C.2.1 Reply

When AESend returns, use AEGetParamPtr to extract any System or
Helix error codes.

AEGetParamPtr (theReply, keyErrorNumber, 
typeLongInteger, returnType, &errNum, 
sizeof(errNum), actSize);

where errNum is the error code. If errNum is negative, then a system
error has occurred. If errNum is positive, then a Helix error has
occurred.

If there is no error—in other words, errNum = noErr—then the reply
will contain a direct keyword parameter of typeBoolean which is the
Done indicator. Use AEGetParamPtr to extract this Done indicator.

AEGetParamPtr (theReply, keyDirectObject, 
typeBoolean, returnType, &TaskDone, 
sizeof(TaskDone), actSize);

If TaskDone is true, then the reply also contains an additional three
keyword specific parameters:

Item Description Descriptor type

1 ProcessID typeLongInteger

Description AEKeyword DescType

Total number of records LSTZ typeLongInteger

Field separator FLDD typeChar

Record separator ROWD typeChar
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C.3 Get row
Request Code = 140.

Create an empty descriptor list for the Apple Event.

Use AEPutPtr to fill the descriptor list. The order in which items are
filled into the descriptor list is critical.

C.3.1 Reply

When AESend returns, use AEGetParamPtr to extract any System or
Helix error codes.

AEGetParamPtr (theReply, keyErrorNumber, 
typeLongInteger, returnType, &errNum, 
sizeof(errNum), actSize);

where errNum is the error code. If there is no error—in other words,
errNum = noErr—then the reply will contain a descriptor list and a
typeLongInteger keyword parameter named ‘LSTZ.’ The keyword
parameter contains the number of host records extracted from Helix. 

Use AEGetParamPtr to extract this keyword parameter.

AEGetParamPtr (theReply,‘LSTZ’, typeLongInteger, 
returnType, &nRowsRet, 
sizeof(nRowsRet),actSize);

The descriptor list contains all the records extracted from Helix. Each
item in the descriptor list contains a record in ASCII format. In addi-

Item Description Descriptor Type

1 Process ID typeLongInteger

2 Info. Type
0: Header
1: Data in the outer repeat
2: Data in the inner repeat

typeLongInteger

3 Starting record # typeLongInteger

4 # of records typeLongInteger

5 SF level tabbing
True: insert subform’s level tabbing
False: otherwise

typeBoolean
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tion, for InnerRepeat type request only, there is a prefix of four bytes
that is the Record ID for the record.

Use AEGetParamDesc to extract the descriptor list out of the reply.

AEGetParamDesc (theReply, keyDirectObject, 
typeAEList, theRetDescList);

Use AECountItems to find out the number of items in the descriptor
list.

AECountItems (theRetDescList, nItems);

Use AEsizeofNthItem to determine the size and type of an item in the
list.

AESizeOfNthItem (theRetDescList, NthItem, retType, 
maxSize);

All the item types in the list will be of type “typeChar.”

Use AEGetNthPtr to extract the Nth item out of the list.

AEGetNthPtr (theRetDescList, NthItem, typeChar, 
keywd, retType, &Buffer, maxSize, 
actSize);

Note: If a target record has been deleted then its content
will consist of only 1 byte ($03).
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C.4 Cancel
Request Code = 130.

Create an empty descriptor list for the Apple Event.

Use AEPutPtr to add in the ProcessID for any outstanding Retrieve
calls into the descriptor list.

C.4.1 Reply

When AESend returns, use AEGetParamPtr to extract any System or
Helix error codes.

AEGetParamPtr (theReply, keyErrorNumber, 
typeLongInteger, returnType, &errNum, 
sizeof(errNum), actSize);

where errNum is the error code. 

There is no reply returned by Helix. Check errNum for any errors
returned by the System or Helix.
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C.5 Delete
Request Code = 150.

Create an empty descriptor list for the Apple Event.

Use AEPutPtr to fill the descriptor list. The order in which items are
filled into the descriptor list is critical.

You can have no more than 10 target Record IDs in the list. Obtain
Record IDs from the ‘GetRow’ request.

C.5.1 Reply

When AESend returns, use AEGetParamPtr to extract any System or
Helix error codes.

AEGetParamPtr (theReply, keyErrorNumber, 
typeLongInteger, returnType, &errNum, 
sizeof(errNum), actSize);

where errNum is the error code. If there is no error—in other words,
errNum = noErr—then the reply will contain a direct keyword param-
eter of typeLongInteger.

Use AEGetParamPtr to extract this parameter (the number of records
actually deleted).

AEGetParamPtr (theReply, keyDirectObject, 
typeLongInteger, returnType, 
&nDeleted, sizeof(nDeleted), 
actSize);

Check nDeleted against the number of supplied target Record IDs. If
they are not equal then there is some problems with a record whose
Record ID is in the nDeleted+1 position of the descriptor list.

Item Description Descriptor Type

1 ProcessID typeLongInteger

2 Record ID typeLongInteger

…

11 Record ID typeLongInteger
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C.6 One time store
Request Code = 110.

Create an empty descriptor list for the Apple Event that will be filled
in with the form identification information and stored data. There is
no limit imposed on the number of stored records but try to keep it
below 10 to avoid starvation of other clients.

Use AEPutPtr to fill the descriptor list. The order in which items are
filled into the descriptor list is critical.

C.6.1 Reply

When AESend returns, use AEGetParamPtr to extract any System or
Helix error codes.

AEGetParamPtr (theReply, keyErrorNumber, 
typeLongInteger, returnType, &errNum, 
sizeof(errNum), actSize);

where errNum is the error code. If there is no error—in other words,
errNum = noErr—then the reply will contain a descriptor list. All
items in the list are of type typeBoolean and there can be no more
than the number of supplied stored record items.

Use AEGetParamDesc to extract the descriptor list out of the reply.

AEGetParamDesc (theReply, keyDirectObject, typeAEList,
theRetDescList);

Use AECountItems to find out the number of items in the descriptor
list.

AECountItems (theRetDescList, nItems);

Item Description Descriptor Type

1 Collection Name typeChar

2 User Name typeChar

3 Password typeChar

4 Relation Name typeChar

5 Form Name typeChar

6 Stored Record typeChar
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If nItems is not the same as the number of supplied records then this
indicates that a problem exists in the nItems+1 supplied record and
the StopOnError is set in Load setup of the associated form. All the
items type in the list will be of type “typeBoolean.”

Use AEGetNthPtr to extract the Nth item out of the list.

AEGetNthPtr (theRetDescList, NthItem, typeChar, 
keywd, retType, &SucessFlag, 
sizeof(SucessFlag), actSize);

If SucessFlag is true then its corresponding Nth supplied record is
successfully stored in Helix; a false indicates that a problem exists in
the supplied record and it will not be stored.
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C.7 Store setup
Request Code = 111.

Create an empty descriptor list for the Apple Event that will be filled
with the form identification information. Stored data must not be sup-
plied in this request.

Use AEPutPtr to fill the descriptor list. The order in which items are
filled into the descriptor list is critical.

C.7.1 Reply

When AESend returns, use AEGetParamPtr to extract any System or
Helix error codes.

AEGetParamPtr (theReply, keyErrorNumber, 
typeLongInteger, returnType, &errNum, 
sizeof(errNum), actSize);

where errNum is the error code. If there is no error—in other words,
errNum = noErr—then use AEGetParamPtr to extract the ProcessID,
which later will be used for ‘store multiple’ requests.

AEGetParamPtr (theReply, keyDirectObject, 
typeLongInteger, returnType, 
&ProcessID, sizeof(ProcessID),
actSize);

Note: Make sure you issue a Cancel request with this Pro-
cessID after you are done with the process.

Item Description Descriptor Type

1 Collection Name typeChar

2 User Name typeChar

3 Password typeChar

4 Relation Name typeChar

5 Form Name typeChar
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Store multiple

C-19

C.8 Store multiple
Request Code = 112.

Create an empty descriptor list for the Apple Event that will be filled
with a ProcessID and stored data. There is no limit on the number of
stored records but try to keep it below 10 to avoid starvation of other
clients.

Use AEPutPtr to fill the descriptor list. The order in which items are
filled into the descriptor list is critical.

C.8.1 Reply

The reply will be exactly the same as the reply for ‘One Time Store’
request. (See C.6.)

Item Description Descriptor Type

1 ProcessID typeLongInteger

2 Stored Record typeChar
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Helix AEEA error codes

010 incorrect number of items in the Descriptor List

020 no collection opened with named Helix application

030 incorrect Collection name

040 collection not in User mode

050 illegal User Name

060 invalid Password for the target User

070 no such relation exists

080 no such form exists

090 no such form exists with the User

100 string length in List > 255

110 invalid Transaction Code

120 form is not compiled

130 form not in Show Form mode

140 form already opened

150 AEDone. Illegal Process ID

160 AECancel. Illegal Process ID

170 only LongInt is accepted

180 End-of-List encountered

190 illegal number of rows requested (between 1 & 10)

200 AEStore. Not an Entry Form

210 AEStore. No valid Field in Entry Form

220 AEStore. Problem with input data

230 AERetrieve. Process not finished yet

240 AEDelete. Illegal Record ID

250 AEDelete. Locking problem

260 maximum number of AE users exceeded

1000 data do not meet validation criteria for the form
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The chart below shows the release dates of the more significant
upgrades in the history of the Helix product family.

Product Version Release Date Publisher

Helix 1.0 December 1984 Odesta

Helix 1+ 1.0 September 1985

Double Helix 1.0 January 1986

2.0 August 1986

3.0 January 1987

Double Helix II 1.0 January 1988

2.0 February 1989

3.0 March 1990

3.5r9 November 21, 1991

3.5r13 August 14, 1992

Helix Express 1.0 September 22, 1992 STI

2.0 November 22, 1993

3.0 November 15, 1994

3.5 August 30, 1995

3.7.1 September 3, 1996

4.0.3 January 15, 1997

4.5 May 2, 1997

4.5.1 June 25, 1997

Helix RADE 4.5.3 April 28, 1999 TCM

4.5.4 September 17, 1999

4.5.5 December 20, 1999
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A
A Less Than B Less Than C 10-64
A Less Than B Less Than or Equal To C 10-65
A Less Than or Equal To B Less Than C 10-65
A Less Than or Equal To B Less Than 

or Equal To C 10-64
Abaci

adding tiles 7-42
components of 7-40–7-41
creating 1-16, 7-39
discarding 7-41
exporting data 12-15
filling black holes 7-44–7-46
icon for 2-19
importing data and 12-24
linking tiles in 7-43–7-44
moving tiles in 7-43–7-44
optimization of 15-5–15-9
printing 7-47, 13-10
retaining results of 4-52
tile components 7-42
uses of 7-39
validation and 7-23–7-25
see also names of individual calculation tiles

Abacus Query
choosing on view 8-57
construction of 10-83
definition of 10-83

About Helix 4-3
Absolute Value 10-9
Add operator 8-90, 8-93
Addition 10-7
Administrator 6-22
ADSP 16-3
Alignment 4-80
Allow Click 4-42, 8-19
Allow Edit 4-44, 8-19
Allow Query 4-43, 8-19, 9-11
Allow Query Bypass 4-49, 9-7
Allow Tab 4-43, 8-19
And 10-65, 15-7
Annuity Rate 10-16
Apple Data Streaming Protocol 16-3
Apple Events

Cancel C-11
creating C-3
Delete B-9
Done C-7
error codes for D-3
Get Row C-9
One time store C-15
Requests

AECountItems C-10, C-15

AECreateAppleEvent C-3
AECreateList C-3
AEGetNthPtr C-10, C-16
AEGetParamDesc C-10, C-15
AEGetParamPtr C-5–C-17
AEPutParamDesc C-4
AEPutParamPtr C-3
AEPutPtr C-4–C-19
AESend C-4, C-5, C-7
AESizeOfNthItem C-10

Retrieve B-5, C-5
Store B-7
Store multiple C-19
Store setup C-17
uses of B-3

Apple menu 4-3–4-4
Apple Menu Items 4-4
Arc Tangent 10-13
Arithmetic calculation tiles

Addition 10-7
Division 10-8
Multiplication 10-8
Subtraction 10-7
see also Exponentiation calculation tiles
see also Mathematical calculation tiles
see also Trigonometric calculation tiles

Arrow cursor 3-5
Asynchronous lists 8-69

cursor for 3-10
AutoClose 8-68
AutoClose View 8-30
AutoMenus 6-25
AutoOpen Forms 8-84–8-86, 8-97–8-99
AutoSave 4-37, 14-4–14-7, 14-13

enabling 4-37
Average 10-37
Average for 10-37

B
Background 4-45, 8-9
Background rectangles

layering 4-27, 4-28
Backing up 18-3–18-5
Beep 4-86
Binary Large Objects

see Documents
Black holes

see Abaci and Tiles
BLOBs

see Documents
Boolean

see Flag fields
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Border rectangles
and tab order 8-25
color 8-26
dialog box for 8-26
frame width 8-26
uses of 8-24–8-25
visiblity 8-27

Break All Indexes 18-11
Bring to Front 4-27
Button cursor 3-5
Buttons

see Command rectangles

C
Calculation Retain 8-22
Calculation tiles

A Less Than B Less Than C 10-64
A Less Than B Less Than or

Equal To C 10-65
A Less Than or Equal to B

Less Than C 10-65
A Less Than or Equal To B

Less Than or Equal to C 10-64
Absolute Value (Abs) 10-9
adding to abacus 7-42
Addition 10-7
And 10-65
Annuity Rate 10-16
Arc Tangent 10-13
Average 10-37
Average for 10-37
Change Document Modify Date To 10-59
Change Document Name To 10-58
Change Document Pathname To 10-59
Change Document Type To 10-58
common logarithm 10-14
components of 7-42
Compound Rate 10-15
Contains 10-17
Cosine (Cos) 10-13
Count 10-35
Count for 10-35
Date 10-52
Date, Time 10-30
Day 10-27
Day of Week 10-26
Defined 10-68
∆ Days 10-32
∆ Hours 10-32
∆ Minutes 10-31
∆ Months 10-33
∆ Seconds 10-31
∆ Weeks 10-32

∆ Years 10-33
Display 10-5
Division 10-8
Document Create Date 10-55
Document Modify Date 10-56
Document Name 10-55
Document Path 10-57
Document Size 10-56
Document Storage 10-57
Document Type 10-56
Ends With 10-18
Equal To 10-61
Exponentiation 10-14
Extract 10-22
filling black holes 7-44–7-46
Fixed Point 10-52
Flag 10-53
Followed By 10-18
Followed/Or 10-19
Form Average 10-45
Form Average for 10-46
Form Count 10-44
Form Count for 10-44
Form Maximum 10-47
Form Maximum for 10-48
Form Minimum 10-46
Form Minimum for 10-47
Form Previous 10-81
Form Time 10-25
Form Total 10-44
Form Total for 10-45
Fraction 10-11
Greater Than 10-63
Greater Than or Equal To 10-63
Hour 10-28
Hour, Minute, Second 10-30
If-Then-Else 10-67
Integer 10-10
Larger Of 10-71
Length 10-21
Less Than 10-62
Less Than or Equal To 10-63
linking 7-43–7-44
Ln 10-14
Locate 10-22
Log 10-14
Lookup for 10-73
Lookup Summary 10-75
Lower Case 10-21
Maximum 10-38
Maximum for 10-39
Minimum 10-37
Minimum for 10-38
Minute 10-28
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Mixed Case 10-21
Month 10-27
Month, Day, Year 10-29
moving 7-43–7-44
Multiplication 10-8
natural logarithm 10-14
Negation 10-12
New Line 10-19
Not 10-66
Not Equal To 10-62
Number 10-50
Or 10-66
Picture 10-60
Post Time 10-26
Previous 10-79
Previous for 10-80
Round 10-9
Round to Nearest 10-9
Second 10-29
Sine (Sin) 10-12
Smaller Of 10-70
speed selection of 10-86
Square Root 10-10
Starts With 10-17
Styled Text 10-49
Sub-Average for 10-41
Sub-Count for 10-40
Sub-Maximum for 10-43
Sub-Minimum for 10-42
Sub-Total for 10-40
Subtraction 10-7
Tangent (Tan) 10-13
Text 10-49
To Power Of 10-14
Today 10-25
Total 10-36
Total for 10-36
Undefined 10-69
Undefined Becomes 10-69
Unique 10-70
Upper Case 10-20
Use From 10-76
UserName 10-5
visual reference to 10-85
Word Equals 10-23
Word Starts With 10-23
Year 10-27

Carriage Return 10-19
Case Conversion

Lower Case 10-21
Mixed Case 10-21
Upper Case 10-20

Change Document Modify Date To 10-59
Change Document Name To 10-58

Change Document Pathname To 10-59
Change Document Type To 10-58
Check boxes 5-4, 7-17–7-18, 8-67
√ menu 4-39–4-52
Chooser 13-19
Clean Up 4-31
Clear 4-16
Clear Selections 4-17
Client Info 4-12, 16-23–16-25
Client/Server

see Helix Server and Helix Client
Clipboard 4-22
Close 4-24
Close All 4-24
Close boxes 8-73
Close collection 4-6
Cold forms 8-69

enabling 8-70
refreshing 4-87, 8-70

Cold Query
creating 9-15
definition of 9-14
power queries as 9-24
refreshing 4-87
using 9-16

Collection Password 4-35
Collections

AutoSave 14-4–14-7, 14-13
backing up 18-3–18-5
changing content display 6-16
checking with Helix Utility 18-7–18-9
closing 4-6
compressing 18-9–18-11
converting for Runtime use 17-7–17-11
copying structure of 6-45
creating 1-14, 4-5
Dump Collection Info 4-11, 6-17
editing mode 6-15
Fast Find mode 6-15
Helix Runtime and 17-5
icons for 2-13, 16-4
keyboard shortcuts for 6-15
logging 4-7

benefits of 14-13
definition of 14-9
operation of 14-9–14-11
turning off 14-11
turning on 14-9

low disk space 14-19
memory and object manager 15-3
opening 4-5
opening in Helix Server 16-7
opening when out-of-date 18-14
opening window 4-30
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passwords for 4-35
pasting structure into 6-46–6-48
printing 6-18, 13-10
recovery 14-13–14-15, 14-17
reverting to saved 14-4
reverting to saved version 4-7
saving 4-6, 4-7, 14-3, 14-14
saving automatically 14-4–14-7, 14-13
updating 1-26, 18-13–18-14
viewing by icon 4-28, 6-12
viewing by kind 4-29, 6-14
viewing by name 4-29, 6-13
visiting 16-11
window components 6-11

Color 8-16, 8-26, 8-75
data rectangles 4-81
label rectangles 4-81
text color 4-89

Color palette 4-37
Color Preferences 4-37
Colors (custom menu command) 4-89
Colors (Style menu) 4-81
Column swapper cursor 3-5
Command cursor 3-9, 8-72
Command rectangles

appearance of 8-39
conditional 8-42–8-44
conditional example 8-44–8-46
contents of 8-38
creating 8-39
dialog box 8-41
formatting 8-41, 8-42
uses of 8-38

Common Calculation 4-52
Common logarithm 10-14
Compile Forms 4-31
Compound Rate 10-15
Concatenation 10-18
Concurrency control 8-69
Conditional buttons

see Command rectangles
Conditional color 8-17–8-18
Conditional sequences 6-43–6-44
Conditional style 8-17–8-18
Contains 10-17
Converter

see Helix Runtime Converter
Copy 4-16
Copy From Volume 4-67, 11-13
Copy Record 4-18
Copy Record Options 4-19
Copy Selected Records 4-18
Copy To Volume 4-67, 8-82, 11-15
Copying database structure 6-45

Cosine 10-13
Count 10-35
Count for 10-35
Create Publisher 4-20, 12-27
Creating

abaci 1-16, 7-39
collections 1-14, 4-5
command rectangles 8-39
fields 1-16, 7-3
indexes 1-19
power queries 9-21–9-26
publishers 4-20
relations 1-15
subforms 8-47

Creator Code 16-4
Cross hair cursor 3-6
Currency 5-16
Currency format 5-12
Cursors

command 8-72
function 3-5–3-7
network 16-7
retrieve 8-67
wait 3-9–3-10

Custom Help
creating 16-27–16-28
data for 16-30
menu option 4-4
source files for 16-28–16-29
templates for 16-30

Custom Helper 16-27
icon for 2-11

Custom menus
AutoMenus 6-25
color options for 4-89
command key equivalents 6-29
creating 6-25
editing 6-26
font list for 4-88
font sizes for 4-88
font styles for 4-88
form permissions 6-28
guidelines for 6-29
hierarchal 6-28
top menu command 4-83
user submenus 6-27

Custom Mode 4-33
Custom Names 4-26, 4-27, 6-7–6-9
Custom Paper 4-36, 13-7
Custom Size 4-80
Custom windows

see Windows
Cut 4-16
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D
Data Damage Check 18-8–18-9
Data rectangles

allowing edit of 4-44, 8-19
allowing query of 4-43, 8-19
allowing selection of 4-42, 4-43, 8-19
calculation retain 8-22
color 8-16
conditional color 8-17–8-18
conditional style 8-17–8-18
creating 8-12
dialog box for 8-15
first page visibility 4-46
font 8-16
in repeat rectangles 8-28
interior page visibility 4-47
keep value 8-21
keeping values 4-42
last page visibility 4-47
overriding formats with 8-23
placing abaci in 8-12, 8-16
placing fields in 8-12, 8-16
resizing 8-14
scaling pictures in 4-40
scroll bars 8-20–8-21
select all 4-17
style 8-16
tabbing between 8-14
trimming 4-20
word wrap 8-21

Data type conversion tiles
Date 10-52
Fixed Point 10-52
Flag 10-53
Number 10-50
Styled Text 10-49
Text 10-49

Data types
document 5-27
flag 5-21
keyword 5-4
number 5-11
picture 5-25
styled text 5-9
text 5-4, 5-7

Date 10-52
Date calculation tiles

Date, Time 10-30
Day 10-27
Day of Week 10-26
∆ Days 10-32
∆ Months 10-33
∆ Weeks 10-32

∆ Years 10-33
Month 10-27
Month, Day, Year 10-29
Today 10-25
Year 10-27
see also Time calculation tiles

Date fields
formats for 5-20
range of 5-19

Date, Time 10-30
Day 10-27
Day of Week 10-26
Decrement operator 8-91, 8-93
Default values, shading 4-50
Defined 7-23, 10-68, 15-7
Delete 4-62
Delete All 4-63
Delete All Originals 4-73
Delete Original 4-73
Delete Selections 4-64
Deleting records 4-62–4-64
Delimiters 12-3–12-4, 12-25–12-26
∆ Days 10-32
∆ Hours 10-32
∆ Minutes 10-31
∆ Months 10-33
∆ Seconds 10-31
∆ Weeks 10-32
∆ Years 10-33
Dialog boxes

in sequences 6-40–6-42
navigating 6-3
selecting buttons in 6-3

Disk space 14-19
Display 10-5
Display view 8-86
Divider dragger cursor 3-5
Division 10-8
Docs menu 4-67–4-75
Document Create Date 10-55
Document Modify Date 10-56
Document Name 10-55
Document Path 10-57
Document Size 10-56
Document Storage 10-57
Document Type 10-56
Documents

calculation tiles
Change Document Name To 10-58
Change Document Pathname To 10-59
Change Document Type To 10-58
Change Modify Date To 10-59
Document Create Date 10-55
Document Modify Date 10-56
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Document Name 10-55
Document Path 10-57
Document Size 10-56
Document Storage 10-57
Document Type 10-56
Picture 10-60

calculation tiles and 11-20–11-22
choosing storage location for 11-5
copying into Helix 4-67, 11-13
copying to disk 4-67, 11-15
deleting all originals 4-73
deleting original 4-73
exporting 12-10
external storage 11-5
external vs. internal 11-5
formatting options for 5-27
importing 12-19–12-20
internal storage 11-5
introduction to management of 11-3
moving 11-11
moving external 4-72
moving into Helix 4-68, 11-15
Open Copy 4-70, 11-20
Open Original 4-70, 11-20
pathname of 11-13
printing 4-71, 13-13
range of 5-27
storage options 11-5–11-7
updating references to 4-74, 4-75
validation for 7-25
versions of 11-9
Work On Copy 4-69, 11-17–11-20
Work On Original 4-68, 11-20

Double clickable lists 8-29, 8-67
Draw Screen 4-84
Dump All 4-11, 12-5, 12-10–12-11
Dump Collection Info 4-11, 6-17
Dump file icon 2-14
Dump Form 4-85, 12-5
Dump Options 12-11–12-15
Dump Relation Info 4-11
Dump Selections 4-12, 12-5
Dumping data

see Exporting data
Duplicate 4-23, 8-11
Duplicate rectangle cursor 3-5
Dynamic popup menus

see Popup menus, dynamic

E
Edit menu 4-15–4-22
Edit Users 4-83, 16-13
Editing mode 6-15

Edition
see Publish & Subscribe

Edition files
icon for 2-16

Enablement keys 1-13
Ends With 10-18
Engine

see Helix Runtime
see Helix Runtime Engine

Enter 4-57
Enter Override 4-86
Entering data 8-64–8-67
Equal To 10-61
Equals 15-7
Exiting Helix 4-13
Exponentiation 10-14
Exponentiation calcuation tiles

Ln 10-14
Log 10-14
To Power Of 10-14

Exporting data
abaci 12-15
collection info 4-11
delimiters 12-3–12-4, 12-25–12-26
documents and 12-10
Dump All 4-11, 12-5, 12-10–12-11
Dump Form 4-85, 12-5
Dump Selections 4-12, 12-5
Fixed Length Record format 12-3
label rectangles and 12-16
options for 12-11–12-15
preparation for 12-9
subforms and 12-16
templates for 12-4
versus publishing 12-7

Exporting relation info 4-11
Extract 10-22

F
Fast Find mode 6-15
Field separators 12-3
Fields

choosing data type for 7-3
components of 7-3
creating 1-16, 7-3
date 5-19
deleting 7-4
fixed point 5-15
flag 7-16–7-19
format options 7-6
formatting 5-3, 5-7, 7-5–7-19
icon for 2-19
indexing on 7-34
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inert 5-4, 7-29
invalid 8-66
keyword 7-27–7-29
overriding formats 7-19
shading invalid 4-51
standard format 7-7
styled text 5-9
time 5-19
undefined 8-67
validation 5-4, 7-20–7-27
see also names of individual data types
see also Validation

File menu 4-5–4-13
Financial calculation tiles

Annuity Rate 10-16
Compound Rate 10-15

Find & Update All 4-74
Find All 4-55
Find and Post All 4-65
Find and Print All 4-9, 13-9
Find First 4-59
Find Last 4-61
Find Next 4-59
Find Previous 4-60
Fixed Length Record export 12-3
Fixed Point 10-52
Fixed point fields

format options for 5-15
range of 5-15

Flag 10-53
Flag fields

custom labels for 7-18
formatting options for 5-21, 7-16–7-19
range of 5-21

Followed By 10-18
Followed/Or 10-19
Font Attributes 4-79
Font menu 4-77
Font Size 4-79
Fonts 4-88
Form Average 10-45
Form Average for 10-46
Form Count 10-44
Form Count for 10-44
Form Maximum 10-47
Form Maximum for 10-48
Form Minimum 10-46
Form Minimum for 10-47
Form Permissions 6-22, 6-28
Form Previous 10-81
Form Query 4-56, 9-9–9-17

abaci for 9-11
choosing on view 8-57
cold 9-14–9-16

components of 9-10
configuring 9-12–9-13
data entry and 9-9
definition of 9-9, 10-83
dialog box for 9-11
example 9-14
fields for 9-11
icon for 2-21
opening 9-9
operators for 9-11
templates for 9-9, 9-10

Form rectangles
modifying 8-52
multipage 8-53
Page Setup 8-53, 8-54
page size 8-51, 8-53
printing 8-53, 8-54
ruler 8-54

Form setup mode 8-55, 8-57–8-60
Form Time 10-25, 16-13
Form Total 10-44
Form Total for 10-45
Formatting fields 7-5–7-19
Forms

AutoOpen 8-84–8-86, 8-97–8-99
calculation tiles

Form Average 10-45
Form Average for 10-46
Form Count 10-44
Form Count for 10-44
Form Maximum 10-47
Form Maximum for 10-48
Form Minimum 10-46
Form Minimum for 10-47
Form Total 10-44
Form Total for 10-45

cold 8-69
compiling 4-31
deleting all 4-63
displaying 4-54
linking entry forms to lists 8-30
opening entry form from list 8-67
optimization of 15-7–15-9
page numbering 4-46, 8-71
Page Setup 8-71
posting from 4-65
printing 8-71
scrolling 8-66
settings memory 8-71
shading default values 4-50
tab order 8-66
user permissions for 6-28
see also Views

Fraction 10-11
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Fragile indexes 7-35
Frame Rectangle 4-41, 8-24, 8-27
Full Mode 4-33
Full Mode Info 4-12, 16-21–16-23

G
Get Edition Now 12-30
Get Info 4-30
Get Info window

components of 6-5
custom icon names 6-7–6-9
hidden references in 6-7
invoking 6-5

Graph Paper 4-47
Greater Than 10-63
Greater Than or Equal To 10-63
Grid 4-48, 8-14
Grow boxes 8-73, 8-76
Grow cursor 3-6

H
Helix Client

forced quit and 16-19
icon for 2-9
installing 1-28, 16-9
leaving a collection 16-17
limit of concurrent users 16-14
missing servers 16-14
monitoring 16-23–16-25
network cursor 16-7
network shutdown and 16-19
open a previously visited collection 16-14
passwords and 16-12–16-13
quitting 16-18
role of 16-3
saved structure file 16-14, 16-18
switching collections 16-15
user names and 16-12
visiting collections 16-11

Helix Engine
opening collections with 17-13
use of 17-5

Helix Info 4-3
Helix RADE

icon for 2-9
launching 1-13
registering 1-29
revision history E-3

Helix Runtime
collections for 17-5
converting collections 17-7–17-11
setting collection expiration dates 17-17
unconverting collections 17-15

Helix Runtime Converter 2-10
Helix Runtime Engine 2-10
Helix Server

allocating RAM for 1-27
clients for 1-27
collection icons for 16-4
documenting user activity 16-13
hardware for 16-3, 16-5
icon for 2-9
launching 1-13
limit of concurrent users 16-14
monitoring activity of 16-21–16-23
monitoring clients 16-23–16-25
network configuration for 16-3
network cursor 16-7
network shutdown and 16-19
opening collections 16-7
quitting 16-7
registering 1-29
role of 16-3
software for 16-5

Helix Translator 1-27
icon for 2-11
uses of 18-14

Helix Update Collection
fonts and 18-15
Helix Utility and 18-15
icon for 2-11
launching 18-13
memory requirements 18-13
opening out-of-date collections 18-14
structure checking 18-15
uses of 18-13

Helix Utility
autofix options 18-12
breaking indexes 18-11
checking collections 18-7–18-9
checking for data damage 18-8–18-9
compressing collections 18-9–18-11
Helix Update Collection and 18-15
icon for 2-10

Help 4-4
see also Custom Help

Home Field 4-85
Hour 10-28
Hour, Minute, Second 10-30

I
I-Beam cursor 3-6
Icon menu 4-23–4-32
Icon Names 4-26, 4-27
Icon Well Labels 4-31
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Icons
application 2-9–2-11
as objects 2-3
Clean Up 4-31
collection level 2-17–2-18
copied 6-45
custom names 4-26, 4-27
desktop 2-13–2-16
duplicating 4-23
finding where used 4-30
linking 8-79, 8-81
opening 4-23
overview of 2-7
referenced 6-45
relation level 2-19–2-22
select name 4-17
well labels 4-31

If-Then-Else 10-67
Importing data

abaci and 12-24
creating files for 12-18–12-19
delimiters 12-3–12-4, 12-25–12-26
documents and 12-19–12-20
Load 4-10, 12-7
options for 12-21–12-23
performing 12-20–12-21
placing in background 12-24
preparation for 12-17–12-18
stopping 12-24
templates for 12-17
versus subscribing 12-7

Include Field Headers 12-16
Increment operator 8-89, 8-93
Indexes 7-31–7-38

adding fields to 7-34
choosing active 7-33
choosing on view 8-57
components of 7-31–7-33
creating 1-19, 7-31
fragile 7-35
icon for 2-20
invalid 7-36
making available to users 4-86, 7-33–7-34
printing 13-15
uses of 7-31

Inert fields 5-4, 7-29
Insert operator 8-90, 8-93
Installation

complete 1-11
custom 1-11
from CD-ROM 1-9
from downloaded installer 1-9
performing 1-10–1-13
preparation for 1-9

system requirements 1-9
Integer 10-10
Invalid indexes 7-36

K
Keep Current 8-69, 8-70
Keep Value 4-42, 8-21
Keyword fields 7-27

calculation tiles for 10-23–10-24
creating 7-27–7-29
definition of 5-4
editing ignored words 7-27
ignored words A-3

L
Label rectangles

background 8-36–8-38
contents of 8-34
dialog box 8-35
exporting data and 12-16
first page visiblity 4-46
formatting 8-35
interior page visiblity 4-47
last page visiblity 4-47
page numbering 4-46, 8-35–8-36
placing in background 4-45
scaling pictures in 4-40, 8-34
select all 4-17
uses of 8-34

Larger Of 10-71
Leave 16-15, 16-17
Length 10-21
Less Than 10-62
Less Than or Equal To 10-63
Ln 10-14
Load 4-10, 12-7, 12-20
Load Options 12-21–12-23
Loading data

see Importing data
Locate 10-22
Lock Quick Query 4-50, 9-7
Log 10-14
Logarithms

common 10-14
Ln 10-14
Log 10-14
natural 10-14

Logfile
icon for 2-13

Logging
benefits of 14-13
definition of 14-9
operation of 14-9–14-11
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turning off 4-7, 14-11
turning on 4-7, 14-9

Logical operator calculation tiles
And 10-65
Not 10-66
Or 10-66
see also Relationship operator calculation tiles

Lookup calculation tiles
Lookup For 10-73
Lookup Summary 10-75
optimization of 15-5
Use From 10-76

Lookup for 10-73
Lookup Summary 10-75
Low disk space 14-19
Lower Case 10-21

M
Mailing labels 13-17
Marching ants 8-58
Mathematical calculation tiles

Absolute Value 10-9
Fraction 10-11
Integer 10-10
Negation 10-12
Round 10-9
Round to Nearest 10-9
Square Root 10-10
see also Arithmetic calculation tiles
see also Exponentiation calculation tiles
see also Trigonometric calculation tiles

Maximum 10-38
Maximum for 10-39
Menus

Apple 4-3–4-4
√ menu 4-39–4-52
Docs 4-67–4-75
Edit 4-15–4-22
File 4-5–4-13
Font 4-77
Icon 4-23–4-32
Set 4-33–4-37
Style 4-79–4-81
View 4-53–4-66
see also Custom menus

Minimum 10-37
Minimum for 10-38
Minute 10-28
Mixed Case 10-21
Modifying data 8-64–8-67
Month 10-27
Month, Day, Year 10-29
Mouse click cursor 3-7

Move Backward 4-28
Move Forward 4-27
Move Into Collection 4-68, 11-15
Move window cursor 3-6
Multiplication 10-8
Multiuser

see Helix Server and Helix Client

N
Natural logarithm 10-14
Negation 10-12
Network cursor 16-7
Network wait cursor 3-9
New 4-5
New Edition 12-27
New Line 10-19
Not 10-66, 15-7
Not Equal To 10-62
Number 10-50
Number fields

formatting options for 5-11
range of 5-11

O
Object Manager 15-3
Online help

see Custom Help
Open (File menu) 4-5
Open (Icon menu) 4-23
Open Copy 4-70, 11-20
Open Original 4-70, 11-20
Open Publisher 12-31
Open Query 4-56

see also Form Query
Opening a collection 4-5
Or 10-66, 15-7

P
P# is Page Number 4-46, 8-35–8-36
Page numbering 4-37, 4-46, 8-35–8-36, 8-71
Page Setup 4-8, 8-53, 8-71, 13-5, 13-6
Palettes 2-3
Passwords 16-12–16-13

collection 4-35
user 4-35, 4-83

Paste 4-16
Paste Record 4-18
Paste Record Options 4-19
Pasting database structure 6-46–6-48
Pause 4-84
Percent format 5-12
Picture 10-60
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Picture fields
formatting options for 5-25
range of 5-25

Pictures
scaling 4-40

Plus cursor 3-6
Popup menus

dynamic
creating 7-9–7-11
definition of 5-3
example of 7-12–7-16

static
creating 7-8
definition of 5-3

Post All 4-65
Post Every 8-78, 8-81
Post First 8-78, 8-81
Post Selections 4-65
Post Time 10-26
Posting 4-64–4-66

all listed records 4-65
AutoOpen Forms 8-84–8-86, 8-97–8-99
choosing triggers for 8-61
choosing views for 8-61
components of window 8-78
configuring 4-54
definition of 8-77
display view 8-86
finding and posting all 4-65
icon for 2-21
linking objects 8-79, 8-81
opening dialog box for 8-79
operation of 8-94–8-96, 8-96–8-97
operators 8-89–8-91, 8-92, 8-93, 8-94
options 8-82–8-84, 8-94–8-96
Post Every 8-81
Post First 8-81
Post Time tile 10-26
selected records 4-65
selection view 8-86
summary of 8-91–8-92
tile black holes 8-80
tile components 8-79
tile configuration actions 8-80
tile operation 8-80
triggers for 8-60, 8-82, 8-94–8-96
triplets 8-86–8-88, 8-92
validation and 7-27, 8-93

Posting selection mode 8-55, 8-60–8-62
Posting tile

see Posting
Power Query 4-56

abaci for 9-21–9-22
attaching to a view 9-24

choosing on view 8-57
cold 9-24
components of 9-19–9-20
creating 9-21–9-26
definition of 9-19, 10-84
deleting search statements 9-29
editing expressions 9-29
example 9-22–9-24, 9-27
fields for 9-21–9-22
icon for 2-21
invalid search statements in 9-25–9-26
modifying search statements 9-28–9-30
opening 4-56
selecting expressions 9-28
using 9-26–9-28

Precision 5-12, 5-16
Preview 4-49, 8-50
Previous 10-79
Previous for 10-80
Print Document 4-71, 13-13
Print Form 4-8, 13-9
Print Paged 4-10, 6-18, 6-35, 13-10
Print Scaled 4-9, 6-18, 6-35, 13-10
Print Template 4-9, 13-11
Printable 4-41
Printing 13-3

abaci 13-10
Chooser changes 13-19
collections 13-10
custom paper sizes 4-36, 13-7–13-8
documents 4-71, 13-13
Find and Print All 4-9, 13-9
indexes 13-15
mailing labels 13-17
page setup 4-8

ImageWriters 13-6
laser printers 13-5

Print Form 4-8, 13-9
Print Paged 4-10, 13-10
Print Scaled 4-9, 13-10
Print Template 4-9, 13-11
queries 13-15
relations 13-10
templates 13-11
views 13-9

Prototype 6-22
Publish & Subscribe

creating publishers 4-20, 12-27
definition of 12-27
icon for 2-16
publisher options 4-21, 12-28
subscriber options 4-21, 12-30
subscribing 12-29
subscribing to editions 4-21
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updating publishers 4-87
Publish Now 4-87
Publisher Options 4-21, 12-28

Q
Query

introduction 9-3
optimization of 15-5–15-9
printing 13-15
types of 9-3
see also Form Query
see also Power Query
see also Quick Query

Quick Entry 4-25, 6-8, 8-4, 8-56
see also Templates, Quick Entry

Quick List 4-26, 4-55, 6-8, 8-4, 8-56
see also Templates, Quick List

Quick Query 4-55
abacus query with 9-6
activating 9-5
allowing 4-43, 4-50
allowing bypass of 4-49, 9-7
cancelling 9-7
definition of 9-5, 10-83
form query with 9-6
locking 9-7
operators for 9-6
optimization of 15-9
specifying 9-5–9-6
use of 4-55

Quit 4-13

R
Radio buttons 5-4, 7-16–7-17, 8-67
Records

clearing selected 4-17
copying 4-18
copying options 4-19
deleting 4-62–4-64
display first 4-59
display last 4-61
display next 4-59
display previous 4-60
drawing in sequences 4-84
exporting 4-85
pasting 4-18
pasting options 4-19
replacing in database 4-57
restoring from unsaved changes 4-62
selecting all 4-17
selecting in a list 8-68
sequential access 4-58–4-61
storing in database 4-57, 4-84

Recovery file
icon 2-15

Rectangles
aligning 8-14
background 8-36–8-38

layering 4-27, 4-28
sending to background 8-9

border
color 8-26
dialog box for 8-26
frame width 8-26
uses of 8-24–8-25
visibility 8-27

borders for 4-41, 8-10
color 8-11
command

appearance of 8-39
conditional 8-42–8-44
conditional example 8-44–8-46
contents of 8-38
creating 8-39
dialog box 8-41
formatting 8-41, 8-42
uses of 8-38

components of 8-5
controlling printing of 4-41
creating 8-7
data

allowing edit of 4-44, 8-19
allowing query of 4-43
allowing Quick Query using 8-19–8-20
allowing selection of 4-42, 4-43, 8-19
calculation retain 8-22
color 8-16
creating 8-12
dialog box for 8-15
first page visibility 4-46
font 8-16
in repeat rectangles 8-28
interior page visibility 4-47
keep value 8-21
keeping values 4-42
last page visibility 4-47
overriding formats with 8-23
placing abaci in 8-12, 8-16
placing fields in 8-12, 8-16
resizing 8-14
scaling pictures in 4-40
scroll bars 8-20–8-21
select all 4-17
style 8-16
tabbing between 8-14
trimming 4-20, 8-14
word wrap 8-21
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definition of 8-5
deleting 8-11
duplicating 3-5, 4-23, 8-11
font 8-10
form

modifying 8-52
Page Setup 8-53, 8-54
page size 8-51, 8-53
printing 8-53, 8-54
ruler 8-54

framing 4-41
label

background 8-36–8-38
contents of 8-34
dialog box 8-35
exporting data and 12-16
first page visibility 4-46
formatting 8-35
interior page visibility 4-47
last page visibility 4-47
page numbering 4-46, 8-35–8-36
placing in background 4-45
scaling pictures in 4-40, 8-34
select all 4-17
uses of 8-34

moving 8-8–8-9
opening 4-23
printability 8-10
repeat

abaci in 8-28
allowing selections in 8-30
AutoClose option 8-68
deleting 8-28
dialog box for 8-29
fields in 8-28
linking entry forms 8-30
resizing 8-28
setting travel direction 8-30–8-33
size of repeats 8-25
subform use of 8-47
uses of 8-27

selecting 8-8–8-9
setting alignment 4-80
setting color of 4-20, 4-81
setting font size for 4-79, 4-80
setting text attributes for 4-79
sizing 8-8–8-9
style 8-10
tab order 8-25
trimming 8-47

Refresh 4-87, 8-70
Registration 1-29
Relations

components of 6-31

creating 1-15, 6-31
Dump Relation Info 4-11, 6-34
icon for 2-17
printing 6-35, 13-10
uses of 6-31
viewing by icon 4-28, 6-32
viewing by kind 4-29, 6-32
viewing by name 4-29, 6-32

Relationship operator calculation tiles
A Less Than B Less Than C 10-64
A Less Than B Less Than or Equal to C 10-65
A Less Than or Equal To B Less Than C10-65
A Less Than or Equal to B Less Than or Equal

to C 10-64
Equal To 10-61
Greater Than 10-63
Greater Than or Equal To 10-63
Less Than 10-62
Less Than or Equal To 10-63
Not Equal To 10-62
see also Logical operator calculation tiles

Repeat rectangles
abaci in 8-28
allowing selections in 8-30
AutoClose option 8-68
deleting 8-28
dialog box for 8-29
fields in 8-28
linking entry forms 8-30
resizing 8-28
setting travel direction 8-30–8-33
size of repeats 8-25
subform use of 8-47
trimming 8-47
uses of 8-27

Replace 4-57
Retrieve cursor 3-6, 8-67
Return 10-19
Return key 8-65
Revert 4-25, 4-62
Revert to Saved 4-7, 14-4, 14-9
Round 10-9
Round to Nearest 10-9
Ruler 4-48, 8-54
Runtime

see Helix Runtime
see Helix Runtime Engine

S
Safety file, icon for 2-14
Save 14-3, 14-9
Save & Log 4-7, 14-9
Save & Stop Logging 4-7, 14-11
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Save (File menu) 4-6
Save (Icon menu) 4-25
Save As 4-6, 14-3
Save cursor 3-9
Saved Structure, icon for 2-14
Saving collections 4-6
Scale Picture 4-40
Scienctific notation format 5-12
Scroll bars 8-20–8-21, 8-74
Second 10-29
Security 4-36, 16-12
Select All 4-17
Select All Records 4-17
Selectable 8-30
Selectable lists 8-30, 8-68
Selected records

clearing 4-17
copying 4-18
copying options 4-19
deleting 4-64
dumping 4-12
exporting 12-5
pasting 4-18
pasting options 4-19
posting 4-65
selecting all 4-17

Selection rectangles
see Border rectangles

Selection view 8-86
Send Editions 12-28
Send to Back 4-28
Sequences

Beep 4-86
Close command in 8-76
commands in 6-40
components of 6-37–6-39
conditional 6-43–6-44
creating 6-37
dialog boxes in 6-40–6-42
drawing screen in 4-84
exporting data from 4-85
icon for 2-17
in sequences 6-40
making top data rectangle active 4-85
pauses in 4-84
refreshing cold forms 4-87
refreshing cold queries 4-87
storing records from 4-86, 4-87
tab actions in 4-86
users in 6-39
uses of 6-37
views in 6-39

Serial numbers 1-13
Server AutoSave cursor 3-9

Server Info 4-12, 16-21–16-23
Set menu 4-33–4-37
Set Rectangle Color 4-20
Set Window Color 8-75
Set Window Type 4-30
Shade Defaults 4-50
Shade Invalid Fields 4-51, 8-66
Show Clipboard 4-22
Show Collection 4-30
Show data mode 8-55, 8-63–8-70
Show Form 4-54
Show Page Boundaires 8-73
Show Posting 4-54
Show posting mode 8-55
Show Setup 4-53
Show setup mode 8-55
Sine 10-12
Sizes (font) 4-88
Sketch 6-45
Smaller Of 10-70
Software registration 1-29
Sort Order 4-86, 7-33, 7-34
Sorting

see Indexes
Square Root 10-10
St. Bernard file 2-15
Standard format 7-7
Start characters 12-3
Starting Page # 4-37
Starts With 10-17, 15-7
Static Enter 4-84, 8-67
Static Enter Override 4-87
Static popup menus

see Popup menus, static
Status boxes 8-73
Stop characters 12-3
String calculation tiles

Extract 10-22
Length 10-21
Locate 10-22
Lower Case 10-21
Mixed Case 10-21
Upper Case 10-20
see also Text calculation tiles

Structure
copying & pasting 6-45

Style menu 4-79–4-81
Styled Text 10-49
Styled text fields 5-9
Styles 4-88
Sub-Average for 10-41
Sub-Count for 10-40
Subforms

configuring on view 8-58–8-60
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creating 8-47
definition of 8-27, 8-46
exporting data and 12-16
modifying 8-49
opening from host template 8-49
operation of 8-47
optimization of 15-8–15-9
resizing 8-49

Sub-Maximum for 10-43
Submenu 6-22
Submenus

see Custom menus
Sub-Minimum for 10-42
Subscribe To 4-21, 12-29
Subscriber Options 4-21, 12-30
Substring 10-22
Sub-Total for 10-40
Subtract operator 8-91, 8-93
Subtraction 10-7
Suitcase 2-14
Summary calculation tiles

Average 10-37
Average for 10-37
Count 10-35
Count for 10-35
Form Average 10-45
Form Average for 10-46
Form Count 10-44
Form Count for 10-44
Form Maximum 10-47
Form Maximum for 10-48
Form Minimum 10-46
Form Minimum for 10-47
Form Total 10-44
Form Total for 10-45
Maximum 10-38
Maximum for 10-39
Minimum 10-37
Minimum for 10-38
optimization of 15-5
Sub-Average for 10-41
Sub-Count for 10-40
Sub-Maximum for 10-43
Sub-Minimum for 10-42
Sub-Total for 10-40
Total 10-36
Total for 10-36

System requirements 1-9

T
Tab Field 4-86
Tab key 8-65
Tab order 8-25

Tangent 10-13
Templates

background rectangles 8-36–8-38
background rectangles on 4-45, 8-9
choosing for a view 8-57
components of 8-3
creating 1-20–1-24, 8-3
Custom Help and 16-30
displaying on views 4-54
exporting data and 12-4
form queries and 9-9, 9-10
graph paper for 4-47
grid for 4-48
icon for 2-19
importing data and 12-17
layers 8-36–8-38
multipage 8-53
opening subforms from 8-49
page numbering 8-71
page numbers 4-37
Page Setup 8-54
previewing 4-49, 8-50
printing 4-9, 8-53, 8-54, 13-11
Quick Entry 4-25, 8-4
Quick List 4-26, 8-4
rectangles 8-5
repeat rectangles on 8-28
reverting to saved 4-25
ruler 8-54
ruler for 4-48
saving 4-25
uses of 8-3
see also Rectangles
see also Subforms

Text 10-49
Text calculation tiles

Contains 10-17
Ends With 10-18
Followed by 10-18
Followed/Or 10-19
New Line 10-19
Starts With 10-17
Word Equals 10-23
Word Starts With 10-23
see also String calculation tiles

Text fields
defining 5-7
formatting 5-7
keyword option for 5-4

Tiles
see Calculation tiles

Time calculation tiles
Date, Time 10-30
∆ Hours 10-32
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∆ Minutes 10-31
∆ Seconds 10-31
Form Time 10-25
Hour 10-28
Hour, Minute, Second 10-30
Minute 10-28
Post Time 10-26
Second 10-29
see also Date calculation tiles

Time fields
formats for 5-20
range of 5-19

Time Stamp 4-19
Title bars 8-75, 8-76
To Power Of 10-14
Today 10-25
Top Menu 4-83
Total 10-36
Total for 10-36
Transactions 14-9
Transfer Original 4-72
Trash can

for collection 2-18
for relation 2-22
icon for 2-18, 2-22

Travel 8-30–8-33
Trigonometric calculation tiles

Arc Tangent 10-13
Cosine 10-13
Sine 10-12
Tangent 10-13

Trim 4-20, 8-14
rectangles 8-47

Triplets 8-86–8-88, 8-92

U
Undefined 7-23, 10-69, 15-7
Undefined Becomes 10-69
Undefined data

definition of 5-5
Undefined fields 8-67
Undo 4-15
Unique 7-23, 10-70
Update All 4-75
Update Document 4-74
Updating collections 1-26

see Helix Update Collection
Upper Case 10-20
Use From 10-76
User 6-22
User definable sorts 7-33–7-34
User interface guidelines 6-29
User Name Security 4-36, 16-12

User Submenus
see Custom menus

UserName 10-5, 16-13
Users

changing passwords 4-83
components of 6-20
creating 6-19
deleting 4-83, 6-24
determining record order 4-86
duplicating 4-83, 6-23
editing 6-23
form permissions 6-28
hiding user names 4-36
icon for 2-17
in sequences 6-39
passwords for 4-35, 6-24, 16-12
selecting 16-12
specifying current 4-34
types of 6-22
uses of 6-19
see also Custom menus

Utility
see Helix Utility

V
Validation

abaci for 7-23–7-25
definition of 5-4
during data entry 8-65
during data modification 8-65
operation of 7-20
operators for 7-21–7-23
posting and 8-93
shading invalid fields 4-51, 7-26

Version control 11-9
View 8-55

by Icon 4-28, 6-12, 6-32
by Kind 4-29, 6-14, 6-32
by Name 4-29, 6-13, 6-32

View menu 4-53–4-66
Views

asynchronous lists 8-69
choosing active index 7-33
choosing indexes for 8-57
choosing posting for 8-61
choosing query for 8-57
choosing template for 8-57
configuring 4-53
configuring subform on 8-58–8-60
creating 1-20–1-24
displaying forms on 4-54
entering data using 8-64–8-67
icons for 2-20
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in sequences 6-39
interuptable actions on 8-72
invalid 8-71
modifying data using 8-64–8-67
page numbering 8-71
Page Setup 8-71
posting triggers for 8-60
power queries and 9-24
printing 8-71, 13-9
selectable lists 8-68
settings memory 8-71
using 1-25, 8-63
see also Windows
see also Forms

Virus protection software 1-9
Visible

on First Page 4-46
on Interior Page(s) 4-47
on Last Page 4-47

Visit 16-11

W
Wait cursor 3-9
Why

menu option 4-3
validation and 7-20

Windows
attributes 8-73–8-75
close boxes 8-73
closing 4-24, 8-76
color 8-75
compiling 4-31
grow boxes 8-73, 8-76
moving 3-6
navigating 6-3
opening collection 4-30
resizing 3-6
scroll bars 8-74
setting type 4-30, 8-73
status boxes 8-73
title bars 8-75, 8-76
zoom boxes 8-73

Word Equals 10-23
Word Starts With 10-23
Word Wrap 8-21
Work On Copy 4-69, 11-17
Work On Document 8-82
Work On Original 4-68, 11-20

Y
Year 10-27

Z
Zoom boxes 8-73
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